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 Getting Started 

The topics covered in the online help assume that you are familiar with pattern making 
techniques and that you have received proper training on the basic functionality of the 
AccuMark™ or MicroMark™ system. 

Pattern Design™/Silhouette™, is the most productive pattern design system available 
today. The power of Gerber’s existing pattern design systems (AccuMark PDS, 
Silhouette™, MicroMark PDS and FCAD) have been combined with the Microsoft 
Windows® interface. The functions are easily accessible in user-definable tool bars. 
The result is a system that eliminates time-consuming, repetitive tasks, allowing you 
to create more patterns in less time.  

The Edition for Your Needs 

PDS is available in the Professional Edition for desktop workstations. Silhouette 
Professional Edition is designed for use with the Silhouette table which lets pattern 
makers work in life size scale to draft and work with muslins or toiles. The Expert 
Edition contains advanced features for use on workstations and on the Silhouette 
table. 

What do you want to do? 

 Customize PDS/Silhouette for your needs. 

 Learn the basics. 

 Work with and print/plot/cut models and styles. 

 Make edits to piece geometry. 

 Change how points, lines, and pieces display in the work area. 

 Create and modify pieces. 

 Create and modify lines. 

 Modify points on a piece. 

 Apply grading to pieces. 

 Measure pieces. 

 Draft or Sketch pieces. 

 Check terms in a glossary. 

 Print a hard copy of this information. 
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Printing Hard Copy of this Information 

There may be times when you need to have a hard copy, or printed page(s), of this 
information. A hard copy is available by any of the following methods. 

Print from Online Help 

You can print selected topics directly from the online help. 
To print an individual topic from the online help: 

1. Go to the topic of interest. 

2. Select Print from the menu bar. 

3. Click OK to print to the selected printer. 
To print a group of topics from the online help: 

1. Make sure the Contents page of the online help is displayed. 

2. Click on a  Book icon. All first-level topics in this book only will be printed. 

3. Click the Print button at the bottom of the help window. 

4. Click OK to print to the selected printer. 

Print from PDF File 

A separate document file is provided that contains the entire contents of the online 
help. This document is in Adobe Acrobat’s Portable Document Format (PDF). A PDF 
file serves two purposes: 

• Alternate electronic document that is portable; it can be viewed on any computer 
• Flexible print resource that allows the entire document to be printed 

To print a full copy of the information contained in the online help: 

1. Locate the PDF version of this information (filename.pdf; it will be on the 
software installation CD in the docs\print manuals folder). 

2. Double-click on the file to open it.  

3. Print the file to your printer. 

Or you can take the CD to a local printer service. Refer to the Printing 
Instructions.pdf file in the docs\print manuals folder.  

 

Pattern Design Work Space 
Get Acquainted with the Work Space 

This section provides information about features in the PDS/Silhouette work space. 
All of the functions for this program are accessed using this screen.  
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Note: The Gerber G at the top left of the screen rotates when the system is busy. 

To view all of the screen, click on the middle button in the upper right corner of this 
help window. 

  

Menu Bar 

The main menu bar has 11 drop-down menus with functions that allow you to 
access options and features in the PDS Silhouette program.  
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Note: The abbreviation of (AM) or (MK) have been added after those functions 
specific to AccuMark or MicroMark. 

Menu Use Functions To: 

File Open, close and save models, styles, and pieces; use Style 
Description; display notes of Style; import PLT files; print; plot; exit. 

Edit Undo, redo, edit point info, edit line info, edit piece info; select and 
delete pieces. 

View Zoom; view point, line, piece, and grade information; clear display, 
customize tool bars and screen layout; set Preferences/Options. 

Point Add points and notches; delete, reduce, and check total points; copy 
point numbers; modify points.  

Line Create lines, perpendicular lines, circles and ovals; delete, replace, 
and swap lines; clip/unclip perimeter/boundary lines; modify lines. 

Piece Create pieces; add pleats, darts, fullness, seams, and asymmetrical 
folds; fold/unfold, split, mirror/open, annotate, combine/merge, 
shrink/stretch, and delete pieces. 

Grade Create/edit rules; modify rules; work with nests and sizes; assign rule 
table; export rules. 

Measure Line length, distance along lines, perimeters, and between points; 
piece area; angles; clear measurements.  

Draft Sketch; draft; scale; trim/extend; reorient using the Silhouette system. 

Window Arrange windows. 

Help Access Help.  

 

Tool Bar 

The standard tool bar is made up of functions that are used frequently when working 
with PDS/Silhouette. Tool bar buttons provide you a quick way to access functions 
without going through the menus.  

Tool bars can be customized to meet your needs. You can: 

Add or remove icon buttons from an existing tool bar. 

Change the size of icon buttons. 
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Create a new tool bar. 

Dock or float tool bars. 
To display the standard tool bar: 

4. Use the Screen Layout function in the View menu. 

5. Click in the check box next to the feature you want to display. 

6. Click OK to save. To change the screen layout back to the default settings, 
click Reset to Default. 

To identify a button in a tool bar: 

1. Hold the mouse cursor over the button until the name of the function 
associated with that button displays. 

Title Bar 

When a Style or Model is retrieved, the number of pieces defined in either the Model 
Editor or Style Description displays behind the Model/Style name in the title bar. The 
count includes the original pieces, not flips or additional material groups that may be 
defined for a particular piece. The count updates as pieces are added or removed in 
PDS to indicate how many are currently are in the Model or Style definition. 
MicroMark™ Standard Pieces are not included in the count. 

  
AccuMark Title Bar 

 

  
MicroMark Title Bar 

 

Using the AccuMark Menu 

If you are more comfortable using the menu structure that existed in the AccuMark 
PDS/Silhouette version, you can turn this menu on. The basic location of the functions 
in the AccuMark menu has been retained.  

However, it is to your advantage to work with the new menus and functions the main 
PDS/Silhouette menu bar to learn the many new enhancements that can increase 
your productivity.  

To display the AccuMark menu: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 

3. To reposition, click any gray area of the menu and drag to wherever you prefer 
in the work area. 
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Using the MicroMark Menu 

If you are more comfortable using the menu structure that existed in the MicroMark 
PDS version, you can turn this menu on. The basic location of the functions in the 
MicroMark menu has been retained. In addition, Exit and Exit to Main buttons have 
been added to this menu. 

However, it is to your advantage to work with the new menus and functions the main 
PDS/Silhouette menu bar to learn the many new enhancements that can increase 
your productivity.  

To display the MicroMark menu: 

1. Use the Screen Layout function in the View menu.  

2. Click in the check box next to the feature you want to display. 

3. To change between MicroMark menus, also turn on the MicroMark tool bar. 

4. To reposition, click any gray area of the menu or tool bar and drag to wherever 
you prefer in the work area. 

To exit a MicroMark menu or close the PDS/Silhouette program: 

1. Do one of the following: 

• Press the Escape key, if the cursor is currently located in this menu. 
• Click the Exit or Exit to Main buttons located at the bottom of each menu. 

 

MicroMark Function Keys 

The function key tool bar can be used to provide quick access to commonly used 
functions. It is a shortcut for those menu functions that may or may not have a tool bar 
button. For example, to view all visible pieces, you can select Zoom – Fullscale from 
the View menu, click the Fullscale button on the tool bar, or press F3.  

Most MicroMark functions for these keys are currently available and display any 
submenus in the MicroMark menu. 

To display the function keys and/or the MicroMark menu: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 

3. To reposition, click any gray area of the menu or tool bar and drag to wherever 
you prefer in the work area. 

To use function keys: 

1. Do one of the following: 

• On-screen, click the function key button. 
• On the keyboard, press the appropriate function key. 
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2. If you pressed F1, F5, or F6, use the MicroMark menu to find a specific 
function. You may have to select More to see all available functions. Then do 
one of the following: 

• On-screen, click the menu item you want to use. 
• On the keyboard, press and hold the Alt key. Note the number or letter to the left 

of the function you want to use and then press the corresponding key. For 
example, to use F1/Original Position, press these keys: Alt and 1. 

MicroMark Tool Bar 

The MicroMark tool bar has icon buttons for MicroMark Points, Lines, Pieces, 
Grading, and Seams menus. Click one of these buttons to quickly access options for 
that menu in the MicroMark menu.  

Functions can also be accessed using the main PDS/Silhouette menu bar. 
To use the MicroMark tool bar: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 

3. To display functions for the following menus in the MicroMark menu, click the 
corresponding button in the MicroMark tool bar. 

4. To reposition, click any gray area of the menu or tool bar and drag to wherever 
you prefer in the work area. 

Button Display Menu: 

 
Points  

 
Lines  

 
Pieces  

 
Grading  

 
Seams  

 

Piece/Icon Menu 

Pieces in the Piece/Icon menu can be displayed by Icon buttons only, Name buttons 
only, or both. An icon is a graphical representation of a piece. 
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User Input Box 

The User Input box provides interactive communication between you and 
PDS/Silhouette while you are working with a function. The User Input box can be 
displayed all of the time or only while a function is active.  

 
To display or hide the User Input box: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 

3. To reposition, click any gray area of the box and drag to wherever you prefer 
in the work area. 

 Related Topic(s):  

 

Status Bar 

The PDS status bar is the standard Widows status bar. 
To display the PDS status bar: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 

3. To reposition, click any gray area of the box and drag to wherever you prefer 
in the work area. 

 

Info Bar 

The Info bar provides information for the work area. Name, size, perimeter/boundary 
type, and measurement type information is determined by the style/model currently 
open and the piece currently selected in the work area. Information and settings in 
the Info bar include: 

Style or model name 

Piece name 

Base/sample size and variation sizes (marked by # symbol) and color pop-up for 
nested pieces 

Sew or Cut perimeter/boundary type 

Measurement type – Imperial or metric 
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Snap to – Grid, Geometry, Precision  

System Smoothing 

Hide Seams  

Show Grid  
To display the Info bar: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 

3. To reposition, click any gray area of the box and drag to wherever you prefer 
in the work area. 

To change settings in the Info bar: 

1. Do one of the following: 

Click on a button in the Info bar to turn it off or on. Settings change in the 
Preferences/Options or Screen Layout pages as well. 

Use Screen Layout to change settings for Snap to. The screen updates while you 
are making changes. 

Use Preferences/Options to change settings for System Smoothing and Hide 
Seams. The screen updates while you are making changes. 

 
To view colors for graded pieces on-screen: 

1. On the Info Bar, click the arrow button next to the base size. 

A pop-up chart of sizes and colors displays. 

 

Prompt Bar 

The Prompt bar can be used, if you prefer, to direct you through the step(s) required 
to use each of the PDS/Silhouette functions. This horizontal bar can be positioned 
above or below the work area.  

Note: The User Input box performs the same function. 

 
To display the Prompt bar: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 
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3. To reposition, click any gray area of the box and drag to wherever you prefer 
in the work area. 

 

Quick Open 

The Quick Open field provides a quick way to open a model, style, or piece, if you 
already know the name of the file you want to open. Multiple pieces or models can 
be retrieved into the same work by using wildcards. 

This input field can be docked in any horizontal location on the workspace or can 
float in a work area. 

To display the Quick Open field: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 

3. To reposition, click any gray area of the box and drag to any horizontal 
location you prefer in the work area. 

To use Quick Open: 

1. Use the General page of Preferences/Options to set the type of the files 
available in this field. 

2. Type a file name in the Quick Open field and then press Enter. 

Wildcards may be used to open multiple files by typing a string of characters with 
an asterisk (*). The system will retrieve all pieces or models with those characters. 

 

Rulers 

Rulers assist in locating and positioning piece geometry in the work area. Displaying 
the rulers helps you keep the sizes of the pieces in perspective while working on 
them. The unit of measurement depends upon the user environment defined in the 
AccuMark user environment or in MicroMark system options. 

 
To display the rulers: 

1. Use the Screen Layout function in the View menu. 

2. Click in the check box next to the feature you want to display. 

3. To reposition the horizontal ruler, click on it and drag it to the top or bottom of 
the work area. 
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4. To reposition the vertical ruler, click on it and drag it to the left or right of the 
work area. 

Set Up Your System 
Customizing Pattern Design Work Space 

Every pattern designer approaches tasks with a set of unique preferences, needs, 
and experience. Designers familiar with a Windows environment will appreciate the 
easy access provided by drop-down menus. Those more comfortable in AccuMark 
or MicroMark environments can make changes to the workspace quickly in the 
Preference/Options dialog box. Or, you can customize simply for convenience by 
moving a menu to a new location, adding a button to the tool bar, or changing a 
default color.  

What do you want to do? 

 Get acquainted with the work space. 

 Display and position menus and tool bars. 

 Customize tool bars. 

 Open, close, and arrange work areas. 

 Place pieces into the work area. 

 Determine how pieces display. 

 Set preferences and options for PDS/Silhouette. 

 

Display Pieces in the Work Area 

Functions in the View menu allow you to customize how pieces display in the work 
area. 

What do you want to do? 

 Turn on piece geometry symbols, piece fill, orientation symbol, seam lines, and line 
extensions. 

 Display pieces with notes. 

 Change the default colors for a piece. 

 Refresh the on-screen display of pieces. 

 Customize how pieces display in the Piece/Icon menu. 
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Docking Tool Bars, Menus, and User Input Box 

Tool bars, AccuMark or MicroMark menus, function keys, and User Input box all use 
standard, Windows conventions for dragging and docking. For example, a custom 
tool bar can be docked to a side of the screen or left free floating over the work 
area. When you exit PDS/Silhouette, these items will be saved in their new 
positions. 

To dock: To undock or float: 

1. Double-click on the gray 
border surrounding the 
item you want to dock. 

Or position the cursor on the 
item you want dock. Choose 
an area other than a button 
or field.  
2. Click and hold the left 

mouse button to 
highlight its border. 
Then drag the item into 
the border of the work 
area and release the 
mouse button. 

Note: The border thickness of 
the item changes when it is 
dragged into a dockable area. 

1 Position the cursor on the item 
you want undock. Choose an 
area of the item other than a 
button or field. 

2 Click and hold the left mouse 
button to highlight its border. 
Then drag the item over the 
work area and release the 
mouse button. 

Hints: Sample: 

• If a tool or tool bar is not 
docked, it has a title bar. 

• If you drag a dockable item 
by the title bar, it will not 
dock. 

• To prevent docking when 
positioning an item near the 
edge of the work area, hold 
down the Ctrl key while 
dragging. 

  

Custom tool bar docked vertically 
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Import and Export User Settings 

The Import and Export User Settings functions allow PDS users to save custom 
settings for the PDS environment. This includes items such as custom toolbars, 
work area settings, preferences and colors. 

The Import and Export User Settings functionality is beneficial in many cases, 
including the following common scenarios: 

• System administrators desiring to pre-set systems with a common standardized 
environment. 

• Shared workstations where different users desire to work with different settings. 
• Reporting, troubleshooting, and resolving problems 
• Any time PDS settings need to be duplicated, shared or saved. 

Note: To ensure accurate results, PDS needs to be closed when Import and Export 
User Settings are activated. 

 

Export User Settings 

Saves the information to a file and exports it to a designated directory. 
To Export User Settings: 

1. In PDS, set the work area, preferences, and toolbars as desired. 

2. Save preferences and close the PDS Session. 

3. Go to the launchpad and select the Export User Settings icon.  

Note: This must be done on the system that has the PDS settings desired for export. 

4. A dialog appears allowing a directory and name for the use settings to be selected. 
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5. After selecting the appropriate path and name, press Save. The exported files are 
saved with the extension ".pol". 

Import User Settings 

Imports the file to the destination PC and overwrites current settings according to the 
options that are checked.  

To Import User Settings: 

1. Close PDS on the system where the new settings are desired. 

2. Go to the launchpad and select the Import User Settings icon. 

3. A dialog appears allowing a directory and previously exported file to be selected 
for importing. 
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1. Browse to the desired path and select the desired file. 

Note: The file to be imported does not need to be located on the system that is 
importing – just in a location that the importing system can access. 

5. When Open is selected, the following dialog appears allowing control of which 
values should be imported. 

  

• Path Information – Imports the MicroMark Path information from the 
Preferences/Options Paths tab 

• Colors and Control Bars – Imports the Preference Color Settings and work area 
toolbars.  

• Other Settings – Imports all other settings not covered by the first two categories. 

To duplicate the same settings as the source PC, all three checkboxes should be 
selected.   

Note: If a checkbox is not selected the existing settings will be maintained. 

6. Select the desired options and then select OK to import the user settings. 

7. Open PDS to view and use the new settings. 
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Use Preferences/Options 

Preferences/Options 

AccuMark = Preferences 

MicroMark = MicroMark System & PDS Options 

 

Use this function in the View menu to change the piece display, adjust screen 
display colors, define plotter information, edit style conversion information, set up 
paths for storage areas, styles, and importing data. There are multiple pages 
available in the Preferences/Option box. 

To move between pages: 

1. Click on the appropriate tab at the top of the box: 

General  

Color  

Plot (AM)  

Style 

Paths  

Fonts  

Draft (only available with Silhouette key) 
To select options or input values on a page: 

1. Do the following: 

• Click to add or remove check marks for every option you want. 
• Click a round radio button to select between one or more options. 
• Click the arrow button next to a field to display choices in a drop-down list box. 
• Press the Tab key to move between fields. 
• Type to enter values. 
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Setting Draft Preferences/Options 

Use the Draft page in the Preference/Options box to define typical settings for using 
the Silhouette table with PDS/Silhouette.  

Additional hints on setting draft preferences  
To set preferences and options: 

 
1. From the View menu, 

select 
Preferences/Options. 

2. Click on the Draft tab. 

3. Edit default values in 
these fields: 

Point Filter – controls how many 
intermediate points may be 
eliminated after using Sketch or 
Note/Illustrate. 

Sketch Pen Resolution – 
controls the number of 
intermediate points on lines 
drawn when using Sketch. 

Note Pen Resolution – control 
the number of intermediate 
points on lines drawn using 
Note/Illustrate. 

Note: Press the Tab key to 
move between fields. 

4. Click Save to save 
changes. 

Note: Changes apply to all 
AccuMark storage areas.  

5. To change back to the 
default settings, click 
Reset to Default. 

6. When finished, click OK 
to close the 
Preferences/ Options 
box. 
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General Page 

Setting General Preferences/Options 

Use this page in the Preference/Options box to set basic preferences for your 
PDS/Silhouette program. 
To set preferences and options: 

Move your cursor around the screen below to 
find out information about settings you can 
make. 

1. From the View menu, select 
Preferences/Options. 

2. Click on the General tab. 

3. Select the options you want 
or enter values.  

4. Click Save to save changes. 

Note: Changes apply to all 
AccuMark storage areas.  
5. To change back to the 

default settings, click Reset 
to Default. 

6. When finished, click OK to 
close the Preferences/ 
Options box. 

 

Changing Preferences/Options for Piece Display 

Use the Display page of the Preferences/Options function to change these options. 

Filled Pieces – When checked, pieces display with color fill rather than as wire 
frames. Use the Fabric Type field on the Color Preferences page to define the fill color 
used. 
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Symbols – When checked, symbols indicate the location of points, points that have 
grade rules and ends of lines. 

Fit Pieces in Work Area – When checked, Full Scale is the default view for the work 
area when pieces are first placed. 

Hide Seam – When checked, non-perimeter seam allowance lines assigned to pieces 
in the work area will not display. You can also use the Info bar in the work space to 
quickly change this setting, if needed. 

 

Note: Using Hide Seams at the time of saving removes the seam internals for 
plotting or marker making.  If seam internals are desired for plotting or marking, 
pieces should be saved with the seams displayed.  For AccuMark data saved with 
the seam displayed, annotation tables marker making preferences allow farther 
control whether or not the seam internals are displayed or plotted. 

 

Orientation Symbol – When checked, the orientation symbol for a piece displays. 
The recommended default setting for this function is ON. To change this setting, you 
can click on the Orientation Symbol button. 

Show Point Info - When checked, point/line information displays when points on lines 
are selected with the cursor. In addition, the point tracking box displays each time you 
pass over a point or line, while dragging the mouse cursor along a line.  

Internal Pattern – Specify whether internals should be displayed as solid or dashed 
lines. 

Perimeter – Specify whether perimeter extensions display (Unclipped) or pieces 
display with a closed perimeter. (Clipped). For some MicroMark grading, Boundary 
should be set to Unclipped. 

 

Changing Preferences/Options for Piece Selection and Tracking 

Use the General page of the Preferences/Options function to change these options. 

Magnetic Tolerance –Specifies how close the cursor must approach to a point or line 
to select it. 

Auto Tracking – When checked, tracking begins automatically when the cursor is 
moved along a line. This is the same as the MicroMark feature. If AutoTracking is Off, 
you must select the Track button in the Tracking box before automatic tracking 
begins. 

Note: The keyboard arrow keys, as well as the arrow keys in the screen dialog box, 
can also be used to track points 
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Tracking Speed – Specifies the speed of auto tracking: Slow, Medium, Fast. 

Changing Preferences/Options for Work Space and Misc. 

Use the General page of the Preferences/Options function to change these options. 

AutoSave – Specifies how frequently data should be stored in case Auto Recovery is 
necessary. This feature makes an independent back up copy of the workspace and 
does not overwrite style, piece, or model data. 

AutoSave Undo Buffer – AutoSave Undo Buffer allows you to save the steps in 
Undo along with the AutoSave of the pieces in the work areas. If this option is ON, 
AutoSave will take longer than if the option is OFF.  

System Smoothing – When System Smoothing is selected, curved (smooth) lines 
display on the screen the same way they would appear if you plotted them. The 
default setting is ON.  

Note: Your setting for this option affects the way lines behave when using functions 
such as Move Smooth or Digitize Line. You can use the Info bar in the workspace to 
change this setting, if needed. 

Modify Grade Rule – When this option is selected, grade rules for pieces modified 
with functions such as Pivot Dart or Tapered Fullness are automatically updated and 
an asterisk (*) is placed next to the rule number. The new rule number is unique to 
that piece, independent of any rule table, and is stored with the piece information. For 
MicroMark data, use Export Rules. 

Fix Seam Corners 

When Fix Seam Corners is selected, line extensions are generated when File/Open is 
used. The extension information is saved with the piece.  

This option is useful for data created in Classic AccuMark PDS or originally created 
without extensions. When Fix Seam Corners is selected, a seam extension is 
automatically applied to any corner that has a corner fixed when the piece is retrieved. 

On Classic AccuMark PDS, when seam and corners are added to certain pieces, 
intersection errors are given when Add/Strip Seam is used. For example, on a front 
piece with a princess seam such as the illustration below, the intersection of the 
princess seam and armhole has a very shallow angle. When a Squared Corner is 
applied in this area, the piece would lose its shape when the seam perimeter is 
swapped. This happens because the line extension of the cut line in the area of the 
corner is not preserved in Classic AccuMark PDS.  
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Display Piece Notes – When this option is selected, annotation, or notes, display 
with a piece. See Annotate Piece. 

Add Non-Smooth to Ends –The Add Non-Smooth to Ends option can be used to 
match the display of pieces between PDS and Piece Plot. N attributes/Turn Points are 
added to all perimeter end points in Open, Plot, Save, and Save as from with in 
PDS.The default setting for this option is ON. If the setting is turned OFF, N 
attributes/Turn Points will not be added and the display in PDS will match piece 
displays in Piece Plot. 

Show Seam Warning-The system automatically updates seam internals and seam 
corners unless a corner has been severed using the Grade Seam/Corners method 
with Auto Updated turned off. If any modifications are attempted on these system-
generated seam internal or corner lines, the system will ignore the selection or not 
allow the lines to be selected. When this option is ON, if selections are attempted on 
system-generated geometry, you are alerted to what the system is doing and which 
selections are valid. 

  

Quick Open – Specifies the default file type to open using the Quick Open feature. 

Rule Table – Specifies the default rule table to assign to pieces, for AccuMark only. 
This setting is utilized whenever you use the Create Rectangle, Skirt, Collar or Sketch 
and Line/Curve functions.  

Note: If you used the Paths page to change storage area, you must click the Apply 
button on that page in order to view the correct Rule Tables. 

Data Stored To – Specifies where new or modified pieces are saved, for AccuMark 
only. Default Area stores the pieces to the default Storage Area. Retrieved Area saves 
modified pieces to the storage area that they were retrieved from. 
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Please refer to Opening and Saving Data in PDS for differences in how data is stored in V7 
and V8. 

Environment – Specifies an AccuMark or MicroMark environment, depending on the 
type of grading and marking system PDS/Silhouette is running on. This is important 
for functions like changing a grade rule number, where an AccuMark rule table or a 
MicroMark rule table must be referenced. 

Value Mode – It is used to control the behavior of the Cursor/Value Mode when 
modifying geometry. The three choices are ‘Default’, ‘Classic AM PDS’ and ‘Reset to 
Cursor’. When the ‘Default’ option is selected, the Cursor/Value mode will stay in 
whatever mode the user selects. When the ‘Classic AM PDS’ option is selected, if the 
system is put into Value mode it will return to Cursor immediately after a function is 
executed. When the ‘Reset to Cursor’ option is selected, if the system is put into 
Value mode it will return to Cursor mode after the current fuction is exited. 

Changing Preferences/Options for AccuMark Piece V7 Compatibility 

Use the General page of the Preferences/Options function to change these options. 

Disable Version 8.0.x (V8) Functions/Options 

When this option is checked, all the functions in the system that will create data not 
compatible with AccuMark version 7.6.5 or earlier are disabled.  

Disable Functions  

The following functions are disabled when the Disable V8 Functions/Options 
checkbox is ON: 

Envelope Corner 

Slanted Step Corner 

Curved Intersection and Oval options in the Bisect Step and Perpendicular Step 
Corners. 

Reference Notch/Add 

Reference Notch/Move 

Reference Notch/Change Reference 

Reference Notch/Group 

Reference Notch/Add Group on Line 

Reference Notch/Add Group Ln Dist 

Specify Dist/Tangent 

Edit Notch Info/Dist to Ref 
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Edit Notch Info/Same Dist on Seam 

Edit Notch Info/Group Notches 

Edit Notch Info/Dist Between 

Edit Notch Info/# of Notches 

Fix Seam Corners 

Apply to both Endpoints 

Note: A (V8) tag has been placed in the drop-down menu option next to the options 
that are disabled when the Disable V8 Functions/Options checkbox is selected.  

Opening and Saving Data in PDS 

When the Disable V8 Functions/Options is selected, File/Open displays only version 
7.0.x (V7) storage areas. In addition, Save and Save As will save data as version 
7.0.x (V7) data. If the checkbox is not selected, File/Open displays version 7.0.x (V7) 
and version 8.0.x (V8) storage areas, and Save and Save As will save data as version 
8.0.x (V8) data. 

If the system is in version 8.0.x (V8) mode, but the Data Stored To Preference is set 
to Default and default is a version 7.0.x (V7) storage area, Save will cancel. If the 
Data Stored To Preference is set to Retrieved Area, the system prompts to select 
another storage area. 

If the system is in version 7.0.x (V7) mode and the data is retrieved from a version 
8.0.x (V8) storage area, Save will cancel. 

Exporting Data in PDS 

When the Disable V8 Functions/Options is not selected, Export can be used to save 
data as version 7.0.x (V7) data. Export data is the only way to move version 8.0.x (V8) 
data into version 7.0.x (V7) storage area. 

Show Warnings  

When this option is checked, a warning is displayed when a function not compatible 
with AccuMark version 7.6.5 or earlier is selected. The checkbox Don’t show this 
Warning Again can be selected to prevent the message from displaying. 
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Color Page 

Setting Color Preferences/Options 

Use the Color page in the box to set default colors for selections, pieces, grading, and 
text. 

To make it easier to identify piece geometry in the work area, you can use the 
Preference/Options function to change the default colors of internal and perimeter 
lines on a piece or a nest of pieces. You can also change colors for text, prompts, 
background, and guidelines/grid in the work area. 
To set preferences and options: 

Move your cursor around the screen below 
to find out information about settings you 
can make. 

1. From the View menu, 
select 
Preferences/Options. 

2. Click on the Color tab. 

3. Click on the color 
swatch next to the item 
you want to change 
color for. 

4. Click on one of the 
standard color chips or 
move the sliders for 
Red, Green, and Blue to 
set a unique color. Click 
OK. 

5. If desired, click to add or 
remove the check mark 
to use a rainbow of 
colors for nested pieces. 

6. Click Save to save 
changes. 

7. To change back to the 
default settings click 
Reset to Default. 

8. When finished, click OK 
to close the 
Preferences/ Options 
box. 
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Changing Piece Colors 

Use the Color page of the Preferences/Options function to change colors for the 
following types of pieces. 

Original – Specifies the color of piece (perimeter and internal lines) that has not been 
edited. This is the color of piece when the piece displayed on the screen is the same 
piece that is stored on disk. 

Highlighted – Specifies the color of the current piece (perimeter and internal lines). 
When multiple pieces are in the work area, the piece that is in focus, displays in this 
color. With multiple pieces in the work area, move the cursor around and notice how 
the pieces change color. The piece closest to the cursor displays in the Highlighted 
color. 

Near – An object, such as a line, changes to the color selected in Near when the 
cursor is close enough to select the object.  

Modified – Specifies the color of pieces (perimeter and internal lines) that has been 
edited. The piece will return to the Original color after it is saved. 

Selected – Specifies the color of the pieces that have been selected for a specific 
function.  

  

Fabric Type – Used to define the colors to be used for color fills. The colors are 
defined by fabric type for an AccuMark model or by material group for a MicroMark 
style. 

 

Changing Nest Colors 

Use the Color page of the Preferences/Options function to change colors for a nest of 
pieces. 
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Base – Specifies the color of the base, or sample size when a grade nest is 
displayed. 

Intermediate – Specifies the color of the intermediate sizes when a grade nest is 
displayed. MicroMark data does not have intermediate sizes. This is only valid for 
AccuMark data. 

Breaks – Specifies the color of the break sizes when a grade nest is displayed. 

Rainbow – Check this box to display a rainbow of colors for pieces in the nest. 
To view colors for graded pieces on-screen: 

1. When in the main PDS/Silhouette screen, click on the arrow next to the base 
size located in the Info Bar. 

2. A pop-up chart of sizes and colors displays. 

Changing Text and Miscellaneous Colors 

Use the Color page of the Preferences/Options function to change colors for the 
following features in the PDS/Silhouette work space. 

Prompt – Specifies the color of the prompt. 

Annotation – Specifies the color of the text on pieces and point and rule numbers. 

Work Area – Specifies the background color of the work area. 

Grid – Specifies the color of the grid. The X and Y dimensions of the grid are defined 
in View/Screen Layout. 

Arrows – Specifies the color of the arrows used in Value mode and for the Measure 
functions. 
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Plot (AM) Page 

Setting Plotter Preferences/Options 

Use the Plot (AM) page in the Preference/Options box to define typical settings for 
plotting from PDS/Silhouette. 
To set preferences and options: 

Move your cursor around the screen below 
to find out information about settings you 
can make. 

1. From the View menu, 
select 
Preferences/Options. 

2. Click on the Plotter tab. 

3. Select the options you 
want or enter values.  

4. For MicroMark data, 
check Plot Piece 
Message to be warned 
of any variation size 
error. 

5. Click Save to save 
changes. 

6. To change back to the 
default settings click 
Reset to Default. 

7. When finished, click OK 
to close the 
Preferences/ Options 
box. 

 

Changing Plotter Defaults 

Use the Plot (AM) page of the Preferences/Options function to change default plotter 
settings. 

Piece Plot ParameterTable – selects the desired Piece Plot Parameter Table.  
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Note: If a plot is requested and the system finds a problem with the piece plot table 
(such as a notch table that no longer exists in the storage area or a size that does 
not exist), an error message prompts that the plot will be aborted. 

Annotation Table – selects the desired Annotation Editor. 

Plot Form – displays the Plotter Window for manual placement of pieces, when 
checked; or allow the system to automatically place pieces (according to whether or 
not Stacking is checked). 

Stacking – determines whether multiple pieces are plotted across the width of the 
paper before the paper advances; when NO, plotter advances after each piece plot.  

Plot Grade Sizes to Use – determines which sizes are plotted from a graded nest; 
choose Parameter Table to plot the size(s) specified in the Piece Plot Parameter 
Table selected above. Or choose Display to plot the size currently displayed on-
screen; this setting allows a non-base or selected group of sizes to be plotted without 
having to create or change the plot parameter table. 

Note: MicroMark variation sizes are not currently supported for this feature unless 
Show Non-base Size is used to plot individual variation sizes. 

Character Size – specifies the size for annotation characters. 

Piece Separation – specifies the space desired between plotted pieces when 
Stacking is checked. 

Plotter Address – determines destination of plot data; choose Local or a Network 
Plot Queue Name to direct the plot data to the currently configured plotter; choose 
Dos File to save the data as a DOS file, based on settings in the DOS File 
Configuration. 

Plotter Type There – indicates the type of plotter currently being used. 

Changing Cut Parameter Overrides 

Use the Plot (AM) page of the Preferences/Options function to change parameter 
overrides, for example, when cutting oak tag samples. 

Cut Line Length – specifies the length you want each perforated cut line to be. 

Tab Line Length – specifies the distance you want between each perforated cut line. 

Cut Force – specifies the percentage of maximum blade pressure you want for cut 
lines. 

Tab Force – specifies the percentage of maximum blade pressure you want for tab 
lines. 
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Style Page 

Setting Style Preferences/Options 

Use the Style page in the Preference/Options box to set preferences for importing or 
exporting MicroMark styles. You can set basic preferences when importing and 
exporting MicroMark styles. These include naming conventions and preferences for 
notch table, grain line, and grading reference line. 
To set preferences and options: 

Move your cursor around the screen 
below to find out information about 
settings you can make. 

1. From the View menu, 
select 
Preferences/Options. 

2. Click on the Style tab. 

3. Select the options you 
want or enter values.  

4. Match notch types 
between AccuMark and 
MicroMark data. 

5. Click Save to save 
changes 

6. To change the 
Preferences/Options 
back to the default 
settings click Reset to 
Default. 

7. When finished, click OK 
to close the 
Preferences/ Options 
box. 
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Changing Preferences/Options for Naming Styles 

Use the Style page of the Preferences/Options function to change these options 
when importing or exporting MicroMark styles. 

Retrieve Style Section 

Prefix Style Name – With button selected, automatically adds the MicroMark style 
names as a prefix for each piece when the style is opened. This is useful when 
opening more than one style into the work space. 

Store Style Section 

Append Style Name – With button selected, automatically removes the MicroMark 
style name from each piece when the style is stored. 

Export Grain Line – With button selected, automatically creates a grain/grade 
reference line for a piece exported to MicroMark. These are based on the primary 
grain line of an AccuMark piece. 

Hints 

In order to import or export MicroMark styles, keep in mind the following when naming 
pieces: 

• In AccuMark, pieces are stored as individual files with unique names which do not 
have to be associated with a model. For example: 1234rfrnt or 5678rfrnt. 

• In MicroMark, pieces are associated with a style and unique names are not used. 
For example, right front for style 1234 and right front for style 5678 may both be 
named rfrnt. 

 

Changing Style Preferences/Options for Notches 

Use the Style page of the Preferences/Options function to specify how PDS/Silhouette 
should match the notch types in MicroMark to the ones in AccuMark when converting 
data. 

To set defaults when retrieving MicroMark data: 

1. From the View menu, select Preferences/Options. 

2. Click on the Style tab. 

3. Set the default base notch point type to applied when retrieving styles where 
the base point type for notches was not defined. Choose: Turn Point or Curve 
Point. 

4. Select the defaults for retrieving notches, if digitized internally or externally of 
the boundary line. 

5. Click Save to save changes. 

6. When finished, click OK to close the Preferences/Options box. 
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To set defaults for converting data with notches: 

1. From the View menu, select Preferences/Options. 

2. Click on the Style tab. 

3. Select the Notch Table to use that will apply the correct notch types and 
depths when transferring data. 

4. Match each MicroMark notch type to a corresponding AccuMark notch type. 

5. Click Save to save changes. 

6. When finished, click OK to close the Preferences/Options box. 
Hints: 

In order to import or export styles or models, keep in mind the following when 
defining notches: 

• In AccuMark, the notch number can refer to any type of notch. You can define five 
different types of notches in a Notch Parameter table. 

• In MicroMark, there are six types of notches, which are referenced by name. The 
notch.depth is specified for every notch and may be unique to each notch. 
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Paths Page 

Setting Paths Preferences/Options 

Use this page in the Preferences/Options function to set basic preferences for where 
PDS/Silhouette finds and stores piece, model, style, and import files. 

Models, styles, and pieces created in PDS/Silhouette are made into markers using 
either an AccuMark or MicroMark marking/grading system. You need to setup for 
either an AccuMark or MicroMark environment.  

For example, 

In AccuMark, storage areas are used for organizing models and pieces.  

In MicroMark, styles are stored in ADS/Styldir and rule tables in ADS/Gdrldir. 
To set preferences and options: 

Move your cursor around the screen below 
to find out information about settings you 
can make. 

1. From the View menu, 
select 
Preferences/Options. 

2. Click on the Paths tab. 

3. Select the options you 
want or enter values.  

4. Click Save to save 
changes. 

5. To change back to the 
default settings click 
Reset to Default. 

6. When finished, click OK 
to close the 
Preferences/ Options 
box. 
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Changing Paths for Storage Areas 

Use the Paths page of the Preferences/Options function to change these options 
when working with AccuMark data. 

Device – Specifies the hard drive on your AccuMark PC or File Server where the 
system finds and stores AccuMark data. 

Storage Area – Specifies the name of the default storage area where PDS/Silhouette 
can find and store AccuMark data. 

 

Changing MicroMark Paths 

Use the Paths page of the Preferences/Options function to change these options 
when working with MicroMark data. 

General – Specifies the drive and path where the system looks for MicroMark seam 
and variation tables or other general MicroMark information. 

Style Path – Specifies the path and name of the directory where the system looks for 
MicroMark style information. 

Grade Path – Specifies the path and name of the directory where the system looks 
for MicroMark grading information. 

Read Rule Table from Style Path 

When this option is ON, the system will look for the rule table on the same device that 
the style is retrieved from. For example, if the ‘Read Rule Table from Style Path’ is ON 
and the Grade Path is set to C:\gdrldir, when a style is retrieved from a network drive 
the system will look on the network drive for the rule table.  

Note: This is equivalent to setting the MicroMark system option "Rule Volume" to the 
value "Style." 

When this option is OFF, the system will look on the C: drive for the rule table when 
the style is opened. 

Changing Paths for Import Files 

Use the Paths page of the Preferences/Options function to change these options 
when working with imported graphic files. 

Path – Specifies the path and name of the directory where graphic files are stored. 
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Fonts Page 

Setting Fonts Preferences/Options 

Use this page in the Preference/Options box to determine whether or not the default 
Windows font size is used in the work area. 

To set preferences and options: 
 

7. From the View menu, 
select 
Preferences/Options. 

8. Click on the Fonts tab. 

Choose whether to use 
default or custom font size in 
the work area.  
9. Click Save to save 

changes. 

Note: Changes apply to all 
AccuMark storage areas.  

10. To change back to the 
default settings, click 
Reset to Default. 

11. When finished, click OK 
to close the 
Preferences/ Options 
box. 

 

Font Preferences for Work Area 

Use the Fonts page of the Preferences/Options function to determine the font size 
used to display information in the work area including: 

Grade rule and point numbers 

Line names and labels 

Measurements 
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System Default – Specifies that PDS use the font size indicated in Windows Display 
Properties. 

Custom Size – Allows a specific font size to be used. Type or use the Arrow key to 
select the specific font size you want to use. 
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Graphics Page 

Setting Graphics Preferences/Options 

Use this page in the Preference/Options box to select the installed renderer. This 
option provides GDI and OpenGL generic display functionality.improving display 
capabilities as well as display and speed enhancements. 

To set preferences and options: 
 

1. From the View menu, 
select 
Preferences/Options. 

2. Choose from the 
Installed Renderers: 

GDI works on all windows 
systems and it is the initial 
PDS default. 

OpenGL may be used with 
video cards that support Open 
GL technology. 

Note: Display is sluggish if 
OpenGL is selected when it 
should not be. 

3. Enable Anti-Aliasing 
provides a thicker 
smoother line. This 
option is available when 
OpenGL renderer is 
selected.  

4. Sort rendering for 
speed allows faster 
redrawing of the screen 
by changing the order 
the lines and colors are 
drawn. This option is not 
recommended for use 
with the filled pieces 
option because the color 
may hide smaller sizes. 

5. Select Make new 
renderer the default 
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renderer to save the 
renderer setting and 
load it again when PDS 
is opened. 

Note: Saving preferences will 
not save the selected 
renderer. This is a safety 
feature. 

 

  
Anti-Alias 
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Standard 

 

System Preferences 

System Preferences 

Use the System Preferences page of the View menu to specify Notation and decimal 
precision: 

Notation -Select Imperial (inches/yards) or Metric (Tcentimeters/meters) to indicate 
the standard of measurement desired.  

Decimal Precision - Select a number from 0 to 3 to indicate the number of decimal 
places the system will use to display measurements. 

Note: This page replaces the User Environment Parameter Table.  
Hints: 

System Preferences set the notation and decimal precision system wide not just per 
storage area. Any updates to this page will take immediate effect throughout the 
system. 
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Use Screen Layout 

Overview of Customizing with Screen Layout 

The amount of space you have to work in depends on the menus, tool bars, and 
status bars you choose to display. For example, AccuMark users might feel more 
comfortable working with the AccuMark menu than with the menu bar. MicroMark 
users probably will decide to display the function keys. New users that do not have a 
history with either of these grading/marking products can choose to work directly from 
the main menu or tool bar. It is to your advantage to work with the new menus and 
functions in the main PDS/Silhouette menu bar to learn the many new enhancements 
that can increase your productivity.  

What do you want to do? 

 Change display options for Screen Layout. 

 Create a custom a tool bar. 

 Customize the work space for AccuMark. 

 Customize the work space for MicroMark. 

 Display a grid of guide lines in the work area. 

 Determine what the cursor selects as it enters the work area. 
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Screen Layout 

AccuMark = Popup/Snap and Grid, New 

MicroMark = F1/Grid, New 

 

Use this function in the View menu to display a variety of menus, tool bars, and 
status bars in the main PDS/Silhouette screen.  

 
To customize the work space: 

Move your cursor around the screen 
below for information about settings you 
can make. 

1. From the View menu, 
select Screen Layout. 

2. Click to add or remove 
check marks next to 
items that can be 
displayed in the work 
area. You will see the 
results on the screen as 
you select each item. 

3. Set options for 
Guidelines and Snap. 

4. Click OK to save 
changes and close the 
Screen Layout box. 

5. To change back to the 
default settings, click 
Reset to Default. 

 

 

Display Guidelines 

A grid of horizontal and vertical guidelines can be displayed in the work area. The X 
and Y distance between these guidelines can be specified, as well as the type of 
lines. The color of the lines can be specified on the Color tab of Preferences.  
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To define guide lines: 

1. From the View menu, select Screen Layout.  

2. In the Guidelines section of the dialog box, click a button to select the type of 
lines you want.  

None – Turns off guidelines. Go to step 4. 

Lines – Displays solid lines. 

Dots – Displays dashed lines. 

Crosshairs – Displays cross hairs where horizontal and vertical guidelines 
intersect. 

3. Enter a value for spacing between lines in the X and Y directions. The unit of 
measurement depends on default settings. 

4. Click OK to save changes and close the Screen Layout box. 
Two ways to turn guidelines on or off: 

1. Click the Apply Grid button in the Screen Layout dialog box. Or, click the Show 

Grid button on the Info Bar.   

Note: If Guidelines is set to None in View/Screen Layout, the Show Grid toggle 
button on the Info Bar will have no effect. 

Snap to Grid, Geometry, or Precision 

To simplify selecting points or lines on pieces in the work space, set the Snap 
option to have the cursor immediately jump to the closest point or line or to a 
guideline/grid. You can also enter an exact value for moving or entering geometry 
for pieces. 

To change snap settings in Screen Layout: 

1. From the View menu, select Screen Layout.  

2. In the Snap section of the dialog box, place or remove a √ next to the options 
you want.  

Grid – Causes the cursor, as it enters the work area, to jump to a guideline. 
Guide lines must be turned on. 

Geometry – Causes the cursor, as it enters the work area, to jump to the closest 
point or line. Also, allows a point selected on one piece to snap to a point 
selected on another piece when not in a function (for example, after selecting 
Edit Point Info and closing that dialog box). 

Precision – Moves geometry exact distances or adds geometry to a piece using 
exact measurements. 

3. If you selected Precision in step 2, enter a value. 
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4. Click OK to save changes and close the Screen Layout box. 
To change snap settings in work space: 

Use the Info bar in the work space, to change settings. Clicking on the Grid, Geom, 
or Prec button automatically changes the setting chosen in Screen Layout. 

 Related Topics  

Keyboard 

Use the Screen Layout function in the View menu to set the keyboard style. Choices 
are: 

Typewriter – customizes keyboard for AccuMark 

Alphabetic – customizes keyboard for MicroMark 

 

Use Custom Toolbars 

Custom Toolbars 

AccuMark = New 

MicroMark = New 

 

Use this function in the View menu to customize tool bars by: 

Adding or removing buttons to the standard tool bars. 

Creating custom tool bars. 

Add or Delete Tool Bar and Buttons 

The standard tool bar, as well as custom tool bars, is made up of buttons that 
provide easy access to frequently-used functions. Each button is marked with an 
icon that represents a function.  

Custom tool bars can be created to meet your needs and speed production. You 
also can change the size of buttons in the tool bar in Screen Layout. Tool bar 
buttons provide quick access to functions without going through the menus. 
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To create a custom tool bar: 
 

1. From the View menu, 
select Custom 
Toolbars. 

2. In the upper section of 
this box, select the 
menu or category that 
contains the function for 
which you want to add a 
button. 

3. In the lower section, find 
the name of the function. 
Left click on it, hold 
down the mouse button, 
and drag the name 
(which becomes a 
button) to one of the 
following locations: 

Next to the standard tool 
bar. 

Onto the work area.  

Note: Either method creates a 
custom tool bar. A custom tool 
bar can be docked or left 
undocked and will be saved 
when you exit PDS/ 
Silhouette. 

4. Click OK to save 
changes and close the 
Custom Toolbar box. 

5. To change the back to 
the default settings, click 
Reset to Saved. 

To delete a button in a tool bar: 
 

1. Right click on the button 
to be deleted.  

2. Click OK to delete. 

 

To delete a custom tool bar: 
 

1. Make sure the custom 
tool bar is not docked. 
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2. Click the  button at 
the top right of its title 
bar. 

 

For the Piece/Icon Menu 

Working with Piece/Icon Menu 

The Piece/Icon menu displays all pieces of a model or style either as piece icons, by 
name only, or both. Information about the pieces in this menu is available both visually 
and by clicking with the right mouse button directly over a piece. 

You can resize and position this menu horizontally or vertically by clicking with the 
right mouse button when the cursor is not directly over a piece and using the Options 
Pop-up menu. 

What do you want to do? 

 Change display options for the Piece/Icon menu. 

 Get information about pieces in the menu. 

 Place pieces into the work area. 

 Delete all pieces from the Piece/Icon menu. 

 Add a piece in the work area to the Piece/Icon menu. 

 Flip piece icons 

Displaying the Piece/Icon Menu 

The Piece/Icon menu displays all pieces in a model or style, either as piece icons, by 
name only, or both. Using the Options Pop-up menus, you can choose to sort pieces 
in the menu, resize and reposition the menu horizontally or vertically, and temporarily 
open a full screen view of the Piece/Icon menu which occupies the entire, current 
work area. This menu displays in the work area automatically when a model or style is 
opened. 

To reposition the Piece/Icon menu: 

1. Position the cursor on the Piece/Icon menu, making sure it is not directly over 
a piece.  

2. Click the right mouse button. 

3. From the Options Pop-up menu, click on one of these options: 

Dock to Top, Left, Bottom and Right – places the menu along the selected edge of the 
work area. 
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FullScreen – displays the Piece/Icon menu in a full screen so that many rows of 
pieces can be seen at one time. 

To change how pieces display in the Piece/Icon menu: 

1. Position the cursor on the Piece/Icon menu, making sure it is not directly over 
a piece.  

2. Click the right mouse button. 

3. From the Options Pop-up menu, click on one of these options: 

Icon Only – displays an icon button for each piece. 

Name Only – displays piece names only. 

Icon and Name – displays an icon button for each piece with the piece name 
below the button. Pieces added by Model Options display with both Icon and 
Name. 

To sort pieces in the Piece/Icon menu: 

1. Position the cursor on the Piece/Icon menu, making sure it is not directly over 
a piece.  

2. Click the right mouse button. 

3. From the Options Pop-up menu, click on one of these options: 

Unsorted – orders pieces in the Piece/Icon menu as they were retrieved. 

Sorted by Name – orders pieces in the Piece/Icon menu alphabetically by 
name. 

Sorted by Fabric – orders pieces in the Piece/Icon menu grouped by fabric 
type/material group. Continue to click to move the first piece in the menu to the 
end of the menu. 

 Related Topic(s):  

 

Deleting Pieces from the Piece/Icon Menu 

You can remove selected piece(s) or all pieces from the Piece/Icon menu without 
deleting the pieces from the hard disk. 

To delete selected piece(s) from the Piece/Icon menu: 

1. Highlight the piece(s) you want to delete. 

2. Click the right mouse button. 

3. From the Options Pop-up menu, click Delete Icon. The selected piece(s) will 
be deleted from the Piece/Icon menu. 
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CAUTION: This will delete piece(s) from the MicroMark style as well as from the 
Piece/Icon menu. 

To delete all pieces from the Piece/Icon menu: 

1. Position the cursor in the Piece/Icon menu, making sure it is not directly over a 
piece. 

2. Click the right mouse button. 

3. From the Options Pop-up menu, click Delete All Icons.  

4. When prompted, do one of the following: 

Click OK to delete all pieces from the Piece/Icon menu but not from the disk.  

Click Cancel to end the option without deleting pieces. 

Note: To delete pieces from the work area only, use the Delete Piece from Work 
Area function in the Piece menu. 

 

 Related Topic(s): 

Placing Pieces into the Work Area 
To select and place a single piece from the Piece/Icon menu: 

1. Click on the icon button for the piece.  

2. Move the cursor into the work area and click the left mouse button to place the 
piece. 

To select multiple pieces from the Piece/Icon menu: 

1. To select a range of pieces or all pieces, press and hold the left mouse button 
over the icon button for a piece and then drag the cursor along a group of 
consecutive icon buttons, or hold the Shift key down and select the icon 
buttons of the first and last desired pieces.  

2. To select several pieces whose icon buttons are not located near each other in 
the Piece/Icon menu, hold the Ctrl key down while clicking on the desired 
pieces. 

To place selected pieces: 

1. To place selected pieces, click the right mouse button. The cursor can be 
directly over a piece or not. 

2. In the Options Pop-up menu, click to choose one of the following: 

Place Selection Tiled – places selected pieces and tiles them in the work area. 

Place Selection Positioned – places selected pieces in the work area as defined 
using Define Position. 
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3. Or click Cancel Selection to make a different selection. 
To place pieces by fabric type/material group: 

1. Make sure the cursor is directly over a piece of the fabric type or material 
group you want to place. Click the right mouse button.  

2. In the Options Pop-up menu, click to choose one of the following: 

Place Fabric Tiled – places pieces of each fabric type/material group and tiles 
them in the work area. 

Place Fabric Positioned – places pieces of each fabric type/material group in 
the work area as defined using Define Position. 

To place all pieces: 

1. Make sure the cursor is not directly over a piece in the Piece/Icon menu. Click 
the right mouse button.  

2. In the Options Pop-up menu, click to choose one of the following: 

Place All Tiled – places all pieces and tiles them in the work area. 

Place All Positioned – places all pieces in the work area as defined using 
Define Position. 

Note: After placing pieces positioned, you can use Separate Pieces or F2 is to 
separate them in the work area. 

 Related Topic(s): 

Piece Information from the Piece/Icon Menu 

Several types of Information about a piece display directly on the icon button in the 
Piece/Icon menu. You can also display a Piece Properties box. 

Seam allowance and mirror status indicators 

The following symbols display either on the lower right of the icon button or before the 
piece name. 

  
Boundary is severed 

  
Mirrored piece with severed boundary 

  
Mirrored piece with severed boundary 

  
Mirrored piece with digitized boundary of sew. (Boundary is not 
severed.) 
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Digitized boundary is cut. (Boundary is not severed.) 

  

Mirrored piece with digitized boundary of cut. (Boundary is not severed.) 

 
Additional Information in the piece icon: 

Shrink/Stretch - It is indicated by (><) symbol, and displays in the lower right of the 
icon. 

Piece Counts - Piece counts tell the number of left and right pieces defined in the 
model/style. The system assumes a left piece is as digitized or unflipped. 

Lefts and rights - Lefts and rights are indicated by numbers on the lower left of the 
icon button. Example: A pocket piece (2,0) calls for two lefts and no rights. 

Model Options - When a model is opened along with its model options, the pieces 
belonging to the model option have the model option name displayed on the lower 
edge of the piece icon. 

Fabric Type/Material Group – Displays in the Piece Properties box. 

 
Displays in the Piece Properties box. 

1. Select a piece in the Piece/Icon menu. 

2. Click with the right mouse button. 

3. From the Options Pop-up menu, click Piece Properties to display the Piece 
Properties box with the following types of information: paths; model/style; rule 
table; piece name, category, and description; fabric type; number of points per 
piece. 

4. Click OK to close the Piece Properties box. 

 Related Topic(s): 

For AccuMark or MicroMark 

Setup for AccuMark or MicroMark Grading/Marking System 

When using PDS /Silhouette, markers can be created on either an AccuMark or 
MicroMark system. For that reason, both AccuMark and MicroMark environments are 
supported by this software. If you already have a grading and marking system, you 
need to consider some or all of the questions on this page before beginning to create 
pieces. 

 

 56 



 
What do you want to do? 

 Use AccuMark menus in the work space. 

 Use MicroMark menus in the work space. 

 Set the default location of models or styles. 

 Set preferences for notches. 

 Set preferences for MicroMark grade rules. 

 Set preferences when importing and exporting MicroMark styles. 

 Set preferences for environment and paths. 

 Display pieces in the work space. 

 Open existing models or styles. 

 Access features in MicroMark function keys. 

 Access features in AccuMark Popup Menu. 

 Convert between AccuMark and MicroMark data. 

 Learn about seam allowance differences in AccuMark and MicroMark. 

 Work with MicroMark grading. 

 View grading. 

 Cross reference to AccuMark or MicroMark options. 

 

Set Preferences for Environment and Paths 

If you are more comfortable working in the AccuMark or MicroMark environment, you 
can set preferences. 

What do you want to do? 

 Set up an AccuMark or MicroMark Environment. 

 Identify paths to existing model or style data. 

Customize Work Space for AccuMark 

If you are more comfortable working in the AccuMark environment, move your cursor 
around the screen below to find out information about AccuMark menus and options. 
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To view all of the screen, click on the middle button in the upper right corner of this 
help window. 

  

Customize Work Space for MicroMark 

If you are more comfortable working in the MicroMark environment, move your cursor 
around the screen below to find out information about MicroMark menus and options 
you can display. 

To view all of the screen, click on the middle button in the upper right corner of this 
help window. 
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Mark Request and Orderload Differences 

Markers can be made using MicroMark or AccuMark marker making.  

• If markers are going to be made in the MicroMark, then the piece restrictions are 
defined in the Style Description and the marker is created using Mark Request.  

• If markers are going to be made in the AccuMark, then the piece restrictions are 
defined in Lay Limits and the marker is created using Orderload. 
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Differences 
Differences Between PDS/Silhouette and AccuMark or MicroMark 

PDS /Silhouette users familiar with AccuMark or MicroMark will notice differences in 
working with certain functions. Information below is important especially it you plan to 
import from one format and export to another format. 

What do you want to know more about? 

 Versions and database requirements. 

 Finding and storing models or styles. 

 Description of model and style. 

 Working with pieces. 

 Selecting, using Options, and tracking. 

 Piece limitations in marker making. 

 Working in AccuMark or MicroMark environment. 

Selection, Options and Tracking Differences 

PDS/Silhouette users will notice the following differences from working in: 

AccuMark MicroMark 
Options/Preferences  

 • Many of the options in the 
MicroMark PDS Options 
table are accounted for in 
the new Function Options 
of PDS/Silhouette 

Selection and Tracking  

• For all of the functions on 
the AccuMark, the function 
is always selected first and 
the object (line, point or 
piece) is selected second. 

• Sometimes the object is 
selected first and the 
function is selected second. 
In the Point menu in 
MicroMark, many of the 
menu options are not 
displayed until a point is 
selected. Points are 
selected by initiating Point 
Tracking .  
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Accessing Features Formerly in AccuMark Popup Menu 

The Pop-up menu in AccuMark provided access to various features for working with 
pieces, such as Zoom. In Silhouette, the Pop-up menu is no longer used and these 
features have been relocated. Refer to the following table: 

Former Popup Menu 
Feature 

Access in Silhouette 

Refresh Screen View/ Clear Display 

Zoom View/ Zoom/ Zoom In 

Fullscale View/ Zoom/ Full Scale 

Keyboard Cursor/Value 

Notch Point/ Add Notch 

Change Grd Rule Grade/ Modify Rule/ Change Grd Rule 

Measure Measure/ Perimeter 2 Pt/ Measure Along Piece 

Undo Edit/ Undo 

Abort Click right mouse button and Cancel 

Grid View/ Screen Layout/ Grid/guidelines 

Print Screen File/Print 

System Smoothing View/ Preferences/Options/ General/ System 
Smoothing 

Snap to Precision View/ Screen Layout/ Snap/ Precision 

Snap to Geometry View/ Screen Layout/ Snap/ Geometry 

Delete All Edit/ Delete Pieces from Work Area 

Cursor Mode versus 
Silhouette Mode 

Automatic 

 

Accessing Features Formerly in MicroMark Function Keys 

In MicroMark, function keys provide access to commonly-used features. In PDS, 
most of these features are available using functions keys, menu functions, or tool 
bar buttons. Refer to the following table. 
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Function 
Key 

MicroMark  
Feature 

Access in  
PDS 

F1 Redraw F1 or View/ Refresh Display 

F1 Original Position F1 or Piece/ Modify/ Use Positions 

F1 Pan – Upper Right, Left, 
Lower Right, Left 

F1 or scroll bars for work area. 

F1 Window View/ Zoom/ Zoom In 

F1 Scale View/ Zoom/ 1:1 

F1 Show Line Grid, Show Dot 
Grid, Remove Grid, 
Change Grid Size 

F1 or View/ Screen Layout 

F2 Separate Pieces F2 or View/ Zoom/ Separate Pieces 

F3 Scale to All Visible F3 or View/ Zoom/ Full Scale 

F4 Selected Piece Only F4 or View/ Zoom/ Zoom to Selected 

F5 Measure Along Piece, 
Line 

Measure/ Perimeter 2 Pt/ Measure Along Piece 

F5 Measure Straight F5 or Measure/ Distance 2 Pt/ Measure Straight 

F5 Measure Angle, Line 
Angles 

F5 or Measure/ Angle 

F5 Point Types, Grade Rules View/ Point/ Point Types/Attributes 
View/ Point/ Grade Rules 

F5 Line Length Measure/ Line Length 

F5 Corner Types F5 or View/ Line/ Seam Corner Types 

F5 Seam Allowance Values View/ Piece/ Seam Amount 

F5 Piece Area Measure/ Piece Area 
Measure/ Piece Perimeter 

F5 Clear All Measure/ Clear Measurements 

F5 Line Types/Numbers, 
Label 

View/ Line/ Types/Labels  

F5 NC Cut Data View/ Point Notch Points 
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F5 View, Copy, Clear 
Specification File, Copy – 
Clear Spec 

View/ MicroMark/ File  
 

F6 Plot Screen, Same as 
Screen, Paper Size, 
Specified Scale 

File/ Plot 
 

 

 

Learn the Basics 
Overview of Working in PDS/Silhouette 

PDS/Silhouette automates the pattern making process while supporting the 
techniques and traditional tools you use to make patterns has many features to 
simplify working with pieces and work areas. Depending on the task you are 
performing, you may want to zoom in on a piece, display internal lines, track to a 
point, and reposition using a cursor. A thorough understanding of how to perform 
these basic tasks increases your productivity. 

What do you want to do? 

 Open, close, and arrange work areas. 

 Place pieces in the work area. 

 Change the view of the work area. 

 Get acquainted with piece geometry. 

 Display or hide points, lines, names, and notes. 

 Select and move pieces and points. 

 End selection to continue. 

 Access Options Pop-up menu from the work area. 

 Use Options Pop-up menu to make and end selections. 

 Track to edit points, lines, or pieces. 

 Input by value or by cursor. 
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 Utilize options and prompts when working with functions. 

 Use short cuts. 

 Access features previously in the AccuMark Pop-up menu. 

 Access MicroMark function key features. 

 Check terms in a glossary. 

Piece Geometry 

Lines, locations on lines, and points are often referred to as piece geometry. When 
working in PDS/Silhouette you should be familiar with the following types of 
geometry.  

To learn more about each type of piece geometry, you can follow the links for the 
Geometry Types or identify each type by number in the example shown below. 
Notice the point info box that can be displayed for the current point. 

Note: Use Preferences/Options to turn on Symbols (shown) and Piece Fill (not 
shown). You can also change the default colors for geometry that is selected or not 
selected. 
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#   Geometry Type Example 

1  Perimeter Line 

2  Internal Line 

3  Grain/Grade 
Reference Line  

4  Orientation 
Symbol 

5  Drill Hole (internal 
line) 

6  Graded End of 
Line 

7  Notch Point(s) 

8  Intermediate Point 

8  Curve Point/ Turn 
Point  

9  Mark X Point  

10  End of Line Point  

11  Grade Point  

12  Smoothing 
Points 

  

 

Geometry Colors 

Different colors are used in the work area to make it easier to identify edits made to 
lines and points on pieces. These colors may represent items such as the original 
line, a modified line, a selected point, or the current piece.  

You can change the default settings using Color Preferences/Options. The chart 
below lists the defaults. 
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Default 
Color 

Indicates 

Black Original, non-modified geometry. 

Green Geometry that is highlighted but not yet 
selected. 

Red Geometry that is selected on a piece. 

Black Geometry modified on a piece but not yet 
saved. 

 

Cursor Shape Changes 

There are several areas in the system where the cursor shape changes. The shape 
change, like prompts, help you know what to do next. Currently the cursor changes 
shape: 

• When selecting points or locations. 
• While using functions to create, modify, grade, measure, and draft pieces. 
• While in the Zoom In function. 

Cursor 
Shape 

Indicates 

 
Normal mode. 

 
Selected point, line, piece, or thumbtack can be moved. 

 
Object closest to the cursor is selected. 

 
A function is active. 

 
A function that has additional options is active. Click the right mouse 
button to display the Options Pop-up menu. 

 
Zoom In function is currently selected. 
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Options for Making Selections in Functions 

When working in functions, choices are available in the Options Pop-up menu to 
end a selection or the function and to select all or clear all selections. 

When an Option Pop-up menu is available for selecting, the cursor shape changes 

to:  
Options Example 

OK – completes the current step 
or function. 

Cancel – exits the functions and 
cancels any changes. 

Select All – selects all of one 
type of piece geometry in a 
function. 

Clear All – clears all selected 
piece geometry. 

Delete Point  
1. Select the function.  

2. Select the point(s) to 
delete.  

3. Click the right mouse 
button. From the 
Options Pop-up menu, 
click OK to delete 
points. 

4. When finished using the 
function, click the right 
mouse button. 

5. From the Options Pop-
up menu, click OK to 
exit the function and 
continue. 

 

Using Zoom Functions 

Use Zoom functions to change the view in the work area. For example, you can 
view all pieces in the work area or move in for a close up view of points. To change 
the view again, select another Zoom function. 

  Related Topics  

Select and Move Points, Lines, and Pieces 

Select and Move Points, Lines, and Pieces 

Piece geometry, such as lines or points, and pieces can be selected individually 
using either Cursor or Value mode. Since many functions in PDS/Silhouette allow 
you to select multiple items, additional techniques are provided including a marquee 
box and quick keys. You can also use thumbtacks to select a range of points. 
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What do you want to do? 

 Select multiple points, lines, or pieces. 

 Focus on a specific piece. 

 Use thumbtacks to select a range of points. 

 End selection and continue. 

 Place piece(s) into the work area. 

 Move piece(s) in the work area. 

 Delete piece(s) from the work area. 

 Switch between lines or pieces while selecting points or locations. 

 

Selecting Multiple Points, Lines, or Pieces 

Many PDS/Silhouette functions allow you to select multiple points, lines or pieces at 
the same time.  

To select object(s) while working in a function: 

1. Do one or more of the following: 

• Click on individual objects; click again to deselect an object. 
• Click in the center of a piece to select all piece geometry for that piece. 
• Hold down the Shift key and click on the first and last of objects located near 

each other; all objects in between these two are selected as well. 
• Hold down the Ctrl key and click to select objects located distant from each other; 

click again to deselect an object. 
• Drag the cursor to draw a marquee box around all of the desired objects  

(see next page). 
• Use Pop-up Options menu to Select All or Clear All selections. 

End Selection 

Because multiple piece selection is permitted, you must end selection using the 
Options Pop-up menu before continuing with the function. 
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To select object(s) with marquee 
box: 

 

1. When prompted by a function 
to select object(s), position 
the mouse cursor in the work 
area to one side of the 
desired objects. Click the left 
mouse button once. 

2. As you begin to move 
the mouse, a marquee 
box attaches to the 
cursor. Move the mouse 
until all of the desired 
objects fall entirely 
within the marquee.  

3. Release the left mouse 
button. All of the 
selected objects display 
highlighted. 

4. End selection to 
continue or see below to 
deselect any object(s). 

  

Using Marquee 

To deselect object(s):  

1. Make a selection by clicking 
or using a marquee box. 

2. Before ending selection. 
Click on unwanted 
object(s) to deselect. 
Hold the Ctrl key down, 
while deselecting, if 
desired. 

3. End selection to 
continue. 

 

 

Selecting a Range with Thumbtacks 

When using a function that requires you to select a range of points, two thumbtacks 
display on the piece at the ends of the line(s) where the points are located. Each 
thumbtack can be repositioned to indicate an appropriate range. 
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To use thumbtacks to select a range: 

1. Open a function that uses thumbtacks, such as Move Range. 

2. When prompted, select the piece geometry. Thumbtacks display indicating a 
range. 

3. In Cursor mode, to reposition one or both thumbtacks: 

• Position the cursor on the thumbtack you want to move and click left.  

The cursor changes to:  
• With the cursor over the line to display points, drag the thumbtack to a new 

location. 
• Click to place.  
• Repeat to reposition the other thumbtack, if desired. 
4. In Value mode, to reposition one or both thumbtacks: 

• Position the cursor on the thumbtack you want to move and click both mouse 
buttons. 

• Enter a value in the Beg field to reposition the first (clockwise) thumbtack and an 
value in the End field to reposition the second. 

• Click OK or press Enter. 
5. End selection to continue.  

Note: When dragging thumbtacks or points, the cursor changes to:  
Hints: 

• Thumbtacks incorporate features of these MicroMark functions: Blend Point, First 
Point of Range, and Last Point of Range. 

• Snap to Geometry can be used to have the thumbtacks snap to existing points. 
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Ending Selection to Continue 

Because multiple points, lines, or pieces can be selected while using many 
PDS/Silhouette functions, you need to indicate when you are done selecting objects 
and are ready to move to the next step.  

Also, a function remains active until you indicate that are you are done using it. This 
makes it convenient to perform a function repeatedly, such as when you are 
digitizing lines. 

To end the selection and continue: 

1. After you complete your selection, do one of the following: 

• With a two-button mouse or pen/stylus, click the right mouse button or pen button 
and click OK in the Options Pop-up menu. Or, double-click the right mouse 
button or pen button. 

• With a three-button mouse or pen/stylus, click the third button or button closest to 
the pen tip. 

To end the current function and continue: 

1. When finished with the function, do one of the following: 

• Follow one of the procedures explained above.  
• Immediately select another function. 
• For a few functions, follow the prompts to end selection. For example, when 

using Create Circle, Create Collar, or Create Skirt, click Cancel in the Options 
Pop-up menu. 

Selecting Points/Locations on Multiple Lines/Pieces 

During selection whenever the cursor is moved near a line, all of the existing points 
on that line are highlighted. When the left mouse button is down and locations/points 
are being highlighted, the arrow keys on the keyboard can be used to switch 
between the different perimeter/boundary and internal lines and between different 
pieces in the work area.  

To move around piece(s) with keyboard keys: 

Key Press To: 

Left Arrow  Move clockwise around the piece. 

Right Arrow Move counterclockwise around the piece. 

Up, Down Arrow Switch between internal and perimeter/boundary lines. 
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Work in Cursor and Value Modes 

Work in Value/Cursor Mode 

When modifying pieces, changes can be made using the mouse cursor or by 
entering specific measurements. When in Cursor mode, changes are made by using 
the cursor to drag the point or line. When in Value mode, select the point or line and 
then type values in fields in the Value Input section of the User Input box to make 
changes. 

What do you want to do? 

 Get acquainted with the User Input box. 

 Change between value and cursor mode. 

 Move a point or line in cursor mode. 

 Move or locate a point in value mode. 
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Getting Acquainted with User Input Box 

While working with PDS/Silhouette functions, the User Input box provides interactive 
communication in each section of this box.  

 

Move your cursor around the 
screen below to get 
acquainted with the User Input 
box. 

Hints: 

• Available fields and 
prompt messages that 
display in this box 
depend on the current 
function. 

• In Screen Layout , you 
can choose to display 
the Value Input box all of 
the time. 

• You can use keys on the 
keyboard as well as with 
the mouse to input 
information. 

• This box can be docked 
or can float in the work 
area. 

 

Options Input Section 

The upper, middle section of the User Input box allows you to choose any options 
available for the function. Depending on the function selected, you can: 
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• Click a round, radio button to choose between two or more options. For example, 
when using Create Line – Offset Even, you can choose to Add or Replace. 

• Click one or more check boxes for options. For example, when using Create Line 
– Offset Even, you can choose to Extend to adjacent lines and/or Select 
Reference Location. 

• Click on the arrow next to a drop-down list box to select a name, type, or quantity. 
For example, when using Create Line – Offset Even, you can choose the exact 
number of offsets from a list of possible choices. 

• Type a name or value in a field and press Enter or click OK to accept. 

  Related Topic(s)  

 

User Input Controls Section 

The bottom section of the User Input box allows you to implement features, 
accept/cancel input from other sections of this box. Buttons in this section are used 
to: 

• Value/Cursor – Switch input mode between Value and Cursor. 

• Tracking – Activate Tracking to move quickly through piece geometry in the work 
area. 

• OK – Accept input and continue with the function. 

• Cancel – Cancel input and return the cursor to an input field. 

• Apply – Accept input and wait for next input. 

  Related Topic(s):  

 

Value Input Section 

This lower, middle section of the User Input box, can be used: 

• In Cursor mode, to check distance information that corresponds to the placement 
or movement of your cursor.  

• In Value mode, to input exact measurements.  

At any time, you can change between using Value and Cursor modes to input 
measurements. 
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To enter values: 

1. Select piece geometry by clicking the left mouse button. 

2. If the Value button is not enabled, click the left and right mouse button at the 
same time to switch to Value mode. 

3. Type to enter values in the following fields: 

• Beg (Beginning) 
• End  
• Dist (Distance) – total distance from current location in a clockwise direction. 
• X – horizontal coordinate for new location. 
• Y – vertical coordinate for new location. 
• Ang (Angle) – angle or orientation to use. 
4. Press Enter or click OK to accept the value you entered. 

Hints: 

• To move between fields in this section, press the Tab key (move to next field) or 
both the Tab and Shift keys (move to previous field). 

• You can enter values in any field that is not grayed out. Fields that are enabled 
depend on the function being used and the specific step being performed. 

•   Related Topic(s): 

Changing between Input Modes 

At any time, you can change between using cursor and value mode to input 
measurements. The name displayed on the Value/Cursor button in the User Input 
box indicates the current mode. The mode stays in the current state until you 
change it. 

• Cursor – Select geometry of the piece and drag with the cursor. 

• Value – Select geometry of the piece and enter value(s) in the Value Input section 
of the User Input box. 

To select Cursor or Value mode before starting a function: 

1. Click on the Cursor/Value button in the User Input box. 

Or press the left and right mouse buttons at the same time. 
To switch between Value and Cursor modes anytime during a function: 

1. When prompted, click to select a point, line, or piece. 

2. Click both the left and right button at the same time. 

  Related Topic(s):  
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Working in Cursor Mode 

When modifying pieces, changes can be made using the mouse cursor or by 
entering specific values. When in Cursor mode, changes are made by using the 
cursor to drag the point or line. 

To move a point or line in Cursor mode: 

1. In the User Input box, check the Cursor/Value button. If it says Value, click on it to 
change to Cursor mode. Or click the left and right mouse buttons at the same time. 

2. Select a function, for example, Move Point. 

3. Select the point(s) or line(s) to move.  

4. End selection to continue. 

5. The point or line will be attached to the cursor. Move it to the new location and 
click the left mouse button to place. 

The amount moved in Cursor mode is displayed in the Value Input area. 

  Related Topic(s):  

 

Working in Value Mode 

When modifying pieces, changes can be made using the mouse cursor or by 
entering specific values. When in Value mode, changes are made using the Value 
Input section of the User Input box. 

Example of moving a point in Value mode: 

1. In the User Input box, check the Cursor/Value button. If it says Cursor, click on 
it to change to Value mode. Or click the left and right mouse buttons at the 
same time. 

2. Select Move Point. 

3. Select the point(s) or line(s) to move.  

4. End selection to continue. 

Notice that the cursor is located In the X field of the Value Input section and 
dimensioning lines display in the work area to indicate where your measurement 
will be applied. 
5. Type the new value and press the Enter key or click OK.  

Note: The Tab key on the keyboard can be used to move through the different, 
active fields. 

The piece on the screen is updated to display the change. 
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Example of finding a location along a line in Value mode: 

1. Select Create Line – Digitized. 

2. Position the cursor over the line where the first point will be placed.  

3. Switch to Value mode while over a line by pressing and holding the left mouse 
button and then pressing and holding the right mouse button. Release both 
buttons simultaneously. 

4. In the Beg field of the Value Input area, type a number. Or in the End field, 
type a number. Notice that dimensioning lines display in the work area to 
indicate where your measurement will be applied. 

Note: The Tab key on the keyboard can be used to move through the different, 
active fields. 

5. Press the Enter key or click OK to create the first point. Or, click the Apply 
button to update the display on the screen.  

Note: If the Apply button is selected, you can continue to make edits to the values to 
Beg and End fields. 

6. After the first point is created, continue creating additional points. 

7. Click right and select End Line from the Pop-up Options menu. 
Example of creating a rectangle in Value mode: 

1. Select Create Rectangle. 

2. Select the point in the work area where a corner of the rectangle should start.  

3. In Value mode, select the desired field in the Value Input Box and type 
dimensions for the new rectangle.  

• The X field displays the length, or horizontal distance, of the rectangle. 
• The Y field displays width, or vertical distance, of the rectangle. 
• The Dist: field displays the diagonal distance of the rectangle. 
4. As you select different fields in the Value Input Box, dimensioning lines display 

to help in selecting the appropriate positive or negative value. Click OK or 
press Enter to accept the rectangle. 

The new rectangle displays. 
Hints: 

• Percentages and equations can be typed into the fields, for example, 42/2 + 0.5. 

• The Apply button updates the piece to reflect the change, the OK button updates 
the piece and completes the function, and the Cancel button cancels the current 
operation.  

•   Related Topics 

Options Pop-up Menus 
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Using Options Pop-up Menu for Work Area Tasks 

An Options Pop-up menu is available directly from the work area when no functions 
are active. These construction tools have been added to increase productivity. 

To access options for work area tasks: 

1. Make sure no function is selected. 

2. Click the right mouse button. From the Options Pop-up menu, click one of the 
following options: 

• Undo – undo the last PDS/Silhouette operation completed.  
• Redo – redo the last action that was "undone."  
• Edit Piece Info – open the Edit Piece Info box. 
• Edit Line Info – open the Edit Line Info box. 
• Edit Point Info – open the Edit Point Info box. 
• Piece to Menu – place a highlighted piece from the work area into the Piece/Icon 

menu. If the piece has changed, enter a new name in the User Input box when 
prompted, and then press Enter.  

• Delete – delete a highlighted piece from the work area.  

Note: This option removes the piece from work area only. It does not delete the 
piece from the disk.  

• Piece Properties – display the Piece Properties box for a highlighted piece in 
the work area. This box displays the following types of information: paths; 
model/style; rule table; piece name, category, and description; fabric type; 
number of points per piece. 

  Related Topic(s):  

Options for Point Location 

The Point Options Pop-up menu is available whenever a function prompts you to 
locate a point, not necessarily one, along a line or in space. This includes functions 
like Split Line or Mark Point, and functions that prompt for new locations, like new 
dart openings or a location for the beginning of a digitized line. 

When an Options Pop-up menu is available for a function, the cursor shape 

changes to .  
To use options when selecting points: 

1. Before making a selection in a function, click the right mouse button. The 
Options Pop-up menu displays directly under the cursor. 

2. Select one of the options in the table below. The default selection is Normal.  

3. Once you have selected another option in this menu, the system prompts for 
your input each time this menu displays.  
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4. When finished using the option selected in step 2, right click and select 
Normal. 

Options Examples 

Normal – selects using the 
cursor or value input section of 
user input box. 

Midpoint – constrains location 
selection to select the midpoint 
of any selected line. 

Multiple – allows selection of 
multiple locations at one time: 
Proportional in space or on a 
line; Distance in space or on a 
line. 

Intersection – constrains 
location selection to the 
intersection of two selected 
lines. 

Along Perpendicular – 
constrains location selection 
along the perpendicular to a 
selected line. 

Along Tangent – constrains 
location selection along a 
tangent to a selected line at a 
selected point. 

Distance from Point – defines 
a location along a line that is a 
given distance from a selected 
point. Can be used for 
measuring from a notch or mark 
point. 
Note: To measure from 
beginning or endpoint of a line, 
use Beg and End fields in Value 
mode. 

Modify Line – Split  
1. Select the function. 

2. Click the right mouse 
button. 

3. From the Options Pop-
up menu, click Multiple 
and then Proportional 
on Line. 

4. Select the line and the 
beginning and end of 
the range. 

5. Select option to include 
end points: none, both, 
first, last. 

6. Enter number of points 
to split. 

7. Click the right mouse 
button and click OK to 
end selection. 

8. Repeat step 7 to end the 
function. 

Create Line – Digitized  
1. Select the function. 

2. Click the right mouse 
button. 

3. From the Options Pop-
up menu, click 
Midpoint. 

4. Select an existing line to 
place the first point of 
the digitized line. 

5. Click the right mouse 
button and click OK to 
end selection. 

6. Repeat step 5 to end the 
function. 
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Options for Lines 

The Line Options Pop-up menu is available while working with lines. When an 

Options Pop-up menu is available for a function, the cursor shape changes to: . 
To use options when creating lines: 

1. While using Digitize Line or 2 Point Line functions in the Create Line menu, click the 
right mouse button. 

2. Select one of the options in the table below. The default selection is Normal.  

Once you have selected another option in this menu, the system prompts for your 
input each time this menu displays.  
3. When finished using the option selected in step 2, right click and select 

Normal. 
Options Examples 

Normal – selects using the 
cursor or value input section of 
user input box. 

 

Line – creates a straight line 
segment. 

Curve – creates a curved line 
segment. 

Horizontal – creates a horizontal 
line segment. 

Vertical – creates a vertical line 
segment. 

Perpendicular to last segment 
– constrains the current line 
segment to be perpendicular to 
the previous line segment. 

Along last segment – 
constrains the current line 
segment to the same direction as 
the last line segment. 

Delete last point – deletes the 
last point entered for a line. 

Close line – connects the last 
point of the line to the first point 

Create Line – Digitized 
1. Select the function. 

2. From the Options Pop-
up menu, click curve. 

3. Select beginning and 
end locations for the 
new curved line. 

4. End selection to 
continue. 
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of the same line. 

End line – creates an end of line 
point to complete a line. 

 

Work areas 

Open, Close, and Arrange Work Areas 

You can have more than one model or style open at a time, each in its own work 
area or window. Only one, however, can be active. The names of the work areas 
that are open are listed under the Windows menu. Work areas are standard 
Windows that can be reduced and arranged on the screen so you can view more 
than one at a time. 

What do you want to do? 

 Open a new work area to create AccuMark pieces. 

 Open an existing model or style. 

 Close the current work area. 

 Close a style or model. 

 Arrange work areas. 

 

Moving Pieces in Work Area 
To move a piece: 

1. Click in the center of a piece in the work area and move the cursor. The piece 
follows the path of the cursor.  

2. Click left again to place the piece in its new location. 
To remove piece(s) from the work area: 

1. Do one of the following: 

• Use the Delete Piece from Work Area function in the Piece menu. 
• Use the Options Pop-up menu in the work area when no function is selected. 

 

Arranging Multiple Work Areas 

There are several ways to select and view a specific work area when more than one 
is open at a time. 

• If the windows are cascaded, click the title bar of the work area you want active. 
If it was behind another work area, it is moved to the front.  
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• Select Window from the Main menu. The name of each open work area is listed 
at the bottom of the menu. A check mark displays next to the one that is currently 
active. Click on the work area you want. 

• Minimize (or maximize), cascade, or close work areas by clicking the window 
control tools  in the top right corner. 

Note: For information on reducing and maximizing windows, refer to your Windows 
online help. 

 Related Topic(s): 

 

Short Cuts 

Short Cuts 

Short cuts are key combinations that can open and close functions, programs, and 
dialog boxes without using the mouse. 

What shortcuts do you want to use? 

 Quick Keys. 

 Keyboard Keys. 

 Function Keys. 

 Hot Keys. 

 

Quick Keys 

Every function in the PDS/Silhouette menu has an underlined letter that can be used 
along with the ALT key to provide quick access to that function. These standard 
Windows Quick keys are available and allow you to quickly choose menu functions 
using the keyboard. 

For example, to access the Add Multiple points function from the Point menu without 
using the mouse, hold down ALT and type the letter P and then type the letter u. 
This has the same affect as if you used the menu bar to access the function. 
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  Related Topics  

 

Keyboard Keys 

The following keyboard keys allow you to perform many functions in PDS/Silhouette 
without using the mouse. 

Enter Key 

The Enter key accepts a name or value typed in a field. Pressing Enter accepts the 
entry and either advances you to the next field or prompts you to right click to exit. If 
you are working in a dialog box, pressing Enter from the last field has the same 
effect as if you clicked OK. 

Escape Key 

The Esc key is the same as if you clicked Cancel to abort a function. Any changes 
that have been made are not saved.  

Ctrl and Shift Keys 

Holding down the Shift key while making a selection, allows you to select multiple 
consecutive items. Holding down the Ctrl key while making a selection, allows you 
to select random multiple pieces.  

Tab and Shift Keys 

Use the Tab key to move to the next field in the Value Input section of the User 
Input box. Press the Tab and Shift keys at the same time to move the previous field. 

Up and Down Arrow Keys 

Use the Up and Down arrow keys on the keyboard to move through submenus in 
the AccuMark menu or the MicroMark menu. 

 83 



Hot Keys with the Alt Key 

Function names and MicroMark function key submenu names have an identifying 
underlined letter or number. To access a function quickly using hot keys, hold down 
the Alt key and then press the key that corresponds to the underlined letter. Refer to 
Windows documentation for examples. 

  Related Topics  

 

Function Keys 

 

Function keys allow you access commonly-used options by pressing a single key, 
such as F2. Many MicroMark functions are still available using function keys. 

  Related Topics  

Hot Keys 

Hot keys allow you access to a function by pressing a combination of keys, such as 
Alt + 9, or a function key such as F2 or F8.  

  Related Topics  

Menu Hot Keys Submenu/ Function 

Point Alt + F1 Delete Point 

 Alt + F2 Modify Points/ Move Point 

 Alt + F3 Modify Points/ Align 2 Points 

 Alt + F4 Add Point 

 Alt + F5 Add Notch 

 Alt + F6 Add Multiple/ Add Drills 

 Alt + F7 Add Multiple/ Add Drills Dist 

 Alt + F8 Add Multiple/ Add Points Line 
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 Alt + F9 Add Multiple/ Add Points Line 
Dist 

 Alt + F10 Point Intersect 

 Alt + F11 Modify Points/ Move Smooth 

 Alt + F12 Modify Points/Move Single Point 

Line Alt + S Swap Line 

 Alt + R Replace Line 

 Ctrl + F1 Delete Line 

 Ctrl + F2 Modify Line/ Move Line 

 Ctrl + F3 Modify Line/ Move Line Anchor 

 Ctrl + F4 Create Line/ Offset Even 

 Ctrl + F5 Create Line/ Copy Line 

 Ctrl + F6 Create Line/ Offset Uneven 

 Ctrl + F7 Create Line/ Digitized 

 Ctrl + F8 Modify Line/ Clip 

 Ctrl + F9 Modify Line/ Combine/Merge 

 Ctrl + F10 Modify Line/ Split 

 Ctrl + F11 Modify Line/ Make/Move Parallel 

 Ctrl + F12 Modify Line/ Flatten Line 
Segment 

Piece Shift + F1 Delete Piece from Work Area 

 Shift + F2 Modify Piece/ Move Piece 

 Shift + F3 Create Piece/ Trace Normal 

 Shift + F4 Create Piece/ Extract Piece 

 Shift + F5 Modify Piece/ Realign 
Grain/Grade Ref 

 Shift + F6 Create Piece/ Rectangle 
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 Shift + F7 Seam/ Define/Add Seam 

 Shift + F8 Seam/ Swap Sew/Cut 

 Shift + F9 Modify Piece/ Flip Piece 

 Shift + F10 Modify Piece/ Rotate Piece 

 Shift + F11 Modify Piece/ Use Position 

 Shift + F12 Modify Piece/ Set and 
Rotate/Lock 

 Shift +W Modify Piece/ Walk Pieces 

 Shift + K Modify Piece/ Fold Keep 

File Ctrl + N New 

 Ctrl + O Open 

 Ctrl + S Save 

 Ctrl + P Print 

 Ctrl + L Plot 

 Ctrl + T Style Description 

 Ctrl + M Style/Piece Manager 

Edit Ctrl + Z Undo 

 Ctrl + Y Redo 

 Ctrl + A Select All 

 Ctrl + D Clear All 

 F10 Delete Pieces from Work Area 

View F7 Zoom/ Zoom In 

 F8 Zoom/ Zoom Out 

 F2 Zoom/ Separate Pieces 

 F3 Zoom/ Full Scale 

 F4 Zoom/ Zoom to Selected 
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 Ctrl + I Point/ Intermediate Points 

 Ctrl + J Point/ Grade Rules 

 Ctrl + B Point/ Point Types/Attributes 

 Ctrl + U Line/ Types/Labels 

 Ctrl + W Line/ Verify by Label 

 Ctrl + G Grade/ Show All Sizes 

 Ctrl + E Grade/ Show Non-base Size 

 Ctrl + K Grade/ Stack On/Off 

 Ctrl + F Grade/ F Rotation 

 Ctrl + H Grade/ Clear Nest 

 Ctrl + R Refresh Display 

Grade Alt +J Create/Edit Rules/ Edit Delta 

 Alt +K Create/Edit Rules/ Create Delta 

 Alt +N Modify Rule/ Change Grd Rule 
Also, Edit Point Info 

 Alt +A Modify Rule/ Add Grade Point 

 Alt +B Modify Rule/ Copy Table Rule 

 Alt +C Modify Rule/ Copy Grade Rule 

 Alt + T Assign Rule Table 

 Alt + Z Clear Charts 

 Alt + Q Measure/ Line 
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Work with Models and Styles 
Overview of File Menu 
Functions in the File menu are used to: 

• Open a new work area. 
• Open and save pieces, models, and styles.  
• Import HPGL files. 
• Send items to the printer or to the plotter.  
• Exit the PDS program. 

Styles 

If you are working with styles, you can: 
• Use style descriptions. 
• Make edits using style/piece manager. 
• Merge digitized data with existing styles. 
• Add style notes. 

Models 

If you are working with models, you can: 
• Create/edit models. 
• Edit parameter tables. 

New 

AccuMark = New 

MicroMark = Not applicable 

  

Use this function in the File menu to open a new work area. Currently, this work 
area can be used to create AccuMark pieces.  

To open a new work area: 

1. From the File menu, select New or press the Ctrl + N keys.  

A blank work area automatically displays and becomes the "active" work area. You 
can have more than work area open at a time. 

 Related Topic(s):  
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Open 

AccuMark = Data Manage/Retrieve Block, Retrieve List, Retrieve Model  

MicroMark = Retrieve Style 

  

Use this function in the File menu to open: 
• AccuMark models or AccuMark pieces  
• MicroMark styles  
• MicroMark digitized data and merge with a style  
• Templates to create Measurement charts  

Note: You can use Quick Open to quickly open a file whose name you know. 
Filters and Wildcards 

Files can be sorted by file name using wildcards. If you prefer to view filtered file 
names only, check the Use Filename Filter Lookup option box. Notice that no file 
names display for the current location UNTIL you type a filter into the File Name field 
and click the Open button or press the Enter key. 

Work Areas 

Files can be opened in the current work area. To have the data retrieved into a new 
work area, check the Open Separate Work Area box.  
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Open AccuMark Models or Pieces 

You can open, or retrieve, an existing AccuMark model or AccuMark Pieces to make 
edits. When a model or piece is opened, the piece(s) display in the Piece/Icon menu 
at the edge of the work area. This includes pieces, such as pockets or collars, added 
using Model options. 

To open a model: 

1. From the File menu or tool bar, select Open or press the Ctrl + O keys. 

2. Select the drive and folder that contains the data. To do this, click the arrow at 
the right of the Look in field. AccuMark data is stored in user defined storage 
areas. 

3. In the Files of Type field, select AccuMark Model.  

4. Select to Open Model Options is you want additional pieces listed in the 
options retrieved along with the main pieces. 

5. To sort files by name, you can use wildcards in the File Name field. Type the 
characters with the * or ? characters and press the Enter key to see the 
filtered list. 

6. When file names display in the list box, do one of the following: 

• Click once on each file(s) you want to open. Multiple files can be selected using 
the Shift or Ctrl keys. Click OK.  
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• Double-click on the name of a single file you want to open. 

Note: You can retrieve and store AccuMark models or pieces with all of the pertinent 
information. Line labels and rule numbers will display on-screen as they would in the 
AccuMark. 

To open an AccuMark piece: 

1. From the File menu or tool bar, click Open or press the Ctrl + O keys. 

2. In the Files of Type field, select AccuMark Piece.  

3. To sort files by name, you can use wildcards in the File Name field. Type the 
characters with the * or ? characters and press the Enter key to see the filtered 
list. 

4. When file names display in the list box, do one of the following: 

• Click once on each file(s) you want to open. Multiple files can be selected using 
the Shift or Ctrl keys. Click OK.  

• Double-click on the name of a single file you want to open. 
5. If prompted that piece(s) will not grade due to missing grade rules (rules 

without corresponding growth values), click one of the following buttons: 

• Yes - Removes the unavailable rule(s). The piece(s) will be able to grade when 
placed in the work area but must be saved to correct the problem. If a piece is 
not saved, after the rules are removed, an error will occur when the piece is 
retrieved again. 

• Yes and Save - Removes the unavailable rule(s) and automatically saves the 
problem piece(s) to disk. This corrects the problem for the piece and the error will 
no longer occur. 

• No - Does not make any changes to the piece. For each copy of a piece brought 
into the work area, the system will prompt the user whether or not to clear the 
unavailable grade rules. The piece will not grade and an error will occur until the 
unavailable rules are removed. Once the rules are removed, the piece needs to 
be saved or the error will still occur when the piece is retrieved again. 

Open MicroMark Styles 

You can open, or retrieve, an existing MicroMark style, to make edits. When a style 
is opened, the pieces display in the Piece/Icon menu at the edge of the work area.  

To open a style: 

1. From the File menu or tool bar, select Open or press the Ctrl + O keys. 

2. Select the drive and folder that contains the data. To do this, click the arrow at 
the right of the Look in field. The default directory for MicroMark data is 
ADS/Styldir.  

3. In the Files of Type field, select MicroMark Style.  

4. To sort files by name, you can use wildcards in the File Name field. Type the 
characters with the * or ? characters and press the Enter key to see the filtered 
list. 
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5. When file names display in the list box, do one of the following: 

• Click once on each file(s) you want to open. Multiple files can be selected using 
the Shift or Ctrl keys. Click OK.  

• Double-click on the name of a single file you want to open. 
6. If the style is already open in another work area, the system prompts the new 

user to open a copy of the currently saved style. If the style was not properly 
closed the last time, the system prompts that the file will be cleaned. 

Also, if some information such as the seam, rule, or variation table, cannot be found 
you will be prompted. Click Yes to continue retrieving the style or No to cancel. 

Note: You can retrieve and store MicroMark models or pieces with all of the 
pertinent information. Line labels and rule numbers will display on-screen as they 
would in the MicroMark 

Open and Merge MicroMark Digitized Data 

You can open or retrieve MicroMark digitized data. This data can be merged into an 
existing style.  

To open digitized data: 

1. From the File menu or tool bar, click Open or press the Ctrl + O keys. 

2. Select the drive and folder that contains the data. To do this, click the arrow at 
the right of the Look in field. The default directory for MicroMark data is 
ADS/Styldir.  

3. In the Files of Type field, select either MicroMark Digitize Data (.r) or 
MicroMark Digitize Data (.dgt).   

For files with an ‘.r’ extension, the system looks in the ADS/ADSDIG directory. 
For files with a ‘.dgt’ extension, the system looks in the default ADS directory or 
on the most recently selected drive.  

4. To sort files by name, you can use wildcards in the File Name field. Type the 
characters with the * or ? characters and press the Enter key to see the filtered 
list. 

5. When file names display in the list box, do one of the following: 

• Click once on each file(s) you want to open. Multiple files can be selected using 
the Shift or Ctrl keys. Click OK.  

• Double-click on the name of a single file you want to open. 

The MicroMark Digitized Data Options dialog box displays. Notice that the file 
name and location of the digitized data selected displays at the top of this box. 

Select from these File options: 
• Delete .r file when finished – Use to delete the .r file after the digitized file has 

been processed. 
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• Delete .dgt file when finished – Use to delete the .r file after the digitized file 
has been processed. 

• Overwrite Existing Style – Use to automatically overwrite an existing file with 
the same name.  

6. To merge digitized data with an existing style, check the Merge into existing 
style option. Select the style to merge into by either using the lookup button or 
typing the device and style name. 

If no device letter was typed, one of these Style device if not specified options will 
be used: 
• Use SERVER_ID – Reads the environment variable SERVER_ID 
• Use digitized data device – Looks for the style on the same device where the 

digitized data is located.  

Note: These options are only activated if there is no device specified. 
7. If multiple files are being opened, check the Use these options for all data 

box. This applies the options selected in the previous steps to all of the files 
being opened.  

If this option is not selected when multiple files are opened simultaneously, the 
dialog box will display for each file and different options may be selected for each 
file.  
8. If the system detects an error while processing the digitized data file(s), the 

DIGSTYLE.TXT file will be created. Click the Yes button to automatically open 
the log file and view the error. 

Open and Create Measurement Charts 

A measurement spec template (.mct file) can be opened and used to create a 
Measurement chart. 

To open the measurement spec template: 

1. Open a style or model in a work area. 

1. From the File menu or tool bar, click Open or press the Ctrl + O keys. 

2. Select the drive and folder that contains the data. To do this, click the arrow at 
the right of the Look in field. The default directory for MicroMark data is 
ADS/Styldir.  

3. In the Files of Type field, select Measure Charts (.mct). 

4. To select file names display in the list box, do one of the following: 

• Click once on each file(s) you want to open. Multiple files can be selected using 
the Shift or Ctrl keys. Click OK.  

• Double-click on the name of a single file you want to open. 
5. When the template opens, create the Measurement chart. 
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Verify Digitized Data from PDS 

In addition to AccuMark Explorer, digitized data can also be retrieved and verified in 
PDS. The data is automatically saved to the current storage area. 

To verify from PDS 

1. From the File menu select Open. 

2. Change the file type to AccuMark Digitized Data. 

3. Select piece and click Open. 

Note: Digitizer data is in the Digitizer area and stored digitized data is located in a 
storage area. 

  
Copy Model 

A new function has been added to the File menu that allows renaming of a model, the 
piece names within the model, and the pieces. After the option is selected, the 
File/Open dialog is displayed and the name of the source model may be selected. The 
Copy Model dialog is then displayed and values can be entered into the Replace: and 
With: fields 
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Use the following fields to assist with modifying the piece names in Copy Model: 

• OK: Applies any name modifications changes and moves to the next step. 

• Cancel: Aborts any current edits and exits the copy model function. 

• Undo Apply: Will undo the last edit made to piece names.  May be used 
multiple times to undo multiple levels of edits.  

• Redo Apply: Will redo the last edit made to piece names.  May be used 
multiple times to redo multiple levels of edits.  

• Reset: Removes any current edits and resets piece names to original names. 

• Apply: Applies current edits typed in the Replace: and With:  fields.  

After the names are modified, several options are available including: 

• Edit New Model – When selected, it will open after the pieces are renamed. 
This allows additional edits to be made to the model if desired. 

• Open New Model – Opens the new model in the work area after Copy Model 
finishes. 

• Open Options – Opens any existing model options after Copy Model finishes. 
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After the edits are made and the OK button is selected, the Save As dialog box is 
displayed. 

  

Select the target device and storage area, and then specify the name of the new 
Model.  When Save is selected the new model and piece names are saved to disk.  
The values of all of the other fields in the model, such as Comments, Flip X, and Flip 
Y are all maintained. 

Hints: 

• When the Copy Model function is selected, the source model should not be open 
in PDS.  If the source model is currently open, an error is displayed. 

•   

Back: Goes back to the previous step, allowing another model to be selected. 
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Close: Closes out the current open model.  Any modifications are discarded 
and Copy Model proceeds using the last saved version of the model. 

Save + Close: Saves the current open model and then closes it so that copy 
model can proceed. 

• Cancel: Aborts the copy model function. 
Examples of Renaming 

• If the characters that you want to replace are the same in the piece names that 
you want to change, simply type the characters you want to replace in the field 
Replace. Then, type the new characters in the With field and click Apply to see 
the results.  An example of this is shown in the initial copy model screen shown 
above where the characters "Ladies" are replaced by the characters "Womens". 

• Replace will replace the first occurrence of the characters that it finds. For 
example: 

Replace ‘02’ with ‘41’ would rename S02-5879-02Front to S41-5879-02Front. 
The second occurrence of  ‘02’ is not altered. 

• The wildcards ‘*’ and ‘?’ may be used when defining the characters. The ‘?’ acts 
as a placeholder, each ‘?’ representing a specific character. The ‘*’ represents all 
characters – either single or multiple places. For example: 

‘M??02*’ can be replaced with ‘MEE02*’. This would rename MSP02Front and 
MFL02Back to MEE02Front and MEE02Back. 

‘M*02*’ can be replaced with ‘MEE02*. This would rename MS02Front and 
M02Back to MEE02Front and MEE02Back. 

• The Replace and With fields may be used multiple times if necessary to apply a 
series of edits. 

• The Destination Piece Names may also be manually edited if desired. 

• If the destination piece names already exist on disk, the system will prompt 
whether to overwrite the pieces or not. 

•   

• If Yes is chosen, all existing pieces will be overwritten. If No is chosen, any pieces 
that do not already exist on disk are saved. The Copy Model dialog will then 
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redisplay. Any piece(s) that was not saved because the piece name already 
existed on disk is displayed in red text. Further edits may then be made to the 
piece name(s) and then the piece(s) may be saved. 

 

Close 

AccuMark = New 

MicroMark = New 

 

Use this function in the File menu to close he active work area.  
To close the active work area: 

1. From the File menu, select Close.  

If there is more than one work area open, the active, or currently selected, one is 
closed. You can also close a work area by clicking the  at the top right corner. 
2. If changes have been made, you are prompted to save them. 

 Related Topic(s):  

Close Style/Model 

AccuMark = Clear Model  

MicroMark = New 

 

Use to close the style or model in the current work area. When you close a style or a 
model, the pieces associated with it are removed from the Piece/Icon menu. 

To close a specific style or model: 

1. From the File menu, select Close Style/Model. A dialog box with the names of all 
of the open styles and models open in the active work area.  

2. Select the model or style name from the list. 

3. Click OK. If you have made changes, you are prompted to save. The pieces 
are removed from the work area and from memory. 
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Import 

AccuMark = Data Management/ Import HPGL 

MicroMark = New 

 

Use this function in the File menu to view thumbnail pictures of clip art and plot files 
and then import them directly into PDS/Silhouette. These graphic file types can be 
imported from non-AccuMark drawing packages (such as AutoCAD™, CorelDraw!™ 
or Artworks™), moved, deleted, and copied as a group. You can then add these 
graphics to pieces you have created or modified in PDS/Silhouette. 

Currently, you can import HPGL files that have the .PLT extension.  

To view all of the screen, click on the middle button in the upper right corner of this 
help window. 

To import an HPGL file: Sample: 

1. From the File menu, select 
Import.  

2. Specify the device and 
path for the files if 
different than the default 
settings for the device 
and storage area.  

3. To automatically add the 
image as a new piece, 
check the Add new 
piece to model/style 
box. 

4. Do one of the following: 

• Click Preview to display a 
thumbnail image of each 
graphic type file in the 
current directory. Click on 
a specific image button 
and then move the cursor 
into the work area. Click to 
place the image. When 
finished placing image 
files, click OK to close the 
Browser. 

• Click to select a file by 
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name and then click OK to 
place it in the work area. 
Click to place the image. 

Hints: 

• The default path is specified in Preferences/ Paths. 

• Clip art can be moved, deleted, and copied as a group.  

• Use the Reduce Points feature after importing HPGL files to remove unnecessary 
points. Add non-smoothing (N attributes or Turn Points) as needed. 

• HPGL files import as internal lines in a proportionally created rectangular piece. 
The rectangular piece can be saved. 

• The internal line or imported image can be copied to another piece. For example, 
if you imported a border as an HPGL file, you could add that same border to a 
shirt front using Copy Line. 

 

Exit 

AccuMark = Exit 

MicroMark = Escape key 

Use this function in the File menu to exit the PDS/Silhouette program. For MicroMark 
users, pressing the Escape key while the cursor is in a MicroMark menu will also exit 
the program.  

To exit: 

1. From the File menu, select Exit. 

2. When prompted, click OK. 

Or if any data is unsaved, a dialog box displays. Do one of the following: 
• Click Yes to save the data and then exit the program. 
• Click No to exit the program without saving the data. 
• Click Cancel to return to the program. 
•  
•  

Save Pieces, Models, or Styles 

Saving and Converting Data  

While saving an existing file, you have the option of converting it to a different 
format. For example, you could open an AccuMark model and save it as a 
MicroMark style. However, only the information supported in the style file will be 
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saved. Also, if a MicroMark style is opened and saved as an AccuMark model, then 
only the information supported in the AccuMark piece file is saved. 

What do you want to do? 

 Save the current data item.  

 Save with a new name. 

 Work with AccuMark and MicroMark data. 

Save - Current Model, Style, or Pieces 

AccuMark = Data Manage/ Quick Store 

MicroMark = Style Piece Manager/ Permanent Store 

 

Use this function in the File menu to save the current model or style under the same 
name. For AccuMark data, you can also save pieces.  

Note: The default choice for the type of files saved depends on the last type saved. 
To change between Save Models/Styles or Save Pieces (AM), click the appropriate 
radio button either in the User Input box or in the Select Objects to Save list box. 

To save an updated, existing model 
or style: 

 

3. From the File menu, 
select Save or press the 
Ctrl + S keys. 

4. The list box of open files 
displays. Or see note 
above. 

5. Select from these 
options: 

• Set Original Position – 
saves the relative position 
of the pieces in the work 
area.  
Note: To retain a previous 
relative position set with 
Use Position, make sure 
this option is not selected. 

• Export Rules – exports 
grade rules 
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6. Select the file name you 
want to save. 

7. Click OK. The model or 
style and all pieces 
associated with it are 
updated on disk.  

Renamed pieces in the 
model or style automatically 
update in the definitions.  
Or use Save Pieces  
(see below) to save both the 
original and renamed pieces 
in an AccuMark model. 

To save updated AccuMark 
piece(s):  
1. From the File menu, select 

Save or press the Ctrl + S 
keys. 

2. The user input displays 
with the following option:  
(Or see note above.) 

• Set Original Position – 
saves the relative position 
of the pieces in the work 
area. 

3. Select the individual 
piece(s) in the work area 
you want to save.  

4. End selection to 
continue. The piece(s) 
update on disk. 

5. To add the piece to the 
Piece/Icon menu, right 
click and choose the 
Add Piece to Menu 
option. 

  

 
Save updated MicroMark styles 

While saving a MicroMark style that has been updated a dialog box will display if the 
system finds that a piece or pieces defined in the style description has been deleted 
from both the piece menu and the work area. 
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Example 

If a Style had 7 pieces and 1 piece was deleted from both the Piece Menu and the 
Work Area, a dialog such as the one below will appear to warn the user that 1 piece 
was not found and will not be saved. Selecting Yes continues the Save process and 
the Style Description will be updated to the new piece count. Selecting No aborts 
the Save process allowing possible recovery of the piece or pieces. 

 

  
Hints: 

• It is possible to add seam corners to a base size, which can not be generated 
correctly, or can not be generated at all on the graded sizes due to invalid 
geometry. When saving a piece and error is found on a graded size the following 
message is displayed. The grading will need to be corrected before proceeding. 

Related Topics: Save As; Saving and Converting Data 

Save As 

AccuMark = Data Manage/ Store Model, Store Style 

MicroMark = Style Piece Manager/ Permanent Store, Copy Style 

 

Use this function in the File menu to save the current piece, model, or style with a 
new name. The original file is not changed. New pieces can be associated by 
category or description. 

Note: The default choice for the type of files saved depends on the last type saved. 
To change between Save Models/Styles or Save Pieces (AM), click the appropriate 
radio button either in the User Input box or in the Select Objects to Save As list box. 
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To save a model or style under a 
new name: 

 

1. From the File menu select 
Save As. 

A list box of open files 
displays. Or see note above. 
2. To export grade rules, 

check the Export Rules 
box. 

3. Select the file name you 
want to save. 

4. Click OK. 

5. In the Save As dialog 
box, choose the storage 
area where the file is to 
be saved.  

6. Enter a new, unique 
name for the model or 
style. 

7. Choose the type of file 
to be saved: AccuMark 
Model or MicroMark 
Style. 

8. To save the relative 
position of the piece(s) 
in the current work area, 
check the Set Original 
Position box. 

9. Click Save. The style or 
model and all 
associated pieces are 
saved to the current 
storage area or to a 
different storage area. 
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To save an AccuMark piece under 
a new name:  
1. From the File menu select 

Save As. 

The user input box displays. 
Or see note above. 
2. Select the individual 

piece in the work area 
you want to save.  

3. End selection to 
continue. 

4. In the Save As dialog 
box, choose the storage 
area where the piece is 
to be saved.  

5. Enter a new unique 
name for the piece. 

6. To save the new piece 
with Category and 
Description information, 
click the Option button. 
This expands the Save 
As dialog box. Enter the 
Category and 
Description information. 

7. To save the relative 
position of piece(s) in 
the current work area, 
check the Set Original 
Position box. 

8. When prompted, select 
a rule table for each 
piece. 

9. Click Save. The piece is 
updated on disk. 

  

Related Topics: Save; Saving and Converting Data 
Hints: 

• To save the copy in a different folder, click a different drive in the Save in box, or 
click a different folder name in the folder list, or both.  

• To save the copy in a new folder, click Create New Folder. 
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• To add a newly saved piece to the Piece/Icon menu, use the Options Pop-up 
menu in the work area. A renamed piece that is part of a model or style will 
automatically be added to the Piece/Icon menu when the model or style is saved. 

• Creating and saving mirrored pieces in a MicroMark style ensures that seams 
and/or the mirrored half of the piece do not get distorted. 

Using Style Description 

Style Description 

AccuMark = Not applicable 

MircoMark = Main Menu/Style Description 

 

Use this function in the File menu to define all MicroMark styles. There are four 
page tabs on the Style Description form. 

• Style Description – Edit a style description, set sample size, and check a history 
of the style. 

• Piece Description – Add or remove pieces and piece descriptions. 
• Cutter’s Must – Enter Cutter’s Must notations. 
• Sorting - control the order of pieces in styles has been added in the Style 

Description 

Ordering a Marker for a Style 

When markers are made to fill a cut order, the marker request specifies the style(s) 
and size(s). Any time a new marker is to be made, the system automatically collects 
the pieces that belong to the appropriate style(s) and grades them to the requested 
size(s). 

Note: An error message displays if this option is selected with AccuMark data open. 
Hints: 

• Available sizes and the sample size can now be assigned whenever the rule table 
is assigned to a piece or through the sample size field. 

Style Description Page 

Using the Style Description Page 

Use this page of the Style Description function to set default information for a 
MicroMark style. 
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Move your cursor around the screen below to find out information about settings you 
can make. To view all of the screen, click on the middle button in the upper right 
corner of this help window. 

To work with styles: 
 

1. Open a MicroMark style. 

2. From the File menu, 
select Style 
Description or press 
the Ctrl +T keys. 

3. Click on the Style 
Description tab. 

4. Make selections in the 
Style Information 
sections. 

5. Set the sample size. 

6. Check the history of this 
style. 

7. Click OK to save. 

 

 

 

 

Setting Style Information for Style Description 

Use the Style Description page to change these options in the Style Information 
section of this page. 

Style Name – Specifies the name of the style. Each time a new style is selected the 
following information updates. 

Grade Rule Table – Specifies the grade rule table to use for grading. Change the 
rule table by clicking on the drop-down arrow and selecting from the list of rule 
tables available. 

Sample Size – Specifies the sample size and designated sizes for the marker.  

Variation Grading Table – Specifies the synonym table to be used. Change the 
synonym table by clicking on the drop-down arrow and selecting from the list of 
tables available. 
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Seam Allowance Table – Indicates what Seam Allowance Table file will be used for 
the selected style when seam is applied. 

MTM Validation Table – Specifies the file that is applied to the style. 

Max Splice – Specifies the maximum splice that can be used for a marker based on 
this style.  

Default Sketch – No longer used. 

 

Setting Sample Size for Style Description 

The sample size can be edited by clicking on the Sample Size field in the Style 
Description page.  

To set the sample size: 

1. Open the Style Description page. 

2. Click in the Sample Size field to display the Select Sizes dialog box. 

 
3. In the list of sizes, click to select sizes you want included in the marker. Sizes 

with an asterisk (*) will be included. 

4. From the drop-down list box, select the sample size from among the sizes you 
chose in step 3. The sample size does not change the geometry of the base 
size. 

5. Click OK. 
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Checking Style History 

The Style Description page allows you to check some historic information about a 
style. The information on this page updates when the style is saved. 

Previous Revision – Specifies the previous revision date. 

Last Revision – Specifies the last revision date. 

Style Creation – Specifies the creation date and User ID for the style. 

 

Piece Description Page 

Using the Piece Description Page 

Use this page of the Style Description function to set or change default information 
for each type of piece included in MicroMark style, including standard pieces. 

Move your cursor around the screen below to find out information about settings you 
can make. To view all of the screen, click on the middle button in the upper right 
corner of this help window. 

To work with pieces  
within a style:  
1. Open a style. 

2. From the File menu, 
select Style 
Description or press 
the Ctrl +T keys. 

3. Click on the Piece 
Description tab. 

4. Select the piece you 
want to edit by doing 
one of the following: 

• Use the slider at the top 
right of this page to view 
icons of pieces included in 
this style.  

• Use the drop-down list box 
to select a Piece Name. 

5. Make edits in Piece 
Information, Piece 
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Restrictions, Piece 
Blocking, Marker 
Preparation and 
Shrinkage sections. 

6. Use buttons at the 
bottom of the page to 
add or delete standard 
piece(s). You also can 
add or delete piece 
descriptions. 

7. Click OK to save. 

 

Setting Piece Information for Style Description 

Use the Piece Description page to change these options: 

Piece Name – Specifies the piece name, which can be up to 10 characters in length 
and should not include spaces. 

Piece Message – Specifies a message characters may be drawn on a specific 
piece when the marker is drawn or at piece plotting time. Piece messages can be up 
to 32 alphanumeric and can contain spaces. 

Type – Indicates Normal or Standard piece type. 

Unflipped – Specifies quantity of the piece as it was stored digitized. 

Opposite – Specifies the quantity of the flipped piece . 

Material Group – Defines a material group; each piece can have a single character, 
alphanumeric identifier. 

Setting Piece Restrictions for Style Description 

Use the Piece Description page to change these options: 

CW Tilt and CCW Tilt – Restricts a piece from being tilted a set amount of degrees 
or linear measurement in the clockwise or counterclockwise direction at marker 
making. The piece may be rotated, but not tilted beyond this restriction. 

Bias – Requests that the piece appear in a bias orientation (45 degree angle) at 
marker time, if a Bias marker is requested. 
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Nap – Requests that if one piece designated with a Nap restriction is rotated during 
marker making, all the pieces of the same size in the style (bundle) which also have 
the Nap restriction also be rotated. 

Flip – Requests that if one piece designated with a Flip restriction is flipped during 
marker making, all the pieces in the same style and size (bundle) which have the 
Flip restriction set to YES will also be flipped.  

Note: The Flip and Nap restrictions are applied at marker making only if the Flip and 
Nap parameters are also included at marker request. If these restrictions will ever 
be used, they should be applied in the style definition. 

Pre-Rotation – Requests that the designated piece be pre-rotated a specified 
amount from the original orientation. The angle of rotation is in degrees and is 
specified be the operator. 

 

Setting Piece Blocking for Style Description 

Use the Piece Description page to change these options: 

Primary X and Y – Specifies that this piece is to be blocked on a plaid or stripe 
marker and the amount available for primary blocking at marker making time. 
Primary block X adds the blocking in the X direction, and Primary block Y adds the 
blocking in the Y direction. 

The value of the primary block X and Y can be set as a percent of a repeat or a 
linear measurement. If percentage is used the primary X is a percentage of the plaid 
repeat and primary Y is a percentage of the stripe repeat. 

Secondary X and Secondary Y – Secondary X and Y block parameters are used 
to specify the amount available for secondary blocking at marker making time.  

The value of the secondary block X and Y can be a set percentage or a linear 
measurement. If percentage is used, the secondary X is a percentage of the plaid 
repeat and secondary Y is a percentage of the stripe repeat. 

Die Allowance – Specifies an equal allowance around the piece. Die allowance can 
be altered during marker making. For die allowance to be enabled or disabled in 
marker making, the parameter must be applied in the style definition. 
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Setting Marker Preparation and Shrinkage for Style Description 

Use the Piece Description page to change these options: 

Number of Splits – Number of Splits is the maximum number of times a piece may 
be split at marker making. A piece may be split up to fifteen times. However, only 
allow the maximum number of splits that would be necessary especially if a large 
marker is needed. Additional memory is taken at marker making for each split noted 
in Style Description. 

Half Piece Table – The Half Piece Table specifies whether this piece is a half piece 
and what half piece table to use when a closed marker is requested. 

Ignore Splice – Ignore splice allows a piece to be ignored in a splice marker 
situation during marker making. 

X Variance and Y Variance – X Variance and Y Variance are a shrink/stretch 
value. X and Y variance alters the piece by a percentage or linear measurement. 
The value can be positive or negative. Positive values increase the size of the 
patterns and negative values decrease the size of the patterns. 

Adding or Deleting Pieces and Descriptions 

Use the Piece Description page to add Standard pieces or remove pieces from the 
style. You can also add or remove the description for a piece using this page. 

 Related Topics  
To add a standard piece to the style: 

1. From the File menu, select Style Description or press the Ctrl +T keys. 

2. Click on the Piece Description tab. 

3. Click the Add Standard Piece button.  

4. In the Add Standard Piece dialog box, select the piece name to be added. 
Click on the button marked with ellipsis (…) to use the lookup. 

5. Enter the material group identifier. 

6. Select Use Current Piece Description, if desired. When checked the piece 
description values that are displayed for the currently selected piece will used 
for the piece being added. If unchecked, the system defaults will be used for 
the new piece description. 

7. Click OK. 
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To remove a piece from the style: 

1. From the File menu, select Style Description or press the Ctrl +T keys. 

2. Click on the Piece Description tab. 

3. Click the Delete Piece button. 

4. In the Confirm Delete Piece dialog box, select the piece name to be removed. 

5. Click OK. 
To add a piece description: 

1. From the File menu, select Style Description or press the Ctrl +T keys. 

2. Click on the Piece Description tab. 

3. Click the Add Piece Desc… button. 

4. In the Add Piece Description box, type to complete the Piece Name and 
Material Group fields. Click OK. 

5. The entry is added to the style. 

6. Complete additional information about the piece, as desired. 
To delete a piece description: 

1. From the File menu, select Style Description or press the Ctrl +T keys. 

2. Click on the Piece Description tab. 

3. Click the Delete Piece Desc… button. 

4. Select the piece description to be deleted. 

5. Click OK. 

 

Cutter's Must Page 

Using the Cutter's Must Page 

Use this page of the Style Description function to set or change default information 
for each type of piece included in a MicroMark style, including standard pieces. The 
Cutters Must page displays the unedited version of the style’s .u file.  

You can also create a text file of this information for editing or printing from a text 
editor.  

Note: What will print is the edited file, even though it does not display in the Cutter’s 
Must window.  

To view all of the screen, click on the middle button in the upper right corner of this 
help window. 
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To create a Cutter’s Must file: 
 

1. Retrieve a style or create 
one. 

2. From the File menu, 
select Style 
Description or press 
the Ctrl +T keys. 

3. Click on the Cutter’s 
Must tab. 

4. View information about 
the Piece, Quantity, and 
any messages. 

5. To print a copy of the 
information on this page 
with the current date, 
click on the Create File 
button. 

6. When prompted that a 
text file has been 
created, click OK. 

  

 
To view the Cutter’s Must file: 

 
1. Return to the Windows 

desktop and open a text 
editor, such as Notepad. 

2. Open the text file named 
after the style name. 
This file is stored in the 
following location: 
C:\ADS\TEXTDIR. 

 

Hints: 

• Some conversion limitations still exist between the MicroMark and AccuMark 
data. 

• Part number for updated Style/Model Conversion manual is 076165001. 

Cutter's Must Details 

In the Style Description, the Cutter’s Must tab displays the unedited version of the 
style’s .u file. 
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To generate a new file: 

1. Click the Create File button. This is equivalent to using F10 and the Cutter’s Must 
option in MicroMark.   

• A new .u file is generated in C:\ADS\Textdir\. 
• If an .u file already exists for the style, the .u file will be regenerated when the 

Create File button is clicked.  

Note: Any edits that were made to the existing .u file prior to clicking the Create File 
button will be lost.  

To edit an existing file: 

1. Click the Edit File button. A text editor displays, allowing you to edit the .u file.  

This is equivalent to using F10, Edit File, and Print File in MicroMark.   

Note: What will print is the edited file, even though it does not display in the Cutter’s 
Must window. 
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Sorting Page 

Sorting Style Descriptions 

Use this page of the Style Description function to control the order in which pieces 
are retrieved when a style is called into the Piece/Icon menu. It also controls the 
order of the pieces in the other tabs of the style description. 

To view all of the screen, click on the middle button in the upper right corner of this 
help window. 

To change piece order in a style: 
 

1. Retrieve a style or create 
one. 

2. From the File menu, 
select Style 
Description or press 
the Ctrl +T keys. 

3. Click on the Sorting tab. 

4. Click on the piece 
names, in order of 
desired appearance. As 
you click next to a piece 
name, the piece name is 
marked with an asterisk 
(*). 

5. Click the Reorder 
button to reorder the 
pieces when finished 
selecting. The piece list 
will be rearranged in the 
order the pieces were 
selected. 

Note: If an error is made while 
selecting piece order, the 
Clear button can be used to 
clear the current order 
selections. Click Cancel and 
reopen the Style Description 
to start again. 

6. Click the OK or Apply 
buttons to accept the 
current piece order. The 
piece order will be 
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updated when the style 
is saved. 

 

Using Style/Piece Manager and Style Notes 

Style/Piece Manager 

AccuMark = Not applicable 

MicroMark = Style/Piece Manager 

 

Use this function in the File menu to merge pieces from one style into another.  

Note: The Style/Piece Manager in PDS cannot be used to swap pieces in and out of 
memory. See Hints below on how to perform other functions formerly done using 
Style/Piece Manager.  

To merge two styles together or pieces from one style to another: 

1. Have the Destination style open in a work area. Use the Sorting tab in Style 
Description to control the order of pieces in styles. 

2. From the File menu, select Style/Piece Manager or press the Ctrl +M keys. 

3. Specify the Source Style Name. 

4. Specify a Destination Style Name, if different than the current style. 

5. From the Source File Piece list, select piece(s) to merge into the destination 
style. Hold down the Ctrl key to select more than one piece. 

6. Click OK. The piece(s) are merged into the destination style. 

7. If prompted that a piece in the source style has the same name as a piece 
already existing in the destination style, rename the piece. 

Hints: 
• Delete Pieces can now be accomplished  in the Style Description form, or by 

deleting the icon in the piece menu. 
• The function Graded Size in the piece menu is similar to using Change Sample 

Grade to verify non-base size pieces.  
• Combine/Merge pieces cannot merge pieces with multiple descriptions or 

materials associated with the piece. 
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MicroMark Style Notes 

Use this function in the File menu to record information about MicroMark styles. 
When selected, a Notepad document supporting the current style will open. If notes 
for the style do not already exist, a blank document will be opened. 

To use Style Notes: 

1. From the File menu, select Style Notes (MK). 

2. Enter the appropriate information. 

3. Save the Notepad document. The name should be in the format, "stylename.n" 
where "stylename" is the name of the current style being described. 

4. Save the MicroMark style that has been described whenever notes have been 
created or edited. 

Create/edit Models and Notch Tables 

Create/Edit Model 

When you choose this function, the Create/Edit Model menu displays. Use the 
functions in this menu to make or modify a Model. When a new model is created, it 
can be accessed when performing tasks in System Management. 

• Add Pieces  
• Remove Pieces  
• Prefix Names  

Note: When adding or removing, multiple pieces may be selected for inclusion. 

Add Pieces 

Use this function in the File/ Create/Edit menu to create a new model or to edit an 
existing one. An active model is one that has already been retrieved. Make sure that 
the storage area and active model are correct before adding pieces.  

The piece must be in the work area before it can be added to the model. 
To add pieces to a model: 

1. From the File menu, choose Create/Edit Model, and select Add Pieces. 

2. When prompted, type the name of the model that the piece is to be added to. 
You have three options: 

• The last model referenced is the default item in the input line. Click OK to accept 
this model. 

• Type the name of an existing model or select the model name from the lookup. 
• If the model does not already exist, type a name and click OK. 
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3. After you specify the name of the model, select the pieces that are to be added 
to it. Selected pieces display with red perimeter. Clicking on a selected piece 
will deselect it. 

4. Right click and select OK when done. The message, Successfully Added 
Pieces to Active Model, displays in the message/prompt line and/or user input 
box. 
The lookup displays the names of the pieces in the order they were added to 
the model. 

5. Choose OK again. 

The system stores the changes made to the model and returns you to the work 
area. 

 

Remove Pieces 

Use this function in the File/ Create/Edit menu to remove one or more pieces from a 
model. Pieces can be removed from either new or existing models.  

Check the status line to see what storage area and model name is active. An active 
model is one that has already been retrieved. 

To remove pieces from a model: 

1. From the File menu, choose Create/Edit Model, and select Remove Pieces. 

2. When prompted, enter the name of the model from which the pieces are to be 
removed. You have two options: 

• The last model referenced is the default item in the input line. Choose Enter to 
accept this model. 

• Type the name of an existing model or select the model name from the lookup. 
The lookup displays a list of the piece names in the model.  

3. Click on the piece names you want to remove. Make multiple selections by 
holding down the Shift or Ctrl key while clicking (Shift-click selects a range of 
pieces: Ctrl-click selects multiple individual pieces). 

4. When done, select OK to accept.  

5. Choose OK again. 
The system stores the changes made to the model and returns you to the 
Create/Edit menu. 

Prefix Names 

Use this function in the File/ Create/Edit menu to determine how pieces will be 
named. When it is on, any piece added to a model using the Add Pieces function is 
prefixed with the name of that model. 
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For example, if you add a piece named "Front" to model "313" when Prefix Names 
is turned on, the system renames the piece "313 Front."  

Note: If you are going to add pieces to a model, check to make sure you have the 
correct model in the work area. 

To apply prefix names to models: 

1. From the File menu, choose Create/Edit Model, and select Prefix Names. 
The message/prompt line shows the name of the model in front of the piece name. 
The piece that is added to the model is a copy of the original piece. 

2. To turn this function off, choose Prefix Names again. 

3. Click any where on the screen to continue. 

Edit Parameter Tables/Notch 

Use this function in the File menu to define depths for notch types in the AccuMark 
notch table. This allows you to plot MicroMark pieces directly from PDS. Notch types 
are converted based on the settings in Preferences/Style tab.  

Note: This feature does not support the MicroMark ability to have different depths for 
the same notch type. For plotting purposes, all MicroMark notches of a specific type 
will be converted to the depth specified in the notch table. If the pieces need to be 
plotted with their actual varied notch depths, the piece will need to be plotted using 
the standard MicroMark methods, such as the MicroMark Plot Request or 
AccuMark-MicroMark Explorer. 

This function may also be used to edit or create new notch tables from within PDS. 
To define notches for plotting MicroMark styles: 

1. Open a MicroMark style. 

2. From the File menu, choose Edit Parameter Tables and then select Notch. The 
Notch table will open up. 

3. Enter values for each of the notch types used in the MicroMark style. Refer to the 
Preferences/Style page. 

4. Click the Save and Exit button to accept these values. Click Reset to Saved or 
Cancel to not accept the changes to this table. 

Note: Save the notch table with the defaul name of P-Notch to automatically apply 
changes during plotting. If the table is saved under another name, the notch table 
will need to be selected in the Piece Plot table in order to see the notches when 
plotting. 

5. Select pieces in the style to plot. 
To create a new notch table: 

1. From the file menu, choose Edit Parameter Tables and then select Notch. 

2. Enter values for each of the notch types used in the MicroMark style. Refer to the 
Preferences/Style page. 
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3. Click the Save and Exit button to accept these values. Click Reset to Saved or 
Cancel to not accept the changes to this table. 

This table may be selected for any AccuMark forms as needed. 

Differences with AccuMark and MicroMark 

File Structures and Data Equivalents Differences 

There will be no data conversions necessary for release 1.0 of PDS/Silhouette 
MicroMark users will use MicroMark 9.5/1.5 styles and AccuMark/Silhouette users will 
use AccuMark 7.6 models and pieces 

MicroMark users will be able to retrieve and store styles, as they would on release 
9.5/1.5 with all of the information in the data intact. Information such as line types and 
rule numbers will display onscreen as they would look on the MicroMark. 

AccuMark/Silhouette users will be able to retrieve and store models or pieces, as they 
would on release 7.x, with all of the information in the data intact. Information such as 
line labels and rule numbers will display on the screen as they would look on the 
AccuMark/Silhouette. 

If you choose to retrieve data in one format and export to another, the rules of 
conversion apply. For example, if an AccuMark model is opened and saved as a 
MicroMark style, then only the information supported in the style file will be saved. If a 
MicroMark style is opened and saved as an AccuMark style, then only the information 
supported in the AccuMark piece file is saved. 

(See Display of AccuMark and MicroMark Functions for more information). 

Model and Style Description Differences 

PDS/Silhouette users will notice the following differences from working in: 
AccuMark MicroMark 

• Pieces and Models are 
stored as separate files.  

• Deleting a piece from a 
model does not delete the 
piece geometry. 

• The Style file includes the 
piece geometry in addition 
to the Style Description 
information.  

• When a piece is deleted 
from the Style Description 
of a MicroMark style, the 
piece geometry is deleted, 
not just the reference to the 
piece in the style. 

• Standard Pieces can be 
shared among different 
styles. They are stored 
separately. 
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• Pieces used for a specific 
model are listed in the 
AccuMark model editor 
along with piece counts and 
fabric types. 

• The Style Description 
includes the piece names 
used in the style, fabric 
types and piece counts. It 
also includes information 
used in marker making 
such as lay restrictions, 
blocking and shrinkage. 

• Information in the Style 
Description is grouped into 
two categories, that which 
is common to all pieces in 
the style, and that which is 
unique per piece.  

• All pieces in the same style 
must share a common rule 
table. 

• There can only be one 
piece per storage area with 
any given name. 

• Because pieces are stored 
inside the style file for 
MicroMark data, different 
pieces can have the same 
name. For example, every 
style can have a piece 
named '‘FRONT".  

• Pieces can be added to an 
existing model using the 
AccuMark model editor. 

• Because pieces exist inside 
styles, existing pieces 
(which are part of another 
style) are added to a style 
by merging two styles 
together. 

 • Whenever a new piece is 
created on the MicroMark 
(for example, Create 
Rectangle or Create Copy), 
a new name is assigned 
and it is automatically 
added to the style. 
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Output to Printer or Plotter 
Printing 

Print 

AccuMark = Popup menu/ Printing Screen 

MicroMark = ALT and END key combination 

 

Use this function in the File menu to submit a request to print items in the 
workspace. You can print multiple copies. PDS/Silhouette uses standard Windows’ 
printing features. 

To print: 

1. From the File menu, select Print or press the Ctrl +P keys. 

Note: To learn more about printing in Windows, refer to documentation provided 
with your operating system. 

 

Print Preview 

AccuMark = New 

MicroMark = New 

 

Use this function in the File menu to preview what will be printed and then to print. 
To preview how pieces in the work area will print: 

1. From the File menu, select Print Preview. 

2. All pieces in the current work area display in the viewer. If more than one page 
is required to print all pieces in the work area, use one or more of the Page 
buttons to move between pages. 

3. To better view how pieces will print, click the Zoom In button once to change 
the overall view. Note that the cursor shape changes shape.  
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4. Click on a specific area of the view screen to enlarge the view in that area. 

5. To view all pieces on a page, click the Zoom Out button once or twice. 

6. When finished viewing, click the Print button to print and return to the work 
area. Or click the Close button to return to the work area without printing. 

 

Print Setup 

AccuMark = New 

MicroMark = New 

 

Use this function in the File menu to specify the default printer or to choose a 
different printer. PDS/Silhouette uses standard Windows’ printing features. 

 

Note: To learn more about printing in Windows, refer to online help for your 
operation system. 

 

Setting up a printer for Measure Line Charts 

In order to generate files from Measure Line charts, use the following procedure to 
set up a file-based printer for use with the print button. For information above 
Measure Line Charts, see the Working with Grading chapter. 

From the desktop 

1. From the Windows desktop, click the Start button. Then choose Settings and 
Printers. 

2. Double-click on the Add Printer icon. 

3. In the Add Printer Wizard, choose My Computer and click the Next button. 

4. In the list of Available ports, scroll down until you see FILE: check it, then click 
the Next button. 
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5. In the list of Manufacturers, choose Generic. 

6. In the list of Printers, choose Generic / Text Only; click the Next button. 

{bmc printerwizard2.bmp}  

7. If asked to choose between new and existing driver, keep the existing driver; 
click the Next button. 

8. Enter a name for the Printer, such as File; click the Next button. 

9. Select to not use this printer as your default; click the Next button. 

10. Select Not Shared; click the Next button. 
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11. If you want a test page, choose Yes, otherwise choose No; click the Finish 
Button. 

From now on, when given the option of choosing a printer to print to, choose File (or 
whatever you named the printer in step 8). When prompted for the file name, enter 
the name of the output file. 

 

Plotting/Cutting 

Plot 

AccuMark = Plot 

MicroMark = F6/Plot Screen 

 

Use this function in the File menu to submit a request to indicate plotters needs to 
be set up and preferences selected prior to selecting plot or cut items in the active 
work area. By changing defaults in Preferences/Options you can: 
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• Plot selected pieces directly from the work area. 
• Preview pieces before plotting using a Plot Form. 
• Control sizes plotted, information, etc. 

For more information on choosing a plotter and setting it up refer to: 

• PDS/Silhouette Getting Started 
• Hardware configuration notes and documentation that came with your AccuMark 

or MicroMark system. 
To plot selected piece(s) in the work area: 

1. Make sure that Plot Form is not checked and an Annotation table is selected in 
Preferences/Options. 

2. From the File menu, select Plot or press the Ctrl + L keys. 

3. Select the appropriate output, Plot or Cut, by clicking the associated radio 
button. 

4. To change the media type, if desired, click the Set Media button in the User 
Input box. Select an existing media type by typing the name or clicking from 
the list. Click OK. 

5. In the work area, select piece(s) you want to plot.  

6. End selection to continue.  

7. To advance to a new page, click the New Page button. An Advance Page 
function is sent directly to the plotter. 

8. When prompted that the plot has been submitted and a job number is 
assigned, click OK. 

To plot/cut pieces using a Plot form: 

1. Make sure that Plot Form is checked and an Annotation table is selected in 
Preferences/Options. 

2. From the File menu, select Plot.  

An empty Plotter Window displays with the Plot Area described by a thick border. 
The plot area depends on the bed size of the default plotter, but can be edited. 

Use features in the Plot Form to perform the following tasks. 
3. If you are plotting to a network plotter, lock the plotter. 

4. Select piece(s) from the work area to be added to the Plot Form. End selection 
to continue. Pieces can be selected for plotting, cutting, or both. 

5. Reposition or rotate the pieces, as needed. 

6. Plot/cut the pieces. 
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Plot Altered 

• AccuMark = New 

• MicroMark = Not Applicable 

• Use this function in the File menu to plot pieces with alterations applied. 
To plot an alter piece: 

1. From the File menu select Plot Altered. 

2. Select the piece(s) to plot and end selection to continue. 

3. The Alteration Setup form displays. Select or complete the following fields: 

• Alteration Library – Select the Alteration editor that should be used for the 
current model. These alterations will be applied during marker order processing 
and the corresponding pieces will appear in the marker in their altered state. 

• Preference - Select one of the following: 

Cumulative – All requested alterations will plot and display blended on the 
piece. 

Nested – Each requested alteration will plot and display separately. 
• Size Code – A Size Code editor may be selected. This is an optional selection 

and the size code table need to be valid for the selected piece(s). 
• Alteration Rule – Enter the name of the alteration rule the system should 

reference. 
• Amount – Enter the alteration amount desired. 
4. Select the size to be plotted from the Plot Altered window and click OK. 

5. When prompted that the plot has been submitted and a job number is 
assigned, click OK. 

 

Using the Plot Form 

The Plot Form allows you to determine how pieces will plot or cut. When turned on 
in Plot Preferences/Options and Plot is selected from the File menu in PDS, an 
empty Plot Window displays. 
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Pieces are placed in the Plot Area that is described by the thick border. This area 
depends on the bed size of the default plotter (identified on-screen) and can be 
edited. 

Use functions in the menu bar of the Plot Form, or click a corresponding icon, to 
perform the following tasks. 

Setting Up the Plot Form 
To set Plot preferences: 

1. Plot Form must be checked on the Plot (AM) page of Preferences/Options. 

2. An Annotation table must also be selected. 
To edit the usable width and length: 

For example, do this if the paper or oaktag being used is smaller than the bed size. 

1. From the View menu, select Bed Size or click .  

2. In the Plotter Bed Sizing dialog box, type different value(s). Click OK. 

The plot area in the Plot Form changes. 
To select the medium to plot or cut: 

The types of media available were defined when the plotter was set up for your 
marking/grading system. The media type set here will remain the selected media 
until another media type is selected (it is a sticky field). The default media type 
displays on-screen. 

1. From the Tools menu, select Set Media or click . 
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2. The Plot dialog box displays. Select an existing media type by typing the name or 
clicking from the list. Click OK. 

To lock a network plotter: 

If plotting to a network plotter, you need to limit access during the plotting session. 

1. From the Tools menu, select Lock Plotter or click . 
Plotting/Cutting Pieces 
To place pieces in the form and plot/cut: 

1. From the Edit menu of the Plot Form, select one of these functions or click the 
appropriate icon: 

•  Place Piece to plot pieces (perimeter/boundary lines display solid)  

•  Place Cut to cut pieces (perimeter/boundary lines display dashed)  

Pieces can be selected for plotting, cutting, or both. 
2. Click on a piece in the work area.  

It is added to the Plot Form, attached to the cursor.  
3. Position the piece in the plot area. 

4. To place a copy of the same piece, click in the work area again.  

5. Or to place a different piece, click on it in the work area and position it. 

6. To remove all pieces and start over, select Clear Pieces from the Edit menu  

or click . 

7. As needed, you can: 

• Reposition pieces 
• Add additional pages to the plot form 

8. When finished, select Plot Pieces from the File menu or click . 
To reposition any piece within the plot area: 

1. After a piece has be placed in the Plot form, select one of these functions or click 
the appropriate icon: 

•  Move Piece – repositions the piece in the plot area or click  

•  Rotate Piece – rotates the piece  
2. If Move piece was selected, use the cursor to reposition and then click to 

place. 

 130 



If Rotate Piece was selected, the piece attaches to the cursor and swings as the 
mouse is moved. When the piece fits the area well, click to end rotating the piece. 
You may have to use Move Piece to reposition it. 

To add a new page to the form: 

1. From the Tools menu, select New Page  

or click . 

This scrolls a new page into view in the plot area. Each new page is equal to the 
plot area you set up. 

 131 



 

Compatibility 
Compatibility - Notches 

AccuMark PDS version 8.0.x (V8) handles notches different than previous versions. 
The following sections explain the differences. 

Reference Notches 

Reference Notches are not only supported in versions of software previous to 
AccuMark 8.0 (V8). 

If a piece with a reference notch is saved in AccuMark PDS version 2.0.10 or earlier, 
or any version of AccuMark Classic PDS, the notch is left at its current location as an 
intermediate point and the reference information is removed. The shape of the base 
size does not change, however the position of the notches on the graded sizes may 
change. When a Reference Notch is added, the distance between the notch and the 
reference point on the base size is maintained on all sizes. If the data is saved in an 
earlier version of software, then the notch position on the graded sizes will float with 
the curve because there is no grade rule on the notch to control the grading. 

The two images below compare a non-graded notch in PDS 2.0.10 and a non-graded 
Reference Notch in PDS 8.0.x. The Reference Notch maintains the same distance to 
the underarm point on all sizes in the nest. When the piece is brought into an earlier 
version of software, the position of the notch is determined by the grading of the 
adjacent grade rules. Note that the notch crossed the path of the intermediate point in 
the piece on the left. 

  
 

Base Points and Notches 

Grade rules can be put on either the notch or the base point of notches in AccuMark 
PDS version 8.0.x (V8). If data created in version 8.0.x (V8) is used in Classic 
AccuMark or PDS version 2.0.x (V2x) the grading of the notch base point is used. 
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If a piece has a grade rule on the notch but not on the base point, the notch will not be 
graded in earlier versions of software. If a piece has a grade rule on the base point but 
not on the notch, the notch will be graded in earlier versions of software. The chart 
below explains where grade rules are assigned on the piece pictured below. 

 Notch 1 Notch 2 Notch 3 Notch 4 

8.0.x - Base Point No Rule No Rule Rule 30 Rule 30 

8.0.x - Notch No Rule Rule 30  Rule 30 No Rule 

7.6.x - Point No Rule No Rule Rule 30 Rule 30 

 

A notch that has a grade rule with no rule on the base point grades differently 
between AccuMark PDS version 7.0.x (V7) and version 8.0.x (V8). 

  

 

Tangent Notch 

Tangent Notches are not supported in earlier versions of AccuMark software. If a 
piece with Tangent grading on a notch is opened in AccuMark PDS Version 2.0.10 or 
earlier, or any version of AccuMark Classic PDS, the position of the notch changes. 

The two images below show a piece with a Tangent notch created in version 8.0.x 
(V8) and the same piece retrieved into an earlier version of PDS. When the piece is 
retrieved into Classic PDS or PDS version 2.0.x, there is no grade rule on the notch. 
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Notches can float along a line, changing position between points and lines on graded 
sizes. With Specify Distance, the shape of the curve will not be distorted, and  notches 
may be located on different lines on different graded sizes. 

 

Grouped Notches 

Grouped Notches are not supported in earlier versions of software. If a piece with 
Grouped Notches is brought into an earlier release, they will be treated like normal 
notches. If the data is saved in the earlier release the grouping will be overwritten. 

 

Seam Distance on Seam Function Option 

The position of the notch is maintained in PDS version 2.0.x if Auto Update Seam is 
OFF. If Auto Update Seam is ON then the position of the notch is maintained at the 
reference distance on the perimeter and the seam internals are updated from the 
perimeter. 

 

Intersection Notches 

Intersection Notches are not supported in earlier versions of software. If a piece with 
an Intersection Notch is brought into Classic PDS or PDS version 2.0 x, the notch is 
lost. 

 

Angled Notches 

Angled Notches are positioned between the sew and cut lines in the direction of the 
angle on AccuMark PDS version 8.0.x (V8). In previous versions, angled notches are 
placed along the perpendicular bisector of the point with the notch. 

 

Compatibility - Seam Corners 

 

Envelope Corner 

In PDS 2.0.x, if the cut line is the piece perimeter, the corner is preserved, regardless 
of whether Auto Update Seam is ON or OFF. If the sew line is the piece perimeter, the 
corner is preserved as an internal line if Auto Update Seam is OFF, and removed, if 
Auto Update Seam is ON. Intersection errors occur if a piece with an Envelope Corner 
is swapped. 
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In Classic AccuMark PDS, if the sew or the cut line is the piece perimeter, the corner 
is preserved if Auto Update Seam is OFF. If Add/Strip Seam is then used the corner is 
lost. If Auto Update Seam is ON, the corner is lost. 

The Envelope Corner can be viewed in Piece Verify and processed in Order load (if 
using Grade Seam/Corners Method), however the shape of the corner may not be 
correct on the graded sizes. 

 

Slanted Step Corner 

If a piece with a Slanted Step Corner and the sew line as the perimeter, is retrieved in 
PDS 2.0.x, the corner is not preserved.  

Classic AccuMark PDS will stop responding if Auto Update Seam is On and the piece 
is brought into the work area. If Auto Update Seam is OFF, the piece will retrieve 
correctly but the corner will be lost if the seam is swapped or if Update Seam is 
performed. 

The Slanted Step Corner can be viewed in Piece Verify and processed in Order load 
(if using Grade Seam/Corners Method), if the sew line is the piece perimeter, 
however, the shape of the corner may not be correct on the graded sizes. 

 

Curved Step Corners 

In PDS 2.0.x, the corner is preserved if Auto Update Seam is OFF. If Auto Update 
Seam is ON, the curve is removed and the corner looks like a regular step corner. 

In Classic AccuMark PDS, if the piece perimeter is the sew line or the cut line; the 
corner is preserved when Auto Update Seam is OFF. If Auto Update Seam is not 
selected and Add/Remove Seam is applied the corner is lost. If Auto Update Seam is 
ON, the corner is lost. 

The Curved Step Corner can be viewed in Piece Verify and processed in Order load -
when using the Grade Seam/Corners Method, however, the shape of the corner may 
not be correct on the graded sizes. 

 

Match Square Corner and Match Seam Corner 

Construction methods have changed with many versions. Match Corners can differ in 
shape between releases even if the same seam grading method is used. 
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Move End points 

In order to simplify the settings the seam preference Move Endpoints has been 
removed in AccuMark PDS version 8.0.x (V8). Move Endpoints is a MicroMark option 
and only affects style data. All style data opened into PDS version 8.0.x (V8) is treated 
as if Move Endpoints was set to YES. This can cause changes in the geometry of the 
piece data. 

  

 

Compatibility - Seam Settings and Grading Methods 

Improved methods for generating seam and corners on graded sizes are supported 
throughout the AccuMark in version 8.0.x. The Seam Preferences previously available 
in PDS versions 2.0.3 through 2.0.10 are now supported in Orderload and Plotting in 
version 8.0.x (V8). Some of these methods are not compatible with earlier versions of 
AccuMark. 

 

Grade Seam Internals/Corners 

Pieces created with the Grade Seam Internals/Corners option are compatible with 
earlier releases of AccuMark and PDS software. The seam internals and corners are 
created from grade rules for the graded sizes therefore Orderload can generate 
equivalent geometry as PDS. 

 

Generate Seam Internals/Corners 

Pieces created with the Generate Seam Internals/Corners option are not compatible 
with earlier releases of AccuMark and PDS software. Since the Generate method 
creates the seam and corners on each individual size, Classic Orderload cannot 
generate the same results. If pieces with the Generate mode are processed through 
Classic Orderload the data could be different. 
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Pieces saved with sew lines as perimeter 

In AccuMark PDS version 8.0.x (V8) pieces can be saved with the sew lines as the 
piece perimeter and Orderload will send the cut lines to marker making. If pieces 
saved with the sew lines as the piece perimeter are processed in MS2000 or Classic 
AccuMark, the sew lines will be sent to Marker Making and subsequently Cutgen. 

 

Data from earlier releases of PDS 

If pieces are retrieved into PDS version 8.0.x (V8) from AccuMark PDS 7.6.5 or PDS 
2.0.3 or earlier, then the seam settings represent Classic AccuMark. The Grade 
method is set to: 

Grade Seam/Corners ON 

Auto Update Seam OFF 

Adjust Seam Grading OFF 

Seam Extensions NO 

Move Endpoints NO 

If pieces are retrieved into PDS version 8.0.x (V8) from PDS 2.0.4 or later, the seam 
settings that were saved with the piece in the earlier version are used. 

Seam settings for MicroMark style data are not saved in earlier versions of PDS. 

 

Compatibility - Unclipped Perimeter Lines 

Pieces with line extensions can grade very differently in AccuMark PDS version 8.0.x 
than in previous versions. The two illustrations below show the same graded, lace 
piece in AccuMark 7.6.5 and AccuMark 8.0. 
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Compatibility with Classic AccuMark 

Several features available in AccuMark PDS version 8.0.x (V8) are not compatible 
with Classic AccuMark or Classic AccuMark PDS version 7.6.5 or earlier, or PDS 
version 2.0.10 or earlier. Some items are not supported and will not be preserved if 
the data is saved in an earlier version of software. In some cases the geometry can 
change shape or notches can move if the data is saved in an earlier version of 
software. 

 

Interface Change in AccuMark PDS 8.0.x (V8) 

The General Preferences page of PDS version 8.0.x includes a Compatibility section 
that determines how the system will handle piece data in previous software versions. 
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Comparison Utility 
AccuMark Data Comparison Utility - AccuMark version 8.0.x (V8) 

The grading engine for AccuMark version 8.0.x (V8) has been modified. A utility to 
check for differences between graded sizes created in version 7.6.5 and graded sizes 
of the same piece created in version 8.0.x is available to review existing data. 

  

Data can be compared from any drive or storage area. Using standard wildcards in 
the Pattern field, specific patters can be compared. The Tolerance field is used to 
define a specific measurement, which a point can deviate between releases. 
Currently, the Tolerance field is only in inches. 

  

After the initial dialog box is completed, click the Check button to initiate the 
comparison. While the utility is running, the Stop button can be used to cancel the 
operation and the Skip Piece button can be used to skip over a specific piece. 

Grade Checker Results 
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Once the comparison has been completed, the utility displays a report with the 
Device, Storage Area, File Pattern –it shows any wildcard string used-, total number 
of pieces, and the total of pieces that do not match between version 7.6.5 and version 
8.0.x. 

Initially all pieces with problems are displayed in a list. The "Show All Pieces" button 
can be used to display all pieces in the storage area. The Status values can show: 
Mismatch, Match, or Error Grading.  

When a specific piece name is selected from the list, the Detail section will display 
information about each size in the size line. The Detail description may be: Point 
count mismatch, Points out of tolerance, or Failed grading PDS piece. 

Grade Viewer 

The View button of the Detail section is enabled after a specific size is selected. 
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The following functions are available in the View window: 
• Tool Bar – The Tool Bar options are New Grading, Old Grading, Symbols, and 

Notches. 
• Status Bar – Use the left mouse button to zoom in and the right mouse button to 

reverse the view. The view can also be control using Full Scale, Full Width, and 
Full Height. 

• New Grading – The grading generated by AccuMark version 8.0.x (V8) is 
displayed as white lines. 

• Old Grading – The grading generated by AccuMark version 7.6.5 is displayed as 
green lines. 

• Symbols –This option may be turned ON or OFF. Rectangles are used for 
intermediate points and triangles are used for grade rules. The application does 
not have information about lines, therefore there are not symbols displaying the 
end of lines. 

• Notches – This option may be turned ON or OFF. 
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Make Edits 
Overview of the Edit Menu 

Use functions in this menu to assist you while you are making edits to pieces. You 
can select pieces and then lines or points to edit. You can also delete pieces from 
the active work area. 

What do you want to do? 

 Edit points, lines, or pieces based on tracking info. 

 Set focus on current piece(s). 

Undo 

AccuMark = Popup/ Undo 

MicroMark = New 

 

Use this function in the Edit menu to undo the last function completed. Undo is 
multilevel, permitting multiple steps to be undone in consecutive, reverse order. 
Undo also reverses operations in the work area such as moving pieces and Options 
Pop-up menus for deleting and placing pieces. Short cut keys for accessing this 
function are Ctrl + Z. 

To undo the last operation: 

2. Immediately after completing an operation, do one of the following: 

• From the Edit menu, select Undo. 
• Click the Undo button in the tool bar. 
• Press the Ctrl and Z keys at the same time. 

The name of the last operation is listed in the drop-down menu. 

 
3. Continue to select this function to undo previous operations in consecutive 

reverse order. 

 Related Topics  
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Redo 

AccuMark = Popup/ Undo 

MicroMark = New 

 

Use this function in the Edit menu to redo the last action that was "undone." The 
name of the last operation is listed in the drop-down menu. Short cut keys for 
accessing this function are Ctrl + Y. 

To redo the last operation that was undone: 

1. Immediately after completing an undo function, do one of the following: 

• From the Edit menu, select Redo. 
• Click the Redo button in the tool bar. 
• Press the Ctrl and Y keys at the same time. 

The name of the last undo operation is listed in the drop-down menu. 
2. Select the name of last "undone" operation. 

3. Continue to select this function to redo previous "undone" operations. 

  Related Topics  

Current Pieces 

Use this function in the Edit menu to set specific piece(s) as active. Once set, all 
other pieces in the work area cannot be selected. This function makes it easier to 
select points, locations and lines when overlapping pieces are present in the work 
area. 

To set piece(s) as current: 

1. From the Edit menu, select Current Pieces.  

Or on the Info bar, click the button located at the right of the piece name field. This 
button is marked with an ellipsis (…). 
2. From the Current Pieces dialog box, select one or more pieces to set as 

active. 

3. To make edits, do one of the following: 

• Leave the dialog box open on-screen 
• Click the button marked by an X in the upper right corner. 
4. To return pieces to normal state, in the Current Pieces dialog box do one of 

the following: 
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• Deselect the piece name(s). 
• Click the Clear All button. 

Set Selected 

 

Use this function in the Edit menu to select a piece to set, or identify, as the current 
piece. 

Select All 

AccuMark = Popup/Select All 

MicroMark = New 

Use this function in the Edit menu to select all of one type of piece geometry while in 
certain functions, such as Assign Rule Table. Short cut keys for accessing this 
function are Ctrl + A.  

You can also access this function from the Options Pop-up menu. 

  Related Topics  

Clear All 

AccuMark = Popup/Select All 

MicroMark = New 

Use this function in the Edit menu to clear all selected piece geometry while in 
certain functions, such as View/ Point/ Intermediate Points. Short cut keys for 
accessing this function are Ctrl + D.  

You can also access this function in from the Options Pop-up menu. 

  Related Topics  
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Delete Pieces from Work Area 

AccuMark = Popup/Delete All 

MicroMark = New 

 

Use this function in the Edit menu to remove all pieces in the active work area. 
To delete all pieces from the work area: 

1. From the Edit menu, select Delete Pieces from Work Area or press F10. 

If any piece has been stored, but not yet returned to the menu, the work area will be 
cleared and the icon will represent the original piece. 

CAUTION: If MicroMark pieces with changes are deleted from the work area before 
the style is saved, the changes will be lost. 

Hints: 

• If you accidentally deleted all pieces from the work area, use the Undo function to 
recover the piece. 

• To delete selected pieces from the work area, use the Delete Piece from Work 
Area function in the Piece menu.  

• To delete pieces from the Piece/Icon menu, use the Option Pop-up menu. 

  Related Topics  

 

 

Edit Point, Line, and Piece Info 

Edit Multiple Points 

Selecting Points 

Multiple points may easily be selected and edited in Edit Point Information. When 
working with multiple points, remember the following: 

• As points are selected, the point symbols will display with color fill. 
• The points will remain selected until the selection is cancelled or the function is 

exited. 
• To deselect a single point, select it again. 
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• To use a marquee box, make sure Tracking is disabled. 
• To clear the selection without exiting Edit Point Info, click the right button and 

choose Clear All. 

Filter Tab for Selecting Information by Type 

Use the filter tab to control which points can be selected. For example if you want to 
change all or a group of notches to another type, select the filter tab, notch points 
option before making your selection. Then, when you make your selection, only 
notch points can be selected and edited. Using the filter tab in combination with 
marquee selection allows you to quickly make changes to common points in a 
region or on several pieces at one time. 

Displayed Information Depends on Selection 

The display of point characteristics such as attributes, modifiers, and notch 
information varies depending on the number and type of point(s) being selected. 

• When a single point is selected, all the information for that point displays in point 
tracking. 

• When multiple points are selected, the information fields become blank until you 
enter values or you press the Backspace key to remove the information without 
making changes. Any edits that are made will be applied to all points, and the old 
values will be removed. 

• When notches are selected, the notch type and depth (if applicable) will display a 
value as long as it is common to all the selected notch points. When there are no 
common values among the notches selected, the fields will display blank and the 
same principles used in editing other point information applies. 

 

Edit Point Info 

AccuMark = Change Point Num, Change Grade Rule, Edit Attribute 

MicroMark = Point/ Point Modifiers Menu, Point Tracking 

 

Use this function in the Edit menu to edit point information such as grade rules and 
point numbers. Depending on whether MicroMark or AccuMark is open, the values 
in the fields vary. Also, certain fields are only applicable for AccuMark or MicroMark 
data. If point information has been modified in the Tracking box, the change is 
applied when the arrow buttons are clicked to move forward or backward on the 
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piece. In addition, if Apply is selected, the arrow buttons may be used without 
having to reselect the point on the piece in the work area. 

To select the point to edit: 

1. In the Edit menu, select Edit Point Info. 

2. Set up to track. 

3. To select the point to be edited, do one of the following: 

• Drag the cursor along a line to display points on that line. Release the mouse 
button to select the point you want to edit. 

• Select multiple grade points in Edit Point Info by using a marquee box to change 
grade rule numbers, attributes, and point numbers. Tracking must be disabled. 

• Click the Track button and then click the Track arrow keys or arrow buttons to 
move clockwise or counterclockwise around the piece. 

• The up arrow key on the keyboard goes to the next point and the down arrow key 
goes to the previous point. The left and right arrows on the keyboard are used to 
move back and forth within a text field. 

• If you set up to use Auto Tracking, click the Track button. When the point you 
want to edit is selected, click the Stop button. 

If you set up to show the Point/Line Info box, this box displays information about the 
current point. 

To make and apply edits: 

1. If desired, use the Filter tab to select the type of information you want, such as 
graded points. 

2. When you have selected the point to be edited, choose any of the following options: 

• If the point is an end of line point, you can click Apply to both end points. Any 
changes made to this point will apply to the other line end point as well. 

• For AccuMark data, check to Mark the point as an X point. 
3. In the ID field, enter a special alteration point number. Or, enter -1 to change a 

point to a non-graded, intermediate. 

4. In the GR field, enter a different grade rule number. For AccuMark data, see 
step 6.  

5. To select from a list of Point Attributes or Point Modifiers, click on the button 
marked with an ellipsis (…). 

6. Track to the next point to edit multiple points or click the Apply button to apply 
your changes.  

7. If you are editing AccuMark data and entered a new grade rule number in step 
3, a dialog box opens. Select the grade rule table to use and then click OK. 

Point selection is cleared automatically when a new selection is made 

When the user attempts to apply either a P, X, or A attribute to a grade point the 
following message appears: 

 147 



  

Select OK to continue with the edit, removing the original attribute or grade rule. If 
Cancel is selected, the edit will abort, leaving the original grade rule or attribute on 
the point. A similar message appears when a user attemps to Add a Grade Point on 
a point with a P, X, or A attribute. 

Note: If point information has been modified in the Tracking box, the change is 
applied when the arrow buttons are clicked to move forward or backward on the 
piece. In addition, if Apply is selected, the arrow buttons may be used without 
having to reselect a point on the piece in the work area. 

Hints: 

• Information displayed and fields used vary depending on the data type, AccuMark 
or MicroMark. 

• Use the up and down arrow keys to track clockwise and counter-clockwise around 
a piece. The left and right arrow keys may be used to move within a text field. 

• Click on the thumbtack at the top right of the Edit Point Info box to have the box 
remain on-screen while using other functions. 

• Set focus on current pieces. 

• Notches may be edited using Edit Notch Info. 

Showing Point Info 

When using Edit Point Info, drag the mouse cursor along a line to display the point 
info box. Information in this box updates for each point on the line. Point information 
includes: 

• Point attribute  
• Type of point  
• ID or special point number 
• Grade rule number 

To have this box display, turn on Show Point using General Preferences and 
Options. This box does not display when using Track arrow buttons or Auto 
Tracking. 
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Edit Line Info 

AccuMark = Relabel Internal, Edit Line Name 

MicroMark = Line/ Line Modifiers Menu 

 

Use this function in the Edit menu to edit line information such as the line type, line 
label, and seam amount. Depending on whether MicroMark or AccuMark is open, 
the values in the fields vary. Also, certain fields are only applicable for the AccuMark 
or MicroMark. 

To edit line information: 

1. In the Edit menu, select Edit Line Info. 

2. Set up to track. 

3. To select the line(s) to be edited, do one of the following: 

• Click the Track button and then click the Track arrow keys to move clockwise or 
counterclockwise around the piece. 

• The up arrow key on the keyboard goes to the next point and the down arrow key 
goes to the previous point. The left and right arrows on the keyboard are used to 
move back and forth within a text field. 

• If you set up to use Auto Tracking, click the Track button. When the line you 
want to edit is selected, click the Stop button. 

4. Select a line type or label: 

• If editing MicroMark data, select a new line type, if desired.  
• If editing AccuMark data, position the cursor in the Type/Label field and enter a 

different line label. 
5. If you selected Stripe, Plaid, or Annotation line type, enter a Group ID or 

Annotation Index in the appropriate field. The value entered will be applied to 
all selected line(s). 
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6. If editing MicroMark data, you can select to add or remove an Opposite 
Grade Axis. Check this option to make the selected line an opposite grade 
axis; or uncheck to remove the definition from the selected line.  

Note:If the piece already had an opposite grade axis, all points that referenced the 
existing one will be updated to reference the new opposite grade axis. 

7. Track to the next line(s) to edit or click the Apply button to apply your 
changes. 

8. Click the OK button to close the Edit Info box. 
To make and apply edits: 

1. If desired, use the Filter tab to select the type of information that is going to be 
edited, such as internals or perimeter. 

2. Enter the new name and seam amount and click OK. 
Hints: 

• Information displayed and fields used vary depending on the data type, AccuMark 
or MicroMark. 

• Use the forward and reverse arrow keys to track clockwise and counter-clockwise 
around a piece. 

• Click on the thumbtack at the top right of the Edit Line Info box to have the box 
remain on-screen while using other functions. 

• Set focus on current pieces. 

Edit Piece Info 

AccuMark = Store Block 

MicroMark = Grade/ Grade Modifiers Menu 

 

Use this function in the Edit menu to edit piece information, including piece name, 
category, description, and grade rule table. You can also check the path and 
style/model for a piece. 

To edit piece information: 

1. Set up to track. 

2. In the Edit menu, select Edit Piece Info. 

3. To select the piece to be edited, do one of the following: 

• Click the Track button and then click the Track arrow keys to move clockwise or 
counterclockwise around pieces in the work area. 
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• If you set up to use Auto Tracking, click the Track button. When the piece in the 
work area that you want to edit is selected, click the Stop button. Use the arrow 
keys to move around the work area. 

4. If desired, you can set the focus on a specific piece. 

5. Type to edit the Name, Category, Description, or Rules for the piece.  

6. Click the Apply button to apply your changes.  

If you have edited AccuMark pieces, you will be prompted to save each piece.  

If you renamed a piece from an existing model or style, the piece name is also 
updated in the Piece/Icon menu. Saving the model or style automatically updates 
the style and model definitions to the renamed piece. To save the old piece and the 
renamed piece separately in an AccuMark model, use Save Pieces instead. 
7. To focus on another piece, repeat step 4. 

8. Track to the next piece to edit or click OK to close the Edit Info box. 
Hints: 

• Information displayed and fields used vary depending on the data type, AccuMark 
or MicroMark. 

• Use the forward and reverse arrow keys to track clockwise and counter-clockwise 
around the piece. 

• Click on the thumbtack in the upper right corner of the Tracking box to have the 
box remain on-screen while using other functions. 

Edit Piece Utility 

The Piece Utility function is used to reset point and line information on pieces. Five 
options are available in the function: Match End Points, Clear Point Numbers, 
Suppress Points, Remove Unavailable Grading, and Clipped Perimeter. 

Match End Points – Sets the end of both lines that make up a corner to the same 
point information. The grade rule, point number and attributes will all be copied from 
the beginning of the second line going in the clockwise direction to the end of the 
previous line. This can cause different results in the graded nest. 

Clear Point Numbers - Removes all of the special point numbers from a piece. 
New point numbers can then be added individually using Edit Point Info or Copy 
Point Numbers can be used to copy numbers from another piece. 

Suppress Points – Removes extra points when multiple points exist at the same 
location. This can be helpful when a piece is not smoothing properly because there 
are two intermediate points at the same location. 
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Remove Unavailable Grading – Converts any graded points for which there is no 
corresponding growth information into a non-graded point. This is helpful when the 
error, "Error grading piece" is given when trying to display a graded nest for a piece. 

Clipped Perimeter – Changes any unclipped parameter lines in the piece into 
clipped lines. 

 

 

Tracking to Edit 

Setting Up for Tracking 

Before you can use Tracking to edit information about points, lines, and pieces, this 
feature must be enabled. You also can use filters to limit the types of information 
displayed while tracking. 

To set defaults for tracking: 

1. Open the General page of Preferences/Options. 

2. To display the Point Info box while tracking points, make sure that Show Point 
Info is checked.  

To enable tracking: 

1. From the Edit menu, select Edit Point Info, Edit Line Info, Edit Notch Info, or Edit 
Piece Info. 

2. In the Edit Info box that displays, make sure the Track button is enabled. 
Otherwise, click the Enable button. 

3. Click the Track button to begin tracking points. Click the Stop button to stop 
tracking. 

      

Tracking enabled  
 

Tracking enabled  
and running 

Tracking disabled 

To filter types of information being tracked: 

1. From the Edit menu, select Edit Point Info, Edit Line Info, or Edit Piece Info. 

2. Click the Filter tab to select the types of information that will be tracked.  

3. If using Edit Point Info, choose one of these filter options: 

• All points 
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• Digitized 
• Grade Point 
• Notch Point 
• Boundary Int/End of Line 
• Point in Space 
4. If using Edit Line Info, choose one of these filter options: 

• All lines 
• Internals 
• Perimeters (boundaries) 
5. If using Edit Piece Info, click to choose one of these filter options: 

• All pieces in work area 
• Selected piece 

Note: Multiple points can be tracked. 
6. Click OK to save any changes you make; or click Cancel. 

Use Tracking to Edit 

Point tracking is used to view individual points on a line or on a piece. If tracking is 
turned on in Preferences/Options, as you move the cursor along a line a box 
displays showing information about the current point. If AutoTracking is Off, you 
must select the Track button in the Tracking box before automatic tracking begins. 

What do you want to do? 

 Edit points using Tracking. 

 Set up for Tracking. 

 Display Point/Line Info box when tracking points. 

 Edit multiple points. 

 Edit lines using Tracking. 

 Edit pieces using Tracking. 

 Focus on current pieces. 

 Set preferences for Tracking. 
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Change View Options 
Overview of View Menu 

Use functions in this menu to zoom in or out in the work area, display or hide point 
and line names and identifiers. When using the PDS/Silhouette main menu to 
access functions, click on Zoom to display additional functions. Or, customize your 
tool bar with the functions you use most frequently. 

Hints: 

• If you have previously worked with AccuMark or MicroMark pattern design 
systems, many of these functions will be familiar but are now accessed differently. 

• Undo does not work for many functions in this menu. Refer to each function for 
specific ways to refresh or change the view after completing a function. 

What do you want to do? 

 Zoom in to change the view in the work area. 

 Verify points. 

 Hide/Ignore lines. 

 Show grading. 

Refresh Display 

AccuMark = Popup/ Refresh Display 

MicroMark = F1/Redraw 

 

Use this function in the View menu to refresh, or redraw, the display of the work 
area. This function removes unwanted measurements left on the screen from 
functions used previously. 

To refresh the screen: 

1. From the View menu, select Refresh Display or press the Ctrl + R keys. 

 

View Undo Buffer 

Use this function in the View menu to compare the previous geometry of selected 
piece(s) with the current geometry after a modification has been made. The buffered 
data displays on-screen along with the current version. 
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To compare piece geometry: 

1. Modify one or more pieces in the work area. 

2. From the View menu, select View Undo Buffer. 

3. Select the piece(s) that you want to view. The buffered data displays on-screen 
along with the current version. 

4. End selection to continue. 

 

Grade Options 

• Use this function in the View menu to select the grade method that the system will 
use. Select one of the following options: 

• Small-Large Incremental – Pieces will grade from the smallest size to the largest 
size. For example, sizes 6 through 20, with a base size of 10 and size breaks at 
16 and 20 would display in the Rule Table Editor as 6 to 10, 10 to 16, and 16 to 
20. In this grading method the growth amount increments per size. 

• Base Up-Down Cumulative – Pieces will grade from the base size to each size 
break. For example, sizes 6 through 20, with a base size of 10 and size breaks at 
16 and 20 would display in the Rule Table Editor as 10 to 6, 10 to 16, and 10 to 
20. In this grading method the growth corresponds to the total growth amount 
between sizes. 

• Base Up-Down Incremental – Pieces will grade from the base size up to the 
next size break and from the base size down to the next size break. This method 
also allows a patternmaker to simulate the manual grading method, threby 
providing a more intuitive method of computer grading. For example, sizes 6 
through 20, with a base size of 10 and size breaks at 16 and 20 would display in 
the Rule Table Editor as 10 to 6, 10 to 16, and 16 to 20. In this grading method 
the growth amount increments per size. 

•  
Hints: 

Grade options are set system wide not just per storage area. Any updates to this page 
will take immediate effect throughout the system. 
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Use Zoom Commands 

Zoom In 

AccuMark = Popup/ Zoom 

MicroMark = F1/ Window 

 

Use this function in the View menu to select a specific area to zoom in on using a 
marquee (drawing a box). This makes it easier to work with small detailed notches, 
darts, or internals.  

To enlarge details of a piece: 

5. From the View menu, choose Zoom and then select Zoom In or press F7.  

6. Click once in the work area near the piece to be enlarged. Diagonally drag the 
cursor across the work area. The system draws a marquee box around the 
area. 

7. Click again when this box is the size you want and that area fills the screen. 

8. To return the piece to normal scale, select Zoom Out or Full Scale. 
To zoom in while using a function: 

1. A function must be open, for example, Move Point or Move Line. 

2. If in Cursor mode, switch to Value mode. 

3. Type X and Y values to define the size of a marquee box and then press 
Enter. 

4. Move the cursor in the work area to position the box. Click to place the box. 

5. Continue with the function. 
Hints: 

• If using MicroMark, it is no longer necessary to always begin at the bottom left of 
the screen. 

  Related Topics  
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Zoom Out 

AccuMark = New 

MircoMark = New 

 

Use this function in the View menu to step backwards after using Zoom In.  
To view more of the work area: 

1. From the View menu, choose Zoom and then select Zoom Out or press F8. 

The work area returns to the size that it was before you zoomed in. 

Note: To change the view again, select another Zoom function. 

  Related Topics  

Zoom - Full Scale 

AccuMark = Popup/ FullScale 

MicroMark = F3/ Scale to all Visible 

 

Use this function in the View menu to adjust the display so that all pieces in the work 
area are visible.  

To view the work area in full scale: 

1. From the View menu, choose Zoom and then select Full Scale or press F3.  

The system reduces the viewing size of the pieces in the work area so they all 
display in the window. 

Note: To change the view again, select another Zoom function. 
Hints: 

• Sometimes when you retrieve a piece from the Piece/Icon menu, you cannot see 
it on the work area. Use this function in the View menu to have all the pieces re-
display. 

• This function does not change the actual scale of your pieces. 

  Related Topics  
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Zoom to Selected 

AccuMark = New 

MicroMark = F4/ Selected Piece Only 

 

Use this function in the View menu to zoom in on the selected piece in the work 
area.  

To view selected piece(s): 

1. Select a piece in the work area. 

2. If selection was made while using a function, end selection to continue. 

3. From the View menu, choose Zoom and then select Zoom to Selected or 
press F4. 

The selected piece fills the window. Other pieces in the work area are not cleared 
from view. 
4. To change the view again, select another Zoom function. 

  Related Topics  

 

Zoom - 1 : 1 

AccuMark = New 

MicroMark = F1/ Scale/ 1.0 

 

Use this function in the View menu to display the pieces in the work area so that 
inch on the screen equals one inch in real life. 

To set screen display to match real life: 

1. From the View menu, choose Zoom and then select 1:1. 

Note: To change the view again, select another Zoom function. 

  Related Topics  

 158 



Zoom - Separate Pieces 

AccuMark = New 

MircoMark = F2/ Separate Pieces 

 

Use this function in the View menu to display the pieces in the work area tiled at full 
scale. This function is useful when all pieces in the Piece/Icon menu are placed in 
the work area. 

To separate pieces in the work area and zoom to view all: 

1. From the View menu, choose Zoom and then select Separate Pieces. 

Note: To change the view again, select another Zoom function. 

  Related Topics  

Verify Points 

Verifying Points 

Use Points functions in the View menu to display additional information about points in 
the work area. These functions make it easy for you verify that you are working with 
the correct point and clear the work area of point information when done. 

  Related Topics  

 

Point - All Points 

AccuMark = Points/ Verify Points/ All Points 

MicroMark = New 

 

Use this function in the View menu to view all of the points on a piece. This includes 
intermediate, grade, smoothing, and end points. 

To view all the points on piece(s): 

1. From the View menu, choose Point and then select All Points. 

2. Select the piece(s) to verify the points.  
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3. End selection to continue. All points on the piece(s) are displayed. 

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 

  Related Topics  

 

Point - Intermediate Points 

AccuMark = Points/ Verify Points/ Intermediate Points 

MicroMark = New 

 

Use this function in the View menu to view all intermediate points on all selected 
pieces. Points display while working.  

To view the intermediate points on piece(s): 

1. Make sure that Symbols is checked in Preferences/Options. 

2. From the View menu, choose Point and then select Intermediate Points or 
press the Ctrl + I keys. 

3. Select the piece(s) whose intermediate points you want to verify.  

4. End selection to continue. The intermediate points show up as squares. 

5. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

6. When finished, select another function or right click and click Cancel. 
Hints: 

• It is helpful to display the intermediate points when selecting a specific point to 
move. 

  Related Topics  
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Point - Point Numbers 

AccuMark = Points/ Verify Points/ Numbered Points 

MicroMark = Not Applicable 

 

Use this function in the View menu to view the point numbers on all selected pieces. 
The display of numbers in the work area has been enhanced. 

To view the numbered points on a piece 

1. From the View menu, choose Point and then select Point Numbers (AM). 

2. Select the piece(s) to display point numbers.  

3. End selection to continue. The system displays the numbers of all of the 
numbered points.  

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 
Hints: 

• To change the point numbers, use Edit Point Info. 

  Related Topics  

Point - Grade Rules 

AccuMark = Points/ Verify Points/ Grade Rules 

MicroMark = F5, Point Types, Grade Nums 

 

Use this function in the View menu to view the grade rule numbers assigned to the 
grade points of all pieces in the work area. Each piece brought down from the Piece 
menu displays its grade points if this function is left on. 

To view the grade points on a piece: 

1. From the View menu, choose Point and then select Grade Points or press the Ctrl 
+ J keys. 

2. The system displays the grade rule numbers on the all of the pieces in the 
work area.  
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3. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

4. When finished, select another function or right click and click Cancel. 
Hints: 

• If an AccuMark piece is created and a rule table is not assigned to it, the system 
automatically assigns a system generated rule table, called PDS, in which the 
base size is 1 and no grading takes place. 

• Re-select this function to turn it off or on. 

  Related Topics  

Point - Point Types/Attributes 

AccuMark = Points/ verify Points/ Point Attributes 

MicroMark = F5/ Point Types & Grade Rule Numbers 

 

Use this function in the View menu to display the Point Modifiers and Point 
Attributes assigned to an individual point or to all of the points on a piece. 

To view types/attributes for point(s): 

1. From the View menu, choose Point and then select Point Types/Attributes or 
press the Ctrl + B keys. 

2. Select piece(s) or individual point(s).  

3. End selection to continue. The system displays the types/ attributes of the 
individual points, or it displays all of the point types/attributes on the selected 
piece. 

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 

  Related Topics  

Attributes 

Point attributes provide information about how a point should be graded, plot or cut. 
Attributes can be assigned to points when the piece is digitized. To display point 
attributes for AccuMark pieces in the work area, use the Point/ Point 
Types/Attributes function in the View menu.  
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To edit point attributes, use the Edit Point Info function. 

# Attributes Use To 

A Average Rule Specify Grade Point Averaging. The grading at 
this point is calculated using the grade rule 
from the previous and the next grade points. 
This averages the grading increments for each 
size. 

B Block Buffer 
Start 

Identify the beginning of each you want to 
buffer. 

E Entry Assign a cut entry attribute to a point to tell the 
cutter exactly where to start cutting.  

F Facing Identify a Facing point. This can be a point on 
either the perimeter or an internal line. Facing 
points can be either grade points or 
intermediate points. Two facing points are 
required on the piece in order to define the 
facing line (orientation line) of the piece. 

K Alternate Start Identify an Alternate Start Point for use with a 
cutter. This allows you to select different 
locations to begin cutting on a piece. Up to four 
alternate start points are allowed per piece. 

L Lift and 
Plunge 

Identify a Lift and Plunge point for use with a 
cutter. This causes the blade of the cutter to 
lift, turn, and plunge back into the fabric cutting 
a sharp angle. 

M Made To 
Measure Line 
Adjustment 

Adjust a piece more than the specified 
tolerance; the line adjustment feature lets you 
select the paste point to move. Select the point 
by assigning an M attribute to it. With this 
attribute, the paste point with the M attribute 
assigned will move to meet its corresponding 
point on the parent, rather than the last paste 
point moving. 

N No Smoothing Identify a Non-Smoothing point. This creates 
non-smoothing (a straight line) at a point. Can 
be applied to an intermediate point or a grade 
point. 

P Fixed Prev Specify a Fixed Perimeter Previous point. This 
creates a graded point that is the same 
distance from the last point digitized for all 
sizes of the piece. This attribute is ignored if 
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the point is already graded. 

Q Block Buffer 
End 

Identify the end of each segment you want to 
buffer. 

S Force 
Smoothing 

Identify a Smoothing point. This creates 
smoothing (a curved line) at a point. Can be 
applied to an intermediate point or a grade 
point. 

R Rotation Indicate any rotation along a line from the 
primary stacking point (Z) when grading 
pieces. 

X Fixed Next Specify a Fixed Perimeter Next point. This 
creates a graded point that is the same 
distance from the next grade point digitized for 
all sizes of the piece. 

Z Stack Identify a Stacking point. This makes a 
selected point common to all sizes in a graded 
nest. 

Note: X and P attributes are converted to reference notches when retrieved into 
PDS version 8.0 (V8). The distance to the next or previous grade point is assigned 
to the notch and the notch is placed onto the grade point so the distance is 
maintained. The X or P attribute does not displayed in version 8.0 (V8) for the 
converted notches. If the piece is stored and retrieved back in version 7.6 or 
previous, the attribute will be present. 

Point Types and Modifiers 

Point modifiers determine how points are graded or cut. Also, point types can be 
assigned to change the shape of a line or to smooth a curved line.  

To display point types and modifiers for MicroMark pieces in the work area, use the 
Point/ Point Types/Attributes function in the View menu.  

To edit point types and modifiers, use the Edit Point Info function. 

Point Types for MicroMark data  
• T – Turn point 
• C – Curve point 
• X – X free point 

Other Point Modifiers for MicroMark data 
• Altst – Alternate start point selects a point as an alternate starting place for 

automated cutting. 
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• CLenRef – Curve Length Reference identifies the selected point as the curve 
length reference point fro this line. Curve length reference points are used in 
tangent grading. 

• LIFPL – Lift and Plunge point can be used to change a point to where a cutter 
will lift the knife and then plunge the knife to assist in angle changes. 

• GLI – Grade Like Intersection grades a digitized point on a piece in the same 
way an intersection of lines grades. 

• OPP – Opposite grade point assigns opposite grading. 

Point - Total Piece Points 

AccuMark = New 

MicroMark = Point/Total Pc Pts 

 

Use this function in the View menu to display the total number of points contained 
within a piece.  

The count includes points on perimeter/boundary lines, drill hole lines (counts as 4 
points), internal cutout lines, internal lines and stripe/plaid lines. For AccuMark data, 
the count includes the equivalent objects. For MicroMark data, notches count as 
three points. The maximum numbers of points allowable for the AccuMark is 
approximately 4000 and for the MicroMark is 256. 

To view the total number of points for a piece: 

1. From the View menu, choose Point and then select Total Piece Points. 

2. Select piece(s) for which you want to display total(s).  

3. End selection to continue. 

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 
Hints: 

• You can also access this function from the Point menu. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

View Lines 

Line - Numbers 

AccuMark = Not Applicable 
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MicroMark = F5/ Line Types & Numbers 

 

Use this function in the View menu to display numbers of lines for pieces in the work 
area. 

To display line numbers: 

1. From the View menu, choose Line and then select Numbers. 

2. Select line(s) or piece(s). 

3. End selection to continue. 

The system displays the line numbers in the work area.  
4. To clear information from the screen but continue with the function, select the 

function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 

Line - Names 

AccuMark = Line/Modify Lines/Edit Line Names 

MicroMark = F5/ Line Types/Labels, Line Numbers 

 

Use this function in the View menu to display the names of lines for pieces in the 
work area. These names are alpha-numeric and up to 10 characters.  

To display line names: 

1. From the View menu, choose Line and then select Names. 

2. Select line(s) or piece(s). 

3. End selection to continue. 

The system displays the existing names of all of the lines in the work area.  
4. To clear information from the screen but continue with the function, select the 

function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 
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Line - Types/Labels 

AccuMark = Line/ Internals/ Verify Internal 

MicroMark = F5/ Line Types/Labels, Line Numbers 

 

Use this function in the View menu to display types or labels for lines in the work 
area. You can use this function to check the status of the current types/labels before 
making edits. In AccuMark data, line labels are used for internal lines for a piece. In 
MicroMark data, types and labels are used to identify all lines for a piece. 

Special line labels are maintained or copied for lines created using Create Trace, 
Offset Even, Offset Uneven, Copy line, Mirror Line, and Create Blend. 

To view types or labels: 

1. Do one of the following: 

• From the View menu, choose Line and then select Types/Labels.  
• Press the Ctrl + U keys. 
• Click the F5 key and from the MicroMark menu, choose the type of points you 

want to view. 
2. Select the line(s) whose types and/or labels you want displayed on-screen.  

3. Right click and then click OK.  

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 

Line Modifiers - Types and Labels 

MicroMark data uses line types or labels to define lines for a piece. Default line types 
explained below identify the type of line. Additional two character line types can be 
defined in a Seam Allowance table, such as NK, HM.  

Type/Labels Indicates 

Style Line Default line label given to any lines added in 
PDS unless otherwise specified.  

Draft Line Temporary line used while working with pieces. 

Stripe Line Reference line used to identify piece placement 
relative to fabric; for example, to match to a 
stripe line. 
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Plaid Line Reference line used to identify piece placement 
relative to fabric; for example, to match to a plaid 
line. 

Grain Line Horizontal reference line parallel to the selvage 
of the fabric which is used to align a pattern 
during marker making and grading. 

Alt Ref Line Additional reference line that can be used in 
delta grading. 

Annotation 
Line 

Determines where annotation characters plot. 

Drill Hole 
Line 

Indicates an internal drill hole. 

Grade Ref 
Line 

Reference line used to determine the horizontal 
position of the piece when digitized. In delta 
grading, this line is parallel to the X-axis. 

Internal Line Line inside the perimeter/boundary of a piece. 

Free XPT 
Line 

Indicator line based on a X point added as a 
visual aid in pattern making to mark placement. 
It is not intended to be cut, and will only show up 
on a plot. It will not show up at Marker Making. 
For example, use to mark where embroidery will 
be placed. 

Split Line One of two lines generated when a single line is 
split. 

Paste Line Reference line used in conjunction with Paste 
Grading. Note: When two pieces that have 
already been graded are combined using 
Combine/Merge to form one piece, it is the paste 
line that shifts the grade of one of the pieces so 
that no new grade rules will need to be added. 

 
To display line types and labels for pieces in the work area: 

Use the Line/ Types/Labels function in the View menu.  
To edit line types: 

Use the Edit Line Info function. 
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Line - Verify by Label 

AccuMark = Line/ Internals/ Verify by Label 

MicroMark = New 

 

Use this function in the View menu to highlight internal lines with a specific label. 
To verify lines by label: 

1. From the View menu, choose Line and then select Verify by Label or press the 
Ctrl + W keys.  

2. In the Value Input box, enter the label of wanted lines and then press Enter. 
Lines with the specified label are highlighted. 

Note: Labels are case sensitive; for example, BACK is not perceived to be the same 
as Back. 

3. End selection to continue. Or select another function to remove line labels 
from the screen.  

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 

 

Hide/Ignore Lines 

Hide/Ignore Lines 

Use Lines functions in the View menu to hide/ignore line types, such as perimeter, 
internals, cut, or sew lines, in the work area. Also, use this function to check or 
change names and labels for lines. These functions make it easy for you verify that 
you are working with the correct line and clear the work area of line information 
when done. 

  Related Topics  
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Line - Hide/Ignore Perimeter 

AccuMark = Line/ Hide/ Hide Perimeter 

MicroMark = Line/ Ignore/ Reset Ln 

 

Use this function in the View menu to temporarily hide or ignore selected 
perimeter/boundary lines of selected pieces. You can not hide all of the 
perimeter/boundary lines in a piece. If you select the entire piece to hide, one 
perimeter/boundary line will remain on the screen.  

To hide perimeter lines: 

1. From the View menu, choose Line, Hide/Ignore, and then select Perimeter.   

2. Select the perimeter line(s) you want to hide.  

3. End selection to continue. The system removes all but one perimeter/boundary 
line in each piece from the screen.  

4. To return to the original view, use Hide/Ignore Reset. 

  Related Topics  

Line - Hide/Ignore Internal 

AccuMark = Line/ Hide/ Hide Internals  

MicroMark = Line/ Ignore/ Reset Ln 

 

Use this function in the View menu to temporarily hide or ignore selected internal 
lines of selected pieces from the screen. 

To hide/ ignore internal lines: 

1. From the View menu, choose Line, Hide/Ignore, and then Internal. 

2. Select the internal line(s) you want to hide.  

3. End selection to continue. The system removes the internal lines you chose 
from the screen.  

4. To return to the original view, use Hide/Ignore Reset. 

  Related Topics  
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Line - Hide/Ignore Reset 

AccuMark = Line/ Hide/ Restore Hidden 

MicroMark = Line/ Ignore/ Reset Ln/ Reset All 

 

Use this function in the View menu to redisplay all of the perimeter lines or internal 
lines that are hidden.  

To redisplay hidden lines: 

1. From the View menu, choose Line, Hide/Ignore, and then select Reset. 

2. Select the piece(s) whose lines you want to redisplay.  

3. End selection to continue.  

  Related Topics  

View Piece Information 

Piece - Seam Amounts 

AccuMark = Blocks/ Seam/ Seam Amounts 

MicroMark = F5/ Seam Allowance Values 

 

Use this function in the View menu to display the amount of seam assigned to each 
line.  

To view the seam amounts: 

1. From the View menu, choose Piece and then select Seam Amounts. 

2. Select the line(s) or piece(s) to display the measurements of the seam 
amount.  

3. End selection to continue.The seam allowances display.  

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 

  Related Topics  
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Piece - Hide Annotations 

AccuMark = New 

MicroMark = New 

  

Use this function in the View menu to hide annotation while working with models or 
styles. 

To hide Annotations: 

1. In the View menu, choose Piece and then select Hide Annotations. 

2. Click Show Annotations to return annotation to the piece displayed in your 
work area. 

Piece - Seam Corner Types 

AccuMark = New  

MicroMark = Corner Types 

 

Use this function in the View/ Piece menu to display seam corner types. 
To display seam corner types: 

1. From the View menu, choose Piece and then select Seam Corner Types.  

2. Select the line(s) or piece(s) to verify. 

3. End selection to continue. The corner type is displayed. 

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 

Piece - Curved Intersections 

AccuMark = Replace 2 Ln Circle 

MicroMark = Curved Intersections 

 172 



  

Use this function in the View menu to display curved intersections on pieces in the 
work area.  

To display curved intersections: 

1. In the View menu, choose Piece and then select Curved Intersections. 

2. Select the piece(s). 

3. End selection to continue. 

Any curved intersections on the selected piece(s) display. 

Note: Curved intersections that are severed do not highlight. 

Show Grading 

Showing Grading for Pieces 

Use Grade functions in the View menu to display or hide grading for pieces in the 
work area. These functions make it easy for you verify grading for a piece and clear 
the work area of grade information when done. Various functions in the View/Grade 
menu are more suitable, depending on whether you are viewing AccuMark or 
MicroMark data. 

  Related Topics  
Hints: 

• A pound symbol (#) displays in grading functions and in the information bar after 
MicroMark Variation sizes. 

• An asterisk (*) displays after grading functions and in the information bar after 
MicroMark Variation sizes.  

• For AccuMark data, Modify Grade Rules can be set to ON in General 
Preferences/Options. Then grading modified with Piece menu functions such as 
Pivot Dart or Tapered Fullness is automatically updated and an asterisk (*) is 
placed next to the rule number. The new rule number is unique to that piece, 
independent of any rule table, and is stored with the piece information. 

• For MicroMark data, use Export data to modify an existing rule table. 
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View 

The following chart summarizes the results of various functions in the View/Grade 
menu for displaying AccuMark and MicroMark data. 

 AccuMark MicroMark 

Show All Sizes  Displays all Break and 
Intermediate sizes 

Displays all Regular 
Sizes and Variations 

Show Selected Sizes  Displays the Show 
Selected Sizes Window 
from which you can 
choose specific sizes  
to view 

Displays the Show 
Selected Sizes Window 
from which you can 
choose specific regular 
or Variation sizes to 
view. 

 

Show Regular/Break 
Sizes  

Displays the Break sizes 
only, no intermediate 
sizes 

Displays the non- 
Variation sizes 

 

Show Regular Sizes + 
Variations  

Not Applicable Displays the Show 
Regular Sizes + 
Variations Window from 
which you can choose 
specific regular sizes to 
view along with their 
corresponding Variation 
sizes 

 

 

Grade - Show All Sizes 

AcccuMark = Grade/ Display Grade/ Show Nest All 

MicroMark = Grade/ Grade Piece 

 

Use this function in the View menu to display the graded nest of all sizes of a 
selected piece. These sizes correspond to sizes rule table for the piece. The nest 
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remains on the screen while the piece is being modified. Edits are made to the base 
size only. 

To show all the sizes in a piece: 

1. From the View menu, choose Grade and then select Show All Sizes or press Ctrl 
+ G keys. 

2. If desired, select the option: View Grade Rules. 

3. Select the piece whose graded nest you want to display. The system shows all 
of the sizes in the piece's nest. 

4. End selection to continue. 

5. To change views for nested pieces, select another View/Grade function. 

6. To return to displaying a single piece, select Clear Nest. 
Hints: 

• If you specified only one size in the rule table, or if that piece is not graded, the 
system only displays the piece. 

• You can set preferences for colors used for each size in a graded nest. 

  Related Topics  

 

Grade - Show Selected Sizes 

AccuMark = Grade/ Grade Display/ Show Nest Range 

MicroMark = Grade/ Sizes to View 

 

Use this function in the View menu to display nest of a range of consecutive sizes 
for a selected graded piece. 

To show selected sizes: 

1. From the View Menu, choose Grade and then select Show Selected Sizes. 

2. Select the piece whose sizes you want to see.  

3. Type the smallest size in the range and press Enter or click OK. 

4. Type the largest size in the range and press Enter or click OK. The system 
displays all of the sizes in the selected range. 

5. To change views for nested pieces, select another View/Grade function. 

6. To return to displaying a single piece, select Clear Nest. 
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Grade - Show Regular/Break Sizes 

AccuMark = Grade/ Display Grade/ Show Nest Breaks 

MicroMark = Not Applicable 

 

Use this function in the View menu to display the nest of a graded piece including 
only the break sizes (no intermediate sizes): displays MicroMark non-Variant sizes. 

To show the size breaks in a piece: 

1. From the View Menu, choose Grade and then select Show Regular/Break Sizes. 

2. Select the piece(s) whose size breaks you want to see. The system displays 
the size breaks as you click on each piece. 

3. End selection to continue.  

4. To change views for nested pieces, select another View/Grade function. 

5. To return to displaying a single piece, select Clear Nest. 
Hints: 

• If you specify only one size in the rule table, or if that piece is not graded, the 
system only displays the piece. 

• You can set preferences for colors used for each size in a graded nest. 

  Related Topics  

 

Grade - Show Regular Sizes + Variations 

AccuMark = Not Applicable  

MicroMark = Grade/ Display Grade/ Sizes to View 

  

Use this function in the View menu to display the Show Regular Sizes + Variations 
window from which you can choose specific regular sizes to view along with their 
corresponding Variation sizes. 
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To show regular sizes plus variations: 

1. From the View Menu, choose Grade and then select Show Regular Sizes + 
Variations. 

2. Select the piece(s) whose size breaks you want to see. The system displays 
the size breaks as you click on each piece. 

3. End selection to continue.  

The Show Regular Sizes + Variations window displays. Variation sizes are 
indicated by the # sign. 
4. Select the size variation(s) you want to view. Then click OK. 

  
Hints: 

• You can plot a single size with variations by first choosing Create Piece/Graded 
Size. Currently, graded nests with variations cannot be plotted. 

• The use of Variations is dependent on an existing synonym table. 

• You can also view Variations by clicking on the Style Description/Sample Size 
Field to display the Size List window. Click the right mouse button for options that 
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allow you to select and view the variations.  

 

• The info bar indicates MicroMark Variation sizes by displaying a pound (#) symbol 
next to the size name. 

Grade - Show Actual Sizes + Alterations 

AccuMark = Piece Verify/Display Alter 

MicroMark = Not Applicable 

Use this function from the View menu to display the original piece and the altered 
piece in any size. The sizes must be in the assigned grade rule table.  

To use this function an alteration library must exist already. Also, the piece must 
contain special point numbers that match the rules in the alteration library. 

To show actual sizes and alterations: 

1. From the View menu, choose Grade and then select Show Actual Sizes + 
Alterations. 

2. Select a piece(s) and end selection. 

3.  The Alteration Setup form displays. Select or complete the following fields: 

• Alteration Library – Select the Alteration editor for the selected piece(s).  
• Preference - Select one of the following: 

• Cumulative – All requested alterations will display blended on the piece. 

• Nested – Each requested alteration will plot and display separately. 
• Size Code – A Size Code editor may be selected. This is an optional selection 

and the size code table needs to be valid for the selected piece (s). 
• Alteration Rule – Enter the name of the alteration rule the system should 

reference. 
• Amount – Enter the alteration amount desired. 
4. Select the size to be displayed from the Show Actual Sizes + Alterations table. 

Hints: 
• Alterations may be applied during order processing and the corresponding pieces 

will appear in the marker in their altered state. 
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• Select Cumulative option to view multiple alterations as they will blend together in 
marker making. 

• When verifying different individual alterations or troubleshooting multiple 
alterations, use the Nested option to display each alteration’s start and end point. 

•  

Create Piece - Graded Size 

AccuMark = Grade/Display Grade/Show New Size 

MicroMark = Grade/ Sizes to View 

 

Use this function in the Piece menu to create a new piece that is a single graded 
size. 

To create a Graded Size piece: 

1. From the Piece Menu, choose Create Piece and then select Graded Size. 

2. If the piece created is new checked the New Piece Name box. 

3. Select the piece (s) to create the graded size from. 

4. A Graded Size window will open. The window displays the existing graded 
sizes, breaks, and base size information. Select the graded size desired for 
the new piece(s) and click OK. 

Hints: 

• For MicroMark data, use this function instead of Change Sample Grade when 
verifying information for a non-base size. For example, show non-base size and 
then walk pieces. 

• Use this function to verify and compare individual graded sizes. 

• All grade rules for the newly created piece are set to zero growth. 

  Related Topics  
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Grade - Stack On/Off 

AccuMark = Grade/ Create Edit/ Stack On-Off 

MicroMark = Grade/ Stack/ (Dig, Inter, Orig., 2 Points) 

 

Use this function in the View menu to display nest as though it were stacked from a 
selected point. On AccuMark data, the stack point is a Z attribute. 

To stack a nest at a specific point: 

1. Display a nest using one of the View/Grade functions. 

2. From the View menu, choose Grade and then select Stack On/Off or press 
Ctrl + K keys. 

3. Select this option: 

• Stack 2 Points – allows graded nests to be stacked on two points. Selecting 
existing stack points removes the stacking information form the point. 

4. To select a new stacking point, do one of the following: 

• In Cursor mode, select a point on a perimeter/boundary line where you want the 
Z attribute applied. 

• In Value mode, type the exact location of the point on the perimeter/boundary 
line in the Beg or End field. Press Enter.  

The piece nest is redrawn as though it were stacked at this point.  
5. To remove the stacking, select the point again while still using this function. 

6. When finished, select another function or click the right button and click 
Cancel. 

  Related Topics  
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Grade - F Rotation 

AccuMark = Grade/ Display Grade/ F Rotation 

MicroMark = Not applicable 

 

Use this function in the View menu to display a piece and its graded nest with the F 
Rotation line stacked for all sizes and on the horizontal. On AccuMark data, the F 
line is created from two points with F attributes. 

Note: Use a function, such as Show All Sizes, first in order to see how grading for 
the piece looks when it is rotated. 

To display a piece’s F rotation: 

1. From the View Menu, choose Grade and then select F Rotation or press Ctrl + F 
keys. 

2. Select piece(s) to rotate.  

3. End selection to continue. The system rotates the piece according to the 
facing points assigned to the piece's perimeter. The orientation, as it appears 
on the screen, is the way it appears in the marker. 

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 

  Related Topics  

Clear Nest 

AccuMark = New 

MicroMark = New 

 

Use this function in the View menu to remove nested sizes from display. 
To clear nest from display: 

1. From the View menu, choose Grade and then select Clear Nest or press Ctrl + H 
keys. 
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Work with Points 
Overview of Point Menu 

Use functions in this menu to add, reduce, delete, and modify points for a piece. 
When using the PDS/Silhouette main menu to access functions, click on Modify 
Points to display additional functions. Or, create a custom tool bar that contains the 
functions you use most frequently. 

If you have previously worked with AccuMark or MicroMark pattern design systems, 
many of these functions will be familiar and can be accessed using the traditional 
AccuMark menu or MicroMark menu. However, you may improve your productivity 
by taking time to become acquainted with some new methods for working with 
points. 

What do you want to do? 

 Modify points. 

 Move points. 

 Work with notch points. 

 Add multiple points. 

 Verify points. 

Add Point 

AccuMark = Points/ Add Point 

MicroMark = Point/ Add Point - Dist, Cursor 

 

Use this function in the Point menu to add a point to a line or an internal drill point to 
a piece.  

To add points to a pattern piece: 

2. From the Point menu, select Add Point or press the Alt + F4keys. 

3. If desired, check to add the point as an N Attribute point. 

Note: A Turn point is a point with an N Attribute used in MicroMark data. 
4. To use Options while completing this function, click the right mouse button. 

Options provide greater control while adding the point. 
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5. Indicate where the new point is to be positioned by doing one of the following: 

• In Cursor mode, click on the internal or perimeter/boundary location to add the 
point. 

• In Value mode, type the distance from the beginning or end of the line in the Beg 
or End field. If adding a drill hole inside the piece, type the X and Y offset 
amounts (from a reference location) in the X and Y fields. Click OK or press 
Enter. 

The new point is added to the piece. 
Hints: 

• If a point is added to the interior of a piece, the system automatically labels the 
point as a drill hole and assigns it the label of D for AccuMark data and DH for 
MicroMark data. These points are represented by plus (+) symbols on the screen 
and can be graded if necessary. 

• To view the added point, Symbols must be selected in Preferences/Options and 
the Intermediate Points function must be selected. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Mark X Point 

AccuMark = Points/ Mark Point 

MicroMark = Point/ Free X Point 

 

Use this function in the Point menu to mark a visible reference point on a line or in 
space. The mark is displayed as an X or *. Points added using this function display 
all of the time.  

 
To add visible intermediate points to a line: 

1. From the Point menu, select Mark X Point. 

2. Select the location on either a perimeter or internal line (excluding the 
grain/grade reference line) where you want to add the point. Do one of the 
following: 

• In Cursor mode, click on the internal or perimeter line where you want to add the 
point. 

• In Value mode, type the distance from the beginning or end of the line in the Beg 
or End field. Click OK or press Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the point. 
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The system creates and displays the point. 
3. End selection to continue. 

Hints: 

• On MicroMark data, the mark is an X Point if added to a line and a Free X Point if 
added in space. Currently, the MicroMark menu option always adds a Free X 
Point. 

Point Intersect  

AccuMark = Points/ Point Intersect 

MicroMark = Point/ Add Point/ Computed Intersection 

 

Use this function in the Point menu to mark a point where two non-parallel lines 
intersect, or would intersect, if extended. For points not on a line, the system marks 
the intersection point with a drill hole (+). 

To mark the intersection point of two non-parallel lines: 

1. From Point menu, select Point Intersect or press the Alt + F10 keys. 

2. Select the two lines.  

The intermediate point is added where they intersect. If the intersection extends 
beyond the perimeter point, a drill hole is added. 
3. End selection to continue. 

Hints: 

• The system cannot create a point if parallel lines are selected or if the lines do not 
intersect within 30 inches of the piece. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Delete Point  

AccuMark = Points/ Delete Point 

MicroMark = Point/ Delete Point 

 

Use this function in the Point menu to delete intermediate points, notch points, or 
grade points. After you remove a point from a line, the system adjusts the line to 
reflect the changes. 

To delete a point on a line: 

1. From the Point menu, select Delete Point or press the Alt + F1 keys. 

2. Select the point(s) to delete. You can select one point, multiple points on the 
same piece, or multiple points on different pieces.  

3. End selection to continue. 
Hints: 

• You cannot use this function to delete an endpoint on a perimeter/boundary line. 
Instead, use the Merge function in the Line/Modify Line menu. 

• You cannot use this function to delete smoothing points. 

• To make sure you are selecting the correct point, click on the line, hold down the 
mouse button, and drag the cursor along the line until the Point/Line Info box 
displays (if Show Point Info is checked in Preferences/Options). The info box tells 
you what type of point you are on. Release the button to select.  

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Reduce Points 

AccuMark = Points/ Reduce Points 

MicroMark = Point/ Delete Extra Points 

 

Use this function in the Point menu to delete extra intermediate points from a line or 
a curve. The amount of points that are deleted is determined by the amount of curve 
and by Reduce Factor. The higher this factor, the greater the number of points that 
are deleted. 

To remove unnecessary intermediate points from a line: 

1. From the Point menu, select Reduce Points. 
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2. In the Value Input box, use the following options: 

• Reduce Factor – type a value from 0 to 5. 
• N Attributes/ Turn Points – allows points with N attributes, for example Turn 

Points, to be deleted. 
• S Attributes/ Curve Points – allows points with S attributes, for example Curve 

Points, to be deleted. 
3. Check Remove Notch Turn/Curve Points to remove any Turn or Curve 

points from the notch location. Frequently, MicroMark data has multiple points 
at a single notch location. 

4. Select the line(s) or piece(s) on which to reduce the number of intermediate 
points.  

5. End selection to continue. 
Hints: 

• If a piece is created using the Sketch function in Silhouette, excess points may be 
created. Use this function to reduce the number of points. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Total Piece Points 

AccuMark = New 

MicroMark = Point/ Total Pc Points 

 

Use this function in the Point menu to display the total number of points contained 
within a piece. The maximum numbers of points allowable for the AccuMark is 
approximately 4000 and for the MicroMark is 256. 

The count is displayed as a fraction. The smaller number equals only boundary 
points. The larger number equals the boundary points on the perimeter, plus the drill 
hole lines (counts as 4 points), internal cutout lines, internal lines and stripe/plaid 
lines. For AccuMark data, the count includes the equivalent objects. For MicroMark 
data, notches count as three points. 

To display the total number of points for piece(s): 

1. From the Point menu, select Total Piece Points. 

2. Select the piece(s) for which you want to display the total.  

3. End selection to continue. 

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 
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5. When finished, select another function or right click and click Cancel. 
Hints: 

• You can also access this function from the View/Point menu. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Copy Point Num 

AccuMark = Points/ Verify Points/ Copy Point Number 

MicroMark = Not Applicable 

 

Use this function in the Point menu to copy point numbers from one piece to 
another. You can copy individual numbers or all numbers on the piece. Numbers are 
assigned to points to assist in matching and alterations macro.  

Note: All point numbers for a piece must be unique.  
To copy individual point numbers: 

1. From the Point menu, select Copy Point Num (M) 

The system displays the point numbers on all of the pieces in the work area.  
2. In the Value Input box, select from these options: 

• Individual Points – copies the numbers of individual points on the perimeter 
• All Perimeter Points – copies the numbers of all perimeter points 
• Grade Rule Numbers – when selected, the grade rule numbers for a piece will 

be copied to the point numbers. For example, a graded point with grade rule 143 
will also have a point number of 143.  

Note: Before selecting Grade Rule Numbers, make sure there will not be any 
duplicate point numbers. 

3. Select the point with the point number to be copied on the perimeter of the 
source piece (the piece the point number is copied from).  

4. Select a point on the perimeter of the target piece (the piece the point number 
is copied to). 

The point number is copied. 
5. End selection to continue. 

To copy all point numbers: 

1. From the Point menu, select Copy Point Num. 

The system displays the point numbers on all of the pieces in the work area.  
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2. In the Value Input box, select: 

• All Piece Pts 
3. Select the start point on the perimeter of the source piece (the piece you are 

copying the point numbers from).  

4. Select the start point on the perimeter of the target piece (the piece the point 
numbers are copied to). 

• If the number of endpoints, intermediate points, and grade points on the two 
pieces are equal, the system copies the point numbers from the source piece to 
the target piece.  

• If they are not equal, the system tells which piece to select or deselect points 
from until they are equal. Deselect point(s). 

5. Click OK when prompted that all point numbers are copied. 

6. End selection to continue. 
Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Add Multiple Drills and Points 

Adding Multiple Points 

PDS/Silhouette provides various functions for adding multiple points, such as drills. 
If you have previously worked with AccuMark or MicroMark pattern design systems, 
many of these functions will be familiar. However, you may improve your 
productivity by taking time to become acquainted with some new methods for 
adding points. 

 Related Topic(s)  

Add Multiple - Add Drills 

AccuMark = Points/ Add Drills 

MicroMark = Point/ Distribute Points Space 

 

Use this function in the Point menu to add drills to a piece spaced proportionally. For 
AccuMark data, the drills are labeled D. For MicroMark data, the drills are labeled 
DH. You can use this function to locate buttonholes. 
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To add drill holes to a piece: 

1. From the Point menu, choose Add Multiple and then select Add Drills. 

2. Select the start point. 

• In Cursor mode, click the start point on a line, inside the piece, or outside the 
piece. A square box represents the point. 

• In Value mode, type the values in the Beg, End, X or Y fields. Click OK or press 
Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while adding points. 
3. Select the end point as above. 

4. When a box displays, select which end points will become drills: 

• None – neither start nor end points 
• Both – both start and end points 
• First – start point 
• Last – end point  
5. Type the number of drill holes to add between the start and end points. Click 

OK or press Enter. The drill holes are spaced out evenly between the points. 

6. End selection to continue. 
Hints: 

• If you choose two points diagonally across from each other, the system places the 
drill holes internally along an imaginary diagonal line. 

• If you select a point outside the perimeter of a piece and an end point, either on or 
inside the piece, the system adds the drill holes in a straight line to connect the 
two points. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Add Multiple - Add Drills Dist 

AccuMark = Points/ Add Drills Distance 

MicroMark = Point/ Distribute Points Space 

 

Use this function in the Point menu to add drills to a piece spaced by a 
measurement. For AccuMark data the drills are labeled D. For MicroMark data the 
drills are labeled DH. The start and end points can be anywhere on the piece. 
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To add drill holes a specified distance apart: 

1. From the Point menu, choose Add Multiple and then select Add Drills Dist. 

2. Select the start point. 

• In Cursor mode, click the start point on a line, inside the piece, or outside the 
piece. A square box represents the point. 

• In Value mode, type values in the Beg, End, X, or Y fields. Click OK or press 
Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
3. Select the end point as above. 

4. When a box displays, select which end points will become drills: 

• None – neither start nor end points 
• Both – both start and end points 
• First – start point 
• Last – end point 
5. Type the distance the drills are to be spaced out between the two points. Click 

OK or press Enter. Based on this value, the system determines how many drill 
holes to add. 

6. End selection to continue. 
Hints: 

• If you choose two points diagonally across from each other, the system places the 
drill holes internally along an imaginary diagonal line. 

• If you select a point outside the perimeter of a piece and an end point, either on or 
inside the piece, the system adds the drill holes in a straight line to connect the 
two points. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Add Multiple - Add Points Line 

AccuMark = Points/ Add Points Line 

MicroMark = Point/ Distribute Points Space 

 

Use this function in the Point menu to add points to a line proportionally spaced. 
Point type can be notch, mark or drills. Grade rules are generated for the points on 
AccuMark data if the line is graded. 

To add specific type and number of points to a line: 

1. From the Point menu, choose Add Multiple and then select Add Points Line. 

2. Select the line the points will be added to. Lines selected can be internal 
(except for the grain line) or perimeter lines. Thumbtacks are displayed on the 
ends of the line.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
3. Position the thumbtacks to select the start and end location of the point 

distribution or left click in work area to continue. 

4. When a list of choices displays, select which type of points to add. You can 
add: 

• Notches 
• Mark Points 
• Drill Points 
5. If you selected Notches in the previous step, a box displays. Select the notch 

type: 

• For AccuMark data: 1, 2, 3, 4, 5 
• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 
6. When a box displays, select which end points will become notch, mark, or drill 

points: 

• None – neither start nor end points 
• Both – both start and end points 
• First – start point 
• Last – end point  
7. Type the number of points to distribute. Click OK or press Enter. The new 

points are created. 

8. End selection to continue. 
Hints: 
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• Use Value mode to enter distances. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Add Multiple - Add Points Ln Dist 

AccuMark = Points/ Add Points Line Distance 

MicroMark = Point/ Distribute Points Line Distance 

 

Use this function in the Point menu to add points to a line spaced a specific distance 
apart. Point type can be notch, mark, or drills. Grade rules are generated for the 
points on AccuMark data if the line is graded. 

To add certain type and number of points to a line a specific distance apart: 

1. From the Point menu, choose Add Multiple and then select Add Points Ln 
Dist. 

2. Select the line the points will be added to. Lines selected can be internal 
(except for the grain line) or perimeter lines. Thumbtacks are displayed on the 
ends of the line. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
3. Position the thumbtacks to select the start and end location of the point 

distribution. or left click in work area to continue. 

4. When a list of choices displays, select which type of points to add. You can 
add: 

• Notches 
• Mark Points 
• Drill Points 
5. If you selected Notches in the previous step, a box displays. Select the notch 

type: 

• For AccuMark data: 1, 2, 3, 4, 5 
• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 
6. When a box displays, select which end points will become notch, mark, or drill 

points: 

• None – neither start nor end points 
• Both – both start and end points 
• First – start point 
• Last – end point  
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7. Type the distance between the points. Click OK or press Enter. The new 
points are created. 

8. End selection to continue. 
Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Modify/Move Points 

Modifying Points 

PDS/Silhouette provides various functions for modifying notch angle, aligning two 
points, or moving points.  

If you have previously worked with AccuMark or MicroMark pattern design systems, 
many of these functions will be familiar. However, you may improve your 
productivity by taking time to become acquainted with some new methods for 
modifying points. 

 Related Topics  

Modify Points - Align 2 Points 

AccuMark = Points/ Modify Points/ Align 2 Points 

MicroMark = New 

 

Use this function in the Point menu to reposition a specific point so it lines up 
horizontally or vertically with another point. You can line up notches, points on an 
line, or drill points inside a piece. If you align a specific region along a line, all 
remaining points on that line are smoothed.  

This function can be used to align drill holes for pocket placement or to line up plaid 
lines when using notches. For example, to line up two drill points vertically; first 
select the point that is to be moved and then select the point you want it to line up 
with. 

To align two points: 

1. From the Point menu, choose Modify Points and then select Align 2 Points or 
press the Alt + F3 keys. 

2. In the Value Input box, select a method of alignment. 

• Horizontal – aligns one point to another horizontally 
• Vertical – aligns one point to another vertically 

 193 



• Between 2 Points – aligns one point between two other points 
• Along Line – moves one point onto an existing line 
3. Select the point to move. This point will be moved to a new location. 

Thumbtacks display on the ends of the line. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
4. Position the thumbtacks to select the region to move. Or, left click in the work 

area to continue. 

5. Select the reference point. This is the point that remains stationary and the 
target point lines up with. The point selected in step 3 lines up with the 
reference point. 

6. End selection to continue. 
Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Moving Points 

Functions in the Point/Modify Points menu allow you to move point(s).  

Type and Location of Points 

Any type of point can be moved. Points to be moved can be located on a line, 
including perimeter/boundary lines, internal lines, and line extensions. An internal 
point can also be moved. 

Direction Limitations 

Direction of movement can be: 

• In both X and Y directions. 
• Restricted to either the X or Y direction. 
• Restricted along a line or line extension. 

Methods for Moving 

Function names reflect two different methods for moving points. 

• Move functions move a single point while adjacent points remain stationary. For 
example, you may use this method to move a notch that is off by 0.25 inches. 

• Move Smooth functions move a point along with adjacent lines or regions. For 
example, you may use this method to lower an armhole while keeping the 
armhole shape the same. 

Example: Move Point vs. Move Smooth 

Move Smooth is similar to Move Point in that both functions are used to move a 
perimeter/boundary point or an internal point in any direction. The difference is, 
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when using Move Smooth, the points and lines adjacent to the point being moved 
are smoothed, or curved, by the system.  

Another difference is that a section of a line can be isolated in order to edit it. For 
example, to change the under arm point, you need to be able to move the whole line 
and retain the shape. Using Move Point, only changes one small area and the 
shape of the piece changes. 

 Related Topics  

 

Modify Points - Move Point 

AccuMark = Points/ Modify Points/ Move Point 

MicroMark = Point/ Move Point Cursor & Menu 

 

Use this function in the Point menu to move one or more points in the X and Y 
direction. 

Move Single Point 

This function provides the AccuMark Classic functionality for moving a single point 
withouth having to end selection. This method is often used to move individual 
points to edit the shape of a curve. 

Move Point vs. Move Smooth 

Move Smooth is similar to Move Point in that both functions are used to move a 
perimeter/boundary point or an internal point in any direction. The difference is, 
when using Move Smooth, the points and lines adjacent to the point being moved 
are smoothed, or curved, by the system. Another difference is that a section of a line 
can be isolated in order to edit it. 

For example, to change the under arm point, you need to be able to move the whole 
line and retain the shape. Using Move Point, only changes one small area and the 
shape of the piece changes. 

To move a point: 

1. From the Point menu, choose Modify Points and then select Move Point or 
press the Alt + F2 keys. 

2. To restrict movement along a line extension, make sure Move Both Joined 
End Points is not checked. 
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3. Select point(s) on the piece to move. They can be points on a 
perimeter/boundary line, end points, a drill hole, or points on an internal line.  

4. End selection to continue. 

5. Specify the new position for the point(s).  

• In Cursor mode, drag the selected point(s) by moving the cursor. Click the left 
button when the point is in position. 

• In Value mode, type the amount to move in the X and Y fields. Value(s) can be 
positive or negative. Click OK or press Enter. 

6. End selection to continue. 
Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Modify Points - Move Pt Line/Slide 

AccuMark = Points/ Modify Points/ Move Point Line 

MicroMark = Point/ Move Point Slide 

 

Use this function in the Point menu to move graded, notch, or intermediate points 
along a line or along an extension of a line. The number of graded, end, and internal 
points stays the same. However, smoothing points are added if necessary.  

Note: When a notch point is to be moved, the system will maintain a point at the 
original location only if moving the notch point will change the shape of a curved 
line.  

To move a point along a line or line extension: 

1. From the Point menu, choose Modify Points and then select Move Pt 
Line/Slide. 

2. Select the point to move. 

3. Move the point to the new position. 

• In Cursor mode, the point travels along the line as the cursor moves. If an end 
point is chosen, both the point and the line segments on either side of it move 
with the cursor. Click the left button when the point is in position. 

• In Value mode, type the amount to move the point in the Beg or End field. You 
can also use the Dist field to enter the distance you want the point to move from 
its original position. Click OK or press Enter.  

• To control the direction of movement when moving a corner point on the 
perimeter of a piece in Value mode, choose Move Along Line, First Line, or 
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Second Line. In clockwise direction, ‘First Line’ moves the point in the positive or 
negative direction. "Second Line’ moves the point in a positive or negative 
direction on the second perimeter line. 

If a notch point was moved on a curved line, an additional point is now located at 
the previous notch location to maintain the shape of the curve. 
4. End selection to continue. 

Hints: 

• If moving a notch point and it passes over an intermediate point, the intermediate 
point does not move. 

• If the point being moved is a graded notch, the grading moves with it. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

• The Options menu displays at the location of the cursor when the right mouse 
button is pressed. When the function is completed, the Options menu displays 
again if an option other than 'Normal' is selected. Change or reset to 'Normal'.on,  
in the X and Y fields. Click OK or press Enter to complete the change. 

Modify Points - Move Point Horiz 

AccuMark = Points/ Modify Points/ Move Point Horizontal 

MicroMark = New 

 

Use this function in the Point menu to move a point or group of points horizontally 
along the X-axis. You can use this function to drop an armhole along the side seam. 

To move a point horizontally: 

1. From the Point menu, choose Modify Points and then select Move Point Horiz. 

2. To restrict movement along a line extension, make sure Move Both Joined 
End Points is not checked. 

3. Select the point(s) to move.  

4. End selection to continue. 

5. Move the point(s) to the new location.  

• In Cursor mode, move the cursor to position the point(s). Both the point and the 
line segments on either side of it move horizontally along with the cursor. Click 
the left button when the point is in position. 

• In Value mode, type the amount to move in the X field. Value(s) can be positive 
or negative. Click OK or press Enter. 
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The system moves the point to the location you specified and adjusts the line 
segments adjacent to that point. 
6. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Modify Points - Move Point Vert 

AccuMark = Points/ Modify Points/ Move Point Vertical 

MicroMark = New 

 

Use this function in the Point menu to move a point or group of points vertically on 
the Y-axis. 

To move a point vertically: 

1. From the Point menu, choose Modify Points and then select Move Point Vert. 

2. To restrict movement along a line extension, make sure Move Both Joined 
End Points is not checked. 

3. Select the point(s) to move. 

4. End selection to continue. 

5. Move the point(s) to the new location.  

• In Cursor mode, move the cursor to position the point(s). Both the point and the 
line segments on either side of it move vertically along with the cursor. Click the 
left button when the point is in position. 

• In Value mode, type the amount to move in the Y field. Value(s) can be positive 
or negative. Click OK or press Enter. 

The system moves the point to the location you specified and adjusts the line 
segments adjacent to that point. 
6. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Modify Points - Move Smooth 

AccuMark = Points/ Modify Points/ Move Smooth 

MicroMark = Line/ Move/ Move Range 

 

Use this function in the Point menu to move a point in any direction. The entire line 
or range on the line is modified.  

Move Point vs. Move Smooth 

Move Smooth similar to Move Point in that both functions are used to move a 
perimeter/boundary point or an internal point in any direction. The difference is, 
when using Move Smooth, the points and lines adjacent to the point being moved 
are smoothed, or curved, by the system. Another difference is that a section of a line 
can be isolated in order to edit it. 

For example, to change the under arm point, you need to be able to move the whole 
line and retain the shape. Using Move Point only changes one small area and the 
shape of the piece changes. 

To move a range of points and change a curve: 

1. From the Point menu, choose Modify Points and then select Move Smooth or 
press the Alt + F11 keys. 

2. Select a point to move. Thumbtacks display at the ends of the line(s) where 
the point is located. You can select multiple points by using a marquee, or by 
holding the shift key and clicking the left mouse button to select points. 

3. Position the thumbtacks to select the region to move or, left click in the work 
area to continue. 

4. Move the point to the new location. 

• In Cursor mode, move the cursor to position the point. The point and the line 
segments on either side of it move as you move the cursor. Click the left button 
when the point is in position. 

• In Value mode, first click on the point, then fill in both the X and the Y fields in the 
input box. Value(s) can be positive or negative and determine the exact distance 
the point moves. The Dist. field represents the straight distance from the original 
to the new location. Click OK or press Enter. 

Both the new and old position display until you complete step 4. Then the system 
moves the point and smoothes the line segments adjacent to that point. 
5. End selection to continue. 
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Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Modify Points - Move Smooth Line 

AccuMark = Points/ Modify Points/ Move Smooth Line 

MicroMark = New 

 

Use this function in the Point menu to smoothly move a point, either a 
perimeter/boundary point or an internal point, along a line or along the extension of 
the line. The entire line or range on the line is modified. You can also use this to 
extend a line by moving an end point to a new location. 

To move points along a line or its extension and change a curve: 

1. From the Point menu, choose Modify Points and then select Move Smooth Line. 

2. Select the point to move. Thumbtacks display at the ends of the line(s) where 
the point is located.  You can select multiple points by using a marquee, or by 
holding the shift key and clicking the left mouse button to select points. 

3. Position the thumbtacks to select the region to move or, left click in the work 
area to continue. 

4. Move the point to the new location. 

• In Cursor mode, move the cursor to position the point. The point travels along the 
line it is a part of, or it creates an extension of that line, as the cursor is moved. If 
an endpoint of a line is chosen, both the point and the line segments on either 
side of it move with the cursor. If extending a line, the point does not deviate off 
the extension of the line. Click the left button to finish moving. 

• In Value mode, type the amount to move the point in the Dist, Beg, or End fields. 
Click OK or press Enter. 

The system moves the point to the location along the line and other points on the 
segment or line are smoothed. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Modify Points - Move Smooth Horiz 

AccuMark = Points/ Modify Points/ Smooth Horizontal 

MicroMark = New 

 

Use this function in the Point menu to move a point smoothly in a horizontal 
direction. The entire line or range on the line is modified. You can retain the shape 
of an entire line, or a portion of a line, while adding fullness to an area. 

To move a range of points and change a curve in the horizontal direction: 

1. From the Point menu, choose Modify Points and then select Move Smooth Horiz. 

2. Select a point to move. Thumbtacks display at the ends of the line(s) where 
the point is located.  You can select multiple points by using a marquee, or by 
holding the shift key and clicking the left mouse button to select points. 

3. Position the thumbtacks to select the region to move. Or, left click in the work 
area to continue. 

4. Move the point to the new location. 

• In Cursor mode, move the cursor to position the point. The point and the line 
segments on either side of it move as you move the cursor. Click the left button 
when the point is in position. 

• In Value mode, type the value in the X field. Value(s) can be positive or negative 
and determine the exact distance the point moves. Click OK or press Enter. 

The system moves the point and smoothes the line segments adjacent to that point. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Modify Points - Move Smooth Vert 

AccuMark = Points/ Modify Points/ Move Smooth Vertical 

MicroMark = New 

 

Use this function in the Point menu to move a point smoothly in a vertical direction. 
The entire line or range is modified. You can retain the shape of an entire line, or a 
portion of a line, while adding fullness to an area with this tool. 
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To move a range of points and change a curve in the vertical direction: 

1. From the Point menu, choose Modify Points and then select Move Smooth Vert. 

2. Select the point(s) to move. Thumbtacks display at the ends of the line(s) 
where the point(s) are located.  

3. Position the thumbtacks to select the region to move or, left click in the work 
area to continue. 

4. Move the point to the new location. 

• In Cursor mode, move the cursor to position the point. The point and the line 
segments on either side of it move as you move the cursor. Click the left button 
when the point is in position. 

• In Value mode, type the value in the Y field. Value(s) can be positive or negative 
and determine the exact distance the point moves. Click OK or press Enter. 

The system moves the point and smoothes line segments adjacent to that point. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Armhole/Sleeve Cap 

AccuMark = New 

MicroMark = New 

  

Use this function in the Modify Points menu to modify an armhole and 
simultaneously update the sleevecap. Curves that span across multiple pieces for 
the armhole or the sleevecap can also be modified.  

This function is divided into two sets of prompts. The first set specifies the groups of 
lines to be modified for the armhole and the second set specifies the groups of lines 
to be modified for the sleevecap. 

Before modifying: 

6. Use Define Position and Use Position to place the pieces together. 

Note: The function can be used without the pieces placed next to each other in the 
work area; however, it is easier to see the affect on the curve with the pieces placed 
together.  

To modify an armhole and sleeve cap: 

7. From the Point menu, choose Modify Points, and then select Armhole/Sleeve Cap.  
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8. Choose these options: 

• Create Composite Line – when checked, multiple lines across one or more 
pieces may be modified. If unchecked, the modification is limited to either a 
single line (if an intermediate point is the point to be moved). Or, if an endpoint is 
the point to be moved, the movement is limited to the line on either side of the 
endpoint. 

• Armhole – choose the type of movement desired for the armhole. Choices are:  
Move Horiz (+); Move Horiz (-); Move Vert (+); Move Vert (-); Mv Smooth (+); Mv 
Smooth (-). 

• Sleeve – choose the type of movement desired for the sleeve. Choices are the 
same as above. 

• % of Distance – specify the percentage of the total amount that armhole, then 
the sleeve should be moved. 

• Move Along Line – Use these options when the Mv Smooth (+) or Mv Smooth (-
) movement is selected for armhole or sleeve. Point(s) can be moved along the 
1st or 2nd line clockwise around the piece. 

9. Select in clockwise order the lines that include the first group of point(s) to be 
modified for the armhole. End Selection to continue. 

10. Select the first group of points or point to be moved, end selection to continue. 

11. Position the thumbtacks at the desired locations to specify the range to be 
modified, left click to continue. 

  
12. Continue steps 1 through 4 for any additional groups to be modified for the 

armhole. 

13. End selection to continue. 
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14. Repeat steps 1 through 5 to identify the points to modify on the sleevecap. 
Also, specify a ‘% of Distance’ value for the amount of the armhole movement 
that should be applied to the sleevecap. 

15. End selection to continue. 

16. Enter the amount to move by doing one of the following: 

• In Cursor mode, move geometry to desired position. Left click to place. 
• In Value mode, type a value in the appropriate field. The armhole and sleevecap 

will be moved the specified percentage of this value. 
Hints: 

• To easily move a thumbtack to an existing point, such as a notch, turn snap to 
geometry on when placing the thumbtack. 

• Clockwise movement is based on the perimeter edge of the complete piece, not 
just the curve to be reshaped. 

•  

Reshape Curve 

AccuMark = New 

MicroMark = New 

  

Use this function in the Modify Points menu to change the shape of a curve which 
spans across multiple pieces. For example: to change the shape of the armhole of a 
jacket that has four panels. 

Before modifying: 

1. Use Define Position and Use Position to place the pieces together. 

Note: The function can be used without the pieces placed next to each other in the 
work area; however, it is easier to see the affect on the curve with the pieces placed 
together.  

To reshape a curve: 

1. From the Point menu, select Modify Points and then choose Reshape Curve. 

2. Select the lines that make up the curve to be reshaped in clockwise order. End 
Selection to continue. 

3. Select point(s) to move. End Selection to continue.  

The system displays a thumbtack at both ends of the composite line and displays 
all of the lines highlighted. 
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4. Reposition the thumbtacks to establish a blending point, and left click to 
continue. 

 
5. Indicate where the line should be positioned. Do one of the following: 

• In Cursor mode, move the cursor and the line moves with it. Click to place the 
line. 

• In Value mode, type a value in the Dist. Field or type the line movement into the 
X and Y fields. Click OK to enter.  

The system moves the line to the location specified and adjusts the geometry 
attached to the line. 

The endpoints along the composite line that are moved (end of princess and side 
seams) are moved and blended to the next intermediate point on the princess and 
side seams. 

Hints: 

• To easily move a thumbtack to an existing point, such as a notch, turn snap to 
geometry on when placing the thumbtack.  

• Clockwise movement is based on the perimeter edge of the complete piece, not 
just the curve to be reshaped. 
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Work with Lines 
Overview of Line Menu 

Use functions in this menu to create, modify, add, delete, or move perimeter and 
internal lines on a piece. When using the PDS/Silhouette main menu to access 
functions, click on Create Line, Perp Line, Conics, and Modify Line to display 
additional functions. Or, create a custom tool bar that contains the functions you use 
most frequently. 

If you have previously worked with AccuMark or MicroMark pattern design systems, 
many of these functions will be familiar and can be accessed using the traditional 
AccuMark menu or MicroMark menu. However, you may improve your productivity 
by taking time to become acquainted with some new methods for working with lines. 

What do you want to do? 

 Create lines. 

 Move and rotate lines. 

 Modify lines. 

 Delete lines. 

 Replace lines. 

 Swap lines. 

 Create lines tangent to a curve. 

 Create internal lines perpendicular to existing lines. 

 Hide internal or perimeter lines without deleting them. 

 Create curved lines including circles and ovals (ellipses). 

 Use line extensions. 

 Remove line extensions. 

 Hide/ignore lines. 
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 Edit line information. 

 

Delete Line 

AccuMark = Lines/ Delete Lines 

MicroMark = Line/ Delete 

 

Use this function in the Line menu to permanently delete style lines. If an existing 
perimeter (boundary) line is chosen, the system automatically creates a straight line 
between the original end points to replace it (similar to Flatten Line). 

To delete lines: 

1. From the Line menu, select Delete Line or press the Ctrl + F1 keys. 

2. Select the line(s) to delete.  

3. End selection to continue. 
Hints: 

• You cannot delete all of the lines that make up a piece simultaneously. To delete 
an entire piece, use the Delete Piece tool in the Piece menu. 

• Use this function to delete internal drill points.  

• If a line is deleted by mistake, use the Undo tool. 

• Delete line on a perimeter line deletes all intermediate (digitized) points on that 
line. 

• If there are several grading lines and you delete the primary grading line, select a 
new primary grading line. When the piece is stored, the system pivots the piece 
so the new GO line is horizontal. You can also do this before you store the piece 
by using the Realign Grain tool in the Piece menu. 

• G0 (AccuMark) and the Grade Reference Line (MicroMark) can only be deleted 
when another alternate grain line exists.  

• When grade reference lines are deleted, the system changes the grade rules of 
the points that reference the alternate. As a result, the points grade off of the 
primary grain line the same way they did off the alternate grain line. 
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Replace Line 

AccuMark = Lines/ Replace 

MicroMark = New 

 

Use this function in the Line menu to change one or more perimeter/boundary lines 
with an internal line (or a group of internal lines). The internal line, as is or extended, 
must intersect the perimeter/boundary at both ends. 

To replace a perimeter line with an internal line: 

1. From the Line menu, select Replace Line or press the Alt+ R keys. 

2. Select the internal line(s) to be replaced with a perimeter/boundary line(s).  

3. End selection to continue. 

The system highlights all of the possible intersection locations.  
4. Select the starting point for the perimeter/boundary replacement. Make sure 

you work in a clockwise order. Highlight the point you want and left click to 
select. 

5. Choose the endpoint in the same way as you selected the start point.  

The system replaces the perimeter/boundary line with the selected internal line. 
6. End selection to continue. 

Hints: 

• Always select the start point and the end point on the perimeter/boundary in a 
clockwise order. Otherwise, you may accidentally replace more of the 
perimeter/boundary than intended. 

Swap Line 

AccuMark = Lines/ Swap 

MicroMark = Line/ Swap 

 

Use this function in the Line menu to exchange an internal line(s) for 
perimeter/boundary line(s). This function works the same as the Replace function, 
except the system changes the original perimeter/boundary lines into internal lines.  
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For example, if you wanted to make the facing for the inside of a shirt’s front, you 
could use Offset Even to duplicate the perimeter/boundary lines and place them 
inside the original. Instead of re-tracing the piece, you can swap the new lines for 
the original lines.  

To swap internal lines for perimeter/boundary lines: 

1. From the Line menu, select Swap or press the Alt+ S keys. 

2. Select the Delete Original Line option if you do not want to save the original 
line. 

3. Select the internal line(s) to replace the perimeter/boundary line(s).  

4. End selection to continue. 

5. After you choose an internal line, click on the perimeter line(s) to be replaced.  

6. End selection to continue. The internal line(s) is swapped with the perimeter 
line(s). The perimeter line becomes an internal, and the internal line becomes 
a part of the piece perimeter. 

7. End selection to continue. 
Hints: 

• For AccuMark data, the internal label is left blank;  
for MicroMark data, the internal label is a Style Line. 

Create Lines 

Overview of Create Line Menu 

The Create Line menu provides various functions for creating straight, curved, 
offset, copied, mirrored, and tangent lines. All lines created are considered internal 
lines until you perform a Swap, Replace, or Trace function. 

Hints: 

• For AccuMark data, all lines created are labeled "I." To change a label, use Edit 
Line Info. 

• For MicroMark data, the default line label is Style line. However, special line 
labels are maintained or copied for lines created using Create Trace, Offset Even, 
Offset Uneven, Copy line, Mirror Line, and Create Blend. 

What do you want to do? 

 Create tangent lines. 

 Create perpendicular lines. 

 Create circles and ovals (ellipses). 
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Create Line - Digitized 

AccuMark = Lines/ Create Lines/ Digitize Line 

MicroMark = Line/ Construct/ Digitize Line 

 

Use this function in the Line menu to create straight or curved internal lines. This 
function is similar to manually digitizing a piece; you specify points to create lines. 
New lines are always associated with a piece that is already in the work area. The 
new line is an internal with default labels/types. 

To create lines: 

1. From the Line menu, choose Create Line and then select Digitize Line or 
press the Ctrl+ F7 keys. 

2. In the User Input box, you can select this option: 

• Add grade rules on intersection – Applies a proportional grade rule where the 
digitized line intersects a graded perimeter line. Using this option has the same 
effect as adding a grade rule at the intersection of the two lines and then copying 
the grade rule from the perimeter onto the internal line. 

3. Select a piece in the work area and a location of the piece.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
4. Choose an input mode and proceed as follows: 

• In Cursor mode, click in the work area or inside a piece to select the beginning 
point. As you move the cursor, a line is drawn. 

• In Value mode, fields of the Value Input box show the difference in the X and Y 
directions between the beginning point and current location of the cursor. The 
Dist field is the length of the current line segment. 

a. To place a point on a perimeter (boundary) line, enter the distance from 
the point to the beginning or end of the line in the Beg or End field. Click 
OK or press Enter. 

b. To place a point at an exact location from another point, type values in 
the X and Y fields. The length of the line segment is in the Dist field. 
Click OK or press Enter. 

c. To place a point at an exact angle in relation to a line segment, type a 
value in the Angle field. You cannot specify an angle until the second 
point for the new line is defined. Click OK or press Enter. 
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5. The mode chosen for a line segment remains the same until you change it 
again. Continue to place points or select the right mouse button to choose an 
option.  

You have the choice of creating a line consisting of straight segments (N attributes - 
AccuMark; Turn points - MicroMark), curved segments (S attributes - AccuMark; 
Curve points - MicroMark), or a combination of the two. 
6. To delete points, click left on them in the reverse order you created them.  

7. End selection to continue. 
Sample: 

  

Digitizing a new line that ends 8 cm from the center front neck 
Hints: 

• You can now digitize a line between two pieces using Value mode on both pieces. 

• To determine the status of the last line segment created, look at the symbol of the 
last point. If the symbol is a square, the segment is straight. If the symbol is a 
circle, the segment is smooth. 

• To digitize tighter curves, position the points closer together. 

• By selecting one point and then ending the line, you can create a drill hole 
(labeled as a ‘D’ on AccuMark data, and ‘DH’ on MicroMark data). 

• Internal lines added to AccuMark pieces are labeled ‘I’. 

• Internal lines added to MicroMark pieces are labeled as Style Lines. 

• MicroMark lines should not exceed 255 points. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

 211 



Create Line - 2 Point 

AccuMark = New 

MicroMark = Line/ Construct/ 2 Point Line 

 

Use this function in the Line menu to automatically complete digitizing an internal 
line after the second point. This function is similar to manually digitizing a piece in 
that you specify points to create lines. New lines are always associated with a piece 
that is already in the work area but can be created between multiple pieces. The 
new line is an internal with default labels/types. 

To create lines: 

1. From the Line menu, choose Create Line and then select 2 Point. 

2. Select a piece in the work area and a location of the piece. As you move the 
cursor around, a line displays on-screen. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
3. Choose an input mode and proceed as follows: 

• In Cursor mode, click in the work area or inside a piece to select the beginning 
point. As you move the cursor, a line displays on-screen. 

• In Value mode, fields of the Value Input box show the difference in the X and Y 
directions between the beginning point and current location of the cursor. The 
Dist field is the length of the current line segment. 

-   To place a point on a perimeter/boundary line, enter the distance from the 
point to the beginning or end of the line in the Beg or End field. Click OK or 
press Enter. 

-   To place a point at an exact location, type values in the X and Y fields. The 
length of the line segment is in the Dist field. Click OK or press Enter. 

4. Place the second point or select the right mouse button to chose from the 
menu of items. The second point can also be created in Cursor or Value 
mode. 

5. Continue to place points or select the right mouse button to choose an option. 
You have the choice of creating a line consisting of straight segments (N 
attributes - AccuMark; Turn points - MicroMark), curved segments (S attributes 
- AccuMark; Curve points - MicroMark), or a combination of the two. 

6. End selection to continue. 
Hints: 

• You can now digitize a line between two pieces using Value mode on both pieces. 
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• Internal lines added to AccuMark pieces are labeled "I". 

• Internal lines added to MicroMark pieces are labeled as Style Lines. 

 

Create Line - Offset Even 

AccuMark = Lines/ Create Lines/ Copy Offset 

MicroMark = Line/ Offset Even 

 

Use this function in the Line menu to create and move one or more offset copies of 
a perimeter/boundary or internal line to a new location without affecting the piece. 
As you move the line, the system keeps it parallel to its original position. Because 
you can offset the lines a specific distance from the perimeter, this function is used 
to make facings.  

To create an offset line: 

1. From the Line menu, choose Create Line and then select Offset Even or press the 
Ctrl+ F4 keys. 

2. In the User Input box, select from these options: 

• Add/Replace – Specifies if the new line should be exchanged for the original 
line.  

• Extend to adjacent lines – Lengthens or shortens the offset to intersect with the 
adjacent lines. 

• Select Reference Location – Selects a location to pick up the line to move. 
• Number of offsets – Creates more than one offset at a time; works in both 

Cursor and Value mode. 
3. Select the line(s) you want to copy.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
4. End selection to continue. 

5. If Select Reference Location option is checked, select a point to guide the 
movement. 

6. Do one of the following to move line(s) to the new location: 

• In Cursor mode, when you move the cursor, the copied line moves with it. When 
the line is where you want it, left click to place the line.  

• In Value mode, use the Value Input box and type the distance you want to move 
the copied line in the Dist field. Click OK or press Enter. 
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7. If a number of offsets was selected in step 2, continue to place lines. 

8. End selection to continue. 
Hints: 

• For MicroMark data, special line labels are maintained or copied. 

Create Line - Offset Uneven 

AccuMark = Lines/ Create Lines/ Copy Uneven 

MicroMark = Line/ Offset Uneven 

 

Use this function in the Line menu to make an internal line which is a copy of a line 
offset from the original in different amounts at specific points. For example, you can 
use this to copy and modify a curved line 

To create an uneven offset line: 

1. From the Line menu, choose Create Line and then select Offset Uneven or press 
the Ctrl+ F6 keys. 

2. In the User Input box, select from these options: 

• Add/Replace – Specifies if the new line should be exchanged for the original 
line.  

• Extend to adjacent lines – Lengthens or shortens the offset to intersect with the 
adjacent lines. 

3. Select the point on the line that is to be the first point of the new offset line. For 
instance, an endpoint on a curved line.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
4. Type the amount of offset to apply. A positive value moves the line away from 

the piece and a negative value offsets the line toward the inside of the piece. 

5. Continue selecting points to offset. Each offset can be of different amounts.  

6. End selection to continue. 
Hints: 

• For MicroMark data, special line labels are maintained or copied. 
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Create Line - Copy Line 

AccuMark = Lines/ Create Lines/ Copy Line 

MicroMark = Line/ Copy Lines 

 

Use this function in the Line menu to duplicate line(s) and then move the copy to a 
new location in the same or different piece(s). Unlike Copy Offset, Copy Line allows 
you to move the copy in any direction and the original length and shape of the line 
are retained. For example, use to make a copy of an arm hole or a neck shape on 
one piece, and then transfer the copy to another piece. 

  Related Topics  
To copy line(s): 

1. From the Line menu, choose Create Line and then select Copy Line or press 
the Ctrl+ F5 keys. 

2. In the User Input box, select from these options: 

• Number of Copies – Creates more than one copy at a time. 
• Select Reference Location – Selects a location to pick up the line to move. 
3. Select the line(s) to copy. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
4. If Select Reference Location option is checked, select a point to guide the 

movement. 

5. End selection to continue. 

6. Select the destination piece(s) you want to add the line to. Choose either the 
original piece or a new piece(s). 

7. End selection to continue. 

8. Move the line(s) to the new location. 

• In Cursor mode, drag the line to its new location and click left to place. Right click 
and then click OK to place the line at its original location. 

• In Value mode, type the distance to move the line in the X, Y fields. Click OK or 
press Enter. 

The line is moved to its new position and is now considered part of the piece you 
moved it to.  
9. End selection to continue. 
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Sample: 

  

Copy Lines with Number of Copies set at 2. 
Hints: 

• For MicroMark data, special line labels are maintained or copied. 

• Use to tile graphics, as shown above, when using the ‘Number of Copies’ option. 
Groups of lines can be selected using Ctrl, Shift, or the marquee box. 

• Before using Copy Line, position multiple pieces together. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Create Line - Mirror 

AccuMark = Lines/ Create Line/ Mirror 

MicroMark = Line/ Mirror Lines 

 

Use this function in the Line menu to create mirror image(s) from selected 
perimeter/boundary or internal line(s). The new line will have the same points as the 
original.  

To create mirrored images for lines: 

1. From the Line menu, choose Create Line and then select Mirror. 

2. Select the line(s) you want to mirror.  

3. End selection to continue. 

4. Click on the line the selected lines are to mirror about. The system creates a 
mirror image of the lines.  

Hints: 

• For AccuMark data, all grade rules and point attributes/types are carried over to 
mirrored lines, except stack (Z) and rotation (R) attributes. 

 216 



• For lines mirrored on AccuMark data, when you mirror an internal line, a new 
internal line is created with the same label (except in the case of grain lines). 
Internal lines are created for mirrored perimeter lines.  

• For MicroMark data, special line labels are maintained or copied. 

• MicroMark users can now mirror more than one line at a time. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Create Line - Create Blend 

AccuMark = Line/ Create Line/ Create Blend 

MicroMark = New 

 

Use this function in the Line menu to create a new internal line and then pivot it on 
one end. The end you pivot the line on is where it is blended into the other line.  

To create an internal blended from another line: 

1. From the Line menu, choose Create Line and then select Copy Blend. 

2. Select the "blend point" which is a point close, but not on, the endpoint you 
want to pivot the line on. A copy of the perimeter line from the blend point to 
the end of the line appears on the screen.  

3. Move line to the new location. 

• In Cursor mode, drag the line to its new location. Click to set. 
• In Value mode, type the amount of distance to move the line in the Dist field. 

Click OK or press Enter. 

The system displays the new internal blend line. For MicroMark data, special line 
labels are maintained or copied. 
4. End selection to continue. 
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Internal Line Labels 

AccuMark data uses line labels to define internal lines for a piece. Default, or fixed, 
line labels are indicated below. Optional labels can be changed to an available line 
number. 

 Indicates 

A A two-point annotation line. Determines the 
width and spacing of characters. (Fixed.) 

B A three-point annotation line. Determines the 
width, height, and spacing for annotation 
characters. (Fixed.) 

C  An opstop (optional stop point) stops the cutter 
to permit repositioning the cutting head for 
matching. 

D A drill hole. (Optional, but recommended.) 

G A grain line. Assigned automatically when you 
digitize a grain line. (Fixed.) 

H An internal cutout. (Fixed; must be digitized as 
a closed internal.) 

I A user defined internal. (Optional; but 
recommended.) 

M A mirror line. Assigned automatically when 
mirroring a piece during digitizing. (Fixed.) 

P Fixed piecing. (Fixed; must be digitized as a 
two point internal.) 

S A seam. (Fixed.) 

T A grid line. Used for large pieces. (Fixed.) 

 

To display internal line labels for pieces in the work area, use the Line/ Types/Labels 
function in the View menu.  

To edit line types, use the Edit Line Info function. 
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Tangent Lines 

Creating Tangent Lines 

The Line menu provides several functions for creating lines that are tangent to 
points on a curve. If you have previously worked with AccuMark, these functions will 
be familiar. However, you may improve your productivity by taking time to become 
acquainted with some new methods for creating tangent lines. 

 Related Topic(s)  

Create Line - Tangent On Line 

AccuMark = New 

MicroMark = New 

 

Use this function in the Line menu to create an internal line tangent to a selected 
point on a curve. 

To create a tangent line: 

1. From the Line menu, choose Create Line and then select Tangent On Line. 

2. Select the point of tangency along an existing line. 

• In Cursor mode, position the cursor over the existing line, press and hold the left 
button. Release the left mouse button at the correct location. 

• In Value mode, type the exact location on the perimeter line where the lines are 
to intersect in either the Beg or End field. Click OK or press Enter. 

3. Specify the length of the tangent line.  

• In Cursor mode, drag the cursor to specify the length of the line. Left click to 
place the line. 

• In Value mode, specify the length of the line in the Dist field. Click OK or press 
Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
4. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Create Line - Tangent Off Line 

AccuMark = New 

MicroMark = New 

 

Use this function in the Line menu to create an internal line tangent to a selected 
point on a curve and ending at another selected point. 

To create a tangent line ending at a specified point: 

1. From the Line menu, choose Create Line and then select Tangent Off Line. 

2. Select the intersection point. 

• In Cursor mode, position the cursor over the existing line, press and hold the left 
button. Release the left mouse button at the correct location. 

• In Value mode, type the exact location on the perimeter/boundary line where the 
lines are to intersect in either the Beg or End field. Click OK or press Enter. 

3. Select the point of tangency along an existing line. Follow procedure above for 
using Cursor or Value mode. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line.  
4. End selection to continue. 

Sample: 

 Tangent Off Line 
Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Create Line - Tangent 2 Circ 

AccuMark = New 

MicroMark = New 

 

Use this function in the Line menu to create a line tangent to two circles at selected 
locations. 

To create a line tangent to two circles: 

1. From the Line menu, choose Create Line and then select Tangent 2 Circ. 

2. Select the first intersection point.  

3. Select the second intersection point. 

The system creates a straight line connecting the two locations. 
4. End selection to continue. 

 

Clipped/Unclipped Lines 

Unclipped Perimeter 

AccuMark = New 

MicroMark = Point/ Move End Points/ Change Move Flag =No 

 

Use this function in the Line menu for MicroMark grading options, such as Line and 
Perpendicular grading. For example, use this function to indicate which lines should 
be allowed to have the line extend beyond the normal perimeter/boundary 
intersection. This function may also be used with AccuMark data. 

 
Warning: This function is supported for AccuMark version 8.0.x (V8) only. 

This function allows pieces to have: 

• Perimeter/boundary geometry that exists beyond the intersections. 
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• End of line points may be unique in location, grade rules and attributes/modifiers. 
The intersection of the two extended lines for each graded size is sent to 
marking. 

Note: In MicroMark data, the ends of two adjacent boundary lines do not have to be 
common. Since they do not need to exist at the same location and can have 
different grade rules and point types, they can be extended. 

In previous releases of AccuMark PDS/Silhouette, perimeter lines could not be 
extended because in AccuMark data, two adjacent perimeter lines shared a 
common end point. This end point always had just one set of attributes (point types) 
and grade rules. 

To allow lines to be extended: 

1. From the Line menu, select Unclipped Perimeter.  

The system displays the current state for the perimeter/boundary lines of the pieces 
in the work area. 
2. Select the line(s) to be unclipped. The system redisplays the current state for 

the perimeter/boundary lines of the pieces in the work area. 

3. End selection to continue.The lines may now be extended by making geometry 
changes. 

Samples: 

  
This image shows two pieces with unclipped lines and line extensions. The images on the 
right side show the piece when using the display option Unclipped in 
Preferences/Options. The left side shows the pieces using the Clipped display option. 
The geometry shown in Clipped display mode is the same as what will appear in Marker 
Making.  
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Hints: 

• When making edits to the piece shape, such as extending the unclipped lines, 
uncheck the Move Both Joined End Points option to move end points 
independently. 

• Use Preferences/Options to set Perimeter to Unclipped to view the line 
extensions.  

• When the lines of a piece are set to Unclipped, functions such as Create Trace 
create the new piece with extended lines. 

• When editing geometry point information use options such as Apply to Both End 
Points or Individual to control whether edits apply to individual or both end points. 

  Related Topics  

 

Clipped Perimeter 

AccuMark = New 

MicroMark = Point/ Move End Points/ Change Move Flag =Yes 

 

Use this function in the Line menu to remove an existing line extension from a piece. 
The end of the perimeter/boundary line is moved to the perimeter/boundary 
intersection. 

To clip extended lines: 

1. From the Line menu, select Clipped Perimeter.  

The system displays the current state for the perimeter/boundary lines of the pieces 
in the work area. 
2. Select the line(s) to be trimmed.  

3. End selection to continue.  

The system redisplays the current state for the perimeter/boundary lines of the 
pieces in the work area. 
4. End selection to continue. 
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Hints: 

• Line extensions are useful for MicroMark grading options, such as Line and 
Perpendicular grading. 

• Use Preferences/Options to set Perimeter to Unclipped to view the line 
extensions. 

• When the lines of a piece are set to Clipped, functions such as Create Trace find 
the normal perimeter/boundary intersections when the new piece is created. 

  Related Topics  

Perimeter Clipped/Unclipped Sample 

Seam with 
Preferences/Perimeter=Clippe
d  

Seam with 
Preferences/Perimeter=Unclip
ped  
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Perpendicular Lines 

Creating Perpendicular Lines 

The Line menu provides several functions for creating lines that are perpendicular to 
piece geometry. If you have previously worked with AccuMark or MicroMark, these 
functions will be familiar. However, you may improve your productivity by taking time 
to get acquainted with some new methods for creating perpendicular lines. 

 

Perp Line - Perp On Line 

AccuMark = Lines/ Create Perpendicular/ Point on Line 

MicroMark = Line/ Construct/ Perpendicular on Line 

 

Use this function in the Line menu to make a line that is perpendicular to an existing 
internal or perimeter line at a particular point. You can Use this function in the Line 
menu in the Line menu to create a pleat or crease line on a pant leg.  

To create a perpendicular line: 

1. From the Line menu, choose Perp Line and then select Perp On Line. 

2. In the User Input box, select from these options: 

• Half/Whole – Controls whether the new line will extend to one side or both sides 
of the intersection point. 

3. Select the intersection point. This is the point where the new line intersects 
with the existing line.  

• In Cursor mode, press and hold the left button with the cursor on a line. As you 
move the cursor, locations highlight on the line. Release the left button at the 
desired location. 

• In Value mode, type the exact location on the perimeter line where the lines are 
to intersect in either the Beg or End field. Click OK or press Enter. 

4. Select the end point of the new line to specify length. 

• In Cursor mode, drag the cursor to the location. As you move the cursor, the line 
displays on the screen. When the line is in the correct position, click the mouse 
button to set. 

• In Value mode, type the length of the line in the Dist field in the status area.  
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To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Perp Line - Perp Off Line 

AccuMark = Lines/ Create Perpendicular/ Point Off Line 

MicroMark = Line/ Construct/ Perpendicular Off Line 

 

Use this function in the Line menu to create a line that is perpendicular to a 
perimeter line and intersects at a selected point.  

To create a perpendicular line that intersects a specific point: 

1. From the Line menu, choose Perp Line and then select Perp Off Line. 

2. In the User Input box, select from these options: 

• Half/Whole – Controls whether the new line will extend to one side or both sides 
of the intersection point. 

3. Select the location where the perpendicular line will intersect with the 
perimeter line.  

• In Cursor mode, press and hold the left button with the cursor on a line. As you 
move the cursor, locations highlight on the line. Release the left button at the 
desired location. A small cross hair represents the point of intersection. 

• In Value mode, type the exact location on the perimeter line where the lines are 
to intersect in either the Beg or End field. Click OK or press Enter. 

4. Select an internal or perimeter line that the perpendicular line is to intersect. A 
perpendicular line is drawn from the intersection point to the target line at the 
point specified. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Perp Line - Perp 2 Points 

AccuMark = Lines/ Create Perpendicular/ 2 Points 

MicroMark = New 

 

Use this function in the Line menu to create a perpendicular line halfway between 
two points on an existing line.  

To create a perpendicular line halfway between two points: 

1. From the Line menu, choose Perp Line and then select Perp 2 Points. 

2. In the User Input box, select from these options: 

• Half/Whole – Controls whether the new line will extend to one side or both sides 
of the intersection point. 

3. Select two locations on the same line that the new perpendicular line is to be 
centered between.  

• In Cursor mode, press and hold the left mouse button with the cursor on a line. 
As you move the cursor, locations highlight on the line. Release the left button at 
the desired location. 

• In Value mode, type the exact location where the first point is to be positioned in 
either the Beg or End field. Click OK or press Enter. Repeat this same process 
to enter the location of the second point.  

4. Select the endpoint of the new line to specify length. 

• In Cursor mode, as you move the cursor, a line is drawn midway between the 
two points. The Dist field reflects the length of the line. Click left to place the end 
of the line. 

• In Value mode, type the line length in the Dist field. Click OK or press Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Conics 

Creating Circles and Ovals 

The Line menu provides several functions for creating circles and ovals (ellipses). If 
you have previously worked with AccuMark or MicroMark, these functions will be 
familiar. However, you may improve your productivity by taking time to become 
acquainted with some new methods for creating circles and ovals. 
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 Related Topic(s)  

Conics - Circle Ctr Rad 

AccuMark = Lines/ Conic/ Circle Center Radius 

MicroMark = Line/ Construct/ Circle Center & Radius 

 

Use this function in the Line menu to create a circle by defining the center point of 
the circle and its radius or circumference. The circle can be created as an internal 
line or as a piece. 

To create a circle: 

1. From the Line menu, choose Conics and then select Circle Ctr Rad. 

2. In the User Input box, select from these options: 

• Create Circle as a New Piece – Creates circle as an internal or piece 
• Add new piece to model/style – Appends the new piece to the current style or 

model. If selected, enter a Piece Name. 
• Show Center – specifies what kind of center point should be created: None, 

Drill, or Mark. 
• Circle Dimension – Specifies measurement by radius or circumference. 
3. Select the center of the circle. 

• In Cursor mode and center is to be located on a line, press and hold the left 
button with the cursor on a line. As you move the cursor, locations highlight on 
the line. Release the left button at the desired location. 

• In Value mode, type a value in the Beg or End field. Click OK or press Enter. 
4. Specify size of circle. 

• In Cursor mode, as you move the cursor, the circle is drawn on -screen. Click left 
when the radius or circumference is the size you want. The length of the radius 
or circumference displays in the Dist field in the status area. 

• In Value mode, type the length of the radius or circumference in the Dist field. 
Click OK or press Enter. 

The system creates a new internal circle.  

If Drill is selected in the Show Center section of the user input box, it also places a 
drill hole (labeled ‘D’ for AccuMark data or a Draft Point Line for MicroMark data) at 
the center point of the circle.  

If Mark is selected in the Show Center section of the user input box, it also places a 
Mark (labeled ‘E’ for AccuMark data or a Free X Point for MicroMark data) at the 
center point of the circle.  

 228 



To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Conics - Circle Ctr Cirm 

AccuMark = New 

MicroMark = Line/ Construct/ Circle Center & Circumference 

 

Use this function in the Line menu to create a circle by defining the center point of 
the circle and its radius or circumference. The circle can be created as an internal 
line or as a piece. 

To create a circle: 

1. From the Line menu, choose Conics and then select Circle Ctr Cirm. 

2. In the User Input box, select from these options: 

• Create Circle as a New Piece – Creates circle as an internal or piece 
• Add new piece to model/style – Appends the new piece to the current style or 

model. If selected, enter a Piece Name. 
• Show Center – specifies what kind of center point should be created: None, 

Drill, or Mark. 
• Circle Dimension – Specifies measurement by radius or circumference. 
3. Select the center of the circle. 

• In Cursor mode, press and hold the left button with the cursor on a line. As you 
move the cursor, locations highlight on the line. Release the left button at the 
desired location.   

• In Value mode, type the value in the Beg or End field.  
4. Draw the circle.  

• In Cursor mode, as you move the cursor, the circle is drawn on the screen. Click 
left when the radius is the size you want. The length of the radius displays in the 
Dist field. 

• In Value mode, type the length of the radius in the Dist field. Click OK or press 
Enter. 

The system creates a new internal circle.  
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If Drill is selected in the Show Center section of the user input box, it also places a 
drill hole (labeled ‘D’ for AccuMark data or a Draft Point Line for MicroMark data) at 
the center point of the circle.  

If Mark is selected in the Show Center section of the user input box, it also places a 
Mark (labeled ‘E’ for AccuMark data or a Free X Point for MicroMark data) at the 
center point of the circle.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while creating the line. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Conics - Circle 2 Pt Center 

AccuMark = Lines/ Conic/ Circle 2 Point Center 

MicroMark = New 

 

Use this function in the Line menu to create a circle by indicating two points on the 
circumference and an approximate center. 

To create a circle from two circumference points with approximate center point: 

1. From the Line menu, choose Conics and then select Circle 2 Pt Center. 

2. Select the first of two points on an existing circle. 

3. Select the second point as follows: 

• In Cursor mode, click to select a location. A circle is created. Drag the cursor to 
position the center and click left to place it. 

• In Value mode, enter a value in the Dist field. Enter a second value in the Dist 
field for the center location. Click OK or press Enter. 

4. End selection to continue. 

 

 

 

 

 230 



Conics - Circle 3 Pt 

AccuMark = Lines/ Conic/ Circle 3 Point 

MicroMark = New 

 

Use this function in the Line menu to create a circle that intersects with three 
selected locations. 

To create an internal circle from three points: 

1. From the Line menu, choose Conics and then select Circle 3 Pt. 

2. Select three points where you want the circumference of the new circle to be. 
You can insert the points either inside a piece or anywhere on the work area. 

A small cross hair represents each point. The system creates a circle based on 
these points. It also places a drill hole (labeled ‘D’ for AccuMark data or a Draft 
Point Line for MicroMark data) at the center point of the circle.  
3. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Conics - Circle Tang 1 Line 

AccuMark = Lines/ Conic/ Circle Tangent 1 Line 

MicroMark = New 

 

Use this function in the Line menu to create a circle that touches a perimeter or 
internal line at one point on a piece. 

To create a circle tangent to a line: 

1. From the Line menu, choose Conics and then select Circ Tang 1 Line. 

2. Select a point on a line where the circle is to touch.  

• In Cursor mode, press and hold down the left mouse button on the line where 
you want the tangent point to be.  

• In Value mode, specify the location for the tangent point in the Beg or End field. 
Click OK or press Enter. 
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A circle displays on the screen with the tangent point in its circumference.  
3. Determine the radius by doing one of the following: 

• In Cursor mode, drag the cursor until the radius of the circle is the length you 
want. 

• In Value mode, determine the center point of the circle by typing the exact 
location in the Dist field. Click OK or press Enter. 

The system creates a new internal circle, tangent to the line at the point specified. It 
also places a drill hole (labeled ‘D’ for AccuMark data or a Draft Point Line for 
MicroMark data) at the center point of the circle.  
4. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Conics - Circle Tang 2 Line 

AccuMark = Lines/ Conic/ Circle Tangent 2 Line 

MicroMark = Line/ Construct/ Circle Tangent 2 Lines 

 

Use this function in the Line menu to create a circle that is tangent to two points on 
two different adjacent lines (these lines form a corner).  

To create a circle tangent to two lines: 

1. From the Line menu, choose Conics and then select Circ Tang 2 Line. 

2. Select the two lines where the circle is to touch. A circle, with points tangent to 
the two lines, displays on the screen.  

3. Specify the radius of the circle.  

• In Cursor mode, as you move the cursor the circle moves with it. Click left when 
the radius of the circle is the size you want. 

• In Value mode, type the exact value for the radius in the Dist field. Click OK or 
press Enter. 

The system creates a new internal circle, tangent to the lines at the points 
specified. It also places a drill hole (labeled ‘D’ for AccuMark data or a Draft Point 
Line for MicroMark data) at the center point of the circle.  
4. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Conics - Curved Intersection 

AccuMark = Conic/ Replace 2 Line Circle 

MicroMark = Line/ Curved Intersection 

 

Use this function in the Line menu to replace a perimeter (boundary) corner (two 
adjacent lines) with a curve (a section of a circle created). 

To replace a corner with a curve: 

1. From the Line menu, choose Conics and then select Curved Intersection. 

2. Select one of these line types: 

• Perimeter – Applies a curved intersection to 2 perimeter lines. 
• Internal – Applies a curved intersection to 2 internal lines. 
3. Select one of these options: 

• Add/Change Radius – Adds a new curved intersection or modifies the radius of 
an existing curved intersection. When a new curved intersection is added with 
this option, the original geometry is maintained so that the corner may be 
modified or removed in the future. The geometry is considered system-
generated, so the intersection cannot be edited with other functions until it is 
severed.  

Note: To modify the curved intersection, the intersection must be applied using 
the Add/Change Radius option. 

• Add Severed – Adds a curved intersection as a separate line that is severed. 
The system does not maintain the original corner shape. This line becomes the 
new permanent geometry and is similar to how Classic AccuMark works. A 
severed curved intersection may be edited like any other line. 

• Delete – Deletes an existing curved intersection and returns to the original corner 
geometry.  

Note: The Delete option only works on a curved intersection that was created 
using the Add/Change Radius option. 

• Sever – Severs an existing curved intersection. This removes the relationship to 
the original corner geometry. The curved intersection is no longer system-
generated and may be modified like any other line. 

4. Specify the radius of the circle. 

• In Cursor mode, as you move the cursor the circle moves with it. Click left when 
the radius of the circle is the size you want. 
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• In Value mode, type the exact value for the radius in the Dist field. Click OK or 
press Enter. 

The system creates a new internal circle using the radius you specified, replacing 
the corner.  
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Conics - Oval Orient 

AccuMark = Lines/ Conic/ Ellipse Orient 

MicroMark = Line/ Construct/ Oval Line 

 

Use this function in the Line menu to create an oval (ellipse) by specifying the center 
of the oval, the length and orientation (angle) of the minor axis, and the length of the 
major axis. 

To create an ellipse: 

1. From the Line menu, choose Conics and then select Oval Orient. 

2. Select the center of the oval.  

3. Create the minor axis of the oval.  

• In Cursor mode, as you move the cursor away from the center point of the oval, a 
line representing the minor axis is drawn. You can pivot this axis to any angle. 
When the minor axis is the length and angle you want, click to place. In the 
status area, the Dist field displays the length of the minor axis and the Angle field 
displays the angle. 

• In Value mode, type the length of the minor axis in the Dist field and the angle in 
the Angle field. Click OK or press Enter. 

4. Once the length and angle of the minor axis are determined, specify the length 
of the major axis. 

• In Cursor mode, as you move the cursor perpendicular to the minor axis, the 
major axis of the oval is adjusted. Watch the Dist field to keep track of the length. 
Click left when the major axis is the length you want.  

• In Value mode, type the length of the major axis in the Dist field. Click OK or 
press Enter. 
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An internal oval is created based on the center point, minor axis, and major axis. 
The oval is part of the piece that was selected when you positioned the center 
point. If you move the piece, the oval moves with it. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Conics - Oval Focus 

AccuMark = Lines/ Conic/ Ellipse Focus 

MicroMark = New 

 

Use this function in the Line menu to create an internal oval (ellipse) by specifying 
the center of the oval, the focus point of the oval, and the length of the major axis. 

To create an ellipse: 

1. From the Line menu, choose Conics and then select Oval Focus. 

2. Select the center of the oval.  

Note: You can reposition the center of the oval inside a piece. 
3. Select the focus point for the oval. The focus point should face in the direction 

that you want the major axis to go.  

• In Cursor mode, as you move the cursor, the Dist field in the status area shows 
the current distance between the center point and the focus point. 

• In Value mode, type a value in the Dist field. Click OK or press Enter. 
4. An oval appears in the work area. Determine the length of the major axis as 

follows:  

• In Cursor mode, as you move the cursor away from the center point, the oval 
moves with it. Watch the Dist field to keep track of the length. Click left when the 
major axis is the length you want. 

• In Value mode, type a value in the Dist field. Click OK or press Enter. 

An internal oval is created. The oval is part of the piece that was selected when you 
positioned the center point.  
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Modify Lines 

Overview of Modify Line Menu 

PDS/Silhouette provides various functions for modifying lines. If you have previously 
worked with AccuMark or MicroMark pattern design systems, many of these 
functions will be familiar. However, you may improve your productivity by taking time 
to become acquainted with some new methods for modifying lines. 

What do you want to do? 

 Move or rotate lines. 

 Edit line information. 

Modify Line - Rotate Line 

AccuMark = Lines/ Modify Lines/ Pivot Line 

MicroMark = Line/ Move/ Rotate Cursor, Angle & Distance 

 

Use this function in the Line menu to rotate a perimeter/boundary or internal line(s) 
by an angle or by a distance. The pivot point remains constant. Use this function 
when you are creating a bias grain/grade reference line. 

  Related Topics  
To rotate a line: 

1. From the Line menu, choose Modify Line and then select Rotate Line. 

2. Select an option to specify a reference point or direction. 

• Select Reference Location – rotates a line about a selected point for a specific 
distance. 

• Bump to Line – rotates a line until it touches another line at a certain point. 
3. Select the line(s) to rotate.  

4. End selection to continue. 

5. Select the pivot point. 

6. If Select Reference Location is checked, select the point to guide the 
movement. 

Or if Bump to Line is checked, select the line that the rotated line will bump into. 
7. Rotate the line(s) to its new location. 
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• In Cursor mode, move the cursor and the line moves with it. Click to place the 
line. 

• In Value mode, type a positive (moves away from piece) or negative (moves 
toward piece) value in either the Dist field or the Ang field. Click OK or press 
Enter. 

The system moves the line to the location specified and adjusts the geometry 
attached to the line. 
8. If desired, repeat steps 3 through 7 to continue to rotate the line(s). 

9. End selection to continue. 

Modify Line - Move and Rotate 

AccuMark = Lines/ Modify Lines/ Move and Pivot 

MicroMark = New 

 

Use this function in the Line menu to move and rotate a perimeter/boundary or 
internal line(s) by cursor, by a specific angle, or by a distance. 

  Related Topics  
To rotate a line: 

1. From the Line menu, choose Modify Line and then select Move and Rotate. 

2. Select an option to specify a reference point or direction. 

• Select Reference Location – Specifies the location to pick up the line to move 
and allows you to rotate a specific distance from this point. 

• Move Perim Lines Opposite – Specifies that perimeter/boundary lines attached 
to the rotated line move opposite, one in a positive and the other in a negative 
direction, or vice versa. 

3. Select the line(s) to rotate.  

4. End selection to continue. 

5. Select the point on the same line to rotate about. If Move Perim Lines 
Opposite is checked, use options to help select this point. 

6. If Select Reference Location is checked, select the point to guide the 
movement. 

7. Rotate the line(s) to the new location. 

• In Cursor mode, move the cursor and the line moves with it. Click to place the 
line. 
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• In Value mode, type a positive (moves away from piece) or negative (moves 
toward piece) value in either the Dist field or the Ang field. Click OK or press 
Enter. 

The system moves the line as specified and adjusts the geometry attached to the 
line. 
8. End selection to continue. 

Hints: 

• To rotate a line by distance, make sure the ‘Select Reference Location’ option is 
selected. 

Modify Line - Set and Rotate 

AccuMark = Lines/ Modify Lines/ Set n Pivot Line 

MicroMark = New 

 

Use this function in the Line menu to move an internal line in order to match it to a 
point on another line. This line can be on the same or a different piece. For 
example, use when you want two lines to intersect at a certain point or angle. The 
line is pivoted around this point. 

 
To set a line and pivot an internal line at a new point: 

1. From the Line menu, choose Modify Line and then select Set and Rotate. 

2. Select a point on the internal. This is the point where the internal line and 
target line will intersect.  

3. Select the match point on the target line. The target line remains stationary.  

4. The system sets the internal line so that it intersects the target line at the 
match point. 

5. Rotate the set line to its new location.  

• In Cursor mode, the set line pivots around the match point in the direction as you 
move the cursor. The system continues to display the original location of the line. 
Move the cursor until the line is pivoted where you want it and then click to set 
the line. 

• In Value mode, type a value in the Ang field. Click OK or press Enter.  

The system displays the line at its new angle and adjusts the geometry attached to 
the line. 
6. End selection to continue. 
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Modify Line - Adjust Length 

AccuMark = Lines/ Modify Lines/ Adjust Length 

MicroMark = Line/ Change Line Length 

 

Use this function in the Line menu to keep end points stationary and move 
intermediate points. 

Currently, works like Move Smooth Line. 

 

Modify Line - Smooth 

AccuMark = Lines/ Smooth 

MicroMark = Line/ Smooth Line 

 

Use this function in the Line menu to smooth an existing perimeter/boundary or 
internal line. This allows the system to reposition points along a line (except end 
points). When using this function, points, such as notches and marks, are 
repositioned along a line. 

To smooth the points along a line: 

1. From the Line menu, select Smooth. 

2. In the User Input box, you can select this option: 

• Smooth Factor – applies smoothing similar to MicroMark by converting 
smoothing points to intermediate points. 

3. Select the line to smooth. Thumbtacks are displayed at the ends of the line.  

4. Position the thumbtacks to specify the range to be affected. Left click in the 
work area to continue. 

The system repositions points and eliminates discrepancies on the curved line. A 
curved line can be smoothed several times, but it will flatten out more with each use 
and its shape will change. 
5. End selection to continue. 

Hints: 
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• This function can be used to eliminate digitizing discrepancies or smooth rough 
edges on a piece. 

• You can smooth a line with notches but you have to define a range at each notch 
location to provide control. Use Modify Points - Move Pt Line/Slide to reposition 
the notches after smoothing the line. 

• Depending on whether you are using an AccuMark or MicroMark system, you 
may prefer to work with the Modify Points – Move Smooth function instead of the 
Modify Line – Smooth function. Or, use the Smooth Factor in the User Input box. 

• It is helpful to use View /Point functions to verify that you have enough 
intermediate points prior to smoothing, in order to control the shape of the line. 

Smooth Factor – How it Works 

After the system has smoothed the curve, the system looks at the system smoothing 
points. These are the points that the system ‘floats’ in between the digitized or 
intermediate points to help maintain the curve shape. If smoothing and intermediate 
points are turned on, you will see system-smoothing points displayed as circles. The 
example below shows an enlarged view of a curve with one system-smoothing point 
and two intermediate points. 

 

The system calculates the distance from the smoothing point to a straight line drawn 
between the two adjacent points. The arrow in the diagram above indicates this 
distance.  The system then compares the distance value to the value in the smooth 
factor field. If the distance is greater than the smooth factor, the smoothing point is 
turned into an intermediate point. If the distance is smaller, the point remains as a 
system smoothing point.   

For example, the distance on the smoothing point shown above is .007 in. / .018 cm. 
If the smooth factor is set at .005 in. / .013 cm, the point would become an 
intermediate point when smooth line is used. 
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Modify Line - Combine/Merge 

AccuMark = Lines/ Modify Lines/ Merge-Combine 

MicroMark = Lines/ Combine Lines 

 

Use this function in the Line menu to connect two or more lines. You can merge 
either perimeter/boundary lines or internal lines. This function should be used to 
delete endpoints on a piece. 

To merge two lines together: 

1. From the Line menu, choose Modify Line and then select Combine/Merge or 
press the Ctrl + F9 keys. 

2. To add a notch at the point where the lines are merged, select Add notch at 
merge point and select the Notch type: 

• For AccuMark data: 1, 2, 3, 4, 5 
• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 
3. Other options that can be selected: 

• N Attribute – Check to add an N Attribute point to the notch point. With this box 
checked, the point will enter as an intermediate point.  

• Turn Point – For MicroMark data, check to add a base point with a Turn label; 
uncheck to add a base point with a Curve label. 

• Apply to Both EndPts – When applying a notch to the end of a line, select this 
option to apply the notch to both endpoints. 
Caution AccuMark Users: The recommended setting for this option is ON. If 
notches do not exist at both endpoints, they may not plot. 

4. Select the lines that are to be merged together. Lines must be selected in a 
counterclockwise direction. 

• To merge two or more perimeter/boundary lines, select the lines to connect. 
These lines must be adjacent to each other. 

If perimeter/boundary lines were selected, the endpoints are made into intermediate 
points. If the perimeter/boundary lines are separated by a graded endpoint, the 
system replaces it with a grade point. 

• To merge two or more internal lines, click on each line close to one endpoint to 
identify that end as the beginning point for the line. The lines do not have to be 
adjacent to each other; the system will create a connecting line between them. 

5. End selection to continue. 

If internal lines were selected, the system creates a new line by connecting the 
endpoint of the first internal line to the beginning point of the second internal line. 
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The system repeats this process until all of the internal lines are connected in the 
order chosen. 

For pieces with only three lines, a Merge Line warning will appear. 
6. End selection to continue. 

MicroMark = Line/ Split Line 

Modify Line - Split 

AccuMark = Lines/ Modify Lines/ Split 

 

Use this function in the Line menu to divide a single line into two or more lines. Use 
this function to separate lines connected with the Merge Line function. 

To split a line into two lines segments: 

 

1. From the Line menu, choose Modify Line and then select Split or press the 
Ctrl + F10 keys. 

2. Select a point on a line where you want it to be split. You do not have to split 
the line at an existing point. 

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location. 

• In Value mode, type the location for the split in the Beg or End field in the status 
area. Click OK or press Enter.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 

The system splits the line into two and adds an end point or a graded end point to 
each line. 
3. End selection to continue. 
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Modify Line - Clip 

AccuMark = Lines/ Modify Lines/ Clip 

MicroMark = New 

 

Use this function in the Line menu to trim an internal line that extends beyond the 
perimeter/boundary of the piece. The clip occurs at the intersection of the internal 
line and the perimeter/boundary line.  

To clip an internal line segment: 

1. From the Line menu, choose Modify Line and then select Clip or press the 
Ctrl + F8 keys. 

2. Select the internal line you want clipped.  

3. Click the part of the line you want to keep. 

If the internal line intersects with more than one perimeter/boundary line, select 
where on the perimeter/boundary you want to clip the line. 

If the line only intersects the perimeter/boundary at one point, the segment of line 
that extends beyond it is removed. 
4. End selection to continue. 

Modify Line - Open Line 

AccuMark = New 

MicroMark = Line/ Open Line 

 

Use this function in the Line menu to designate an internal on a mirrored piece as 
unrelated to the opposite side of the piece. Use this function to add drill holes on 
one side of a mirrored piece. 

To add an open line: 

1. From the Line menu, choose Modify Line and then select Open Line. 

2. Select the internal line that you do not want to be mirrored. 

3. End selection to continue. 
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Modify Line - Flatten Line Segment 

AccuMark = New 

MicroMark = Line/ Flatten Line 

 

Use this function in the Line menu to delete all of the intermediate points on a line 
with an option to keep notches and dart points.  

To flatten a line: 

1. From the Line menu, choose Modify Line and then select Flatten Line 
Segment or press the Ctrl + F12 keys. 

2. In the User Input box, select from these options: 

• Delete Notches – allows notch points to be removed. 
• Omit Dart Points – prevents dart points from being removed. 
3. Select the line to flatten. Thumbtacks are displayed at the ends of the selected 

line. 

4. Reposition the thumbtacks to specify the region to be affected. Left click in the 
work area to continue. The system changes the line. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
5. End selection to continue. 

Modify Line - Edit Line Names 

AccuMark = Lines/ Modify Lines/ Edit Line Names 

MicroMark = Not Applicable 

 

Use this function in the Line menu to assign names to lines. These names can 
consist of letters, numbers, or labels. Line names are used in procedures to 
recognize certain lines in a piece.  

To assign names to lines: 

1. From the Line menu, choose Modify Line and then select Edit Line Names. 

The system displays the existing names of all of the lines in the work area.  
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2. Select the line you want to edit or a line that you want to assign a name to.  

3. Enter a new name: 

• If the selected line did not already have a name assigned to it, type in the new 
name. Click OK or press Enter. Line names can consist of up to ten letters, 
numbers, or a combination of both.  

• If you selected a named line, the name displays in the User Input box. Make edits 
and then click OK or press Enter. 

4. End selection to continue. 

Modify Line - Copy Line Names 

AccuMark = Lines/ Modify Lines/ Copy Line Names 

MicroMark = Not Applicable 

 

Use this function in the Line menu to copy the names of lines from one piece to 
another. Internal line names can only be copied individually. Perimeter/boundary 
line names can also be copied individually or you can select all the names in an 
entire piece at once.  

To copy lines names: 

1. From the Line menu, choose Modify Line and then select Copy Line Names.  

The system displays the existing names of all of the lines in the work area.  
2. Select a starting point on the perimeter/boundary of the piece to have all the 

line names from one piece copied to another. 

3. If copying individual names, select the source line. The name of this line is 
copied to the other line. 

4. Click on the target line. This is the line assigned the same name as the source 
line. 

5. If copying all the names on one piece to another, click the start line on the 
target block that is to receive the same names. One of the following occurs: 

• If there are an equal number of perimeter/boundary lines on the two pieces, the 
system copies the names of the lines on the source piece to the target piece. 

• If there are not an equal number of perimeter/boundary lines on the two pieces, 
deselect lines on the target piece until the amount of perimeter/boundary lines 
equals those on the source piece. When the number of lines is equal, the system 
copies the names of the lines on the source piece to the target piece. 

6. End selection to continue. 
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Move Lines 

Moving Lines 

PDS/Silhouette provides various functions for moving lines. You can move or rotate 
perimeter/boundary, internal, grain/grade reference, annotation, and style lines. 

If you have previously worked with AccuMark or MicroMark pattern design systems, 
many of these functions will be familiar. However, you may improve your 
productivity by taking time to become acquainted with some new methods for 
moving lines. 

 Related Topic(s)  

Modify Line - Move Offset 

AccuMark = Lines/ Modify Lines/ Move Offset 

MicroMark = New 

 

Use this function in the Line menu to move a perimeter/boundary or internal line. 
The line you move remains parallel to its original position as you move it. When a 
perimeter/boundary line is moved, adjacent lines extend to meet the new position. 
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To offset a line: Sample: 

  
Offsetting a line in Value mode 

Hints: 
 

 

7. From the Line menu, choose 
Modify Line and then select 
Move Offset. 

8. In the User Input box, select 
from these options: 

• Select Reference Location – 
moves the line offset from a 
reference point.  

• Move Multi line in Reverse – 
moves two lines in the same 
direction, resulting in opposing 
changes (for example, in the area 
of two different pieces). 

9. Select the line(s) to move.  

10. End selection to continue. 

11. If the Select Reference Location 
option was selected in step 2, 
select a point to guide 
movement. 

12. Move the line to its new 
location.  

• In Cursor mode, move the cursor 
and the line moves with it. Click to 
place the line. 

• In Value mode, type a value in the 
Dist field. 
Click OK or press Enter.  
The system moves the line to the 
location specified and adjusts the 
geometry attached to the line. 

13. End selection to continue. 

• Use Move Line Anchor or Parallel 
Fullness to maintain the length of 
the line being moved. 

• When offsetting lines in Value 
mode, the direction arrows tell you 
which direction is positive and 
which is negative. 

•  
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Modify Line - Move Line 

AccuMark = Lines/ Modify Lines/ Move Line 

MicroMark = Line/ Move/ Line Cursor & Menu 

 

Use this function in the Line menu to move a line in any direction in order to make 
simple alterations to a piece. Movement can be guided by a reference point. This is 
useful when moving grain/grade reference lines or annotation lines. 

To move a line: 

1. From the Line menu, choose Modify Line and then select Move Line or press 
the Ctrl +F2 keys. 

2. In the User Input box, select an option: 

• Select Reference Location – moves the line offset from a reference point. 
• Move Multi Line in Reverse – moves two lines in the same direction, resulting in 

opposing changes (for example, in the area of two different pieces). 
3. Select the line(s) to move. 

4. End selection to continue. 

5. If the Select Reference Location option was selected in step 2, select a point 
to guide movement. 

6. Move the line(s) to new location(s). 

• In Cursor mode, move the cursor and the line(s) move with it. Click to place. 
• In Value mode, type a value in the Dist field. Or, type the line movement into the 

X and Y fields. Click OK or press Enter.  

The system moves the line to the location specified and adjusts the geometry 
attached to the line. 
7. End selection to continue. 

 

 

 

 

 

 248 



Modify Line - Move Line Anchor 

AccuMark = New 

MicroMark = Line/ Move Line/ Anchor 

 

Use this function in the Line menu to move a line, maintaining the original length 
with the ability to select locations on the adjacent lines to blend to. 

To move a line with an anchor point: Sample: 

The system moves the line to the 
location specified and adjusts the 
geometry attached to the line. 

  
Moving a line with Move Line Anchor 

Hints: 
 

 

1. From the Line menu, choose Modify 
Line and then select Move Line 
Anchor or press the Ctrl +F3 keys. 

2. In the User Input box, select an 
option: 

• Select Reference Location – 
moves the line offset from a 
reference point. 

• Bump to Line – rotates a line until 
it touches another line at a certain 
point. 

3. Select the line to move.  

4. End selection to continue. 

5. Move the line to its new 
location.  

• In Cursor mode, move the cursor 
and the line moves with it. Click to 
place the line. 

• In Value mode, type a value in the 
Dist field. Click OK or press Enter. 

6. End selection to continue. 

• Use Move Line Anchor or Parallel 
Fullness to maintain the length of 
the line being moved. 
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• Click on the thumbtack in the 
upper-right corner of the Tracking 
box to have the Tracking box 
remain on the screen while using 
other functions. 

• When offsetting lines in Value 
mode, the direction arrows tell you 
which direction is positive and 
which is negative. 

 

Modify Line - Move Range 

AccuMark = Points/Modify Points/Move Smooth, Move Smooth Line 

MicroMark = Line/ Move/ Move Range - Cursor, Value  

 

Use this function in the Line menu to move a perimeter/boundary point or an internal 
point on the line it is on in any direction. This function is similar to the Move Smooth 
function in the Point menu. Which function you choose to use may depend on 
whether you are using an AccuMark or MicroMark marking/grading system. 

Also, the Move Range function is similar to the AccuMark function Move Smooth 
Line. When using Move Range: 

• Points and lines adjacent to the point being moved are smoothed, or curved, by 
the system. 

• A section of a line can be isolated in order to edit it. 
To move a point and retain its curvature: Sample: 

1. From the Line menu, choose Modify 
Line and then select Move Range. 

2. Select the point to edit with 
Tracking on.  

• If an intermediate (digitized) point 
is selected, thumbtacks are 
displayed at the ends of the line.  

• If a corner is selected, thumbtacks 
are displayed at the ends of the 
adjacent lines. 

3. Reposition the thumbtacks to 
specify the range to be affected. 
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Left click in the work area to 
continue. 

4. Move the point to its new 
location. 

• In Cursor mode, move the cursor 
and the line moves with it. Click to 
place the line. 

• In Value mode, type a value in the 
X or Y fields. Click OK or press 
Enter. The Dist field represents 
the straight distance from the 
original to the new location. 

The system moves the point and 
smooths the line segments adjacent 
to that point. 

  

he existing line in the piece to be used as 

 

5. End selection to continue. 

 

Modify Line - Make Move Parallel 

AccuMark = New 

MicroMark = Line/ Move/ Make Move Parallel 

 

Use to make selected line(s) parallel to another line or the X or Y axis, and also 
move the line. 

To make a line parallel to another: 

1. From the Line menu, choose Modify Line and then select Make Move Parallel 
or press the Ctrl +F11 keys. 

2. Select an option to specify a reference point or direction. 

• Move Perimeter Lines Opposite – Moves two lines in opposite directions. 
• Select Reference Location – Specifies the location to pick up the line to move. 
• Parallel to – Specifies whether the selected line should be parallel to a line, X-

axis, or Y-axis. 
3. Select the line(s).  

4. End selection to continue. 

5. If Parallel to Line is checked, select t
a guide. 
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6. Select the end of the line that should remain stationary.  

7. Move line(s) to new location. 

• In Cursor mode, move the cursor and the line moves with it. Click to place the 
line. 

• In Value mode, type a positive (moves away from piece) or negative (moves 
toward piece) value in the Dist field. Or, type the line movement into the X and Y 
fields; typing data in either of these fields automatically adjusts the value in the 
Dist field. Click OK or press Enter.  

The system moves the line to the location specified and adjusts the geometry 
attached to the line. 
8. End selection to continue. 

Modify Line - Make Parallel 

AccuMark = New 

MicroMark = Line/ Move/ Make Parallel 

 

Use this function in the Line menu to make a selected line(s) parallel to another line 
or the X or Y-axis. This is useful when making a grain line parallel to a center front. 
You can use this function to make a center-front or center-back parallel to the grain 
after entering the piece on the Silhouette table. 

To make a line parallel to another: 

1. From the Line menu, choose Modify Line and then select Make Parallel. 

2. Select an option to specify a reference point or direction. 

• Move Perimeter Lines Opposite – Moves two lines in opposite directions. 
• Select Reference Location – Specifies the location to pick up the line to move. 
• Parallel to  – Specifies what the selected line should be parallel to. 
3. Select the line(s) to modify.  

4. End selection to continue. 

5. If Select reference location is checked, select the point to guide the movement. 

6. If Parallel to Line is checked, select the existing line in the piece to be used as 
a guide. 

7. Select the end of the line that should remain stationary.  

8. End selection to continue. 
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Work with Notches 
Overview of Working With Notches 

Notches are marks on pattern pieces that indicate where pieces should line up as 
they are stitched together. In PDS/Silhouette you can create various notch types, 
including angled notches and notches at the intersection of two perimeter/boundary 
lines. However, all notch types display on pieces in the work area as slit notches. 

 

The diagram shows how several AccuMark notch types are cut on fabric.  

Notches are created as objects on a line. Notch locations may be defined so that the 
notch maintains its position along the line as the shape or length of the line is 
modified. Every notch is attached to some other object (points, lines, etc.) to which it 
references. A notch is modified as its reference point is modified. 

In PDS version 8.0 (V 8.0), notches can float along a line, changing position 
between points and lines on graded sizes. The notch can jump over existing points 
to maintain its relative position. With Specify Distance, the shape of the curve will 
not be distorted, and the notches may be located on different lines on different 
graded sizes.  

Terms 

Notch Base Point – Every notch exists or is attached to a base point. Notch base 
points are also called base reference points. When a base point is modified the 
notch is also modified. Functions that alter the shape of a piece may be used on the 
notch base point and the notch will automatically follow. 

Note: Base points are not applicable with intersection notches, including those on 
mirror lines. 

Notch Reference Point – Every notch is attached to some other object that is its 
reference. The Notch Reference point may be an actual point, or in the case of 
intersection notches, a line. The reference point can be located at a zero distance 
from the notch; in that case the reference point becomes a base reference point. A 
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notch can also be located at a specified distance or percentage away from the 
reference point. When a reference point is modified the notch is also modified. 

Standard Notch –The reference/base point is at the same location as the notch. A 
standard notch is similar to a Classic AccuMark and MicroMark notch. 

Reference Notch - A notch positioned along a line of the base size with a user-
defined distance to a reference location. The distance between the notch and its 
reference is maintained as the piece is modified. 

Tangent Notch – It is a type of a reference notch. A tangent notch is graded along 
a line using a single –tangent- value rather than a delta rule. 

Intersection Notch – Notch placed at the intersection of two lines or where two 
lines would intersect if extended. The intersection notches position updates as the 
internal reference is modified. This is the only type of notch without a base point. 

In AccuMark, a notch point is a single point on the perimeter of a piece. Each notch 
exists at the same location as its base point; in other words, the notch is zero 
distance from its reference point. In AccuMark, the notch number can refer to any 
type of notch. You can define five different types of notches in a Notch Parameter 
table. 

 

AccuMark/MicroMark Notches - Converting Data 

If a piece with a reference notch is saved in AccuMark PDS version 2.0.10 or earlier, 
or any version of AccuMark Classic PDS, the notch is left at its current location as 
an intermediate point, and the reference information is removed. The shape of the 
base size will not change, however the position of the notches on the graded sizes 
may change. When a reference notch is added, the distance between the notch and 
the reference point on the base size is maintained on all sizes. If the data is saved in 
any of the versions mentioned above and the notch is not control by a grade rule, 
the notch position on the graded sizes will float with the curve.  

When opening data created in AccuMark PDS version 2.0.10 or earlier, all notches 
will have reference points that are zero distance from the notch. The reference point 
is placed at the same location as the notch.  

In MicroMark, three points are used to define the notch: one on the boundary (turn 
or curve point), one inside the boundary (tip) indicating notch depth, and a final 
notch point on the boundary (base point, turn or curve). In MicroMark, there are six 
types of notches which are referenced by name. The notch depth is specified for 
every notch and may be unique to each notch. 
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When converting between the AccuMark and MicroMark data types, use the Style 
page in Preferences/Options to map the AccuMark and MicroMark notch types and 
to specify the notch table that should be used.  

View - Notches 

AccuMark = Points/ Verify Points/ Notch Points 

MicroMark = F5/ NC Cut Data 

 

Use this function in the View menu to display the notch type assigned to each point. 
All notch types display on-screen as slit notches located on the perimeter/boundary 
of the piece.  

To view notches on a piece: 

1. From the View menu select Notches. 

2. Select piece(s) or individual notch(es) to display the notch attribute 
numbers/notch types assigned to them. The distance to the reference point 
displays for each notch or group of notches along with a dimensioning line 
drawn between the notch and the reference point. 

3. End selection to continue. Notch attribute numbers display. 

4. To clear information from the screen but continue with the function, select the 
function again or right click and click OK. 

5. When finished, select another function or right click and click Cancel. 
Hint: 

For AccuMark users, when you add a notch to a piece, you can assign it a "notch 
type" that corresponds with a setting defined in the Notch Parameter Table. This table 
defines the types of notches (such as castle, slit, etc.) and their external and internal 
width and depth. 

 

Notch Display 

Notches displayed using the View Notch function display the following information: 
• Notch reference point 
• Notch reference distance with dimensioning lines 
• Notch type 

Note: Group notches only display the notch type for the first notch in the group. 
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 Display of Standard Notch 

  
Reference Notch with Reference 

Displayed 

  
Display of Tangent Notch or Graded 

Regular Notch 

  
Tangent Notch with Reference Displayed 

 

PDS version 8.0.x (V8) displays notches using the actual depth. For AccuMark data, 
the notch depth is displayed using the depth defined in the P-Notch Table in the 
default storage area. The default storage area is defined in 
Preferences/Paths/AccuMark Storage Area.If the depth defined in the P-Notch Table 
is 0.00, the notch does not display but it can be displayed using View/Point/Notch. For 
MicroMark data, the depth defined for each notch is used. 

 

 

Add Notch 

AccuMark = New 

MicroMark = Point/ Add Point 

 

Use this function in the Notch menu to add a notch to a line. You choose the type of 
notch. All notches are added with base points. A notch added using this function, is 
referred to as a Standard Notch. 

To add a notch to a line: 

1. From the Notch menu, select Add Notch. 

2. In the Input box, select the Notch type: 

• For AccuMark data: 1, 2, 3, 4, 5 
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• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 
3. N Attribute/Turn Point – When checked, the notch base point will be 

assigned an N Attribute for AccuMark data, and a Turn Point for MicroMark 
data.  

4. Select a location on a perimeter/boundary line where the notch will be added. 
The notch is added. 

5. End selection to continue. 

 
Hints: 

• Notches float on lines. They may be in different positions relative to intermediate 
points on graded sizes, and they may even be on different lines on different sizes. 

• Notches do not control the shape of lines, therefore in some functions, such as 
Move Points can not be used on notches. Instead, modify or used the function on 
the notch base point and the notch will update accordingly. 

  Related Topics  

 

Edit Notch Info 

Edit Notch Info is used to change the settings for a notch. The Notch Type, Grade 
Rule, Angle, Depth (MicroMark only), and Dist to Ref can all be edited.  

When Dist to Ref is changed, the notch is repositioned on the line. The Notch 
Position on Seam determines the position of the notch on the seam internal. There 
are three options: 

• Perpendicular – this option places the notch in the perpendicular direction 
between the sew and the cut lines. This is equivalent to the Classic 
AccuMark method. 

• Notch Angle – this option places the notch in the direction of the angle of 
the notch between the cut and sew lines. The illustration below shows the 
positioning of the notches. 

  

• Same Dist on Seam – this option is used to control the position of the notch 
on the seam line. When the option is ON, the reference distance is used to 
position the notch on the cut and the sew lines. 
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Groups can also be created in Edit Notch Info. When the Group option is ON, the 
spacing between notches and the number of notches is specified. 

To select the notch to edit: 

6. In the Edit menu, select Edit Notch Info. 

7. Set up to track. 

8. To select the notch to be edited, do one of the following: 

• Drag the cursor along a line to display notches on that line. Release the mouse 
button to select the point you want to edit. 

• Select multiple grade notches in Edit Notch Info by using a marquee box to 
change type, depth, angle, Dist to Ref, Dist Between, and # of Notches. 

• Click the Track button and then click the Track arrow keys or arrow buttons to 
move clockwise or counterclockwise around the piece. 

• The up arrow key on the keyboard goes to the next point and the down arrow key 
goes to the previous point. The left and right arrows on the keyboard are used to 
move back and forth within a text field. 

• If you set up to use Auto Tracking, click the Track button. When the point you 
want to edit is selected, click the Stop button. 

If you set up to show the Point/Line Info box, this box displays information about the 
current notch. 

 

 

Delete Notch 

This function is used to remove a reference notch and the reference information from 
the reference point. When this function is used on one notch in a group of notches all 
of the notches in the group are deleted. 

 
To delete a reference notch: 

1. From the Notch menu, select Delete Notch. 

2. Select the reference notch to delete. You can select one notch, multiple 
notches on the same piece, or multiple notches on different pieces.  

3. End selection to continue. 

 

Angled Notch 

AccuMark = Points/ Modify Points/ Angled Notch 

MicroMark = Point/ Move Point Cursor 
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Use this function in the Notch menu to specify the angle of an existing angled notch or 
create an angled notch. An angled notch is placed in the direction of the angle of the 
notch between the cut and sew lines. The illustration below shows the positioning of 
the notches. 

  

 
To angle an existing notch: 

1. From the Notch menu choose Angled Notch. 

2. Use the Zoom In function to enlarge the area where existing notch(es) are 
located. 

3. Drag the cursor along the perimeter/boundary line to select an existing notch.  

4. Use the cursor to position the notch angle.  

Note: As you move the cursor, the line representing the notch moves with it. 
Visually, this line can appear very long depending on the angle and distance 
you move the cursor. This is not the actual length of the notch, as you will see 
when you set the angle.  

5. When the notch is at the angle that you want, click left again to set.  

6. End selection to continue. 

 
To create an angled notch: 

1. From the Notch menu choose Angled Notch. 

2. Click on a perimeter/boundary line at the location where you want to place a 
notch.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 

3. In the User Input box, option area, select the notch type: 

For AccuMark data: 1, 2, 3, 4, 5.  

For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 

4. N Attribute – For AccuMark data, check to add an N Attribute point to the 
notch point. With this box checked, the point will enter as an intermediate 
point.  
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• Turn Point – For MicroMark and AccuMark data, check to add a base point 
with a Turn label; uncheck to add a base point with a Curve label. The turn 
point controls the attribute/modifier on the notch base point for both types of 
data. 

5. Use the cursor to position the notch.  

Note: As you move the cursor, the line representing the notch moves with it. 
Visually, this line can appear very long depending on the angle and distance 
you move the cursor. This is not the actual length of the notch, as you will see 
when you set the angle.  

6. When the notch is at the angle that you want, click left again to set.  

7. End selection to continueEnding_Selection_to_Continue. 
Hints: 

• You cannot create a notch angled outside of the piece. 

• If the Mirror Piece function is used, the notch at the mirror line appears to angle 
into the piece.  

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

• On MicroMark data, notches are represented by three data points..  

• The notch type determines the depth, perimeter/boundary width, and internal 
width. For AccuMark data, these attributes are defined in the Notch Parameter 
Table. 

 

Intersection Notch 

AccuMark = New 

MicroMark = Point/ Inter Notch 

 

Use this function in the Notch menu to: 

• Add a notch at the intersection of two lines or where two lines would intersect if 
extended. This notch type is commonly used on a mirror line. 

• Edit an existing intersection notch 
• Delete an existing intersection notch 

As shown on picture below if one of the two lines is repositioned, the notch point 
moves in relation to it. 
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Note: Base points are not applicable with intersection notches, including those on 
mirror lines. 

 
To add a notch to an intersection of two lines: 

1. From the Notch menu, select Intersection Notch. 

2. In the Input box, select the Notch type: 

• For AccuMark data: 1, 2, 3, 4, 5 

• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 
3. N Attribute/Turn Point – When checked, the notch base point will be 

assigned an N Attribute for AccuMark data, and a Turn Point for MicroMark 
data.  

4. Select a perimeter/boundary line. 

5. Select notching line(s). This reference line must intersect, or it can be 
extended to intersect, the line selected in the previous step. 

6. End selection to continueEnding_Selection_to_Continue. 

7. Click OK or press Enter. The notch is added. 

8. End selection to continue. 
To edit an intersection notch: 

1. From the Notch menu, select Intersection Notch. 

2. In the Value Input box, select Edit. 

3. Enter a new notch type.  

4. Select lines and pieces with notches to be edited. 

5. Click OK or press Enter. All notches on the selected lines or pieces are edited. 
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6. End selection to continue. 
To delete an intersection notch: 

1. From the Notch menu, select Intersection Notch. 

2. In the Value Input box, select Delete. 

3. Select lines and pieces with notches to be deleted. 

4. End selection to continueEnding_Selection_to_Continue. 
To display intersection notches: 

1. Do one of the following: 

• Use the View/ Point/ Notches. 

• Or after the notches are edited, the system will automatically display the 
new notch types for visual verification. 

Hints: 
• Intersection notches do not have base points. 

 

 

 

 

 

 

Specify Dist/Tangent 

AccuMark = New 

MicroMark = Not applicable 

Tangent grading is used on notches to control notch positioning along curve shapes 
when grading. Tangent grading maintains the smoothness of a curve as a notch is 
graded. Use Specify Distance/Tangent to create a new Tangent graded notch or to edit 
an existing Tangent rule previously created with this function.  

A Tangent grade rule uses only one value, as opposed to two values (X and Y) 
required in delta grading. Plus and minus values determine whether growth is in the 
clockwise or counter-clockwise direction from the sample size (Base up-down grading 
method) or previous size (Small-Large Incremental method). 

For example, if a notch is 10 cm from its reference point on the base size, and an 
amount of 0.00 cm is specified, then the notch will be 10 cm from the reference point 
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on all sizes. If 1 cm is entered, then the notch would be 10 cm from the reference point 
on the base size, 11 cm on the next size up, 12 cm on the next size and so on. 
 

For MicroMark data please see Tangent Grading for MicroMark Data. 
 

To create a Specify Dist/Tangent: 

1. From the Notch menu select Specify Dist/Tangent. 

2. In the Input box, select the Notch type: 

• For AccuMark data: 1, 2, 3, 4, 5 

• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 
3. Select one of the Notch Position on Seam options: 

• Perpendicular – this option places the notch in the perpendicular direction 
between the sew and the cut lines. This is equivalent to the Classic 
AccuMark method. 

•  Notch Angle – this option places the notch in the direction of the angle of 
the notch between the cut and sew lines. The illustration below shows the 
positioning of the notches. 

  

• Same Dist on Seam – this option is used to control the position of the notch 
on the seam line. When the option is ON, the reference distance is used to 
position the notch on the cut and the sew lines. 

4. To create a Group, select the group option under Multiple, then enter the 
following: 

• Dist Between- spacing between the notches. 

• # of Notches- number on notches in the group. 

The group is created on the line to the side opposite the Reference point. 
5. Select a location on a perimeter/boundary line where the new grade point will 

be added.  

• In Cursor mode, position the cursor over the line, press and hold the left 
button. Release the left mouse button at the correct location. End selection 
to continue. 

• In Value mode, type the location for the grade point in the Beg or End field 
in the value input area, click OK or press Enter. 
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6. Select the previous or next adjacent grade point for distance measurement. 
When a point is selected the grading distances form displays. Enter the growth 
amount for every size break according to the grading method used. This grade 
rule is saved with the piece. 

7. End selection to continue. 

 
Hints: 

• When a Specify Dist/Tangent is applied on AccuMark data it is also a reference 
notch. 

• Tangent rules have only one value in the grade rule, making them ideal for 
grading along curves. 

• Use Specify Distance to edit an existent Specify Dist/Tangent. 

Examples of Specify Dist/Tangent 
Base Up-Down Incremental grading method 

The following example shows the values entered and the result using the Base Up-
Down Incremental grading method. The notch grows .25 inch between the smaller 
sizes and the base and .50 inch between the base size and each larger size. 
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Specify Distance is too large 

 

When the growth amount entered in Specify distance will cause the point to go 
beyond the end of the line or to interfere with a corner, the system will display a 
message. The message indicates that the growth amount entered is too large for 
the geometry selected on a specific size.  No grading is applied and the piece is 
returned to the previous state 
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Messages and Corrections for Notch Base Points (MK) 

Due to an error in the MicroMark system, piece geometry may be distorted or some 
notches may not be drawn or cut in markers that are generated by the MicroMark 
marking system. The problem does not occur all of the time or in all sizes. For 
example, some notches in some sizes may be omitted. It is not possible to 
definitively state when this problem will occur, however the problem may be more 
prevalent for data having seam corners, curved intersections, uneven seam, or 
different grade rules for the notch and base point. PDS does not have this same 
difficulty, so the notches and graded sizes are displayed properly by PDS. As a 
result, these problems may not be discovered until the data is processed for 
Marking. 

Note: If a style was digitized or if it was created in a release previous to 8.0, the 
base point may be before or after the notch but must be within .01 in/.025 cm of the 
notch for the system to consider the point as a base point. 

To avoid the omission of notches or distortion of the piece shape on MicroMark 
systems, changes may be made to the style when the data is retrieved or saved by 
PDS. The situations in which distortion may occur or notches may be omitted by the 
MicroMark are described below, along with the modifications that may be made by 
PDS. 

MicroMark may omit a notch or distort the piece shape when the notch point exists 
without a point at the base of the notch. To avoid this problem, PDS will offer to 
automatically add a curve point at the base of the notch.  

• If the notch is graded using a delta or perpendicular rule, the newly added curve 
point at the base of the notch will have the same grade rule as the notch. 

• If the notch point does not have a grade rule, or if it uses a tangent grade rule, 
then the newly added curve point will not have a grade rule associated with it. 

 

• Whenever this case is found in the piece data, the following message displays 
and lists the pieces that contain notches without base points. 
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If Yes is selected, all cases that are found are changed. If No is selected, then no 
changes are made to the data. The default response is Yes. 
 
Caution: If Yes is chosen and base points are added, grading should be verified since adding 
base points may alter grading. 

 

• MicroMark may also omit a notch when the point at the base of the notch does not 
have a grade rule and the notch point uses a delta or perpendicular grade rule. 
When PDS finds graded notch points using delta or perpendicular grade rules and 
the base point does not have a grade rule, the software will offer to automatically 
assign the grade rule used by the notch to the point at the base of the notch. 

• The following message displays to alert the user when this situation is found and 
the names of the pieces that contain notches with non-graded base points are 
listed. 

  

If Yes is selected, all cases that are found are modified by adding the grade rule 
used by the notch to the notch base point. If No is selected, none of the base points 
will be modified.  The default response is Yes. 
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Caution: If Yes is chosen and base points are modified, grading should be verified since 
modifying base points may alter grading. 

The cases listed above are checked when the MicroMark Style is opened in PDS, 
and again as the Style data is saved by PDS in MicroMark data format. When 
opening a style, if the user is prompted to correct the style and answers Yes to have 
PDS make automatic corrections, they will also be prompted to save the changes.  
Selecting Yes for the save prompt will overwrite the existing style. If desired, the 
user may select No when prompted to save so that the automatic changes may be 
viewed in PDS prior to saving. 

• To properly identify the situations described above, PDS must have access to the 
grade rule table used by the style. If the Grade Rule Table is not available when 
the Style is opened and graded notches without base points or with non-graded 
base points are found, PDS displays the following message and lists the pieces 
that may need correction. 

  

The Style should be reopened with the Grade Rule Table so that any needed 
corrections may be made to the data. 

Note: If the style also contains non-graded notches without base points, those 
notches may be corrected since they do not require access to the Grade Rule 
Table. 

 

 

Distance to Notch/Measure Along Piece 

Use this function in the Measure menu or the Grade menu to measure the distance 
along the piece perimeter from a notch to the next notch or to the end of the line.  

To measure distance between notches or to the end of the line: 

1. From the Measure menu select Distance to Notch/Measure Along Piece. 
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2. Select a location along the portion of the line between notches or between a notch 
and the end of a line. 

3. End selection to continue 

Note: This function eliminates the need to use Measure/Perimeter 2 Point or 
Measure/Line and splitting the line at the notches. 

  
Reference Notch - Add 

A Reference Notch is a notch positioned along a line on the base size with a user-
defined distance to a reference location. The distance between the notch and the 
reference location can be defined as a percentage or a constant. As geometry is 
modified, the reference notch position updates, maintaining the distance to the 
reference point. 

When AccuMark data is retrieved, the notches are converted to reference notches 
and the reference point is placed underneath the notch. 

There are several ways the relationship between a reference notch and reference 
point can be broken: 

• If the line is split between the reference notch and the reference point when the 
amount is a percentage.  

• Splitting the piece between the reference notch and the reference point. 
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• Deleting the reference point. 
To add a reference notch: 

1. Select the reference point for maintaining notch distance 

2. In the Input box, select the Notch type: 

• For AccuMark data: 1, 2, 3, 4, 5 

• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 

• Copy Distance – Use this option to add a new notch with the same 
reference distance as another notch. When selected, the system will prompt 
first for the reference point, then for the notch to match. 

Note: The reference distance of a source notch should be different than zero. 
3. The Notch Position on Seam option determines where the notch is 

positioned on the seam internal. Choose one of the following options: 

• Perpendicular – this option places the notch in the perpendicular direction 
between the sew and the cut lines. This is equivalent to the Classic 
AccuMark. 

•  Notch Angle – this option places the notch in the direction of the angle of 
the notch between the cut and sew lines. The illustration below shows the 
positioning of the notches. 

  

• Same Dist on Seam – this option is used to control the position of the notch 
on the seam line. When the option is ON, the reference distance is used to 
position the notch on the cut and the sew lines 

4. To create a Group select the group option under Multiple. Specify the 
following: 

• Dist Between- Spacing between the notches. 

• # of Notches - Number on notches in the group. 
5. End selection to continue. 

Reference Notch - Move 

This function is used to slide a reference notch along a line. When the notch is moved 
the reference amount saved with the piece automatically updates. The function can 
also be used on a regular notch, in which case, it will convert the notch to a Reference 
Notch. 
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Notch Groups can also be moved. After one of the notches in the group is moved, the 
other notches are repositioned by the system. 

To move a reference notch: 

1. From the Notch menu select Reference Notch and then Move. 

• Copy Distance – Use this option to automatically position a notch so that 
the reference distance matches the reference distance of the source notch. 

2. Indicate notch position. 

3. End selection to continue  

 

Reference Notch - Group 

Use the Group function to create a Reference notch group from existing notches. The 
reference distance is measured from the notch closest to the reference point. If the 
spacing between the notches is not equal, the system will correct the notch 
placement. 

 
To create a group: 

1. Select the notches to be included in the group. 

2. Select the reference point for maintaining the notch distance. 

3. The Notch Position on Seam option determines where the notch is 
positioned on the seam internal. Choose one of the following options: 

• Perpendicular – this option places the notch in the perpendicular direction 
between the sew and the cut lines. This is equivalent to the Classic 
AccuMark method. 

• Notch Angle – this option places the notch in the direction of the angle of 
the notch between the cut and sew lines. The illustration below shows the 
positioning of the notches. 

  

• Same Dist on Seam – this option is used to control the position of the notch 
on the seam line. When the option is ON, the reference distance is used to 
position the notch on the cut and the sew lines. 

Reference Notch - Add Group on Line 

This function is used to add a group of notches evenly spaced between two points. 
When the line is modified the group maintains the spacing between the notches. The 
group maintains the spacing when geometry is modified. 

 271 



 
To add group on line: 

1. From the Notch menu select Reference Notch and then Add Group on Line. 

2. Select the line to receive notches. 

3. Select the ends to receive notches – None, Both, First or Last. 

4. In the Input box, select: 

• The Notch type: 

• For AccuMark data: 1, 2, 3, 4, 5. 

• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit. 

• The Number of notches in the group. This is an addition to any ends 
selected to receive notches in step 3. 

5. Select one of the Notch Position on Seam options: 

• Perpendicular – this option places the notch in the perpendicular direction 
between the sew and the cut lines. This is equivalent to the Classic 
AccuMark method. 

•  Notch Angle – this option places the notch in the direction of the angle of 
the notch between the cut and sew lines. The illustration below shows the 
positioning of the notches. 

  

• Same Dist on Seam – this option is used to control the position of the notch 
on the seam line. When the option is ON, the reference distance is used to 
position the notch on the cut and the sew lines. 

 

Reference Notch - Add Group Ln Distance 

This function is used to add a group of notches spaced by a specified amount. When 
the line is modified the group maintains the spacing between the notches. The group 
maintains the spacing when geometry is modified. 

 
To add group line distance: 

1. From the Notch menu select Reference Notch and then Add Group Ln Dist. 

2. Select a line to receive the notches. 
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3. You may position thumbtacks to define the desired range or left click to 
continue. 

4. Select the ends to receive notches – None, Both, First or Last. 

5. Select reference point for maintaining group notch distance. 

6. In the Input box, select: 

• The Notch type: 

• For AccuMark data: 1, 2, 3, 4, 5. 

• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit. 
7. Enter the distance between the notches. 

8. Select one of the Notch Position on Seam options: 

• Perpendicular – this option places the notch in the perpendicular direction 
between the sew and the cut lines. This is equivalent to the Classic 
AccuMark method.  

•  Notch Angle – this option places the notch in the direction of the angle of 
the notch between the cut and sew lines. The illustration below shows the 
positioning of the notches. 

  

• Same Dist on Seam – this option is used to control the position of the notch 
on the seam line. When the option is ON, the reference distance is used to 
position the notch on the cut and the sew lines. 

 

Reference Notch - Change Reference 

This function is used to change the reference point of a Reference Notch. When this 
function is used, the notch will no longer refer to the previous reference point but will 
update based on the new reference point selected. 

In the Change Reference and the View/Notch functions, the reference point and the 
distance between the notch and reference point is displayed. The notch type also 
displays next to the notch. 
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To change notch reference: 

1. From then Notch menu select Reference Notch and then Change Reference. 

2. Select the notch to change reference. 

3. Select reference point for maintaining notch distance. 

4. Add Base Point. 

5. N Attribute – For AccuMark data, check to add an N Attribute point to the 
notch point. With this box checked, the point will enter as an intermediate 
point. 

• Turn Point – For MicroMark and AccuMark data, check to add a 
a Turn label; uncheck to add a base point with a Curve label. The turn point 
controls the attribute/modifier on the notch base point for both types of data. 

base point with 
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Work with Pieces 
Overview of Piece Menu 

Use functions in this menu to create, modify, add, delete, or move pieces. When using 
the PDS/Silhouette main menu to access functions, click on Create Piece, Pleats, 
Darts, Fullness, Asymm Fold, Modify Piece, and Split Piece to display additional 
functions. Or, create a custom tool bar that contains the functions you use most 
frequently. 

If you have previously worked with AccuMark or MicroMark pattern design systems, 
many of these functions will be familiar and can be accessed using the traditional 
AccuMark menu or MicroMark menu. However, you may improve your productivity by 
taking time to become acquainted with some new methods for creating pieces. 

What do you want to do? 

 Learn about pieces. 

 Create new pieces. 

 Delete selected piece(s) from the work area. 

 Modify pieces, such as flip, rotate, walk, anchor (lock), or position. 

 Create and work with split pieces. 

 Create asymmetrical folds. 

 Add pleats to pieces. 

 Add fullness to pieces. 

 Create and work with darts. 

 Define and work with seams and corners. 

 Create and work with mirrored pieces. 

 Save a piece and add to Piece/Icon menu. 

 Display pieces in the work area. 
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 Work with the Piece/Icon menu. 

 Edit piece information. 

About Pieces 

A piece is a geometric shape with three or more lines that can become a pattern 
piece. A piece may also be a pattern piece that was digitized on an AccuMark or 
MicroMark system, created in Silhouette, or created in AccuMark or MicroMark 
PDS. In order for PDS/Silhouette to recognize a piece, all pieces created must have 
at least three adjacent lines.  

Piece Geometry  

Pieces are made up of different types of geometry that are identified by line types 
and symbols.  

• Perimeter/boundary lines define the shape or outline of the piece and are 
normally represented by solid lines.  

• The perimeter/boundary line may be a sew or cut line, depending on how the 
piece was created. 

• Internals are non-perimeter/boundary lines or points that are used for style 
labeling or cutting purposes. They can represent: grain or grade reference lines, 
drafting or style lines, such as dart lines, and can be displayed as dashed lines or 
solid lines.  

• Internal points, which are represented as a + sign, represent drills, punch holes, 
or single points not on a line.  

• Notches display as slits on the perimeter/boundary of the piece regardless of 
notch type. If symbols are turned on in Preferences/Options, points such as end 
of line points, display as triangles at the end of the line, or at the intersection of 
two perimeter/boundary lines. 

Piece Selection Hints 

• To select all piece geometry for a piece, click in the center of the piece. 

• You can use the Tab key to simplify selection of more than one piece. 

• When multiple pieces are in the work area, you can specify which piece you want 
to work with by using the Set Focus button in the Edit Piece Info box.  

• Use Zoom functions in the View menu to control your view. 
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Saving Pieces 

If you use the same name for a modified piece as the original, the system will not 
overwrite it until you use the Save As function. At that time you will be prompted as 
to whether or not you want to overwrite the original with the modified piece. If, 
however, you use Save to store a modified piece that has the same name as the 
original, you will not be prompted and the original piece will be overwritten. It is 
recommended that you provide a unique name to each piece created or modified. 

Piece Colors 

The colors that display when working with pieces are determined in the Piece Colors 
section of the Preferences/Options Color Tab. The color-coding allows you to 
quickly see which pieces have original geometry, selected geometry, or modified 
geometry that has not yet been saved.  

 

 

Differences in Working with Pieces 

PDS /Silhouette users will notice the following differences from working in: 

AccuMark MicroMark 
Seam Allowance 

 

 

Grading 
 

• Seam allowance can be 
defined in a table by line 
type. Seam amounts can 
also be defined manually. 

• The Switch Digitize function 
is the equivalent of the 
Add/Strip function, but 
customers were 
encouraged during training 
to chose either the sew or 
cut lines as the piece 
boundary and not to switch 
back and forth. 

• Grading can be defined in a 
rule table or in a piece 
itself.  

• Grade rules exist only in the 
rule table. If a style is 
moved to a different system 
the rule table must be 
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moved with it. 
• While working in PDS, 

certain functions such as 
Pivot Dart or Fullness can 
modify existing grade rules. 
Those modified rules stay 
with the piece, and the 
rules can be exported to a 
table. 

• AccuMark Offset Grading is 
similar to MicroMark 
Perpendicular rules. 

• Assigning Z and R 
attributes to the merge line 
before combining the 
pieces is similar to 
MicroMark Paste Grading. 

• In the MicroMark rule table, 
several different types of 
grade rules can be defined. 
In addition to Delta rules, 
there are also Tangent and 
Perpendicular.  

• On MicroMark pieces, 
different grade rules can be 
assigned to the ends of two 
lines that meet at the same 
corner. 

• Paste Grading is a feature 
offered in the Combine 
Piece function (Merge 
Block) of the MicroMark. 
When two pieces are 
merged together, the 
resulting piece can be 
created with the combined 
grading of the original 
pieces. 

• Proportional grading is a 
feature in MicroMark that 
can be used to 
proportionally grade split 
pieces. 

Grain Lines and Alternate Grading 
Lines 

Grain Lines and Grade Reference 
Lines 

Line Extensions  

• The G0 line can be used as 
the Grain Line and the 
Grade Line. Pieces are 
always displayed on the 
screen with the G0 line on 
the horizontal.  

• Alternate grading lines can 
be used. 

• There is a Grade Reference 
Line and a Grain Line. The 
piece is always displayed 
on the screen with the 
Grade Reference Line on 
the horizontal. Alternate 
grading lines can also be 
used. 

• The piece perimeter is 
always a closed polygon. 

• On PDS/Silhouette, Allow 
Extensions function in the 
menu is used to indicate 

• Pieces can be made up of 
different, intersecting lines, 
which do not form a closed 
polygon. The Move End 
Points option on the 
MicroMark is used to 
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that extensions are allowed 
for a given line/piece. 

indicate that line extensions 
will be allowed for a given 
piece. 

Notches  

• Notch dimensions are 
specified in the Notch 
Parameter Table. 

• Notches are always 
displayed in PDS to look 
like slit notches. 

• Notch dimensions are 
defined for each notch in 
each piece. 

• Notches are displayed with 
real data points at the tips 
of the notches. 

 

Fold Keep  

AccuMark = New 

MicroMark = Piece/ Fold Keep/ Select Line, Match 2 Points, Define Fold Line 

 

Use this function in the Piece menu to quickly return a mirrored piece that has been 
opened back into a mirrored piece. It can also be used to quickly select part of a 
piece and discard the rest of the geometry. The new piece can be automatically 
mirrored or have seam allowance automatically added to the fold line. The Fold 
Keep function does not create a new piece, but alters the geometry under the 
existing piece name. 

Related Topics  
To use fold keep on a piece: 

1. From the Piece menu, select Fold Keep or press the Shift + K keys. 

2. Select the desired options. 

• Fold Line Selection: 

Select Line – Folds the piece on an existing internal line.  

Match 2 Points – Uses two points when the location of the fold line is not and 
folds the piece so that the two selected points match. 

• Mirror After Fold Keep: 

Fold Internals – Maintains the internal lines from the side of the piece that will 
be discarded. Those internals will be mirrored across the fold line and 
maintained on the part of the piece that is kept.  
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Mirror Piece – Automatically folds the new piece using the fold line as the 
mirror line.  

Fold after Mirror – this option is only available when Mirror Piece is checked. 
• Define Seam on Split Line – prompts to add seam allowance, if the piece has 

seam allowance. 
3. Depending on the Fold Line Selection option selected, select an existing line 

or two points to match for the fold line. 

The system automatically draws the fold line. If two points were chosen, the piece 
is folded so that the points match. 
4. As you move the mouse, the two different sides of the piece will highlight. A 

weight also displays on the currently highlighted side.  

 
5. Click left on the side of the piece to keep. 

The system discards the other half of the piece, applies seam allowance to the fold 
line, folds internals, or displays a mirrored piece depending on which function 
options were chosen.  
6. When finished, save the piece. 

Hints: 

• If the Mirror Piece option is used, the piece will automatically display unfolded. To 
make alterations and maintain the mirrored state, use he piece 
in half before making alterations. 

Fold Mirror to fold t

• The Fold Internals option is useful when there are asymmetrical internal lines 
inside an otherwise symmetrical piece. For example, use Fold Keep with the Fold 
internals option selected to return an open piece to a mirrored state. Reopen the 
piece and the internal lines are now mirrored. 

Delete Piece from Work Area 

AccuMark = Blocks/ Delete Block 

MicroMark = New 

 

Use this function in the Piece menu to delete selected piece(s) from the active work 
area. The pieces are not permanently deleted from the hard disk. If changes have 
been made and not saved, however, those changes will be lost.  
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To delete piece from the work area: 

1. From the Piece menu, select Delete Piece from Work Area or press the Shift + F1 
keys. 

2. Select the piece(s) to delete from the work area. 

3. End selection to delete the piece(s) from the work area. 

If a piece has been stored, but not yet returned to the menu, the work area will be 
cleared and the icon will represent the original piece. 

CAUTION: If MicroMark pieces with changes are deleted from the work area before 
the style is saved, the changes will be lost. 

Hints: 

• If you accidentally delete a piece from the workspace that you did not want to 
delete, use the Undo function to recover the piece. 

• To delete all pieces from the work area, use the Delete Pieces from Work Area 
function in the Edit menu. 

• To delete pieces from the Piece/Icon menu, use the Option Pop-up menu. 

Combine/Merge 

AccuMark = Blocks/ Modify Blocks/ Merge Block 

MicroMark = Piece/ Combine Piece 

 

Use this function in the Piece menu to combine two pieces into one new piece. 
Grade rules are retained for the first piece selected. Depending on the options 
chosen, Grade rules for the merged line and second piece selected can be modified 
or retained. If modified, the new grading can be based on the grading line for either 
the first or second piece. 

  Related Topics  
To combine or merge two pieces: 

1. From the Piece menu, select Combine/Merge. 

2. Select one of these Grade Options: 

• Create Modified Rules – modifies rules using Z and R attributes to grade from 
the primary piece. 

• Alternate Grade Ref Line – converts the primary grain/grade reference line of 
the set piece into an alternate grain/grade reference line. All grade points on the 
set piece will reference the alternate grain or grade reference line. 
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• Target Pc Grade Ref Line – bases rules on the grain/grade reference line of the 
target piece; rules are not modified. 

• Paste Grading – creates a paste line. 
3. Select one of these Merge Line Rules: 

• Keep All Rules – maintains all rules on the merge line. 
• Keep Target Piece Rules – uses rules from the target piece. 
• Remove Rules – removes all rules from the merge line. 
4. Select from the desired options: 

• Delete Original Pieces – deletes the original pieces from the work area and 
Piece/Icon menu; the new merged piece remains in the work area. 

• Convert Merge Line to Internal – determines whether the merge lines will be 
deleted or converted into an internal line. 

• Add Piece to Model/Style – adds the new piece to the active style of model. 
5. Select the line on the first piece you want to designate as the merge line. This 

line is where the second piece will attach to the first. 

6. Select the target line on the other piece. The target line will be merged with the 
line chosen in the previous step.  

7. If the lines to be merged are different lengths, when prompted select match 
points first on the set piece and then on the target piece. These points will be 
matched, each to the other during merging. 

The system combines the pieces. The newly created piece has the same 
orientation as the second or target piece. The system modifies the grade rules on 
the first, or merged piece, so the piece maintains its nest in the new orientation. 
8. As the cursor is moved, the new piece moves with it. Move the piece to where 

you want it on the work area and click left to place.  

9. Enter a name for the piece or click OK to accept the system default name. The 
first piece created is named P1, the second P2, etc.  

Hints: 

• If the Create Modified Rules is selected when working with AccuMark data, use 
stacking points (Z and R attributes to control and maintain the grading. Before 
merging pieces, use the Z and R attributes to rotate the grading on the merge 
lines. 

• Use this function to prepare pieces for Walk Pieces when one piece needs to be 
walked along multiple pieces. For example, use to combine back and front pieces 
at the shoulder seam in order to walk a collar piece. 
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Shrink/Stretch 

AccuMark = Blocks/ Modify Blocks/ Scale Block 

MicroMark = Piece/ Shrink/ Stretch 

 

Use this function in the Piece menu to apply fabric shrinkage or stretch tolerance to 
a piece. The system will increase or decrease the size of the piece to allow for 
shrinkage or stretch. Shrink or stretch can be applied using a linear measurement or 
by percentage. The Shrink Stretch (><) symbol will display on the piece in the piece 
geometry in the work area. The symbol is displayed in front of the Orientation 
Symbol and can be hidden along with the Orientation Symbol using the option in 
Preferences. 

To apply shrink or stretch tolerance to a piece: 

1. From the Piece menu, select Shrink/Stretch. 

2. If desired, select from these options: 

• Linear – Applies shrink or stretch by using a measurement.  
• Percent – Applies shrink or stretch as a percentage of the overall piece size.  
• Remove – Removes any applied shrink or stretch and returns the piece to its 

original size. Only available if a selected piece has applied shrink/stretch. This 
option has no effect once the piece has been saved. 

• Clear Symbol – Removes the Shrink/Stretch symbol from the piece icon without 
changing piece dimensions. 

3. Select the piece(s) to apply shrink or stretch tolerance to. 

4. Type the desired amounts for both X and Y dimensions.  

• If Linear is selected, type the exact measurement to increase or decrease the 
piece by. Use a positive amount to increase the size of the piece (shrink) and a 
negative measurement to decrease the size of the piece (stretch.) 

• If Percent is selected, type a percent value for both the X and Y-axis followed by 
the % symbol. For example, to scale a piece to half its current width, enter 50%. 
To scale a piece 14 percent larger, enter 114% (negative values are not 
required). 

5. Click OK or press Enter.  

The piece is scaled to your specifications. When Shrink/Stretch is applied to a piece, 
only, the piece in the work area is modified. Additional copies of the piece retrieved 
from the menu will not reflect the shrink/stretch modification unless ‘Piece to Menu’ 
is used after applying Shrink/Stretch. 
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When ‘Piece to Menu’ is performed after using Shrink/Stretch, the symbol is added 
to the Piece Menu and the geometry is updated. Using the overwrite option in Piece 
to menu controls whether the modified piece is added to the menu under a new 
name or replaces the original piece in the menu. This method allows for an accurate 
display of the shrink/stretch status for each piece in the work area as well as in the 
piece menu 

 

  

 
Hints: 

• For MicroMark data, information about any Shrinkage applied to a piece can be 
viewed in the Piece Description page of the Style Manager. 

• For AccuMark models with shrink/stretch applied, the shrink/stretch symbol is 
removed after saving. 

• For MicroMark styles with shrink/stretch applied, the shrink/stretch symbol is kept 
after saving. 
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Annotate Piece 

AccuMark = New 

MicroMark = New 

 

Use this function in the Piece menu to type instructions and pattern notes directly on 
the pattern piece. This function can be used to apply new annotation or to edit, 
move, and copy existing annotation. The annotated text can be plotted; set 
character size in preferences. 

Annotation stays with the piece as the piece is rotated and flipped on screen, 
remaining horizontal for readability as the piece is manipulated. See Flip Piece 
Icons for more piece information. 

Note: This information currently cannot be stored for MicroMark style data. 
To apply new annotation: 

1. From the Piece menu, select Annotate Piece. 

2. Position the cursor in the desired area and click left to select the location for 
new annotation. 

A New Piece Annotation dialog box displays.  
3. Type the annotation as desired. Standard Windows right button options such 

as cut and paste are available.  

4. Click OK to accept the annotation. 

The piece now displays with the annotation written on it.  
To edit an existing annotation: 

1. From the Piece menu, select Annotate Piece. 

2. Position the cursor over the existing annotation and click left to select. 

An Edit Annotation dialog box displays with the existing annotation.  
3. Edit the annotation as desired by typing, or using the standard Windows right 

button options such as cut and paste.  

4. Click OK to apply the edited annotation in the same location.  
To move, or copy an existing annotation: 

1. From the Piece menu, select Annotate Piece. 

2. Position the cursor over the existing annotation and click left to select. 

3. An Edit Annotation dialog box displays with the existing annotation.  
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4. Click one of these buttons: Copy or Move. 

The dialog box clears from the screen.  
5. Position the mouse in the desired location for the new annotation and click left.  

The annotation is copied or moved to the new location.  
To delete an existing annotation: 

1. From the Piece menu, select Annotate Piece. 

2. Position the cursor over the existing annotation and click left to select. 

An Edit Annotation dialog box displays with the existing annotation.  
3. Click the Delete button. 

To hide annotations: 

1. Use the View/ Hide Annotations function. 
Hints: 

• This form of annotation is not supported on previous AccuMark and MicroMark 
systems. If a model or style is retrieved into an AccuMark 7.6 or MicroMark 9.5 
system and saved on either system, the annotation will no longer be available if 
the model or style is retrieved back into PDS/Silhouette. 

• For MicroMark data, the piece annotation information is stored in the Style 
extension (.f) file. 

 

Piece to Menu 

AccuMark = New 

MicroMark = Data Manage/Block to Menu 

Use this function in the Piece menu to move a newly created piece or an edited 
existing piece in the work area to the Piece/Icon menu. 

To return a piece to the Piece/Icon menu: 

1. From the Piece menu, select Piece to Menu. 

2. If desired, select the option to Overwrite.  

3. Select the piece(s) you want to return. 

4. End selection to continue. 

If Overwrite was checked in step 2, the piece(s) will automatically return to the 
menu, overwriting the existing piece(s) in the menu (similar to Styles in Classic 
MicroMark). 
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Otherwise if a piece is not saved, you are prompted to name that piece. Click OK or 
press Enter. The piece is removed from the work area and displays in the 
Piece/Icon menu. 
5. Save any modified pieces or styles. This includes pieces that were returned to 

the Piece menu using the Overwrite option. 

Note: To turn Overwrite off after it has been activated, use Piece to Menu from the 
Piece menu rather than the right button menu. This will display the option, allowing it 
to be unchecked. 

Create Pieces 

Creating Pieces 

Functions in the Create Piece menu are used to create new pieces.  

 
Hints on Creating Pieces 

• Pieces can be created from existing pieces, or can be system generated from 
measurements you input.  

• When you create a new piece, it is recommended that you provide a unique 
name.  

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

Hints on Saving Pieces 

• If you use the same name for a new piece as an existing piece, the system will 
not overwrite it until you use the Save As function. At that time you will be 
prompted as to whether or not you want to overwrite the original with the new 
piece.  

• CAUTION: If you use the Save function to store a new piece that has the same 
name as an existing piece, you will not be prompted and the original piece will be 
overwritten. 

• When Add piece to model/style is selected in the User Input box, the piece is 
added to the current style or model and the style or model also needs to be 
saved. Or you can create a new model or style (see below for MicroMark pieces). 

Style Defaults for Add Piece Option 

When Add piece to model/style is selected in the User Input box and you are 
creating a new MicroMark style, the system will setup the following style defaults: 

• Grade rule table and base/sample size based on the piece that is added (not 
from the MicroMark Grade Options) 

• Creation Date (current date) 
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• Creation Operator (read from C:\ADS\IDOP.BIN) 
• Seam Allowance Table Name (read from MicroMark Grade Options) 
• Maximum Splice Length (read from MicroMark Marker Options) 
• Blank.syn for Variation Rule Table name 

Create Piece - Rectangle 

AccuMark = Blocks/ Create Blocks/ Create Rectangle 

MicroMark = Piece/ Rectangle 

 

Use this function in the Piece menu to create a new rectangular piece.  
To create a rectangle: 

1. From the Piece menu, choose Create Piece and then select Rectangle or 
press the Shift + F6 keys. 

2. Select the desired options. 

• Add new piece to model/style – Adds the new piece to the active style or 
model. Or you can create a new model or style. 

3. Select the point in the work area where a corner of the rectangle should start.  

• In Cursor mode, drag the mouse across the work area. The system creates a 
rectangle using the first corner as the base. The values displayed in Value Input 
Box represent the change in the X and Y coordinates from the beginning point of 
the rectangle. Click left to select the opposite corner of the rectangle. 

• In Value mode, type dimensions for the new rectangle.  

The X field displays the length, or horizontal distance, of the rectangle. 

The Y field displays width, or vertical distance, of the rectangle. 

The Dist field displays the diagonal distance of the rectangle. 

As you select different fields in the Value Input Box, dimensioning lines display to 
help in selecting the appropriate positive or negative value. Click OK or press Enter 
to accept the rectangle. 

The new rectangle displays as a solid line. A horizontal grain or grade reference 
line for the new piece is created automatically based on an invisible grid within the 
system. 
4. Enter a name for the piece or accept the system default name. Click OK or 

press Enter. The first piece created is named P1, the second P2, etc.  

5. When finished, save the piece. 
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Hints: 

• If creating samples and are unsure of how you want the piece named, you may 
want to let the system generate the name.  

• It is easier and more accurate to create rectangular pieces on-screen instead of 
digitizing them. 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• Pieces can be displayed with perimeter/boundary lines as sew or cut lines. 

 

Create Piece - Circle 

AccuMark = New 

MicroMark = Piece/ Circle 

 

Use this function in the Piece menu to create a circular piece visually or with an 
exact radius or circumference measurement.  

To create a circle as a new piece: 

1. From the Piece menu, choose Create Piece and then select Circle. 

2. Select the desired options. 

• Create Circle as a New Piece – Creates a new piece rather than an internal 
circular line. 

• Add new piece to model/style – Adds the new piece to the active style or 
model. Or you can create a new model or style. 

• Show Center – Determines the point type used to mark the center of the circle. 
• Circle dimension – Selects the measurement you want to enter: Radius or 

Circumference. 
• Dist between Pts – Controls the number of points on the perimeter when the 

circle is created providing control as needed to smooth the perimeter. 
3. Select the point in the work area where a center of the circle should start.  

• In Cursor mode, drag the mouse across the work area. The system creates a 
circle using the first point as the center. The value in the Dist field represents the 
change in either the radius or circumference, depending on the Circle Dimension 
option you chose. When the circle is the desired size, click left to place the circle.  
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• In Value mode, type the desired value for either the radius or circumference in 
the Dist field. Click OK or press Enter. The system automatically creates a circle 
the specified measurement.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
4. The new Circle will display as a solid line. A horizontal grain or grade 

reference line for the new piece is created automatically based on an invisible 
grid within the system. 

5. Enter a name for the piece or accept the system default name. Click OK or 
press Enter. The first piece created is named CIRCLE.  

6. When finished, save the piece. 
Hints: 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• If creating samples and are unsure of how you want the piece named, you may 
want to let the system generate the name.  

MicroMark = Piece/ Skirt 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• Pieces can be displayed with perimeter/boundary lines as sew or cut lines. 

 

Create Piece - Skirt 

AccuMark = New 

 

Use this function in the Piece menu to create a one-quarter panel of a circular skirt 
by inputting the total circumference and length measurements of the skirt. 

To create a quarter circular skirt: 

1. From the Piece menu, choose Create Piece and then select Skirt. 

2. Select the desired options.  

• Add new piece to model/style – Adds the new piece to the active style or 
model. Or you can create a new model or style. 

• Show Center Point – Marks the center of the circle skirt piece with a Mark/X 
point.  
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3. Type or use drop-down list boxes to enter measurements in the Total waist 
and Skirt Length fields. When finished, click OK or press Enter. 

One quarter of the skirt has been created. The system places the piece 
automatically, displaying the perimeter/boundary as a solid line. A horizontal 
grain/grade reference line for the new piece is created automatically based on an 
invisible grid within the system. 
4. Enter a name for the piece or accept the system default name. Click OK or 

press Enter. The first piece created is named SKIRT.  

5. Right click and select Cancel to continue. 

6. When finished, save the piece. 
Hints: 

• Cursor mode is not available when using this function. 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• If creating samples and are unsure of how you want the piece named, you may 
want to let the system generate the name.  

• This function can be useful for creating certain types of cuffs and ruffles. 

• Pieces can be displayed with perimeter/boundary lines as sew or cut lines. 

Create Piece - Oval 

AccuMark = New 

MicroMark = Piece/ Oval 

 

Use this function in the Piece menu to create oval shaped pieces by entering the 
horizontal and vertical dimensions.  

To create an oval piece: 

1. From the Piece menu, choose Create Piece and then select Oval. 

2. Select the desired options.  

• Add new piece to model/style – Adds the new piece to the active style or 
model. Or you can create a new model or style. 

• Show Center Point – Marks the center of the oval with a Mark/X point.  
3. Type or use drop-down list boxes to enter the horizontal and vertical 

dimensions of the new piece. When finished, click OK or press Enter.  
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The system automatically creates the oval, displaying the perimeter/boundary as a 
solid line. A horizontal grain or grade reference line for the new piece is created 
automatically based on an invisible grid within the system. 
4. Enter a name for the piece. Click OK or press Enter.  

5. When finished, save the piece. 
Hints: 

• Cursor mode is not available when using this function. 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• Pieces can be displayed with perimeter/boundary lines as sew or cut lines. 

Create Piece - Collar 

AccuMark = New 

MicroMark = Piece/ Collar 

 

Use this function in the Piece menu to create a basic collar piece by specifying the 
collar measurements. 

To create a collar piece: 

1. From the Piece menu, choose Create Piece and then select Collar. 

2. Select the desired options.  

• Add new piece to model/style – Adds the new piece to the active style or 
model. Or you can create a new model or style. 

• Notch – Specifies whether a notch should be added where the collar crosses the 
shoulder seam, and the type and depth of the notch. 

3. Type or use drop-down list boxes to enter dimensions for the Collar Width, 
Center Back to Shoulder, Shoulder to Center Front and Line Rotation 
amounts. When finished, click OK or press Enter.  

4. The system automatically creates the collar, displaying the perimeter/boundary 
as a solid line. A horizontal grain or grade reference line for the new piece is 
created automatically based on an invisible grid within the system. 

5. Enter a name for the piece or accept the system default name. Click OK or 
press Enter. The first piece created is named COLLAR.  

6. Right click and select Cancel to continue. 

7. When finished, save the piece. 
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Hints: 

• Cursor mode is not available when using this function. 

• The piece is named but not saved. If you attempt to exit the system completely, 
you are notified that there are pieces that need to be saved. 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• If creating samples and are unsure of how you want the piece named, you may 
want to let the system generate the name.  

• Pieces can be displayed with perimeter/boundary lines as sew or cut lines. 

Create Piece - Facing 

AccuMark = New 

MicroMark = Piece/ Facing 

 

Use this function in the Piece menu to quickly create a facing piece using an 
existing line. This function allows the user to select the desired facing piece and 
eliminates the need to select multiple lines to trace off the piece. 

Note: If you prefer to trace, use Create Piece Trace functions or Draft Trace in 
Silhouette. 

To create a facing piece: 

1. From the Piece menu, choose Create Piece and then select Facing. 

2. Select the desired options.  

• Add new piece to model/style - adds the new piece to the active style or model. 
Or you can create a new model or style. 

• Define Seam on Facing Line - if the piece has seam allowance, prompts to add 
seam allowance; added seam allowance is always positive. 

• Line Type - select whether to use an existing line or digitize a new line in step 3. 
3. Select the internal line that defines the internal edge of the facing. If the line 

does not intersect the piece perimeter/boundary, the system will automatically 
extend the line. 

The system will automatically use the facing line to create a piece from the 
geometry on either side of the facing line. 
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4. Use the cursor to highlight the side you want to keep as the facing piece and 
click left to select. An image of a weight displays to show the side you 
selected. 

5.  
6. As you move the cursor, the new piece is attached to the cursor. Click left to 

place the new facing piece in the work area.  

7. Enter a name for the piece. Click OK or press Enter. When the new piece is 
stored, it overwrites the original. It is recommended that a unique name is 
given to each piece created.  

8. When finished, save the piece. 
Hints: 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• If creating samples and are unsure of how you want the piece named, you may 
want to let the system generate the name.  

• New pieces can be created with the seam allowance built in or seam allowance 
can be added at a later time. 

• Pieces can be displayed with perimeter/boundary lines as sew or cut lines. 

Create Piece - Copy 

AccuMark = Blocks/ Create Blocks/ Create Copy 

MicroMark = Piece/ Copy 

 

Use this function in the Piece menu to create an exact duplicate, including all 
internal geometry, of an existing piece. This function makes it easy to experiment 
with changes on a piece without modifying the original piece. Or, you can copy a 
piece that has many internals. It differs from the Trace functions in that you cannot 
selectively choose the perimeter/boundary or internal lines to be copied.  

 
To copy a piece: 

1. From the Piece menu, choose Create Piece and then select Copy. 
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2. Select from these options: 

• Add new piece to model/style - adds the new piece to the active style or model. 
Or you can create a new model or style. 

3. Select the piece to be copied.  

An exact duplicate of the piece is created.  
4. As the cursor is moved, the copy moves with it. Move the copy where you 

want it in the work area and click left to place.  

5. Enter a name for the piece or accept the system default name. Click OK or 
press Enter. The first piece created is named P1, the second P2, etc. When 
the new piece is stored, it overwrites the original. It is recommended that a 
unique name is given to each piece created.  

6. When finished, save the piece. 
Hints: 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• If creating samples and are unsure of how you want the piece named, you may 
want to let the system generate the name.  

Create Piece - Extract Piece 

AccuMark = New 

MicroMark = New 

 

Use this function in the Piece menu to quickly create pieces from an existing piece. 
The user creates design lines on a piece, which define the area(s) to be created into 
a new piece. When this function is used, the selected area(s) fill with color as the 
system automatically finds the new piece perimeter/boundary. This function 
eliminates selecting multiple lines to trace off a new piece perimeter/boundary and 
allows internal lines to be selectively copied to the new piece. 

Note: If you prefer to trace, use Create Piece Trace functions or Draft Trace in 
Silhouette. 

To extract a piece: 

1. From the Piece menu, choose Create Piece and then select Extract or press 
the Shift + F4 keys. 

2. Select from these options: 
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• Add new piece to model/style - adds the new piece to the active style or model. 
Or you can create a new model or style. 

3. Select the piece that you want to extract regions from for the new piece.  

4. Click left inside the region(s) that you want to make up the new piece. As you 
select a region, the area fills with color, indicating the perimeter/boundary of 
the new piece.  

5. End selection to continue. 

6. Select the desired internals to copy to the new piece. If a grain/grade 
reference line is not selected, a horizontal grain or grade reference line for the 
new piece is created automatically based on an invisible grid within the 
system.  

7. End selection to continue. 

A new piece is created.  
8. As the cursor is moved, the piece moves with it. Move the new piece where 

you want it on the work area and click left to place.   

9. Enter a name for the piece. Click OK or press Enter.  

10. When finished, save the piece. 
Hints: 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• Design or perimeter/boundary lines that define new piece to extract must intersect 
each other. 

• If creating samples and are unsure of how you want the piece named, you may 
want to let the system generate the name.  

 

Create Piece - Altered Size 

AccuMark = New 

MicroMark = Not Applicable 

Use this function in the Piece menu to create a new copy of the piece, in a specified 
size, with alterations applied.  

To create a piece with an altered size: 

1. From the Piece menu, choose Create Piece and then select Altered Size. 

2. Select the piece(s) to alter. 

3. The Alteration set up form displays. Select or complete the following fields:  
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• Alteration Library – Select the Alteration editor that should be used for the 
current model. These alterations will be applied during marker order processing 
and the corresponding pieces will appear in the marker in their altered state. 

• Preference - Select one of the following: 

Cumulative – All requested alterations will plot and display blended on the 
piece. 

Nested – Each requested alteration will plot and display separately. 
• Size Code – A Size Code editor may be selected. This is an optional selection 

and the size code table needs to be valid for the selected piece(s). 
• Alteration Rule – Enter the name of the alteration rule the system should 

reference. 
• Amount – Enter the alteration amount desired. 

4. Select the size to be altered from the Altered Size table. 

5. Enter a name for the new piece. 
Hints: 

• Alterations may be applied during order processing and the corresponding pieces 
will appear in the marker in their altered state. 

• Select the Cumulative option to view multiple alterations, as they will blend 
together in marker making. 

• When verifying different individual alterations or troubleshooting multiple 
alterations, use the Nested option to display each alteration’s start and end point. 

+ Create Binding 

AccuMark = New 

MicroMark = New 

  

Use this function in the Create Piece menu to create binding pieces (such as 
binding tape for a seam), waistbands, and cuffs. The piece created is a rectangle, of 
a specified width, with notches placed along the length to indicate seam positions 
and notches. Grade rules are generated for the four corners of the rectangle and the 
notches so that the binding fits for all graded sizes. 

To create a binding: 

6. From the Piece menu, choose Create Piece and then select Create Binding. 

7. Enter a name for the new piece, or use the default name, BINDING. 

8. Set values for these options: 

• Add Piece to Model/Style – adds the new piece to the active style or model. 
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• Binding Width – specifies the width of the binding piece to be created. 

• Notch Type – specifies whether a notch should be added on the binding piece 
to correspond with intersecting seams and existing notch locations on the pieces 
it will sew to. 

• Notch Depth – specifies the depth of the notches to be added. Only applicable 
for MicroMark users. 

9. Select the perimeter lines for the binding. The lines can be on different pieces. 
Some pieces may need to be flipped to the same relative position that they will 
be in during assembly before lines are selected. End selection to continue . 

10. The system generates the piece and attaches it to the cursor. Place the piece 
in the work area. 

The system creates a rectangle the length of the sum of the selected lines for the 
base size. The width of the rectangle is the width specified in the ‘Binding Width’ 
field. If desired, notches are created along the length of the rectangle at each seam 
and notch position. In the illustration below, notches are created at locations B 
through G. 

  

Grading of Binding 

The binding piece created using the Create Binding function will have the same 
base size, rule table/size line as the other pieces in the style/model. 

The X value for each rule is the differences between the graded line lengths, from 
each end-of-line to the next notch or end-of-line. The Y value is always 0. 
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For the illustration below, the grading at point A is 0,0. For point B, the X growth 
from size 2 to 4 is X=.3, Y=0. The growth from size 4 to 6 is X=.39, Y=0. The 
grading at point C is compounded on top of the grading of point B. 

  
Hints: 

• The system creates modified grade rules for the binding. For MicroMark systems, 
use Export Rules to export the new rules to a MicroMark rule table. 
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Trace Pieces 

Tracing to Create Pieces  

Use the Trace function in the Create Piece menu to create new pieces from one or 
more existing pieces by tracing selected perimeter/boundary lines, internal lines, or 
pieces. Mirrored or scored pieces can be created as well as normal pieces. 

Note: The six Create Trace functions are 
combined into the single Trace function. The 
Sew/Cut variations have been removed and 
the Normal, Mirror, and Scored options 
appear as radio buttons. 

  
General Hints: 

• Perimeter/boundary lines should always be selected clockwise, except when a 
score line is involved. Then lines after the score line should be selected 
counterclockwise. The lines or extensions of the lines must intersect one another.  

• The lines that will be the perimeter/boundary of the traced piece can be internal 
lines, including the grain /grade reference lines. 

• If the lines that will make up the perimeter/boundary of the new traced piece have 
not been extended to intersect, the system will automatically extend them until 
they intersect.  

• For MicroMark data, special line labels are maintained or copied for lines created 
using Create Trace. 

• For AccuMark data, the rule table specified in Preferences/Options is assigned to 
the piece. 

• If creating samples and are unsure of how you want the piece named, you may 
want to let the system generate the name.  
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Create Piece - Trace 

AccuMark = Blocks/ Create Blocks/ Create Trace 

MicroMark = Piece/ Trace/ Trace Normal – Sew 

 

Use this function in the Piece menu to create a new piece from one or more existing 
pieces. The perimeter/boundary of the new piece will be a style line. Specific lines of 
one or more pieces can be selectively copied and combined into a new piece. For 
instance, you can create a new style line, such as neckline or armhole, and create a 
piece with the modification, or create a one-piece pattern from several pieces. 

Note: The six Create Trace functions are combined into a single function. The 
Sew/Cut variations have been removed and the Normal, Mirror, and Scored 
options appear as radio buttons. 

Trace to create a new piece: 

1. From the Piece menu, choose Create Piece and then select Trace or press 
the Shift + F3 keys. 

2. Select a Trace Type: Normal, Mirror, or Scored. 

If desired, select Add new piece to model/style to add the new piece to the active 
style or model. Or you can create a new model or style. 
3. Select the internals to copy onto the new piece.  

• If a grain or grade reference line is not selected, one is generated automatically 
for the new piece according to the horizontal grid on-screen.  

• To maintain an existing Opposite Grade Axis, this line must be selected as one of 
the internal lines. 

• If multiple grade reference lines exist, the first line selected using the Trace 
function becomes the primary grade reference line and any other grade 
reference lines become alternate reference lines. 

• If an intersection notch is traced, the reference line for the notch must also be 
traced. 

4. End selection to continue. 

5. The traced perimeter/boundary and internal lines form a new piece in the work 
area. As the cursor is moved, the new piece moves with it. Move the piece to 
where you want it on the work area and click left to place.  

6. Enter a name for the piece or accept the system default name. Click OK or 
press Enter. The first piece created is named P1, the second P2, etc.  

7. When finished, save the piece. 
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Hints: 

• For general hints, see Tracing to Create Pieces. 

• If the piece(s) to be traced has corners applied, do not select the corner lines. The 
corners will be automatically copied.  

• The new piece must be a closed piece containing at least three adjacent lines 
with end points to specify the enclosed area. 

• Use Swap Sew/Cut to decide which set of lines you want to work with, and which 
set of lines you want the system to generate.  

 

Seams and Corners 

Overview of Working with Seams and Corners 

Use functions in the Seam menu to add or view seams on a piece. Functions in this 
menu also allow you to create various corner types.  

Terms 
• Seam Line is the designated line along which the seam is sewn or joined.  
• Seam Allowance is the distance from the fabric edge to the sew (stitching) line. 

Seam allowance is planned according to the width needed for the type of seam, 
seam finish, or garment design.  

• Cut Line is any perimeter/boundary line of a piece that will be used in marker 
making and when cutting the piece.  

• Sew Line is any non-perimeter/boundary line of a piece that will be used when 
the piece is sewn.  

• Digitized Boundary is the perimeter line, either cut or sew, that existed when the 
piece was digitized or created or ser using Fix Boundary Type. 

• Master Lines are the perimeter/boundary lines of a piece that are currently the 
solid lines.  They may be either the cut or sew lines. 

• Seam Internals are the dashed lines that display when a seam is defined for a 
piece.  They may represent either the cut or sew lines depending on the state of 
the piece. Seam internals are system generated from the master lines on the 
base size. On the graded sizes, seam internals can be graded or generated 
depending on the seam settings. 

• Swapped State occurs when the function Swap Sew/Cut has been used and the 
current perimeter lines (solid lines) are not the same as the digitized boundary 
lines.  

• A Corner is a special shape applied to the cut lines of a piece that is different in 
shape from the sew lines. Corners are typically used to enhance construction 
and to make production more efficient. 
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Note: All seam settings, default or custom, are applied when the piece is retrieved 
into the work area or on a global basis.  This means that the pieces reflect the seam 
settings currently set in Preferences/Options and that the current settings may not 
be the same settings the piece was originally created under.  (The exception to this 
is the Move End Points setting, which is applied only to new pieces.) 

 
Since different settings can give different results, it is often desirable to 
coordinate the seam settings of systems that will be working on the same 
data or to decide on a selection of seam settings that will be used as the 
standard setting.  

AccuMark Settings and MicroMark Settings 

An overview of seam settings for AccuMark and MicroMark is explained below: 

AccuMark Seams Overview MicroMark Seams Overview 

Pieces: 

Seam allowance internals (dashed 
lines): 

Pieces: 

Non-Digitized Boundary lines (which can be 
the sew or the cut lines): 

• Seam is defined on a per 
piece basis.  

• At any time you can switch 
the piece perimeter between 
the sew and the cut lines.  

• Changes to the piece 
geometry are always made on 
the piece perimeter (solid 
line).  

• Pieces may be saved with the 
sew line or the cut line as the 
piece perimeter. If a piece is 
save with the sew line as the 
perimeter Orderload will send 
the cut lines to marker 
making. 

• May be either sew or cut 
lines.  

• The display of the seam 
allowance internals can be 
turned on and off at any time. 

• Piece modifications can be 
made to the piece when the 
seam internals are displayed. 

• Reflect the changes to the 
piece perimeter only when 
Auto Update Seam in turned 

• Seam is defined using a Seam Table or 
on a per piece basis. 

• The piece can be stored with either the 
sew or the cut line as the piece perimeter 
because the cut line is always sent to 
marker making. 

• Display of non-Digitized Boundary lines 
can be turned on and off at any time, 
using Add/Remove Seam or Hide 
Seams. 

• Piece modifications may be made with 
both sets of lines displayed. 

• The function Fix Boundary Type is used 
to re-define which set of lines is the 
Digitized Boundary. 

• When seam is added to the piece, 
extensions of the sew lines are always 
saved so that the corner intersections 
never slip.  

• The non-Digitized Boundary is system-
generated after the piece is graded. So 
Adjust Grading, is not necessary.  

• When used in combination with 
unclipped lines, Move End Points (off) 
allows line extensions to be used to 
preserve special piece shapes or grading 
types. 
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ON.   
• Grade rules are copied from 

the perimeter /boundary line 
to the seam internal when 
seam is defined. In order to 
have the seam internals 
graded properly on some 
geometry, the function Adjust 
Grading needs to be used. 

 
 
 
MicroMark Settings 

One default setting is available based on MicroMark strategies explained below in 
the Overview. 

Setting MicroMark Seams Overview 

Generate seam internals and 
corners on graded sizes 

Seam Extensions (checked) 
Grade Seam/Corners (unchecked) 
Fix Seam Corners (checked) 
Auto Update Seam (unchecked) 
Move End Points (unchecked) 
Adjust Seam Grading (unchecked) 

Pieces: 

Non-Digitized Boundary lines (which can be 
the sew or the cut lines): 

• Seam is defined using a Seam Table or 
on a per piece basis. 

• The piece can be stored with either the 
sew or the cut line as the piece perimeter 
because the cut line is always sent to 
marker making. 

• Display of non-Digitized Boundary lines 
can be turned on and off at any time, 
using Add/Remove Seam or Hide 
Seams. 

• Piece modifications may be made with 
both sets of lines displayed. 

• The function Fix Boundary Type is used 
to re-define which set of lines is the 
Digitized Boundary. 

• When seam is added to the piece, 
extensions of the sew lines are always 
saved so that the corner intersections 
never slip.  

• The non-Digitized Boundary is system-
generated after the piece is graded. So 
Adjust Grading, is not necessary.  

• When used in combination with 
unclipped lines, Move End Points (off) 
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allows line extensions to be used to 
preserve special piece shapes or grading 
types. 

 

Seam Settings for Existing Data retrieved in PDS version 8.0 (V8) 
 

Source/Data Saved 
In 

Sew/Cut 
Perim 

Generate or Grade 
Seam/Corners 

Auto Update 
Seam 

Adjust Seam 
Grading 

PDS 2000 AccuMark 
with Seam (V 2.03 or 
earlier) 

Seam 
Extension

AM Classic with 
Seam 

Known Grade OFF OFF OFF 

MK Classic with 
Seam 

Known Known – Grade or 
Generate 

OFF OFF ON 

PDS 2000 with 
Seam* (V2.0.4 or 
later) 

Known Known Known Known Known 

Known Grade OFF OFF OFF 

PDS 2000 MicroMark 
withSeam (V 2.0.3 or 
earlier) 

Known Known – Grade or 
Generate ** 

OFF OFF ON 

* Data saved in PDS version 2.0.4 or later is saved with seam settings. 

** Grade – If saved with only one set of lines visible. 
Hints: 

• Pieces can be displayed with cut lines or sew lines as the perimeter/boundary. 
The non-perimeter sew/cut lines can be displayed or hidden while working using 
Preferences/Hide Seams, also located on the Info bar. 

• The digitized boundary may be viewed using piece properties or changed using 
the function Fix Bound Type. 

• When working with corners, set the Corners Off/On function to On. 
• If Fix Seam Corners is checked in Preferences/Options, line extensions are 

automatically generated when AccuMark pieces with certain corners added in 
version 7.6 are opened in PDS/Silhouette.  

• Use Seam - Swap to Sew/Cut to switch the seam internal lines with the perimeter 
lines. 

What do you want to do? 

 View or hide seams, seam amounts, and corners. 

 Work with corners. 
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 Be prompted about updates to system-generated seam geometry. 

 Work with system-generated intersection points. 

 Learn about seam allowance differences in AccuMark and MicroMark. 

 Grade seam internals. 

 

Viewing Seams and Amounts 

Functions in Preferences and View/Piece/Seam Amounts allow you to view or hide 
seam lines and seam amounts. 

You can also change the default preferences/options for viewing pieces. 

Viewing seam when cut line is 
perimeter/boundary 

Viewing seam when sew line is 
perimeter/boundary 

  

  

What do you want to do? 

 View or hide seams. 

 View seam amounts. 

 View/Hide seam corners. 

 View seam corner types. 

 Set Preferences/Options for whether seam lines display on pieces. 

 Learn about seam allowance differences in AccuMark and MicroMark. 

 See example of seams on pieces with clipped/unclipped extensions. 
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Hints: 
• If for any reason you want to get rid of the seam, use swap sew/cut so the 

perimeter is the sew line, define seam to 0.00, and re-apply seam if desired. 

About Seam Differences 

There are some important differences between how AccuMark and in MicroMark 
systems handle seam allowance and how seam allowance is handled in 
PDS/Silhouette. Refer to the following table. 

AccuMark MicroMark 

Seam allowance is defined for 
each piece. 

Seam allowance can be 
defined from a table. This is 
because boundary lines are 
given labels, which refer to 
specific seam allowance 
values in the table. 

Seam allowance values can 
also be defined for individual 
lines. 

Add Strip function is required 
to return cut lines for marker 
making. 

PDS/Silhouette Note: This 
function is now called Swap 
Sew Cut. 

MicroMark data can be stored 
with the sew line as the piece 
boundary. When the style is 
sent to marker making, the 
cut lines of the piece are 
used. 

PDS/Silhouette Note: It is no 
longer necessary to remove 
the non-boundary seam lines 
from the piece before using 
other functions. 

Seam allowance is graded. In 
some cases it may be 
necessary to use the function 
Adjust Seam Grading to 
maintain the correct seam 
allowance for all sizes. 

Seam allowance is generated. 
This means that the piece is 
graded and seam allowance 
is added to the sizes after 
they are graded. 

Seam may also be graded for 
MicroMark data. 

PDS/Silhouette Note: 
Perimeters are handled as 
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MicroMark Perimeter 
Clipped/Unclipped.  
See samples.  
Set Preferences/Options . 

 

Maintaining vs. Editing Seams 

Setting Pro Con 

Grade Seam 
Corners  

 

Prevents automatic updating of 
system-generated corners and 
seam internals. 

Seam internals do not 
automatically update 
when piece is edited. 

Generate Seam 
Corners  

Do not need Auto Update Seam 
or Adjust Seam Grading.  

 

Sew and Cut lines 
cannot differ.   

Cannot modify corner 
lines. 

Not supported for 
AccuMark data. 

Auto Update 
Seam  

Updates seam on severed 
pieces. 

Informs user when system 
cannot make a specific change. 

Cannot have seam 
internals different from 
the perimeter. 

Seam Extensions  Prevents intersections from 
slipping. Corner placement and 
piece shape as maintained as 
piece is manipulated. 

Complicates piece 
geometry.  

Creates system- 
generated intersections 
which require special 
handling in some 
functions.  

Adjust Seam 
Grading  

Maintains parallel seam 
allowance.  

Applies modified grade 
rule numbers and values 
to piece, which may 
change frequently as the 
piece is modified. 
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Working with System Generated Seam Geometry 

The system automatically updates seam internals and seam corners for pieces 
using the Generate Seam/Corners method and for pieces using the Grade/Seam 
Corners method with Auto Update set to ON. This is equivalent to the way 
MicroMark works when seam allowance is added. If any modifications are attempted 
on these system-generated seam internal or corner lines, the system will ignore the 
selection or not allow the lines to be selected.  

In PDS, it is possible to turn on a notification message that will display whenever 
selections are attempted on system-generated geometry. This gives the user 
feedback on what the system is doing and which selections are valid. This type of 
system response is particularly helpful for new users. 

  

 

The messages can be turned on and off using the Show Seam Warning Message 
option on the General tab of Preferences/Options. When the message displays on 
the screen, the user also has the option to turn off the messages by checking the 
Don’t show this warning again checkbox within the message. 

System-Generated Temporary Intersection Points 

In some cases, the system needs to add a temporary intersection point to a piece. 
These points are necessary when seam internals cross each other and there is no 
point at the intersection of the seam internals. The system will automatically add a 
point at the intersection of the lines so that the lines can be manipulated in the 
expected manner. 

The following example shows how temporary intersection points are generated. 
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Original Piece with original rule on 
perimeter line. 

 

 

Same piece in unclipped mode. Negative 
seam has been added. The seam is offset 
from the original lines and the system has 
generated new rules (31* and 30*) for the 
seam internals. These points are indicated 
in red. In some cases, the system would 
not need to generate new rules: the 
number would display on the seam internal 
the same as it displays on the perimeter 
line.   

Note that the seam internals cross each 
other and that there is not a ‘real’ point at 
the intersection of the seam internals. 

 

The same piece as shown above, but 
shown here in clipped mode. The system 
has clipped the seam internals and added 
a temporary point at the intersection of the 
seam internals.  The system has also 
generated a new rule (3*) for the point.  

 

If the piece from the example above is swapped so that the sew lines become the 
solid lines: 

• The temporary point can be selected for piece modifications 
• The temporary point cannot be used in several grading functions 

Error Message When Grading 

If you try to select the temporary intersection point while using the following 
functionss in the Grade menu, the following error message displays. 
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When using: 

Create Delta, Create Offset, 
Copy Table Rule, Copy Grade 
Rule, Copy X/Y Rule, Copy 
Nest Rule, Copy Nest X/Y, Flip 
X/Y Rule, Rotate 90 

  
To edit grading for the intersection point: 

1. Do one of the following: 

• Work with the other set of lines (i.e. sew vs. cut) 
• Use Fix Bound Type  
• Set the system to unclipped mode and work with the real end of line points 

Define Seam and Preferences/Open without Extensions 

When seam is defined on a piece, it 
can be done so that the seam 
internals intersect or not (see 
illustrations).  

When the option Seam Extensions 
of Edit Seam Properties is OFF (as 
shown at right), positive and negative 
seam amounts are created like in 
illustrations A and C. 

When the option Seam Extensions 
is ON, positive and negative seam 
amounts are created like in 
illustrations B and D. 

Note: These illustrations are viewed 
with Preferences/ Perimeter set to  
‘Unclipped’. 
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A. + Seam with option OFF B. + Seam with option ON 

  

 

  

C. - Seam with option OFF D. – Seam with option ON 

Note: When defining seam, if Adjust Seam Grading is not checked, the seam 
internals are created with the same grade rules that are on the original perimeter. 

Seam - Edit Seam Properties 

Use this function in Define/Add Seam and Update Seam to define the seam properties 
to use on the piece. 

There are two options to set the piece properties: 
1. Maintain Seam Properties – Choose this option to use the properties already 

set in the piece 

2. Edit Seam Properties – Choose this option to apply the settings when seam 
is defined. The piece properties choices are: 

• Seam Extensions – If this box is checked seam extensions will be applied 
when the seam is defined. 

• Generate Seam/Corners – When this option is selected, seam internals 
and seam corners will be generated on the graded sizes at plot and 
Orderload time. 
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• Grade Seam/Corners  - When this option is selected, seam internals and 
seam corners will be graded using grade rules to create the graded sizes. If 
Grade Seam/Corners is selected, there are additional options: 

• Auto Update Seam – If selected the cut and sew lines will be updated 
together when the piece is modified. If this option is not selected pieces 
where the Grade Seam/Corners method have been used to may be 
updated manually by selecting Piece/Seam/Update Seam.  

• Adjust Seam Grading – If selected modified grade rules are created so 
that the seam will be parallel on the graded sizes. When ON, the grading 
of the seam internals is done by the system, by grading out the master 
boundary, adding seam allowance to all sizes and then calculating the 
necessary growths. This results in modified grade rule numbers and 
grade rule values on the non-Master Boundary. When Adjust Seam 
Grading is turned on for the piece, it does not adjust the rules on the 
seam back to the original rules; but continually calculates new rules. 
When using this method and swapping the seam multiple times, slight 
differences may be observed in the graded sizes between the original 
data and swapped data. 

Note: This option only works for pieces where the Grade Seam Corners 
method has been used and is necessary if Match corners will be applied 
to pieces. 

 

Update and Define Seam 
Use with Boundary where Grade Seam/Corner Method has been Applied 

The function Update Seam can be used on pieces that have a boundary where the 
Grade Seam/Corner has been applied. In this case, the sew and cut lines can still 
be manipulated independently, but if Update Seam is used, the seam internal 
(dashed line) will update based on the current piece perimeter (solid line). 

On a piece where the Grade Seam/Corner method has been used, seam may be 
added or the amount currently defined may be changed. On the lines that the seam 
is defined for, the seam internal(s) will update, but the sew and cut lines can still be 
independently modified.  

For AccuMark users, this functionality is similar to working on an AccuMark with 
‘Auto Update’ turned off and then manually selecting ‘Update Seam.’ 

Seam - Define/Add Seam 

AccuMark = Blocks/ Seam/ Define Seam, New 

MicroMark = Piece/ Seam Allowance/ Manual/ Even and Uneven 
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Use this function in the Piece menu to assign seam allowance to one or more 
pieces, either line by line or piece by piece. Pieces can have the cut line or the sew 
line as the perimeter/boundary. The seam amounts can be manually added evenly 
or unevenly (tapered). Seam allowance can also be added to MicroMark pieces 
using a Seam Table.  

You can also use this function to edit or remove existing seam allowance. Once 
seam allowance has been defined on a piece, the amount assigned to each line is 
saved and included in the Edit Line Info.  

 
To assign seam allowance manually:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. From the Piece menu, choose Seam 
and then select Define/Add Seam.  

2. Select Seam Type Manual for 
defining seams: 

• Even – assigns even seam 
allowance manually.  

• Uneven – assigns uneven 
(tapered) seam allowance 
manually.  

3. The Edit Seam Properties 
button displays a dialog box 
with the various options for 
defining seam. The first two 
radio button options, Maintain 
Seam Properties and Edit Seam 
Properties, determine whether 
the existing properties set in the 
piece will be used or the 
properties will be set when 
seam is defined.  

• Maintain Seam Properties- uses 
the properties already set on the 
piece. 

• Edit Seam Properties- applies 
settings when seam is defined. 

• If the Seam Extensions box is 
checked, seam extensions will be 
applied when seam is defined. 

• If Generate Seam/Corners is 
selected, seam internals and 
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seam corners will be generated on 
the graded sizes at plot and 
Orderload time. 

• If Grade Seam/Corners is 
selected, seam internals and 
seam corners will be graded using 
grade rules to create the graded 
sizes. If this option is selected 
Auto Update Seam and Adjust 
Seam Grading are available. 

• Auto Update Seam - updates the 
sew and cut lines together when 
the piece is modified. 

• Adjust Seam Grading - creates 
modified grade rules so that the 
seam will be parallel on the 
graded sized 

4. Select the lines or pieces that 
are to be assigned the same 
seam allowance.  

5. End selection to continue. 

6. Enter the exact amount of seam 
allowance. Do one of the 
following: 

• If the perimeter/boundary lines are 
cut lines, specify negative seam 
amounts.  

• If the perimeter/boundary lines are 
sew lines, type positive seam 
amounts in order to add seam 
allowance to the outside of the 
piece. Enter a zero (0) seam 
amount to remove seam 
allowance.  

The system displays the seam 
allowance applied to the lines 
and/or pieces you selected. 

 

 

 

 

 

 

 

 

 

 

 

  

Display of piece with the cut line 
displayed as the piece perimeter 

  

Display of piece with the sew line 
displayed as the piece perimeter 

To assign seam allowance from a 
MicroMark Seam table: 

 

 

7. End selection to continue 

1. From the Piece menu, choose Seam 
and then select Define/ Add Seam
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and then select Define/ Add Seam.  

2. Select a Seam Table option: 

• Add Cut Lines – adds sew lines 
on the outside of the piece. 

• Add Sew Lines – add cut lines on 
the inside of the piece. 

3. Select the lines or pieces that 
are to be assigned the seam 
allowance.  

4. End selection to continue.  

The system displays the seam 
allowance applied to the lines and/or 
pieces you selected. 
5. End selection to continue. 

Hints: 
• Use Swap Sew/Cut to decide which set of lines you want to work with, and which 

set of lines you want the system to generate.  
• If for any reason you want to get rid of the seam, use swap sew/cut so the 

perimeter is the sew line, define seam to 0.00, and re-apply seam. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 
• Use the Hide Seam setting in the Info Bar or Preferences/Options to turn the 

display of the seam allowance on or off. 
• For AccuMark pieces, the sew line is assigned an internal label of S. 
• For MicroMark data, when seam is defined manually for a line (not from a table), 

that amount overrides the value in the seam table. Use Reset SA Values to have 
the piece use the values from the table. If uneven seam is defined for a line, 
define it back to an even seam amount manually first. To have the piece not read 
the seam table, define the seam value to 0.00 manually. 

• For MicroMark data, the seam amounts are updated automatically while working. 
If the seam table is changed while the style is open, the seam amounts are 
updated to reflect the change. 

• Hotkey (Shift F7). 
• To view seam amounts assigned to each line, use View/Piece/Seam Amount. 
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Seam - Hide/Remove Seam 

AccuMark = Preferences/Hide Seam (now for selected pieces) 

MicroMark =Piece/Seam/Remove Cut, Sew Lines  

 

Use this function in the Piece menu to hide the non-perimeter/boundary lines on 
selected pieces. 

To remove the display of the non-perimeter/boundary seam lines: 

1. From the Piece menu, choose Seam and then select Add/Remove Seam. 

2. Select the piece(s) to hide the display of the non-perimeter/boundary seam 
lines. 

3. Reselect pieces to redisplay the seam lines. 

4. End selection to continue. 
Hints: 

• Saving pieces with seam removed or hidden removes the seam internals for 
plotting and marking.  This can be helpful when only the cut lines are desired for 
markers.  

• Use the option Hide Seam in the Info Bar or Preferences/Options when you want 
to quickly toggle the seam off or on for all of the pieces in the work area. 

  

Seam - Swap Sew/Cut 

AccuMark = Blocks/ Seam/ Add Strip Seam 

MicroMark = Piece/ Seam Allowance/ Switch Digitized 

 

Use this function in the Piece menu to switch the main perimeter/boundary from the 
sew lines to the cut lines and vice versa. All pattern changes must be made on the 
solid line, or the main perimeter/boundary line of the piece. 

For example, when a positive seam is defined on a piece, the original piece 
perimeter/boundary displays solid and the cut lines display as dashed lines. Use this 
function to switch so that the cut line appears solid and the sew line appears 
dashed. 
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AccuMark and MicroMark pieces may be saved with either the cut or sew line as the 
perimeter line. When pieces are sent to marker marking the system will sent the cut 
lines as the piece perimeter. 

To switch the perimeter/boundary line between sew and cut lines: 

1. From the Piece menu, choose Seam and then select Swap Sew/Cut. 

2. When swapping from cut to sew lines for pieces that have been digitized into 
the system with manually-generated seam corners, or for pieces with manual 
corners made in PDS, select from these Digitized Corners options: 

• Ignore – performs a normal swap, swapping each seam internal for its related 
perimeter line. If system-generated corners are applied, swap will automatically 
account for them. 

• Remove – removes manually-created seam corners.  
• Manual/Sever – allows the piece to be swapped and maintains the original 

manual seam corner shape.  
3. Select from these Grade Rules options: 

• Ignore – handles grade rules normally. 
• Move Grade Rules – copies the grade rules from the original piece perimeter to 

the system-generated seam lines. If Adjust Seam Grading was ON, and the rules 
were updated, turn Adjust Seam Grading OFF and use this option to copy the 
original rules back to the seam internals. (Adjust Seam Grading is set using the 
Seams tab in the Preferences/Options.) 

4. Select the pieces whose cut and sew lines you want to switch.  

5. If in step 2 you selected Remove or Manual/Sever Digitized Corners, any 
corners that the system will remove turn the highlighted color. Any lines that do 
not have the seam defined will also be selected for removal or severing. 
Deselect any lines that should not be deleted. 

6. End selection to continue..  

The display of sew and cut lines switches. 

If you selected Remove Digitized Corners, when the swap is performed the system 
removes the manual corner and any other selected lines. Example  

If you selected Manual/Sever Digitized Corners, when the swap is performed the 
system automatically severs the corners. The system recognizes the lines as 
corners, and the piece can be swapped normally maintaining the corner lines. 
Since the corners are considered severed, they can be edited manually just like any 
system-generated corner that has been severed. Example 

Note: To avoid points crossing, the system warns whenever changes made to points 
on a curve cause them to overlap and, when swapped, will shift position.  
Example  

7. To change the lines back again, simply repeat these steps. 

8. End selection to continue. 
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Hints: 
• Functions in PDS/Silhouette manipulate the solid perimeter/ boundary lines. The 

dashed seam lines are automatically regenerated by the system. If you do not 
want the dashed lines to update, set the seam properties to Grade 
Seam/Corners and uncheck Auto UpdateSeam when using the Define Seam or 
Update Seam functions. 

• Sew or Cut displays in the status line next to the piece name field when each 
piece is highlighted. 

• If Remove or Sever is selected, the system will attempt to remove or sever any 
lines with zero seam.  If seam is only defined for part of a piece, be sure to 
deselect any lines you do not wand to remove or sever.  

• Set the focus on a specific piece using Current Pieces in the Edit menu.  
• Use Hotkey (Shift F8), then CTRL A to select all pieces in the work area.  

Swap Sew/Cut Example 

Swap Sew/Cut has three options that allow easy handling of manually-created seam 
corners. Examples shown below. 

• Ignore 
• Remove  
• Manual/Sever 

An example of points crossing when swapped is also included below. 

Use the Ignore option when performing a swap on pieces that have system-
generated corners or pieces without corners. This will perform a normal swap, 
swapping each seam internal for its related perimeter line. If system-generated 
corners are applied, swap will automatically account for them. 

The Remove and Manual/Sever option should be used on pieces with manually 
created seam corners.  

Example: a pattern created by hand has been digitized into the system using the cut lines  

The pattern maker now wants to add seam and work with the sew lines. However, if 
the piece has manually-created seam corners, the piece shape for the sew lines 
cannot be generated correctly by adding seam to all perimeter lines. The corner 
lines often do not need seam added, so the piece ends up with an unequal number 
of seam internal lines compared to piece perimeter lines. An example of such a 
case is shown in the picture below where there are three perimeter lines and two 
seam internals. 
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Original Piece 

Use the Remove option to remove the manually created seam corners. When the 
swap is performed, the system removes the manual corner and any other selected 
lines. 

 

  

Piece directly above after is the original piece after swap with ‘Remove’ option has been used 

 

Use the Manual / Sever option to allow the piece to be swapped, and maintain the 
original manual seam corner shape. When the swap is performed, the system will 
automatically sever the corners. The system will now recognize the lines as corners, 
and the piece can be swapped normally maintaining the corner lines. Since the 
corners are considered severed, they can be edited manually just like any system-
generated corner that has been severed. 

 320 



Note: When the Remove or Manual /Sever options are used, the system looks for 
any line that has zero (no) seam defined, and will highlight those lines.  If some lines 
have zero seam defined but you do not want them to be removed or become 
manual corners, be sure to deselect those lines when prompted. 

 

  

Original piece from above after swap with ‘Manual / Sever’ option has been used. Original 
corner shape is maintained and system now recognizes corner as ‘Severed’ corner. 
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Sew/Cut Example: Points Cross when Swapping 

The system warns whenever changes made to points on a curve cause them to 
overlap (shown below) and, when swapped, shift position. 

 

  

Seam - Update Seam 

AccuMark = Blocks/ Seam/ Update Seam 

MicroMark = Automatic 

  

Use this function in the Piece menu to update the non-perimeter/boundary seam line 
to match changes made to the boundary line, or to change or edit the seam settings 
for a piece if Grade/Seam Corners were previously used. 

To update a non-perimeter/boundary seam: 

1. From the Piece menu, choose Seam and then select Update Seam. 

2. Select this option: 
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• Ignore – updates the seam internal shape to correspond to the perimeter shape 
and maintains the existing grade rules.  

• Adjust Seam Grading – applies Adjust Seam Grading on a per piece basis. If 
necessary, new grade rules are calculated to maintain parallel seam for all 
graded sizes. 

• Copy Grade Rule – copies the grade rule from the current piece perimeter to the 
seam internals. When a piece is graded, this option may be used to update the 
shape of the graded seam internals without creating additional modified rules.  

3. Select the piece(s) to update seams for. 

4. End selection to continue. 
Hints: 

• Seam shape may be updated automatically by using the Generate Seam/ 
Corners seam setting. Seam shape is also updated automatically when the 
Grade Seam/Corners seam setting along with the Auto Update Seam option are 
used. 

• When the Adjust Seam Grading radio button of the Seam Grade Rules is 
selected the piece is updated once. When the Adjust Seam Grading check box of 
Edit Seam Properties is checked the option is continuously applied to the piece. 

• To have greater control of grade rule numbers, use a seam setting where Adjust 
Seam Grading is off.  Then, use Update Seam with the Adjust Seam Grading 
option to apply Adjust Seam Grading toward the end of the pattern making 
process, or only for pieces where the angle changes significantly between the 
smallest and largest sizes.  

 Related Topics  

Seam - Copy Piece No Seam 

AccuMark = Blocks/ Seam/ Copy Block No Seam 

MicroMark = New 

 

Use this function in the Piece menu to make a copy of a piece geometry without 
carrying over seam allowance or corner information from the original piece. You can 
then edit the copied piece without the restrictions of system generated corner 
shapes. For example, you can delete the sew lines or move a corner point. The sew 
lines may be carried over but cannot be updated.  

To copy a piece with no seam information: 

1. From the Piece menu, choose Seam and then select Copy Piece No Seam. 

2. Select the piece to copy.  

An identical copy of the piece is created. 
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3. Move the cursor and click left to reposition the piece in the work area. 

4. Specify a new piece name. Or, to use the current name, click OK or press 
Enter. 

The system copies the seam lines as S internals. 
5. End selection to continue. 

Hints: 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 
• Swap Sew/Cut can no longer be used.  
• If seam internal lines are not desired in the new piece, use Hide Seams prior to 

using Copy Piece No Seam.  

 

Seam - Fix Bound Type 

AccuMark = Not/Applicable 

MicroMark = Seam/Fix Boundary Type 

 

Use this function in the Piece menu to indicate whether the sew lines or the cut lines 
are the original digitized piece perimeter/boundary.  

Fix Boundary Type also forces the intersection of the seam internals so that no 
extensions or gaps exist (see illustrations in Define Seam section). 

CAUTION: This option makes the current perimeter the selected perimeter, which 
means that the piece shape can change sizes depending on what is selected. For 
example, if the current perimeter is the sew line and it is redefined as the cut line, the 
total area of the piece becomes smaller. 
To fix perimeter/boundary type: 

1. From the Piece menu, choose Seam and then select Fix Bound Type. 

2. Select the Sew Boundary or Cut Boundary option. The system will use the set 
of lines selected, make them piece perimeter and update the other set of seam 
lines. 

3. Select the piece(s) to fix boundary types for. 

4. End selection to continue. 
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Example: 

If the piece perimeter is currently the sew lines and this function is used to switch 
the Master Boundary to the Cut lines,  

Then the current perimeter is identified as the cut lines and sew lines are then 
added to the piece. The piece information is also updated.  

Hints: 
• Use Piece Properties to check the current Digitized Boundary. 

 Related Topics  

Seam - Reset SA Values 

AccuMark = Not Applicable 

MicroMark = Seam/Reset SA Values 

 

Use this function in the Piece menu to override any manual seam amounts that 
were defined for any lines on a piece. After the function is used, all boundary lines in 
the piece get their seam amounts from the seam table. 

To reset seam allowance: 

1. From the Piece menu, choose Seam and then select Reset SA Values. 

2. Select the piece(s) to reset seam allowance. 

3. End selection to continue.  
Hints: 

• To view seam amounts assigned to each line, use View/Piece/Seam Amount. 
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Seam - Grade Seam/Corners 

AccuMark = Preferences/Auto Update Seam OFF 

MicroMark = Seam/Sever Boundary 

 

Use this function in the Edit Seam Properties button in some of the Seam functions 
of the Piece menu, to prevent non-perimeter/boundary lines from being updated 
when the piece perimeter/boundary is modified. When the piece is set to Grade 
Seam/Corners, the grade rules from the piece perimeter/boundary will be copied 
onto the seam internals. 

Note: The Grade Seam/Corners method is comparable to the classic AccuMark 
method of applying seam allowance. 

Hints: 
• The Grade Seam/Corners method is supported for both AccuMark and 

MicroMark data. 
• The Grade Seam/Corners seam setting may be defined for pieces as seam is 

being defined or updated by selecting the option in the Define Seam and Update 
Seam functions. 

• If Auto Update is ON for the piece, the seam internal shape will continue to 
change as the perimeter/boundary line is changed. 

• Changing a piece to the Grade Seam/Corners method, changes how seam 
internals and seam corners are created for graded sizes. When using this 
method, Adjust Seam Grading may also need to be used. 

  

Seam - Generate Seam/Corners 

AccuMark = Blocks/Seam/Update Seam, or Auto Update Seam On 

MicroMark = Seam/Relate Boundary 

 

Use this function in the Edit Seam Properties button in some of the Seam functions 
of the Piece menu, to update non-perimeter/boundary lines after the piece 
perimeter/boundary is modified using different functions. This is similar to the 
Update Seam function but maintains the relationship as the piece is modified. When 
this method is used, seam internals and corners are system-generated for each 
graded size. 
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Hints: 
• The Generate Seam/Corners method is supported for both AccuMark and 

MicroMark data on release 8.0 and higher. It is not supported for AccuMark data 
on previous versions. If AccuMark data will be used on earlier versions of 
AccuMark, using the Generate Seam/Corners method may result in differences 
in the graded sizes when viewed or processed on previous versions of 
AccuMark. 

• Changing a piece to the Generate Seam/Corners method, changes how seam 
internals and seam corners are created for graded sizes. Seam internals and 
corners are generated rather than graded. 

 

Seam Extension 

Seam extensions allow piece geometry to be correctly maintained as a piece is 
swapped or corners are applied.   

When ON, seam extensions are defined for a piece.  This is the portion of the line 
cut or sew that exists beyond the temporary intersection points. 

When OFF, seam extensions are clipped when a piece which was previously 
created on Classic MicroMark PDS or PDS is retrieved. If a piece previously created 
on Classic AccuMark PDS is retrieved, no change is made to the piece. 

Using Seam Extensions  

This setting can be helpful if pieces have extreme angles (very sharp, such as darts 
or very shallow, such as the some princess lines on a body piece) This setting is 
also recommended if corners are going to be applied to pieces, particularly Match 
Corners.  

 

 

Seam/Adjust Seam Grading and Update Seam 

System generated grading on seam internals can be done: 

On a per piece basis using the function Piece/Seam/Update Seam - Adjust Seam 
Grading  

If Adjust Seam Grading is checked in the Edit Seam Properties function. 

Note: When Match corners are applied, this option is necessary to achieve the 
correct corner results in the graded sizes.   
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When this option is used, the grading of the seam internals is done by the system. 
PDS grades out the master boundary, adds seam allowance to all sizes and then 
calculates the necessary growths. This is the same as the function Adjust Grading in 
Classic AccuMark PDS. 

When Adjust Seam Grading is turned on for the piece, it does not adjust the rules on 
the seam back to the original rules; but continually calculates new rules. When using 
this method and swapping the seam multiple times, slight differences may be 
observed in the graded sizes between the original data and swapped data. 

When this option is not used, the grade rules from the original boundary are copied 
to the seam internals.  

  

  

When Adjust Seam Grading is 
OFF, the grade rule numbers 
remain the same between the 
Digitized Boundary and the 
system-generated seam lines. 

  

When Adjust Seam Grading is 
ON, new grade rule numbers 
and grade rule values are 
created by the system on the 
non-Digitized Boundary.  
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When the non-Digitized 
Boundary is the current piece 
perimeter, modified rule 
numbers may be displayed on 
both the perimeter and the non-
perimeter seam lines. 

Note:  This option is useful for maintaining parallel seam when there is a noticeable 
change in the angle of a corner from the smallest size to the largest size.  In these 
cases, copying the grade rule to the seam internal may not maintain parallel seam 
allowance for all sizes.  

Example of Piece with Grade Seam Corners method with a changing Angle 
between sizes 

  

Piece without Adjust Seam Grading.  Rule 10 is used for both the perimeter and 
seam internal.  Seam allowance is not parallel for all sizes due to angle changing 
significantly on graded sizes.  
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Piece after Adjust Seam Grading is used.  Rule 3* has been calculated for the seam 
internal.  Seam allowance is correct for all graded sizes.  

Hints: 

• If greater control over grade rule numbers is desired, apply Adjust Seam Grading 
on a piece-by-piece basis using Update Seam or as a post process routine after 
pieces have been completely developed.  

• This option only works on pieces using Grade Seam Corners method in 
boundaries/perimeters. 

 

Corners 

Overview of Working with Corners 

Functions in Piece/Seam menu allow you to create special types of corners, return 
to a regular corner, and turn the display of corners on or off.  

A Corner is a special shape applied to the cut lines of a piece that is different in 
shape from the sew lines. Corners are typically used to enhance construction and to 
make production more efficient.   

Guidelines for working with corners 

Pieces need to have seam defined before a corner is applied. Some corners may be 
applied when seam is defined for only one of the corner lines. Refer to the help for 
specific corner types to view the requirements. 

Corners may be applied where two perimeter lines intersect.  When adding the 
special corner type, the system may prompt to select the line before or after the 
corner. These lines are referenced by a clockwise direction of movement around the 
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piece from the corner point. For example, if at the actual point where the two lines 
intersect, moving clockwise around the piece to the next perimeter line would put 
you on the line after the corner.   

After a special corner type is applied, the system creates new geometry.  The 
original intersection of perimeter lines is replaces by a single system-generated line 
on the piece(s) where he corner was added. The perimeter lines, which connect to 
either side of the corner line, are referred to as the Adjacent lines. 

When a seam corner is applied to a piece, the system will continue to update the 
corner geometry as the piece is modified. If the shape of the piece is changed in 
such a way that the system can no longer calculate the correct corner shape for one 
or more sizes, a warning message will display:  

"Piece modification has invalidated a corner angle … no corner generated at 
point" 
 

Note: Since the corner geometry does continue to update, some corners work best if 
applied toward the end of the development process, after the major pattern changes 
have been made.  

Some corner types require specific handling and seam settings for them to work 
correctly.  Please refer to the help topics for the individual corner types for further 
information.  

Hints: 
• Special corners can only be created on pieces that have seam allowance. 
• Seam allowances can be modified without losing corner attributes, though some 

piece modifications may invalidate a corner type.  
• If a corner is slipping or not maintaining the correct geometry when using Swap 

Sew/Cut, Seam Extensions may be needed. 
• When working with corners, set the Corners Off/On function to On. 
• You can remove special corner types by replacing them with the standard corner. 
• Once corners are applied, if a piece changes shape due to modification, the 

system will recreate the corner to ensure it is still the correct shape. 
• If you have previously worked with AccuMark or MicroMark pattern design 

systems, many of these functions will be familiar. However, you may improve 
your productivity by taking time to get acquainted with some new methods for 
working with corners. 

NOTE: Some functions can only be used on pieces that will be saved as either 
AccuMark or MicroMark data. For example, there is no support for TabCorners in 
the AccuMark piece format. The abbreviations, (AM) and (MK) appear after specific 
function names in drop-down menus. 

What do you want to do? 

 Display or hide corners. 
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 Display seam corner types. 

 Remove corners. 

 Learn about notch options for corners. 

 Work with seams. 

 Troubleshoot Squared Corners. 

 Troubleshoot Match Corners. 

Notch Options for Corners 

There are three types of notches, each of which can be applied to all corner types 
except for envelope corner and step corner-perpendicular, bisect, and slanted. The 
corner line that is notched can also be controlled. Select from these options when 
using functions in the Seam menu to create a corner. 

 

  

 

Notch Type Options 
• None – If selected, no notch type assigned to a corner. If a corner already had 

either perpendicular or extension applied to it, changing it to No Notch removes 
it. 

• Perpendicular Notch – the system calculates where a perpendicular line 
created from the intersection of the sew lines would intersect with the two cut 
lines and creates notches at those locations. 

 

 332 



  

 
• Extension Notch – the system extends the sew lines to the adjacent cut lines 

and creates notches at those locations. 

 

  

 

Notch – Select the appropriate type and depth of Notch. 

Note: The options that are displayed in the dropdowns are controlled in 
Preferences/Environment: AccuMark or MicroMark 

Notch Line Options – When notches are added, the Notch Line Options allow you 
to control whether notches are added to both corner lines, or just the first or second 
(determined by clockwise direction). 

 
Hints: 

• For Match Seam and Match Square corners, if notches are desired on the first 
line of one piece and the second line of the corresponding piece, flip one of the 
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pieces and then apply the corner using the option, First or Second, that allows 
the correct line to be notched on both pieces. 

• Corner notches are considered part of the corner and will display only on the cut 
line. They also continue to update as seam amounts or the corner is changed. 

 

Seam - Corners On/Off 

AccuMark = Blocks/ Seam/ Corners On/Off 

MicroMark = New 

 

Use this function in the Piece menu to turn the display of seam corner types on or 
off. The corner information is not removed from the piece. This function operates 
like a toggle switch in that you can switch it off or on by clicking on it. 

To change the display of corners: 

1. From the Piece menu, choose Seam and then select Corners On/Off. 

2. Select the piece(s) in the work area whose corners are to be turned off or on.  

3. End selection to continue. 

The system displays or hides the corners on the pieces. 
Hints: 

• Use this function to look at the original cut line shape without having to remove 
and reapply the corner. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Seam - Remove Corner 

AccuMark = New 

MicroMark = Piece/ Seam Allowance/ Standard Corner 

 

Use this function in the Piece menu to remove any corner treatment applied to a 
corner. 
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Regular Corner Remove Corner 

Corner with a Regular Corner applied 
using the Perpendicular Notch option on 
both lines. 

  

Corner, after using Remove Corner, with 
all system-generated corner geometry 
and notches removed 

  
To apply remove corner 

1. From the Piece menu, choose Seam and then select Regular Corner or 
Remove Corner. 

2. Select from these options: 

• Selection Type – choose Point to remove corners point by point or Piece to 
remove all corners for the piece. 

3. Select the corner you want to remove, or select the piece you want to change 
all corners for. 

The system removes any special corner type and makes it a regular corner. 
4. End selection to continue. 

Hints: 
• Use Remove Corner to remove any special seam corner shape. Use Regular 

Corner to remove any special seam corner shape but maintain or add notches on 
the cut line(s). 

• Remove Corner may also be used on severed corners. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Seam - Regular Corner 

AccuMark = Blocks/ Seam/ Corners/ Regular Corner 

MicroMark = Piece/ Seam Allowance/ Standard Corner 

 

A regular corner is formed where the cut lines normally intersect. Use this function in 
the Piece menu to remove a special corner type from your seam allowance. You 
can also use this corner to add corner notches to the cut lines. 

To apply regular corners to a piece: 

1. From the Piece menu, choose Seam and then select Regular Corner. 

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Selection Type – choose Point to define corners point by point or Piece to 

define all corners for the piece. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, this 

is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" = 
Yes. 

3. If creating notched corners, select a Notch Type from the drop-down list box. 
For MicroMark data, enter a depth value for the notch. 

4. Select the corner you want to make into regular corner. Or, select the piece 
you want to change all corners for. 

The system removes any special corner type and makes it a regular corner. 
5. End selection to continue. 

Hints: 
• Before using this corner function, seam needs to be defined for at least one of 

the corner lines. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Seam - Slant Corner 

AccuMark = Blocks/ Seam/ Corners/ Slant Corner 

MicroMark = Not/Applicable 

 

Use this function in the Piece menu to create a slant corner. The system extends 
each sew line to the adjacent cut line. A new corner line is created between the two 
intersection points, clipping off the original corner shape. 

 

  

Slant corner construction 

 
To create a slant corner: 

1. From the Piece menu, choose Seam and then select Slant Corner. 

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, this 

is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" = 
Yes. 

3. If creating notched corners, select a Notch Type from the drop-down list box. 

4. Select the corner you want to make a slant corner. Or, select the piece you 
want to change all corners for. 

The system creates the mitered corner type. 
5. End selection to continue. 
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Hints: 
• Before using this corner function, seam needs to be defined for at least one of 

the corner lines. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Seam - Mitered Corner 

AccuMark = Blocks/ Seam/ Corners/ Mitered Corner  

MicroMark = Piece/ Seam Allowance/ Corner/ Miter 

 

Use this function in the Piece menu to create a corner seam that is clipped to form a 
straight edge in order to eliminate excess fabric. Known as a mitered corner, the 
corner line may be sewn to itself allowing a cleanly finished corner when it is turned 
right side out. 

The distance for the corner (Line A in the pictures) is measured from the intersection 
of the sew lines along a line that bisects the angle formed by the sew lines. The new 
corner line is then drawn perpendicular to the measurement line and intersects the 
adjacent cut lines.  

 

 

Mitered corner construction with equal seam amounts 
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Mitered corner construction  with different seam amounts. 

 
To create a mitered corner: 

1. From the Piece menu, choose Seam and then select Mitered Corner. 

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, 

this is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" 
= Yes. 

3. If creating notched corners, select a Notch Type from the drop-down list box. 
For MicroMark data, enter a depth value for the notch. 

4. Select a corner to be made into a mitered corner. When you select the corner, 
a line displays across it. 

5. Indicate where you want to clip the corner seam.  

• In Cursor mode, move the line until it is at the point where the corner seam will 
be clipped. Click to place accept. 

• In Value mode, type the exact distance from the sew line to the clip in the Dist 
field. Click OK or press Enter. 

The system creates the mitered corner and the piece is redrawn on the work area. 
6. End selection to continue. 

Hints: 
• Before using this corner function, seam needs to be defined for at least one of 

the corner lines. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Seam - Double Miter Corner 

AccuMark = Not/Applicable 

MicroMark = Piece/ Seam Allowance/ Corner/ Double Miter 

 

Use this function in the Piece menu to create a double-miter corner. This creates a 
slanted line across the corner, the angle of which is determined by two user-defined 
distances. 

Double-Mitered corners are constructed based on two distances measured from the 
intersection of the cut lines.  Each distance may be up to or equal to the seam 
amount defined for the corresponding line.  For example, in the picture shown, the 
first distance (1) may be up to or equal to the seam amount A.  The second distance 
(2) may be up to or equal to the seam amount B.  The corner is a straight line drawn 
between the 2 points. 

 

  
Double Miter Corner Construction shown with Different Seam Amounts. 

 
To add a double miter corner: 

1. From the Piece menu, choose Seam and then select Double Miter Corner.  

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, 

this is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" 
= Yes. 
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3. If creating notched corners, select a Notch Type from the drop-down list box 
and enter a depth value for the notch. 

4. Select a corner to be made into a double-mitered corner. When you select the 
corner, a line displays across it. 

5. Indicate where you want to clip the corner seam for each cut line.  

• In Cursor mode, move the line until it is at the point where the corner seam will 
be clipped. Click to place.   

• In Value mode, type the exact distance from the cut line intersection to the clip in 
the Dist field. Click OK or press Enter. 

The system creates the mitered corner and the piece is redrawn on the work area. 
6. End selection to continue.  

Hints: 
• Before using this corner function, seam needs to be defined for at least one of 

the corner lines. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Seam - Manual/Sever Corner 

AccuMark = New 

MicroMark = Piece/ Seam Allowance/ Corners/ Sever 

 

Use this function in the Piece menu to sever a corner so that the shape of the corner 
can be independently manipulated. After a corner has been severed, the system will 
no longer regenerate the corner or update the shape when the piece is modified. To 
have the system update the corner again, the corner must be reapplied.  

To sever a corner: 

1. From the Piece menu, choose Seam and then select Manual/Sever Corner.  

2. Select the line(s) that should become manual/severed corners 

3. End selection to continue. 
 
The corner lines are severed.  If seam was defined for the corner line, it is 
removed. 

 

Example of Severed Corners 
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This image shows corners that have been manually made.  The corner lines are 
split and seam is defined for all lines.  The areas in the red circles show how the 
seam internal shape is not correct or overlaps. 

  
 

In this example, Sever Corner has been used on the lines shown in red.  The seam 
is removed for the corner line and the seam internals on the adjacent lines now 
intersect correctly. 

 

  
 

AccuMark Data 

In the past, AccuMark users would have used ‘Copy Piece No Seam’ in order to 
manually manipulate the corner shape. The ‘Sever Corner’ function may be used 
instead of the ‘Copy Piece No Seam’ function to: 

• Edit some of the corners on a piece  
• Maintain seam allowance and have it continue to update as pattern modifications 

are made 

Note: Severed corners are not supported on Classic AccuMark PDS. If 
Manual/Sever corner is applied to a piece in Pattern Design and the piece is 
retrieved into Classic AccuMark PDS, the severed corner will exist until Update 
Seam or Auto Update Seam is used. It will then reapply the original corner. 
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Hints: 

• The area that you want to be a manual corner should be one single line that is split 
along the piece perimeter where you want the corner to begin and end. 

• Manually made corners may also be severed in the function Swap Sew/Cu by 
selecting the option Manual/Sever. 

• After corners are severed, they do not display a corner type when View/Seam 
Corner Types is used.   

• The function Remove Corner may be used to remove the severed corner and 
return to the original geometry.  

 

Seam - Tab Corner 

AccuMark = Not/Applicable 

MicroMark = Piece/ Seam Allowance/ Corner/ Tab 

 

Use this function in the Piece menu to create an extension the width of the seam 
allowance.  

 

  
 
 

Tab Corner Construction, second line selected 
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Tab corners are created perpendicular to the line selected for the corner.  The first 
distance entered (1) is measured from the intersection of sew lines. The second 
distance entered (2) determines where the tab blends into the adjacent cut line.  
This distance is measured from a perpendicular line drawn between the sew line 
intersection and the adjacent cut line.  In this example, a value of zero was entered.  
The dashed blue line indicates possible results if a larger value is entered. 

 
To add a tab corner: 

1. From the Piece menu, choose Seam and then select Tab Corner.  

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
3. If creating notched corners, select a Notch Type from the drop-down list, box 

and enter a depth value for the notch. 

4. Select the corner you want to make a tab corner. Select the line along which to 
generate the corner. The line selected is the line that the corner is squared 
from. 

5. Indicate where you want the corner to intersect for each cut line. 

• In Cursor mode, move the line until it is at the point where the corner seam will 
be extended. Click to place.   

• In Value mode, type the exact distance desired for each extension in the Dist 
field. Click OK or press Enter. 

The system creates the tab corner and the piece is redrawn on the work area. 
6. End selection to continue. 

Hints: 
• Before using this corner function, seam needs to be defined for both the corner 

lines. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

 

Seam - Nub Extension Corner 

AccuMark = Not/Applicable 

MicroMark = Piece/ Seam Allowance/ Corner/ Nub Extension 

 

Use this function in the Piece menu to create an extension off the seam allowance. 
The extension for a Nub Extension corner is measured along the selected corner 
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line from the intersection of the selected line and the adjacent sew line (Indicated by 
1 in the picture).  The corner is then drawn from the extended point to the other sew 
line/cut line intersection.  

 

  
Nub Extension Corner Construction, first line selected 

 
To add a nub extension corner: 

1. From the Piece menu, choose Seam and then select Nub Extension Corner.  

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Select Line – Select the line along which to generate the corner, then place the 

tip of the corner. 
3. If creating notched corners, select a Notch Type from the drop-down list box 

and enter a depth value for the notch. 

4. Select the corner you want to make a Nub Extension corner. Select the line 
along which to generate the corner. This is the line that you want to extend. 

5. Indicate how far you want the corner to extend. 

• In Cursor mode, move the line until it is at the point where the corner seam will 
be extended. Click to place.   

• In Value mode, type the exact distance desired for the extension in the Dist field. 
Click OK or press Enter. 

The system creates the Nub Extension corner and the piece is redrawn on the work 
area. 
6. End selection to continue. 

Hints: 
• Before using this corner function, seam needs to be defined for both the corner 

lines. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Seam - Mirrored Corner 

AccuMark = Blocks/ Seam/ Corners/ Mirrored Corner 

MicroMark = Piece/ Seam Allowance/ Corner/ Mirrored 

 

Use this function in the Piece menu to add a corner that is mirrored about a selected 
line. 

 

  
Mirror Corner Construction, second line selected 

 

  
Mirror Corner Construction, first line selected 
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To add a mirror corner: 

1. From the Piece menu, choose Seam and then select Mirrored Corner.  

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, 

this is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" 
= Yes. 

3. If creating notched corners, select a Notch Type from the drop-down list box. 
For MicroMark data, enter a depth value for the notch. 

4. Select a corner to be made into a mirror corner. 

5. Select a perimeter/boundary line that is before or after the corner to mirror 
about. A mirror corner seam is created. 

6. End selection to continue. 
Hints: 

• Before using this corner function, seam needs to be defined for at least one of 
the corner lines. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Seam - Turnback Corner 

AccuMark = Blocks/ Seam/ Corners/ Turn Back Corner 

MicroMark = Not/Applicable 

 

Use this function in the Piece menu to create a mirrored corner on both ends of a 
line, called a turnback seam. PDS/Silhouette generates a fold back corner on each 
end of the line you choose. This function is frequently used for sleeve or trouser 
hem.  

To create a turnback seam: 

1. From the Piece menu, choose Seam and then select Turnback Corner. 

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, 

this is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" 
= Yes. 
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3. If creating notched corners, select a Notch Type from the drop-down list box.  

4. Select the corner you want to make a turnback corner by selecting the line that 
serves as the fold line.  Mirror corners will be applied to both ends of this line.  

The system creates the Turnback corner type. 
5. End selection to continue. 

Hints: 
• Before using this corner function, seam needs to be defined on the line selected 

for the corner. 
• If notches are desired at both ends of where the corner folds back, select Both 

for the Notching Line option and Extension for the Notch Type option. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Seam - Frame Corner 

AccuMark = Blocks/ Seam/ Corners/ Frame Corner 

MicroMark = Not/Applicable 

 

Use this function in the Piece menu to create a framed corner seam on a corner with 
an angle of less than 90 degrees. 
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Frame corner construction on angle -less than 90 degrees 

A frame corner is constructed by offsetting each sew line inside the piece by the 
amount of seam defined for that line.  These offset lines are then extended to 
intersect the cut lines.  The corner line is drawn from each intersection point, 
perpendicular to the offset line, until the two lines intersect forming the new frame 
corner shape. If this option is used on an angle that measures more than 90 
degrees, the system creates a double mitered corner. 

 To create a framed corner: 

1. From the Piece menu, choose Seam and then select Frame Corner. 

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, 

this is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" 
= Yes. 

3. If creating notched corners, select a Notch Type from the drop-down list box.  

4. Select the corner you want to make a frame corner.  

The system creates the frame corner type. 
5. End selection to continue. 
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Hints: 
• Before using this corner function, seam needs to be defined for both the corner 

lines. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Seam - Envelope Corner 

Use this function in the Piece menu to create an envelope corner. This corner is 
similar to a mitered corner but the corner line of an envelope corner is not necessarily 
a straight line as it is in a mitered corner.  

The envelope corner is constructed by offsetting a line inside the sew lines by the 
amount of seam define for that line. An angle bisector is then drawn from the original 
sew line intersection to the intersection of the offset lines. The angle bisector is then 
mirrored about the sew lines forming the corner shape. A seam amount or distance 
can be entered to offset this line and allow for sewing (indicated by distance C in the 
image below). 

  
To create an envelope corner: 

1. From the Piece menu, choose Seam and then select Envelope Corner. 

2. Select a corner to make an envelope corner. 

3. Notch Type - Select a notch type to use for the corner. 

4. Indicate distance of the new postion. 

• In Cursor mode, move the line until it is at the point where the corner seam is at 
the location desired. Click to place.   

• In ce desired for the envelope corner in the 
Dist field. Click OK or press Enter. 

Value mode, type the exact distan
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5. End selection to continue. 
Hints: 

• Use this corner for sleeve or skirt vents where a mitered corner is desired but the 
angle of the corner is less or greater than 90 degrees. 

 

Seam - Perpendicular Step Corner 

AccuMark = Blocks/ Seam/ Corners/ Perpendicular Step Corner 

MicroMark = Piece/ Seam Allowance/ Corner/ Step 

 

Use this function in the Piece menu to create a perpendicular step where the seam 
allowance amount changes width. The line segment created for the step is 
perpendicular to either of the lines adjacent to the corner. Generally, this function is 
applied to straight lines, but you can use it on corners. Kick pleats, and plackets are 
common examples. 

  

Perpendicular Step Corner Construction, first line selected 

Before applying a step corner: 
• Split the line where the step will be applied. 
• A grade point should be added at the split point to help control grading and seam 

internals on graded sizes.  
• There should be an equal amount of seam allowance defined for each of the line 

segments. 
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To create a perpendicular step corner: 

1. From the Piece menu, choose Seam and then select Perpendicular Step 
Corner. 

2. Select the point to be made into a perpendicular step corner.  

3. Choose the perimeter/boundary line either before or after the corner that you 
want the step to be perpendicular to. 

4. Click on the line to have seam allowance modified. Both design lines should 
have the same amount of seam allowance applied to them.  

5. Type the amount of seam allowance to apply to the line. Click OK or press 
Enter.  

The system creates the perpendicular step corner. 
6. Select the location for the Curve Type desire: 

• None- Use this option to add a step corner with standard, angular corners. This 
option does not add any special curve shape. 

• Curved intersection - Use this option to add a curved intersection (circular 
shape) at one or more corner points. They system allows to add up to two curved 
intersections corners in a line at one time. 

• Oval – Use this option to add an oval shape to one or more corner points. The 
system allows adding one oval corner in a line at one time. 

7. End selection to continue. 
Example of a Perpendicular Step Corner applied adjacent to Zero Seam 

  

In certain cases, a step shape is needed next to an area that has zero seam 
defined.  In these cases, define seam for both lines involved with the step corner.  
The seam width should be the width of the final step.  Then, select the line that 
should have no seam as the line to modify and enter a seam amount of zero.  An 
example of this is shown above  In this case, seam was defined for lines 1 and 2.  
The corner was squared from line 1 and line 2 was selected as the line to modify.  
An amount of zero was entered.  Line 3 also has zero seam defined. 
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Hints: 
• To remove a step corner, set the seam allowance value of one of the lines to 

equal the other. 
• For straight lines, Bisect Step Corner will give the same result as Perpendicular 

Step corner, but with fewer steps. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 

 

Seam - Bisect Step Corner 

AccuMark = Blocks/ Seam/ Corners/ Bisect Step Corner 

MicroMark = Not/Applicable 

 

Use this function in the Piece menu to create a step that bisects an angle where the 
seam allowance amount changes width.  

When you use this function, the system creates a line segment for the step. This line 
bisects the angle created by the two adjacent lines.  

 

  
Bisect Step Corner Constructed on Outside Corner 
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Bisect Step Corner Constructed on Inside Corner 

 
Before applying a step corner: 

• Split the line where the step will be applied.  
• A grade point should be added at the split point to help control grading and seam 

internals on graded sizes. 
• There should be an equal amount of seam allowance defined for each of the line 

segments. 
To create a bisect step corner: 

1. From the Piece menu, choose Seam and then select Bisect Step Corner.  

2. Select the point for the Bisect Step Corner. 

3. Click on the line with the seam allowance the system is to modify. 

4. Type the amount of seam allowance for the line. Click OK or press Enter. 

The system creates the bisecting step corner seam. 
5. Select the location for the Curve Type desire: 

• None- Use this option to add a step corner with standard, angular corners. This 
option does not add any special curve shape. 

• Curved intersection - Use this option to add a curved intersection (circular 
shape) at one or more corner points. They system allows to add up to two curved 
intersections corners in a line at one time 

• Oval- Use this option to add an oval shape to one or more corner points. The 
system allows adding one oval corner in a line at one time. 

6. End selection to continue. 
Hints: 

• To remove a step corner, set the seam allowance value of one of the lines to 
equal the other. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
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Seam - Slanted Step Corner 

Use this function in the Piece menu to create a slanted step corner. This function can 
be used to apply a step corner to a piece with an angled step line. The angle of the 
step can be defined by an offset amount from the perpendicular location or by defining 
an angle.  

  
Slanted Step Corner constructed on first line 

Before applying a step corner: 
• Split the line where the step will be applied.  
• A grade point should be added at the split point to help control grading and seam 

internals on graded sizes. 
• There should be an equal amount of seam allowance defined for each of the line 

segments. 
To create a slanted step corner: 

1. From the Piece menu, choose Seam and then select Slanted Step Corner. 

2. Select the point for the Slanted Step Corner. 

3. Select the location for the Curve Type desire: 

• None- Use this option to add a step corner with standard, angular corners. This 
option does not add any special curve shape. 

• Curved intersection - Use this option to add a curved intersection (circular 
shape) at one or more corner points. They system allows to add up to two curved 
intersections corners in a line at one time 

• Oval- Use this option to add an oval shape to one or more corner points. The 
system allows adding one oval corner in a line at one time. 

Note: If Curve Intersection or Oval is selected, the system will prompt for the corner 
point(s) where the curve(s) should be added. If no curves are desired, or when 
finished adding curves, End Selection to complete the corner. 

4. Click on the line with the seam allowance the system is to modify. 

5. Type the amount of seam allowance for the line. Click OK or press Enter. 

6. Indicate where the step should slant. 
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• In Cursor mode, move the step until it is at the desired angle. Click to place. 
• In Value mode, type the exact distance in the Dist field or anangle value in the 

Ang. Field. Click OK or press Enter. 
7. If Curved Intersection or Oval is selected, indicate the corner point(s) where 

the curve type should be. 

Note: When Oval is selected, one corner point may be selected. When Curved 
Intersection is selected, up to two corner points may be selected. 

The system creates the slanted step corner and the piece is redrawn on the work 
area. 

Hints: 
• To remove a step corner, set the seam allowance value of one of the lines to 

equal the other. 
• Set the focus on a specific piece using Current Pieces in the Edit menu. 

Curve Type Options for Step Corners 

There are three options for Curve type, which may be applied for each of the three 
Step Corner types. Select from these options when using th Step Corner functions. 

  

Curve Type Options 
None  

 Use this option to add a step corner with standard, angular corners. This option 
does not add any special curve shape. 

Curved Intersection  

Use this option to add a curved intersection (circular shape) at one or more corner 
points. They system allows to add up to two curved intersections corners in a line at 
one time.  

This type or corner is often used in skirt vents that will be bound. Curve intersection 
corners are used when automated cutting or sewing is critical.\ 

To create a curve intersection: 

After the corner has been created: 
1. Select location for corner curve. 

• In Cursor mode, select the radius and left click.  
• In Value mode, type the amount of the radius in the Dist field. Click OK or press 

Enter. 
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2. Select the length of the radius. Up to two corner points may be selected. 

• In Cursor mode, move the radius until it is at the length angle and left click to set.  
• In Value mode, type the exact length in the Dist field. Click OK or press Enter. 
3. When curve is placed in the desired location end selection to continue. 

  

 
Oval  

Use this option to add an oval shape to one or more corner points. The system allows 
adding one oval corner in a line at one time. One common use of oval corners is fly 
extensions. 

To create an oval: 

1. Select location for corner curve  

• In Cursor mode, select the radius and left click.  
• In Value mode, type the amount of the radius in the Dist field. Click OK or press 

Enter. 
2. Select the length of the radius. Up to two corner points may be selected. 

• In Cursor mode, move the radius until it is at the desired length. Left click to set.  
• In Value mode, type the exact length in the Dist field. Click OK or press Enter. 

When curve is placed in the desired location end selection to continue. 
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Note: If Curved Intersection or Oval is selected, the system will prompt for the 
corner point(s) where the curve(s) should be added. If no curves are desired or 
when finished adding curves, End Selection to complete the corner. 

 

 

Seam - Squared Corner 

AccuMark = Blocks/ Seam/ Corners/ Squared Corner 

MicroMark = Piece/ Seam Allowance/ Squared 

 

Use this function in the Piece menu to square a corner where two 
perimeter/boundary lines intersect. The sew line of the line selected is extended to 
meet the cut line and the corner is drawn perpendicular, or ‘squared’ from the line 
selected to the intersection. 
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To create a squared corner: 

1. From the Piece menu, choose Seam and then select Squared Corner.  

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, 

this is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" 
= Yes. 

3. If creating notched corners, select a Notch Type from the drop-down list box. 
For MicroMark data, enter a depth value for the notch. 

4. Select the corner to square. 

5. Select the perimeter/boundary line before or after that corner that is to be 
squared at the end of the cut line. The system creates the squared corner. 

6. End selection to continue. 
Hints: 

• Before using this corner function, seam needs to be defined for both the corner 
lines. 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
• Troubleshooting Squared Corners . 

 

Seam - Match Seam Corner 

AccuMark = Piece/ Seam/ Match Squared Corner 

MicroMark = Not/Applicable 

  

Use this function in the Piece menu to create curved corners so that the cut lines 
match in shape between two pieces. 

Match Seam Corner Construction  
Before applying a Match Seam corner: 

Since Match Seam Corners involve two pieces, some special guidelines are 
necessary.  

• Seam Settings: The use of Seam Extensions and edit seam is strongly 
recommended when applying Match Corners in order to maintain the correct 
geometry for all graded sizes.  Seam extensions help to maintain the shape as 
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the piece is altered and swapped, while Adjust Seam Grading calculates 
additional grade rules allowing the corners to match in all graded sizes.  

Note:  Adjust Seam Grading may be applied globally in Preferences/Options or 
applied manually using the option in the Update Seam function.  
• Pieces should have the same size line with the correct grading applied.  
• All piece modifications should be done before applying corners.  Modifying the 

pieces after corners are applied may invalidate the corners and they may need to 
be reapplied.  

Note: This corner type will not be saved if pieces are saved in Piece Verify or 
AccuMark PDS. 

To create match corners: 

1. From the Piece menu, choose Seam and then select Match Seam Corner 
(AM).  

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notch – choose Type to specify the notch shape, and Depth to specify the notch 

size. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, this 

is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" = 
Yes. 

3. Select a corner on the first piece where you want to apply the match seam 
corner.  

4. Select a perimeter line before or after this corner that is common to both 
pieces. This is the line where the pieces would be sewn together or joined. 

5. Select a corner point on the second piece to create the matched seam corner. 

6. On the second piece, select the perimeter line before or after this corner that is 
common to both pieces. This is the line where the pieces would be sewn 
together or joined. 

A corner is created on both pieces. The corner shape matches the cut line shape 
on the matching piece, and is generated for the graded sizes. 
7. End selection to continue. 

Hints: 
• This function is often used when a seam is going to be pressed (ironed) to one 

side.  After applying Match Seam Corner, use Mirrored Corner on the other 
piece. 

• If notches are desired on the first line of one piece and the second line of the 
corresponding piece, flip one of the pieces and then apply the corner using the 
option, First or Second, that allows the correct line to be notched on both pieces. 

• To create a squared corner that matches another piece, use Match Squared 
Corner. 
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• Seam needs to be defined for at least both of the common lines prior to applying 
the corner.  

• Set the focus on a specific piece using Current Pieces in the Edit menu. 
• Troubleshooting Match Corners  

 

 

Seam - Match Squared Corner 

AccuMark = Piece/ Seam/ Match Squared Corner 

MicroMark = Not/Applicable 

  

Use this function in the Piece menu to create square corners so that the cut lines 
match in shape and length between two pieces.  For example, this corner can be 
used for princess line seams, two-piece sleeves, or any area where the seam shape 
and cut line length needs to match a corresponding piece. Match Square Corner 
Construction  

Note:  Match Square Corners created in Classic PDS are applied using a different 
method.  To take advantage of the updated Match Square Corner functionality 
(matched curve shape and graded sizes), the old corners should be removed and 
Match Square corners should be reapplied in PDS.  

Before applying a Match Square corner: 

Since Match Square Corners involve two pieces, some special guidelines are 
necessary.  

• Seam Settings: The use of Seam Extensions and Adjust Seam Grading is 
strongly recommended when applying Match Corners in order to maintain the 
correct geometry for all graded sizes.  Seam extensions help to maintain the 
shape as the piece is altered and swapped, while Adjust Seam Grading 
calculates additional grade rules allowing the corners to match in all graded 
sizes.  
Note:  Adjust Seam Grading may be applied globally in Preferences/Options or 
applied manually using the option in the Update Seam function.  

• Pieces should have the same size line with the correct grading applied.  
• All piece modifications should be done before applying corners.  Modifying the 

pieces after corners are applied may invalidate the corners and they may need to 
be reapplied.  

Note: This corner type will not be saved if pieces are saved in Piece Verify or 
AccuMark PDS. 

 

 361 



To create match corners: 

1. From the Piece menu, choose Seam and then select Match Squared Corner 
(AM).  

2. Select from these options: 

• Notch Type – choose the notch type to use for the corner. 
• Notch – choose Type to specify the notch shape, and Depth to specify the notch 

size. 
• Notching Line – with Selection Type set to Piece and Notch Types defined, this 

is equivalent to the MicroMark function "Remove Sew Lines/Notch Cut Lines" = 
Yes. 

3. Select a perimeter line before or after this corner to square from.  

4. Select a corner point on the target piece to create the matched squared 
corner. 

5. Select the perimeter line before or after corner on target piece to square from. 

A corner is created on the reference and target pieces. The corner is squared and 
is generated for the matching piece based on the reference piece. This results in 
cut lines of equal length. 
6. End selection to continue. 

Hints: 
• This function creates cut lines of equal length.  It is useful for pieces that need to 

be quickly placed together and matched during construction. 
• If notches are desired on the first line of one piece and the second line of the 

corresponding piece, flip one of the pieces and then apply the corner using the 
option, First or Second, that allows the correct line to be notched on both pieces. 

• To create a matched corner that matches the curve shape of another piece, use 
Match Seam Corner. 

• Seam needs to be defined on all four corner lines prior to applying the corner.  
• Set the focus on a specific piece using Current Pieces in the Edit menu. 
• Troubleshooting Match Corners  

 

 

 

Match Seam Corner Construction 

1. The intersection of the adjacent cut lines is found. 
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Original Pieces overlaid, intersection of cut line shown by red dot. Common lines are shown in 
red 

 
2. A portion of the cut line shape in the common seam area is copied to each 

piece as shown in the picture. 

 

  
Cut line shape copied. Match Seam Corner line shown in blue. 

 
3. Cut line shapes of both pieces match. 
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Piece with corners overlaid. Area inside circle shows how the shape is matched for both 
pieces. 

 

Match Squared Corner Construction 

1. The intersection of the adjacent cut lines is found  

 

  

Original pieces overlaid, intersection of cut line shown by red dot.  The blue line shows the 
curve shape that will be copied to the other piece. 

 
2. A portion of the cut line shape in the common seam area is copied to the 

matching piece. A square corner is then applied to each piece.  

 

 364 



  
Cut line shape copied.  Matching shape shown in blue. 

 
3. Cut line shapes of both pieces match 

 

  
Piece with corners overlaid.  The adjacent cut line shapes match and the length of the cut line 
on the common line matches for the two pieces including the graded sizes.  

 

 

Troubleshooting Match Corners 

When applying a Match Seam or Match Square Corner, one of the following messages 
may display if the piece does not meet the requirements needed for the corner to be 
applied.  

Displays for Match Seam Corner when both corner lines do not have seam defined. 
Seam needs to be defined for at least the common lines on both pieces for Match 
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Seam Corners to be applied.  This message also displays for Match Square Corner 
when any of the corner lines do not have seam defined. 

 

 

 

Displays for Match Seam and Match Square corners when the angle of the corner is 
less than or equal to the required minimum of 87 degrees.   

 

  

 

Note: This measurement is the angle between the 2 lines of the corner measured on 
the outside of the piece. 

 

Displays for Match Seam and Match Square corners when the two pieces selected for 
the match corners do not have the same size lines. 
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• Displays for Match Seam and Match Square corners when the cut lines of the 
adjacent lines do not intersect on one or more of the graded sizes. This problem 
occurs most frequently when the size range is very large or the corner is applied 
to pieces that have invalid grading; such as growth amounts that cause the same 
graded sizes to be very different for the two matching pieces. 

 

  

 

• Displays for Match Seam and Match Square corners when the seam amounts 
may cause the corner to fail. Certain combinations of seam may make the corner 
geometrically impossible to apply.  This message is simply a warning that occurs 
for those cases -- the corner may still be able to apply. However, if the corner 
does not apply, seam amounts may need to be adjusted in order for the corner to 
apply correctly.  

 

  

 

Displays when the piece has been altered in such a way that the corner cannot be 
created. For match corners, PDS removes the corner definition from the piece. This 
may occur after a manual modification of the geometry or from functions such as 
Update Seam or Adjust Seam Grading being applied, either manually or globally from 
seam settings.  This means that a piece created under a specific set of seam settings, 
such as one having Auto Update Seam OFF or Adjust Seam Grading OFF, may 
generate this error when either of these functions is applied to the piece.  If Adjust 
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Seam Grading is ON, this message may be followed by another message indicating 
the sizes that the system could not generate the corners for. 

 

  

 

• Displays when Adjust Seam Grading calculates the corner for the graded sizes 
and can not create the corner on one or more specific sizes.  The piece name and 
size or sizes that PDS cannot create the corner on are listed in the message.  
This message often displays after another message indicating that the corner 
could not be created or was invalidated.   Check the grading of the pieces, 
specifically the problem sizes, to view the geometry and determine why the corner 
cannot be created.  In some cases, removing the corner and reapplying will 
correct the error. 

 

  

 

• This message displays in two different cases where the intersection cannot be 
found. 
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• Case 1: The message displays for Match Seam and Match Square corners when 
the cut lines of the adjacent lines do not intersect on the base size.  An easy way 
to see this problem is to use Set and Rotate/Lock to set the pieces together along 
the common line with the corner point on the sew lines matched.  The adjacent 
cut lines need to intersect (cross) in the area where the seam overlaps. 

 

     
Intersection Found      No Intersection Found 

• Case 2: This message also displays for Match Square corners when no 
intersection can be found between the sew line of the common line and the 
adjacent cut line.   

This problem occurs on the geometry of the base size.  In the image below line A is 
the line selected for the corner and line B is the adjacent line. When the sew line of 
line A is extended (indicated by the blue arrow) it does not intersect line B, so no 
corner can be created.  
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When working with problem pieces this problem can easily be visualized and corrected 
using the following steps:  First, apply a Match Seam Corner to the piece. Then, digitize 
a line showing how the sew line would extend.  To do this, digitize a line starting at the 
end of the sew line of the common line.  Use the right button option Along Tangent and 
select the end of the sew line again.  Dragging the mouse toward the adjacent line 
shows how the system would extend the line and the necessary adjustments can then 
be made. 

 

Troubleshooting Squared Corners 

When applying a Square Corner, one of the following messages may display if the 
piece does not meet the requirements needed for the corner to be applied.  

Displays when one or both corner lines do not have seam defined.  

 

  

 

Displays when the angle of the selected corner is greater than 175 degrees. 

 

  

 

Displays when no intersection can be found between the sew line of the selected line 
and the adjacent cut line.  
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This problem occurs on the geometry of the base size.  In the image below line A is the 
line selected for the corner and line B is the adjacent line. When the sew line of line A 
is extended (indicated by the blue arrow) it does not intersect line B, so no corner can 
be created.  

 

  

 

 When working with a problem piece, an easy way to visualize and correct the problem 
is to actually digitize a line showing how the sew line would extend.  To do this, digitize 
a line starting at the end of the sew line of the selected line.  Use the right button option 
Along Tangent and select the end of the sew line again.  Dragging the mouse toward 
the adjacent line shows how the system would extend the line and the necessary 
adjustments can then be made. 

 

Additionally, the use of Seam Extensions is recommended with Squared Corners.  This 
prevents the shape from changing or slipping as the piece is swapped.  
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Modify Pieces 

Modifying Pieces 

Once pieces are created or retrieved into the work area, functions in the Modify 
Piece menu allow you to manipulate these pieces to simplify pattern making and 
grading procedures.  

 
Hints: 

• If you use the same name for a modified pieces as the original, the system will not 
overwrite it until you use the Save As function. At that time, you must choose 
whether or not to overwrite the original piece with the modified piece. 

• If you use the Save function to save a modified piece that has the same name as 
the original, you are not prompted and the original piece is overwritten. It is 
recommended that a unique name is given to each piece created or modified. 

• When Add new piece to model/style is selected in the User Input box, the piece 
is added to the style or model and the style or model also needs to be saved.  

 

Modify Piece - Move Piece 

AccuMark = Blocks/ Position Block 

MicroMark = Piece/ Position/ Move Cursor, Value 

 

Use this function in the Piece menu to reposition a piece using X and Y 
measurements, match a piece to a grid point, or to quickly place pieces together. 

To move a piece: 

1. From the Piece menu, choose Modify Piece and then select Move Piece. 

2. Select the desired function options. 

• Position to Piece or X/Y move – Sets one piece against another by selecting a 
reference point on the piece to move and a target point on another piece.  

• Lock to Grid – Places a specific point on a piece to a guideline or grid point. 
This option allows multiple pieces to be aligned using the grid as a horizontal (X) 
or vertical (Y) reference.  

• Rotate after Lock – Allows a piece to be rotated after it has been positioned. If 
this option is selected, the system will prompt to end selection to begin rotating 
after the piece(s) are positioned. 
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3. Select the Piece(s) to reposition.  

4. Select a reference point. Depending on the function option selected, this point 
will be matched to a grid point or point on another piece, or it will be used as 
the reference for measuring an X and Y value. 

5. Select the appropriate target point on another piece, grid point, or enter values 
in X and Y fields. 

The piece(s) move to the new specified position.  
6. If Rotate after Lock is selected in step 2, end selection to automatically begin 

the Rotate Piece function.  
Hints: 

• If a group of pieces has already been positioned but needs to be moved or 
rotated, select all the pieces at once using the Shift or marquee box technique. 
Then, they can all be moved as one.  

• If the resulting piece placement is one you will use many times during pattern 
development or grading, save the position using Define Position. Later, the pieces 
can be quickly recalled to the same position using the function Use Position.  

 

Modify Piece - Flip Piece 

AccuMark = Blocks/ Modify Blocks/ Flip Block 

MicroMark = Piece/ Flip 

 

Use this function in the Piece menu to change the orientation of a piece in the work 
area. Pieces can be flipped along a line or in one of four quadrants based on the X 
and Y Axes. 

 
To flip a piece: 

1. From the Piece menu, choose Modify Piece and then select Flip Piece. 

2. Select the desired function option. 

• Flip about Line – Allows a piece to be flipped about any line of the piece, 
internal or perimeter/boundary. If a curved line is chosen, the system will flip the 
piece based on a straight line drawn between the endpoints of the curved line.  

• Flip Piece – Flips a piece on the X or Y Axes. When this option is selected, the 
Flip piece quadrant choices become active.  
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3. If Flip Piece was selected, select the quadrant that you want to flip the 
selected piece to, using the pictures as a guide. The orientation symbol 
indicates the quadrant into which the piece will flip. 

  
4. If Flip about Line was selected, select the line(s) for each piece to flip about.  

If Flip Piece was selected, select the piece(s) to flip. 
5. End selection to continue. 

Hints: 

• When pieces are retrieved from memory or created, the original position is the 
quadrant where the piece is outlined in red, provided the grain line was created 
from left to right.  

• When you flip a piece, the grade rules and point attributes you assigned to the 
piece do not change. 

• The Realign Grain/Grade Ref function can be used to return a piece to its original 
quadrant, or to reorient the grain/grade reference line and modify the rules. 

Modify Piece - Rotate Piece 

AccuMark = Blocks/ Modify Blocks/ Pivot Block 

MicroMark = Piece/ Position/ Rotate Piece 

 

Use this function in the Piece menu to rotate a piece around a selected point. The 
rotation can be freehand using the cursor, by angle, or by distance.  

 
To rotate a piece: 

1. From the Piece menu, choose Modify Piece and then select Rotate Piece. 

2. Select the desired options. 

• Select Reference Location – Prompts for a specific location to measure 
rotation. 
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• Perform Alignment – Uses the X and Y axes options along with Select 
Reference Location. The piece will automatically rotate until the reference point 
lines up with the X or Y Axis, whichever Alignment preference is selected. 

• Increment – Automatically rotates a piece by common pre-defined amounts. 
Select the Increment and the direction, either clockwise or counter clockwise. 

3. Select the Piece(s) to rotate.  

4. End selection. 

5. Select an existing point on the piece to rotate the piece about. 

6. If Select Reference Location is selected, system prompts for a reference 
location. 

A duplicate image of the piece is displayed on the work area. This piece can be 
pivoted around the original piece. Once you place the duplicate at its new location, 
the original piece no longer displays on-screen.  
7. Rotate the piece using one of the following methods:  

• In Cursor mode, the image rotates around the pivot point as you move the 
cursor. The Ang: field in the User Input box displays the number of degrees as 
the image moves. Click left to place, and the rotated piece replaces the original 
piece in the work area.  

• In Value mode, type the exact number of degrees you want the piece rotated in 
the Ang: field, or type a distance in the Dist field. Click OK or press Enter to 
accept and the piece rotates, replacing the original.  

8. End selection to continue. 
Hints: 

• The Realign Grain/Grade Ref function can be used to return a piece to its original 
quadrant, or to reorient the grain/grade reference line and modify the rules. 

Modify Piece - Set and Rotate/Lock 

AccuMark = Blocks/ Modify Blocks/ Set-N-Pivot 

MicroMark = Piece/ Position/ Lock Piece 

 

Use this function in the Piece menu to set one piece on top of another at a match 
point, and then pivot the first piece around it. Set and Rotate/Lock is useful when 
you want to overlap two pieces in order to use the Trace functions. You can also 
use this function to compare different lines or pieces.  
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To set and rotate/lock a piece: 

1. From the Piece menu, choose Modify Piece and then select Set and 
Rotate/Lock. 

2. Select the desired options:  

• Specify Location to Bump – Determines whether an actual line or a system-
generated line is used as a reference for the Distance to bump the line on the set 
piece away from the match line on the target piece (see step 6). 

• Perform Alignment – Uses the X and Y-axes options along with Select 
Reference Location. The piece will automatically rotate about the match point 
until the line where the set point is located is aligned to the X or Y-axis, 
whichever Alignment preference is selected. 

3. Select the point to be designated as the match point on the target piece. The 
target piece is the piece that remains in the same position when the set piece 
is rotated. The pieces will be joined and rotate at the match point.  

• In Cursor mode, click to select the match point. 
• In Value mode enter a value in the Beg or End: fields. Click OK or press Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
4. Designate a match line on the target piece. The match line is the line the 

system references for distance or angle measurements when the set piece is 
rotated. 

5. Select the match point on the set piece. The set piece is the piece that is 
rotated and is moved to the target piece. The target piece and the set piece 
are joined together at the match points. 

6. Designate the set point on the set piece. Depending whether or not the 
Specify Location to Bump option is checked in step 2, the system uses: 

• The line on which this point is located. (checked) 
• A line between this point and the match point (step 5) as reference when rotating 

in the next step. (unchecked) 
7. Rotate the set piece using one of the following methods: 

• In Cursor mode, the piece rotates around the match point as the cursor is moved. 
The Angle and Distance are displayed in their respective Value Input fields. Click 
left to set the rotated piece in the new position.  

• In Value mode, enter the exact distance between the set point and the match 
line. Type a value in either the Ang or Dist fields. Click OK or press Enter to 
rotate and set the piece in the new position.  
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• 

 
 
Example shows the set piece (blue 
points) bumped out from the target 
piece (white points) a specified 
Dist from the line on which the set 
point was located, as in Classic 
AccuMark PDS. 

8. End selection to continue. 
Hints: 

• Entering a value of zero in the Ang or Dist field will set the two lines on top of 
each other. 

• If the resulting piece placement is one you will use many times during pattern 
development or grading, save the position using Define Position. Later, the pieces 
can be quickly recalled to the same position using the function Use Position.  

 

Modify Piece - Walk Pieces  

AccuMark = Blocks/ Block Walking 

MicroMark = Piece/ Position/ Walk Piece 

 

Use this function in the Piece menu to check seam lengths and curves. The User 
Input box is used to select set position and target position by measurements and to 
enter the distance to walk the piece. Pop-up Options can be used to control how 
pieces are walked. 

Multiple pieces can be walked against multiple pieces. While defining the set and 
walk paths, a right button menu is available. Use this to change the direction of the 
walk path and exclude regions. Additional functionality in the right button menu that 
displays while walking includes: Mobile to Stationary, Stationary to Mobile, and 
Change Mobile Side.  

To walk pieces to check measurements: 

1. From the Piece menu, choose Modify Piece and then select Walk Pieces or 
press the Shift + W keys. 
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2. Select the lines for the walk path on the stationary piece.  Using the right 
mouse button, specify the direction to walk, and define any Exclude Region 
points, before ending selection to continue. 

3. Select the lines for the walk path on the mobile piece. Using the right mouse 
button, specify the direction to walk, and define any Exclude Region points, 
before ending selection to continue. 

• If walking in g, End, or Dist fields. Note that 
other fields update automatically. Press Apply to preview amounts, and change 
as needed. Press Enter or click OK. 

• Mark Stationary – adds notches or marks the stationary piece during walk. 

• Change Mobile Side – flips the mobile piece to allow walking on the outer, or 
inner edge of the stationary piece.  

4. When the two walk paths are defined, the moving piece will snap against the 
stationary piece.  Move the cursor in the direction of the walk path to activate 
the walk. 

• If walking in Cursor mode, drag along the perimeter/boundary line of the 
stationary piece. Check values in the Beg, End, and Dist fields. Beg field displays 
the distance between the current location on the target line and beginning of the 
line. End field displays the distance between the current location on the target 
line and end of the line. Dist field displays the distance along the line already 
walked. 

Value mode, enter a value in the Be

5. To control how pieces are walked, click right and select an option: 

• Continue Walking – resumes moving along the walk path. 

• Mark Mobile – adds notches or marks the mobile piece during walk 
• Mark Both – adds notches or marks both pieces simultaneously during walk. 

• Mobile to Stat – adjusts the endpoint of the walk line on the mobile piece to 
meet the endpoint of the walk line on the stationary piece. Moves the pushpin 
that appears to define the blending point. 

• Stat to Mobile – adjusts the endpoint of the walk line on the stationary piece to 
meet the endpoint of the walk line on the mobile piece. Moves the pushpin that 
appears to define the blending point. 

6. End selection to continue. 
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Modify Piece - Use Position 

AccuMark = New 

MicroMark = Piece/ Position/ Original Position 

 

Use this function in the Piece menu to display pieces on-screen in a pre-defined 
orientation. For AccuMark users, this function along with Define Position allows you 
to quickly place many pieces in a specific arrangement.  

To use a stored position: 

1. Bring into the work area the pieces that you want to position. 

2. From the Piece menu, choose Modify Piece and then select Use Position. 

3. In the Position Name field, use the drop-down list box to select the desired 
position name. The pieces that will move become the selected color. 

4. If you do not want all of the selected pieces to move, manually select the 
desired pieces.  

5. End selection to automatically position the pieces. 

 

Modify Piece - Define Position 

AccuMark = New 

MicroMark = Piece/Position/ New Original Position  

 

Use this function in the Piece menu to define and store the screen placement of 
pieces. Multiple positions can be defined. Save Time by using this function to define 
positions that you use frequently. These could be specific piece placements used for 
pattern development and grading, or assemble positions. 

To define a position: 

1. Place the pieces in the position that you want to save.  

2. From the Piece menu, choose Modify Piece and then select Define Position. 

3. In the Position Name field, type a name for the position. If no name is 
entered, the system automatically assigns a number, start with 1,2, etc. 

4. Select the pieces that you want to save the position for.  
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5. End selection to record and store the Position. 

The new position is available for use in the Use Position function.  
6. To permanently save the new position for use during later sessions, save the 

Model, Style, or pieces. 
Hints: 

• Multiple positions are not supported on previous AccuMark and MicroMark 
systems. If a model or style is retrieved into an AccuMark 7.6 or MicroMark 9.5 
system and saved on either system, the positions will no longer be available if the 
model or style is retrieved back into PDS/Silhouette. 

• For MicroMark data, the position information is stored in the Style Extension (.f) 
file. 

 

Modify Piece - Remove Position 

AccuMark = New 

MicroMark = Piece/Position/ New Original Position (To be implemented) 

 

Use this function in the Piece menu to delete piece positions previously defined 
using the Define Position function. 

To remove a position: 

1. From the Piece menu, choose Modify Piece and then select Remove 
Position. 

2. If you want to delete all previously defined positions for pieces in the work 
area, select Remove All. 

3. In the Position Name field, select a position. Only the positions valid for the 
pieces currently in the work area will display. 

The pieces that are affected by the selected position name will display in the 
selected color.  

If you desire to remove only the position for a single piece and not for the entire 
group of pieces, manually select only the pieces that should be removed from the 
position. 
4. End selection to remove the pieces or the position.  

5. To permanently save the change, save the piece, model, or style. 
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Modify Piece - Realign Grain/Grade Ref 

AccuMark = Block / Realign Grain  

MicroMark = New 

 

Use this function in the Piece menu to return a piece to its original orientation, or to 
realign the grain/grade reference line to the horizontal axis after the piece 
orientation has changed. 

If Modify Grade Rules is selected in Preferences/Options, any grade rules on 
portions of a piece that rotate around the grain line are automatically updated by the 
system. If it is not selected, the grade rules remain as they are. 

To reorient a piece or align grain/grade reference line to horizontal: 

1. From the Piece menu, choose Modify Piece and then select Realign 
Grain/Grade Ref. 

2. Use the function in one of the following ways:  

• To realign a grain or grade reference to the horizontal axis, without affecting the 
piece's current orientation of a piece, select the desired grain/grade reference 
line. The grade rules are modified in order to maintain the geometry of the nest.  

• To return a piece to its original orientation, click anywhere on the piece to have it 
return to its original orientation (what the piece looked like before it was moved). 
If functions such as Flip Piece or Rotate Piece were applied to the piece, the 
effects are reversed. 

Modify Piece - Lock to Grid 

AccuMark = New 

MicroMark = Piece/ Position/ Lock to Grid 

 

Use this function in the Piece menu to align a piece to the horizontal or vertical grid, 
reposition a piece using X and Y-axes measurements, or to quickly place pieces 
together by matching points. Multiple pieces can be selected. 

To use Value mode to lock a piece to a grid: 

1. From the Piece menu, choose Modify Piece and then select Lock to Grid. 
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2. In the User Input box, make sure you are in Value mode. 

3. Select the desired options. 

• Position to Piece or X/Y move – Sets a piece by positioning a reference point 
on the piece to a specific X, Y location. If multiple pieces are selected, other 
pieces move also to maintain their current relationship with the repositioned 
piece. 

• Lock to Grid – Locks a specific point on a piece to a grid point. This option 
allows multiple pieces to be aligned using the grid as a horizontal or vertical 
reference. To display the grid or guidelines, use the Screen Layout function. 

• Rotate after Lock – Allows piece(s) to be rotated after it has been positioned. 
Lock to Grid option must be selected also. After piece(s) are positioned, the 
system prompts to end selection and begin rotating piece(s). 

4. Select the pieces to reposition.  

5. End selection to continue. 

6. Select a reference point on one of the piece(s) you are moving. Depending on 
the function option selected, this point will be matched to a grid point or used 
as the reference for measuring an X and Y value. 

7. Enter value(s) in the X and Y fields. 

The piece(s) move to the new specified position.  
8. If Rotate after Lock is selected, do all of the following: 

• End selection when prompted to automatically begin rotating the piece.  
• Enter a value in the Dist or Ang fields. Click OK or press Enter. 
9. End selection to continue. 

To use Cursor mode to lock a piece in relation to another piece: 

1. From the Piece menu, choose Modify Piece and then select Lock to Grid. 

2. In the User Input box, make sure you are in Cursor mode. 

3. Select the desired options, as explained above in using Value mode. 

4. Select the piece(s) to reposition.  

5. End selection to continue. 

6. Select a reference point on one of the piece(s) you are moving. Depending on 
the function option selected, this point will be matched to a grid point or to a 
point on another piece. 

7. Select the appropriate target point on another piece or on a grid point. 

The piece(s) move to the new specified position.  
8. If Rotate after Lock is selected, end selection to automatically begin rotating 

the piece. Click to place. 

9. End selection to continue. 
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Hints: 

• If a group of pieces has already been positioned but needs to be moved or 
rotated, select all the pieces at once using the Shift or marquee box technique. 
Then, they can all be moved as one.  

• If the resulting piece placement is one you will use many times during pattern 
development or grading, save the position using Define Position. Later, the pieces 
can be quickly recalled to the same position using the Use Position function.  

 

Modify Piece - Anchor/Unanchor 

AccuMark = Block/ Lock Unlock 

MicroMark = Piece Selection 

 

Use this function in the Piece menu to anchor a piece temporarily in the work area 
and prevent the piece from being moved. For example, use this function when you 
have traced a piece on the Silhouette table and you don’t want to move it 
accidentally.  

To lock or unlock a piece: 

1. From the Piece menu, choose Modify Piece and then select 
Anchor/Unanchor. 

The status of each piece, locked or unlocked, displays in the center of each piece. 
2. Select the piece(s) to toggle Locked or Unlocked.  

3. End selection to toggle the state of the selected pieces.  
Hints: 

• You can still store, delete, or reposition a piece if it is locked. 

Split Pieces 

Creating Pieces using Split Lines 

PDS/Silhouette provides various functions for splitting pieces along a line when 
splitting pieces for color blocking. 

If you have previously worked with AccuMark or MicroMark pattern design systems, 
many of these functions will be familiar. However, you may improve your 
productivity by taking time to become acquainted with some new methods for 
creating pieces using split lines. 
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Split on Line 

AccuMark = Blocks/ Modify Blocks/ Split Blocks Ln 

MicroMark = Piece/ Split (Select Line) 

 

Use this function in the Piece menu to divide a piece at an existing internal line, 
creating two smaller pieces. This function can be used to create new blocks when 
"color blocking" a garment. The input box is used to delete the original piece and to 
name the new pieces. 

To split a piece at a selected line: 

1. From the Piece menu, choose Split Piece and then select Split on Line. 

2. Select an option: 

• Add Piece to Model/Style – Adds the new pieces added to the model or Style 
Description. Or you can create a new model or style. 

• Delete Original Piece – Removes the original piece from the work area. 
• Define Seam on Split Line – Prompts to add seam allowance, if the piece has 

seam allowance. 
• Select Internals – Chooses which half of the piece internal lines belong to (if 

internals are originally positioned in both halves). 
• Grading – AccuMark users can select one of these options to control the type of 

grading generated at the new corners.options. 
-  Grade Straight or Grade Proportional  
-  Maintain Graded Nest – grading from the internal used to split the piece is 
assigned to the new intersections if the next will be the same after splitting. 
Otherwise, grade rules are calculated. 

Note: MicroMark users need to export the new rules to the Styles Rule table.  
3. Select the internal line where you want to split the piece. This line will be 

extended to bisect the piece and can be a grain/grade reference line or an 
internal line.  

Note: If you select the grain/grade reference line, this line is used to split the piece. 
The system then creates two new grain/grade reference lines.  

The existing piece is split. An image of a weight displays to show the side that is 
currently selected. The system prompts for new names. 
4. Type a name for each piece, pressing Enter after each one.  
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The system highlights the first half of the split piece. Once named, the second half 
shows. The original name of the piece, with a number 1, 2, 3, etc., is displayed on 
the status line. If a new name is not specified the system uses the indexed number. 
5. End selection to continue. 

Hints: 

• If the line does not intersect the perimeter/boundary of the piece at two points, 
PDS/Silhouette automatically extends end points for the internal line.  

• Any internal line(s) bisected by the split line will also be split. 

• When you indicate you want to use straight grading at the points where the split 
line bisects the perimeter/boundary of the piece through the nested sizes, the 
system does just that: it grades the nest along that straight line. 

• When you indicate you want to use proportional grading, the system maintains the 
proportion of where the split line bisects the perimeter/boundary line on all sizes. 

• If there is an existing grade rule on the perimeter/boundary where the splitting line 
intersects it, that grade rule is used instead of straight or proportional grading. 

 

  
Top = Straight Grading: Bottom = Proportional Grading 
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Split on Digitized Line 

AccuMark = New 

MicroMark = Piece/ Split - Define Split Line 

 

Use this function in the Piece menu to digitize a line and then use it to split a piece. 
To digitize a line and use it to split a piece: 

1. From the Piece menu, choose Split Piece and then select Split on Digitized 
Line. 

2. Select an option: 

• Add Piece to Model/Style – Adds the new pieces added to the model or Style 
Description. Or you can create a new model or style. 

• Delete Original Piece – Removes the original piece from the work area. 
• Define Seam on Split Line – Prompts to add seam allowance, if the piece has 

seam allowance. 
• Grading – AccuMark users can select one of these options to control the type of 

grading generated at the new corners.options. 
-  Grade Straight or Grade Proportional  
-  Maintain Graded Nest – grading from the internal used to split the piece is 
assigned to the new intersections if the next will be the same after splitting. 
Otherwise, grade rules are calculated. 

Note: MicroMark users need to export the new rules to the Styles Rule table.  
3. Select the first point of the digitized line.  

4. Select additional point(s) for the digitized line. 

• In Cursor mode, click and drag the cursor any angle and distance. Release the left 
mouse button at the correct location(s). End selection to continue. 

• In Value mode, type a value in the Dist field. Click Apply. For additional point(s), 
enter new angle(s) and/or distances in the Ang and Dist fields. When finished, 
click OK or press Enter.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points.  

The existing piece is split. An image of a weight displays to show the side that is 
currently selected. The system prompts for new names. 
5. Type a name for each piece. The system displays the first half of the split 

piece. Once named, the second half shows. Type a name for each piece, 
pressing Enter after each one.  
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The original name of the piece, with a number 1, 2, 3, etc., is displayed on the 
status line. If a new name is not specified the system uses the indexed number. 
6. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

• Right button options to control grading are available while digitizing the line. 

 

Split Point to Point 

AccuMark = Blocks/ Modify Blocks/ Split Blocks Point to Point 

MicroMark = Piece/ Split - Define Split Line 

 

Use this function in the Piece menu to define a straight split line from two selected 
points. The input box is used to delete the original piece and to name the new 
pieces. 

To split a piece from one location to another: 

1. From the Piece menu, choose Split Piece and then select Split Point to 
Point. 

2. Select an option: 

• Add Piece to Model/Style – Adds the new pieces added to the model or Style 
Description. Or you can create a new model or style. 

• Delete Original Piece – Removes the original piece from the work area. 
• Define Seam on Split Line – Prompts to add seam allowance, if the piece has 

seam allowance. 
• Grading – AccuMark users can select one of these options to control the type of 

grading generated at the new corners.options. 
-  Grade Straight or Grade Proportional  
-  Maintain Graded Nest – grading from the internal used to split the piece is 
assigned to the new intersections if the next will be the same after splitting. 
Otherwise. grade rules are calculated. 

Note: MicroMark users need to export the new rules to the Styles Rule table.  
3. Select the first point of the split line.  

• In Cursor mode, position the cursor over the existing line, press and hold the left 
button. Release the left mouse button at the correct location. 
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• In Value mode, type the exact location on the perimeter/boundary line where the 
lines are to intersect in either the Beg or End field. Click OK or press Enter.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points.  
4. Select the second point of the split line. 

The existing piece is split. An image of a weight displays to show the side that is 
currently selected. The system prompts for new names. 
5. Type a name for each piece. The system displays the first half of the split 

piece. Once named, the second half shows. Type a name for each piece, 
pressing Enter after each one.  

The original name of the piece, with a number 1, 2, 3, etc., is displayed on the 
status line. If a new name is not specified the system uses the indexed number. 
6. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

• Indicate Straight or Proportional Grading through right button options. 

 

Split Horizontal 

AccuMark = Blocks/ Modify Blocks/ Split Horizontal 

MicroMark = New 

 

Use this function in the Piece menu to create a horizontal split line from a selected 
point. The input box is used to delete the original piece and to name the new pieces.  

To split a piece horizontally: 

1. From the Piece menu, choose Split Piece and then select Split Horizontal. 

2. Select an option: 

• Add Piece to Model/Style – Adds the new pieces added to the model or Style 
Description. Or you can create a new model or style. 

• Delete Original Piece – Removes the original piece from the work area. 
• Define Seam on Split Line – Prompts to add seam allowance, if the piece has 

seam allowance. 
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• Grading – AccuMark users can select one of these options to control the type of 
grading generated at the new corners.options. 
-  Grade Straight or Grade Proportional  
-  Maintain Graded Nest – grading from the internal used to split the piece is 
assigned to the new intersections if the next will be the same after splitting. 
Otherwise, grade rules are calculated. 

Note: MicroMark users need to export the new rules to the Styles Rule table.  

•  using Current Pieces in the Edit menu. 

3. Select the first point of the split line.  

• In Cursor mode, position the cursor over the existing line, press and hold the left 
button. Release the left mouse button at the correct location. 

• In Value mode, type the exact location on the perimeter/boundary line where the 
lines are to intersect in either the Beg or End field. Click OK or press Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points.  

The existing piece is split. An image of a weight displays to show the side that is 
currently selected. The system prompts for new names. 
4. Type a name for each piece. The system displays the first half of the split 

piece. Once named, the second half shows. Type a name for each piece, 
pressing Enter after each one.  

The original name of the piece, with a number 1, 2, 3, etc., is displayed on the 
status line. If a new name is not specified the system uses the indexed number. 
5. End selection to continue. 

Hints: 

Set the focus on a specific piece

• Indicate Straight or Proportional Grading through right button options. 

 

Split Vertical 

AccuMark = Blocks/ Modify Blocks/ Split Blocks Vertical 

MicroMark = New 

 

Use this function in the Piece menu to create a vertical split line from a selected 
point. The input box is used to delete the original piece and to name the new pieces.  

 
 

 389 



To split a piece vertically: 

1. From the Piece menu, choose Split Piece and then select Split Vertical. 

2. Select an option: 

• Add Piece to Model/Style – Adds the new pieces added to the model or Style 
Description. Or you can create a new model or style. 

• Delete Original Piece – Removes the original piece from the work area. 
• Define Seam on Split Line – Prompts to add seam allowance, if the piece has 

seam allowance. 
• Grading – AccuMark users can select one of these options to control the type of 

grading generated at the new corners.options. 
-  Grade Straight or Grade Proportional  
-  Maintain Graded Nest – grading from the internal used to split the piece is 
assigned to the new intersections if the next will be the same after splitting. 
Otherwise, grade rules are calculated. 

Note: MicroMark users need to export the new rules to the Styles Rule table.  
3. Select the first point of the split line.  

• In Cursor mode, position the cursor over the existing line, press and hold the left 
button. Release the left mouse button at the correct location. 

• In Value mode, type the exact location on the perimeter/boundary line where the 
lines are to intersect in either the Beg or End field. Click OK or press Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points.  

The existing piece is split. An image of a weight displays to show the side that is 
currently selected. The system prompts for new names. 
4. Type a name for each piece. The system displays the first half of the split 

piece. Once named, the second half shows. Type a name for each piece, 
pressing Enter after each one.  

The original name of the piece, with a number 1, 2, 3, etc.,  is displayed on the 
status line. If a new name is not specified the system uses the indexed number. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

• Indicate Straight or Proportional Grading through right button options. 
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Split Diagonal Left 

AccuMark = Blocks/ Modify Blocks/ Split Blocks Diagonal Left 

MicroMark = New 

 

Use this function in the Piece menu to create a diagonal split line from a selected 
point. The input box is used to delete the original piece and to name the new pieces.  

To split a piece diagonally: 

1. From the Piece menu, choose Split Piece and then select Split Diagonal Left. 

2. Select an option: 

• Add Piece to Model/Style – Adds the new pieces added to the model or Style 
Description. Or you can create a new model or style. 

• Delete Original Piece – Removes the original piece from the work area. 
• Define Seam on Split Line – Prompts to add seam allowance, if the piece has 

seam allowance. 
• Grading – AccuMark users can select one of these options to control the type of 

grading generated at the new corners.options. 
-  Grade Straight or Grade Proportional  
-  Maintain Graded Nest – grading from the internal used to split the piece is 
assigned to the new intersections if the next will be the same after splitting. 
Otherwise, grade rules are calculated. 

Note: MicroMark users need to export the new rules to the Styles Rule table.  
3. Select the first point of the split line.  

• In Cursor mode, position the cursor over the existing line, press and hold the left 
button. Release the left mouse button at the correct location. 

• In Value mode, type the exact location on the perimeter/boundary line where the 
lines are to intersect in either the Beg or End field. Click OK or press Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points.  

The existing piece is split. An image of a weight displays to show the side that is 
currently selected. The system prompts for new names. 
4. Type a name for each piece. The system displays the first half of the split 

piece. Once named, the second half shows. Type a name for each piece, 
pressing Enter after each one.  

The original name of the piece, with a number 1, 2, 3, etc.,  is displayed on the 
status line. If a new name is not specified the system uses the indexed number. 
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5. End selection to continue. 
Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

• Indicate Straight or Proportional Grading through right button options. 

 

Split Diagonal Right 

AccuMark = Blocks/ Modify Blocks/ Split Blocks Diagonal Right 

MicroMark = New 

 

Use this function in the Piece menu to create a diagonal split line from a selected 
point. The input box is used to delete the original piece and to name the new pieces.  

To split a piece diagonally: 

1. From the Piece menu, choose Split Piece and then select Split Diagonal 
Right. 

2. Select an option: 

• Add Piece to Model/Style – Adds the new pieces added to the model or Style 
Description. Or you can create a new model or style. 

• Delete Original Piece – Removes the original piece from the work area. 
• Define Seam on Split Line – Prompts to add seam allowance, if the piece has 

seam allowance. 
• Grading – AccuMark users can select one of these options to control the type of 

grading generated at the new corners.options. 
-  Grade Straight or Grade Proportional  
-  Maintain Graded Nest – grading from the internal used to split the piece is 
assigned to the new intersections if the next will be the same after splitting. 
Otherwise, grade rules are calculated. 

Note: MicroMark users need to export the new rules to the Styles Rule table.  
3. Select the first point of the split line.  

• In Cursor mode, position the cursor over the existing line, press and hold the left 
button. Release the left mouse button at the correct location. 

• In Value mode, type the exact location on the perimeter/boundary line where the 
lines are to intersect in either the Beg or End field. Click OK or press Enter. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points.  
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The existing piece is split. An image of a weight displays to show the side that is 
currently selected. The system prompts for new names. 
4. Type a name for each piece. The system displays the first half of the split 

piece. Once named, the second half shows. Type a name for each piece, 
pressing Enter after each one.  

The original name of the piece, with a number 1, 2, 3, etc.,  is displayed on the 
status line. If a new name is not specified the system uses the indexed number. 
5. End selection to continue. 

Hints: 

• Set the focus on a specific piece using Current Pieces in the Edit menu. 

• Indicate Straight or Proportional Grading through right button options. 

 

Split Piece Grading Example 
Grade Straight and Grade Proportional 

These two pieces show the difference between Straight and Proportional Grading 
when splitting a piece. The grading of the top pieces was done using Straight 
Grading the grading of the bottom pieces was done using Proportional Grading. 
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Mirrored Pieces 

Working with a Mirrored Piece 

Functions in the Modify Pieces menu allow you to work with mirrored pieces. A 
mirrored piece is one that is symmetrical, or has identical sides. The mirror line is 
the line that divides the piece into two equal halves. A mirrored piece can be open 
or folded. In the Piece/Icon menu, a mirror symbol (square) displays at the bottom 
right of the icon button. 

   
Hints: 

• If one side of the piece has been altered, the system no longer considers the 
piece a mirrored piece. To maintain the piece as symmetrical and mirrored, all 
piece modifications should be made on the folded piece. Use the Fold Mirror 
function to fold the piece on the mirror line before modifying the piece. 

• A folded piece displays with a dashed line indicating the mirror line. 

• If you save an unfolded piece or retrieve it from the Piece/Icon menu, it will 
automatically display folded again.  

Mirror Piece 

AccuMark = Blocks/ Modify Blocks/ Mirror Block 

MicroMark = Piece/ Mirror 

 

Use this function in the Piece menu to create a whole piece from half a piece. The 
mirrored piece geometry will be reflected across the mirror line so that both sides of 
the piece are symmetrical.  

To mirror a piece: 

1. From the Piece menu, select Mirror Piece. 

2. Select the perimeter/boundary line to become the mirror line. All other piece 
geometry will be reflected across this line. Multiple pieces can be mirrored at 
one time.  

The piece(s) display as an unfolded mirrored piece. In the Piece/Icon menu, a mirror 
symbol (a square) displays at the bottom right of the icon button. 

3. End selection to continue. 
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To define notches on a mirror line: 

To define notches on a mirror line when a piece is mirrored, check the Add Notches 
option on the mirror piece user box. This selection allows you to add regular notches 
to single end, or both ends, and works for both MicroMark and AccuMark users. For 
MicroMark users, the Add Intersection Notches option is for Intersection Notches. 

Hints: 

• See General Hints for working with mirrored pieces. 

• For AccuMark model data: 

-  The system will not mirror internal labels, A through N except for D. The system 
will mirror internal labels D and O through Z. Drill holes are assigned the internal 
label of D by default. When you unfold the piece, the drill hole will be mirrored on 
both sides. Some internals are pre-assigned by the system. Verify these labels 
before using. 

-  The grade rules for the mirrored section of the piece are copied. 

-  Seam lines and alternate grain lines are mirrored. This allows you to use these 
lines when a mirrored piece is no longer considered a mirrored piece. 

Fold Mirror 

AccuMark = Blocks/ Modify Blocks/ Fold Mirror 

MicroMark = New 

 

Use this function in the Piece menu to fold a mirrored and display half of the piece. 
The piece remains mirrored and will display as half the piece with a dashed line 
indicating the mirror line. 

To fold mirrored pieces: 

1. From the Piece menu, select Fold Mirror. 

2. Select the mirrored piece(s) you want folded. Multiple pieces can be selected 
using the Shift and marquee box techniques.  

3. End selection to continue. 

The system folds the piece(s) and displays the piece on the half with a dashed line 
as the mirror line.  

Hints: 

• See General Hints for working with mirrored pieces. 
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• To maintain the piece as symmetrical and mirrored, all piece modification should 
be made when the piece is folded. You cannot fold a mirrored piece if one side of 
the piece has been altered. 

 

Unfold Mirror 

AccuMark = Blocks/ Modify Blocks/ Open Mirror 

MicroMark = New  

 

Use this function in the Piece menu to unfold, a mirrored piece so you can see the 
entire block. The piece is still considered mirrored when it is unfolded. If you save 
the piece or retrieve it from the Piece/Icon menu, it will automatically display folded 
again. If you make any changes to an unfolded mirrored piece, the piece will no 
longer be mirrored.  

To unfold a mirrored piece: 

1. From the Piece menu, select Unfold Mirror. 

2. Select the mirrored piece(s) you want unfolded. Multiple pieces can be 
selected using the Shift and marquee box techniques.  

3. End selection to continue. 

The system unfolds the piece(s) and displays both sides of the piece. The mirror 
line displays as a dashed line.  

Hints: 

• See General Hints for working with mirrored pieces. 

 

Open Mirror 

AccuMark = Block/ Modify Blocks/ Open Mirror 

MicroMark = Piece/ Open Piece 

 

Use this function in the Piece menu to convert a mirrored piece into a piece where 
each side can be manipulated independently of the other side. This function is 
useful when creating: 
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• Asymmetrical piece. 
• Symmetrical piece with asymmetrical internals. 

To open a mirrored piece: 

1. From the Piece menu, select Open Mirror. 

2. Select the mirrored piece(s) you want to open.  

3. End selection to continue. 

The system opens the piece(s) and displays both sides of the piece. The piece is 
no longer considered mirrored.  

Hints: 

• See General Hints for working with mirrored pieces. 

• When the piece is unfolded, the mirror line becomes a M label for AccuMark data 
or a style line for MicroMark data. 
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Pleats 
Working with Pleats 

Functions in the Pleats menu can be used to add pleats to a piece. AccuMark users 
will be familiar with most of the available features. However, two new functions allow 
you to add fullness to multiple stacked pieces.  

Note: These functions can be used on both AccuMark and MicroMark data. For 
AccuMark pieces, internal lines labeled P may be selected as "internals to move" in 
fullness and pleat functions. 

Pleats 

Pleats are really folds used to add fullness to a piece. Pleats can be added: 

• Singularly, or in a series. A series of pleats can face one direction or face each 
other. 

• At the waist, shoulder, or hipline. 
• Below the yoke line. 
• To fit the lower edge of a sleeve into a cuff. 
• As a design feature on the sleeve cap. 
• On a blouse, bodice, or jacket releasing fullness over apex or across the 

shoulder.  
• As a furniture design feature, such as the skirt of a sofa or chair. 

The quantity of pleats that can be added is limited only by how much the 
perimeter/boundary of the piece can handle. 

Hints: 
• For AccuMark data use notch type 1 and for MicroMark use flick notch. 

Terms 

Terms associated with creating pleats: 
• Pleat depth is the distance from the outside fold of the pleat to the inside fold. 
• Underlay is a distance equal to twice the depth of the pleat, whether knife or box 

style. One half underlay is the same as half the finished width of the pleat. 
• Open side 
• Pleat lay side 
• Slash lines  
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Pleats - Knife Pleat 

AccuMark = Blocks/ Pleats/ Knife Pleats 

MicroMark = New 

 

Use this function in the Piece menu to create knife pleat(s) on a line. The pleat is 
created by specifying underlay amount, number of pleats, and distance between 
pleats. 

Knife Pleat 

A knife pleat is a fabric ply that is doubled upon itself in a series of folds which form 
an underlay.  

 

Knife pleats are grouped and permanently pressed to lie in one direction. 

Knife pleats can be applied: 

• On skirts, blouses, bodices, and one-piece garments. 
• In conjunction with fitted yokes. 
• As an insert panel. 
• On furniture upholstery skirts. 

To add knife pleats: 

4. Make sure you have an internal line to be used as the fold line in step 3. 

5. From the Piece menu, choose Pleats and then select Knife Pleat. 

6. Select the pleat fold line. 

7. Type a percentage or fixed measurement to distribute. Click OK or press 
Enter. This value is half of the underlay. 

8. Type the number of pleats. Click OK or press Enter. If you enter "1," skip to 
step 8. 

9. If you want more than one pleat, type the distance between pleats. Click OK or 
press Enter. 
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10. Pick the pleat open side by clicking to either side of the pleat fold line. 

11. Pick the pleat lay side by clicking to the opposite side of the pleat fold line. 

12. End selection to continue. 
Hints: 

• To see what the pleats look like after you have created them, select the Pleat Fold 
function from the Asymmetrical Folds menu. 

Pleats - Box Pleat 

AccuMark = Blocks/ Pleats/ Box Pleat 

MicroMark = New 

 

Use this function in the Piece menu to create box pleat(s) on a pre-defined line. The 
pleat is created by specifying an underlay amount and number of pleats. 

Box Pleat 

Box pleats are evenly spaced folds in a fabric ply which are doubled over to face 
away from each other. When you add a box pleat to a pattern, the system adds the 
necessary amount of fabric to the piece area. A type of box pleat, an Inverted Pleat 
is folded to meet itself as viewed from the right side of the fabric.  

   

Box Pleat    Inverted Box Pleat 

The depth of the underlays producing box pleats need not be equal to the width of 
the box. The pleat may be pressed or un-pressed, partially stitched, grouped, or 
designed to fill the circumference of the piece.  

Box pleats are used: 

• On skirts, blouses, bodices, and one-piece garments. 
• Below the hip or shoulder yokes. 
• On upholstery sofa skirts. 
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To add box pleats: 

1. Make sure you have an internal line to be used as the fold line in step 3. 

2. From the Piece menu, choose Pleats and then select Box Pleat. 

3. Select the pleat fold line. 

4. Type a percentage or fixed measurement to distribute. Click OK or press 
Enter. This value is half of the underlay. 

5. Type the number of pleats. Click OK or press Enter. If you enter "1," skip to 
step 7. 

6. If you want more than one pleat, type the distance between pleats. Click OK or 
press Enter. 

7. Pick the pleat open side by clicking to either side of the pleat fold line. 

8. End selection to continue. 
Hints: 

• To see what the pleats look like after you have created them, select the Pleat Fold 
function from the Asymmetrical Folds menu. 

 

Pleats - Variable Pleat 

AccuMark = Blocks/ Pleats/ Variable Pleat 

MicroMark = New 

 

Use this function in the Piece menu to create an uneven knife or box pleat. The 
pleat line is created by specifying pleat width at both ends of the pleat.  

Variable Pleat 

When one end of a pleat is wider than the other end, it is considered a variable 
pleat. The dimensions of variable pleats can vary from each other because the 
internal lines do not have to be parallel. Variable pleats can be either knife or box 
style pleats. 

To add variable pleats: 

1. From the Piece menu, choose Pleats and then select Variable Pleat. 

2. Create slash line(s) by selecting two points on perimeter/boundary lines. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
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3. End selection to continue. 

Each slash line selected in step 2 becomes two lines. 

4. To position the first end points for the slash lines: 

• In Cursor mode, drag the lines apart and click to position the spread distance. 
Check the Dist field.  

• In Value mode, type a value in the Dist field for the new position. Click OK or 
press Enter. 

5. To position the second end points for the slash lines: 

• In Cursor mode, repeat step 4. 
• In Value mode, type a different value in the Dist field or type a value in the Ang. 

Click OK or press Enter. 

The pleats are separated at one end by the distance specified in step 4 and at the 
other end by the distance or angle values specified in step 6. 
6. Select the pleat type from the pop-up window: Knife Pleat or Box Pleat. 

7. Pick the pleat lay side by clicking to either side of the slash line. 

8. End selection to continue. 
Hints: 

• To see what the pleats look like after you have created them, select the Pleat Fold 
function from the Asymmetrical Folds menu.  

• New grade rules are calculated for the piece if Preferences/Modify Grade Rules is 
checked. 

 

Pleats - Taper Pleat 

AccuMark = Blocks/ Pleats/ Tapered Pleat 

MicroMark = New 

 

Use this function in the Piece menu to create an uneven knife or box pleat. The 
pleat line is created by specifying pleat width at one end of the pleat while the other 
end is automatically set to 0.  

Tapered Pleat 
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A tapered pleat has an open end that diminishes down to nothing at the other end. 
Width is applied only to the open end of the pleat that angles around the pivot point. 
Tapered pleats can be either knife or box style pleats. 

This type of pleat may used to apply a pleat at the top of a sleeve without changing 
the distance around the cuff. Or, to add pleats to a skirt without adding fullness at 
the bottom. 

To add taper pleats: 

1. From the Piece menu, choose Pleats and then select Taper Pleat. 

2. Create slash line(s) by selecting two points on perimeter/boundary lines. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
3. End selection to continue. 

4. Position piece to create the spread by doing one of the following: 

• In Cursor mode, drag the slash lines apart and click to position the spread. 
Check the Dist field. 

• In Value mode, type a value in the Dist or Ang fields. Click OK or press Enter. 

The pleat lines are hinged at one end and separated at the other end by the 
distance or angle specified. 
5. Select the pleat type from the pop-up window: Knife Pleat or Box Pleat. 

6. Pick the pleat lay side by clicking to either side of the slash line. 

7. End selection to continue. 
Hints: 

• To see what the pleats look like after you have created them, select the Pleat Fold 
function from the Asymmetrical Folds menu. 

• New grade rules are calculated for the piece if Preferences/Modify Grade Rules is 
checked. 
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Darts 
Working with Darts 

Use functions in the Darts menu to create and work with darts on a piece. 

If you have previously worked with AccuMark or MicroMark pattern design systems, 
many of these functions will be familiar. However, you may improve your 
productivity by taking time to become acquainted with some new methods for 
working with darts. 

Terms 

You need to be familiar with the following terms before you can effectively use the 
functions in the Darts menu: 

• Dart  
• Apex – A new apex can be 

selected in many Dart functions by 
dragging along the angle bisector. 

• Pivot point  
• Hold Line  
• Opening Point  
• Angle bisector – Center line of a 

dart. 

 

Fold/Unfold Hints: 

• For AccuMark data, to unfold the dart, use the Swap Line function to swap the 
internal fold line with the altered perimeter/boundary line. Then delete the new 
internal line, the drill hole, and the notches at the base of the dart. 

• For MicroMark data, use the Open Dart function to unfold a dart.  
Preferences/Options/Options Hints: 

• If Modify Grade Rules is set to On in Preferences/Options, grade rules on moving 
parts are modified along with the piece. If set to Off, the grade rules remain as 
they are.  

Grading Hints: 

• When using the Rotate, Combine Diff Line, and Distribute/Rotate, the system 
generates correct grading by pivoting each size individually. 

• Opening Point – If a grade rule X, P, or A exists (grading points), the system 
applies the rule to the stationary left leg of the dart and calculates grading for the 
moving leg. If not graded, the system creates the rule for the stationary leg and 
calculates grading for the moving leg. 
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Messages: 

The system recognizes a 3-point line with an apex of less than 75 degrees as a dart. 
The following message displays if the dart has greater than 3 points (intermediate 
points on the dart legs) or is split at the apex: 

 

If the selected line is a 3-point line, but the apex angle is too large, the following 
message displays: 

 

 

 

Darts - Rotate 

AccuMark = Blocks/ Darts/ Pivot Darts 

MicroMark = Piece/ Dart/ Pivot Individual 

 

Use this function in the Piece menu to rotate, or pivot, an entire dart around a 
selected point so that it opens at a different location on the perimeter/boundary. 

To pivot a dart: 

1. From the Piece menu, choose Darts and then select Rotate. 

2. Select the dart to rotate (pivot).  
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3. Select the point to pivot the dart around. The pivot point can be any point (not 
necessarily an existing point) within a piece. If you mark a non-existing point 
inside of the block, a small cross hair (+) identifies the pivot point. 

4. Select the Hold line (the line to keep stationary). This line is not affected when 
the dart is pivoted, and maintains its orientation with the grain of the fabric. 

5. Place the new opening of the repositioned dart. The point chosen represents 
the point where the piece is cut to pivot the dart. 

• In Cursor mode, press and hold the left button while the cursor is on a 
perimeter/boundary line. As you move the cursor, locations and points highlight. 
Release the left button at the location where the new dart opening will be 
positioned. 

• In Value mode, type the exact location of the dart opening in either the Beg or 
End fields. Click OK or press Enter. 

6. Select the dart apex. 

• In Cursor mode, select a location along the dart bisector. 
• In Value mode, specify a distance along the dart bisector in the Beg or End 

fields. Click OK or press Enter. 
7. End selection to continue. 

Sample: 

  
Pivoting a dart from one location to another 

Hints: 

• See hints on grading when Working with Darts. 
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Darts - Distribute Same Line 

AccuMark = New 

MicroMark = Piece/ Dart/ Distribute Same Line 

 

Use this function in the Piece menu to pivot part, or all, of the dart to new location(s) 
along the same line. Unlike Distribute/Rotate, the dart is distributed by moving rather 
than pivoting. The portion can be distributed by a distance or a percentage.  

To distribute a dart to the same line as the original dart: 

1. From the Piece menu, choose Darts and then select Distribute Same Line. 

2. Select the dart to distribute by clicking on its apex or one of the dart leg end 
points. 

3. Select the new dart opening(s).  

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location(s). 

• In Value mode, type the location(s) for the split in the Beg or End field in the 
status area. Click OK or press Enter after each location. 

4. End selection to continue. 

Type an amount or percentage (example, 15%) of the original dart to be distributed. 
Click OK or press Enter.  

The system splits the line, distributes to the new darts, and displays an end point or 
a graded end point. 
5. End selection to continue. 

Hints: 

• See hints on grading when Working with Darts. 

 

Darts - Distribute/Rotate 

AccuMark = Blocks/ Dart/ Distribute Dart 

MicroMark = Piece/ Dart/ Pivot Individual 
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Use this function in the Piece menu to pivot the entire dart or a portion of the dart to 
a new location. Unlike Distribute Same Line, the dart is distributed by pivoting rather 
than moving. The portion to distribute can be a distance or a percentage. This 
function allows you to add a dart to a piece without decreasing the total area. For 
example, if you have a three-inch dart you can create a new one that is equal to a 
fixed amount of 1.5 (50%).  

To distribute a dart: 

1. From the Piece menu, choose Darts and then select Distribute/Rotate. 

2. Select the dart that is to be distributed. 

3. Select the pivot point location for the new dart. This can be any internal point 
(not necessarily an existing point) in the piece. The section of the piece that 
pivots to partially close the original dart and open the new dart, pivots around 
this point. 

4. Select the Hold line. This line maintains its orientation with the grain/grade 
reference line and remains stationary when the dart is distributed. 

5. Select a point on the perimeter/boundary where the new dart opening is to be 
positioned.  

• In Cursor mode, click on the perimeter/boundary point or location where the dart 
opening is to be positioned. 

• In Value mode, type the exact location on the perimeter/boundary line where the 
dart opening is to be positioned in the Beg or End field. Click OK or press Enter. 

6. Type a distance or percentage for how much of the original dart is to be 
distributed. Click OK or press Enter.  

For example, to distribute 50% of the existing dart (which is currently 3.0) to the 
new dart, enter 50%. If you want to use a fixed amount, enter 1.5 (which is half of 
the original dart) to achieve the same result. The total distance between the two 
dart legs at the perimeter/boundary is displayed in the Value Input area. 

The system creates a new dart based on the percentage of the existing dart 
distributed, the opening point, and the pivot point. The existing dart is reduced in 
width by the distributed amount. 
7. Select the dart apex. 

• In Cursor mode, select a location along the dart bisector. 
• In Value mode, specify a distance along the dart bisector in the Beg or End field. 
8. End selection to continue. 
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Sample: 

  
Distributing and rotating 50% of a dart 

Hints: 

• To use this function, the dart must be a cut dart (not folded).  

• See hints on unfolding darts for AccuMark or MicroMark and on grading. 

 

Darts - Combine Same Line  

AccuMark = Blocks/ Darts/ Combine Dart 

MicroMark = Piece/ Dart/ Combine Same Line 

 

Use this function in the Piece menu to combine one dart with another dart along the 
same line. Moving rather than pivoting combines the dart. 

To distribute a dart to the same line as the original dart: 

1. From the Piece menu, choose Darts and then select Combine Same Line. 

2. Select the dart to combine. 

3. Select the target dart, or the dart to combine into. 

The system redraws the piece with the darts combined. 
4. End selection to continue. 
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Darts - Combine Diff Line 

AccuMark = Blocks/ Darts/ Combine Dart 

MicroMark = Piece/ Dart/ Combine Different Line 

 

Use this function in the Piece menu to combine a dart with another dart on a 
different perimeter/boundary line of the piece. The width of the new dart is the 
combined width of the two original darts. The original size of the piece is 
unchanged. When combining darts, dart legs must be of similar length. 

To combine two darts: 

1. From the Piece menu, choose Darts and then select Combine Diff Line. 

2. Select the dart that is to be joined with the target dart. The target dart is the 
dart that will include both widths. 

3. Select the pivot point location. 

4. Click on the line you want to designate as the hold line. 

5. Select the target dart. The location of the new dart is at the same location as 
the target dart.  

6. Select the point you want to designate as the new dart apex. You may want to 
move the apex in so the dart, such as a bust point, is not sewn out too far. Do 
one of the following: 

• In Cursor mode, move the dart bisector to the length of the new dart and click to 
place. 

• In Value mode, type the exact location on the bisector line where the apex is to 
be positioned in the Dist field. Click OK or press Enter. 

The system combines the first dart with the target dart using the selected pivot 
point. The new dart is the combined width of both. 
7. End selection to continue. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 410 



Sample: 

  
Combining two darts into one 

Darts - Add Dart 

AccuMark = Blocks/ Darts/ Create Dart 

MicroMark = New 

 

Use this function in the Piece menu to add a dart to a piece without adding fullness. 
This is helpful when creating a pattern piece from scratch or modifying an existing 
one. 

To create a dart: 

1. From the Piece menu, choose Darts and then select Add Dart. 

2. Select an opening point on the perimeter/boundary where the angle bisector is 
to be located.  

• In Cursor mode, click on the perimeter/boundary point or location where the dart 
opening is to be positioned. 

• In Value mode, type the exact location on the perimeter/boundary line where the 
dart opening is to be positioned in the Beg or End field. Click OK or press Enter. 

3. Select the apex of the dart. The apex of the dart is the inside ending point. 
This is usually where the drill point is located. It may or may not be the pivot 
point. Do one of the following: 

• In Cursor mode, move the dart bisector to the length of the new dart and click to 
place. 

• In Value mode, type the exact location on the bisector line where the apex is to 
be positioned in the Dist field. Click OK or press Enter. 

4. Type a value for dart width. Click OK or press Enter. 

The dart, along with the angle bisector, is created on the piece. 
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5. End selection to continue. 
Sample: 

  
Creating a dart without adding fullness 

Hints: 

• Adding a dart to a perimeter/boundary line does not add fullness to the piece in 
order to compensate for the dart. This results in the area of an existing piece 
being reduced when the dart is folded. 

 

Darts - Add Dart With Fullness 

AccuMark = New 

MicroMark = Piece/ Darts/ Add Dart 

 

Use this function in the Piece menu to add fullness, along with a dart, to a piece.  
To create a dart with added fullness: 

1. From the Piece menu, choose Darts and then select Add Dart with Fullness. 

2. Select the new dart opening. 

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location.  

• In Value mode, type the location for the split in the Beg or End field in the status 
area. The system splits the line and displays an end point or a graded end point . 
Click OK or press Enter. 

3. Select a point for the apex, or dart tip. 

4. Select the point to slash to. 

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location.  
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• In Value mode, type the location for the slash point in the Beg or End field in the 
status area. Click OK or press Enter. 

5. Type a value for the dart width. 

• In Cursor mode, rotate either part of the piece to the new location. Left click to 
place. 

• In Value mode, type a value in the Dist or Ang fields. Click OK or press Enter. 
6. End selection to continue. 

Sample: 

  
Adding a dart and changing the fullness 

 

Darts - Change Dart Tip 

AccuMark = New 

MicroMark = Piece/ Darts/ Change Dart Tip 

 

Use this function in the Piece menu to change the dart tip of an open dart. This 
change is allowed along the bisector line of the dart. 

To change the length of a dart: 

1. From the Piece menu, choose Darts and then select Change Dart Tip. 

2. Select the dart at the apex. 

3. Select the new length of the dart. 

• In Cursor mode, move the apex along the dart bisector to the new length of the 
dart and click to place. 

• In Value mode, specify the length of the dart bisector in the Dist field. Click OK or 
press Enter. 
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4. End selection to continue. 
Hints: 

• When using this function, merge the dart lines with the previous and next 
perimeter/boundary lines. 

 

Darts - Equal Dart Legs 

AccuMark = New 

MicroMark = Piece/ Darts/ Equal Dart Legs 

 

Use this function in the Piece menu to automatically adjust the dart legs to the same 
length. To balance the dart legs select the dart tip. To maintain the length of one 
dart leg, select the dart leg.  

To equal the length of two dart legs: 

1. From the Piece menu, choose Darts and then select Equal Dart Legs. 

2. Select the dart to change at one of the dart points. 

3. Select the dart apex to average the length of the two darts, or select the end of 
one of the dart legs to have the other leg match its length. 

4. End selection to continue. 

 

Darts - Balanced Resize 

AccuMark = New 

MicroMark = Piece/ Darts/ Balance Resize 

 

Use this function in the Piece menu to reposition both dart legs and add or remove 
fullness. 

To reposition both dart legs: 

1. From the Piece menu, choose Darts and then select Balanced Resize. 

2. Select the dart to change at one of the dart points. 

3. Select the point to slash to. 
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• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location.  

• In Value mode, type the location for the slash point in the Beg or End field in the 
status area. Click OK or press Enter. 

4. Select internal line(s) to move. End selection to continue. 

5. Type the amount to resize based on the current dart width, which displays on 
the Value Input line. Enter the desired final width, a positive percentage to 
increase the current width, or a negative percentage to decrease the current 
width. Click OK or press Enter. 

The dart legs are resized 
6. End selection to continue. 

 

Darts - One Sided Resize 

AccuMark = New 

MicroMark = Piece/ Darts/ One Sided Resize 

 

Use this function in the Piece menu to reposition one dart leg and add or remove 
fullness. 

To reposition one dart leg: 

1. From the Piece menu, choose Darts and then select One Sided Resize. 

2. Select the dart to change at one of the dart points. 

3. Select the point to slash to. 

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location.  

• In Value mode, type the location for the slash point in the Beg or End field in the 
status area. Click OK or press Enter. 

4. Select the hold line. 

5. Select internal line(s) to move. End selection to continue. 

6. Type the amount to resize based on the current dart width, which displays on 
the Value Input line. Enter the desired final width, a positive percentage to 
increase the current width, or a negative percentage to decrease the current 
width. Click OK or press Enter. 

The dart leg is resized. 
7. End selection to continue. 
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Darts - Open Dart 

AccuMark = New 

MicroMark = Piece/ Darts/ Open Dart 

 

Use this function in the Piece menu to open a closed or folded dart. 
To open a folded dart: 

1. From the Piece menu, choose Darts and then select Open Dart. 

2. Select the dart to change at one of the dart points. 

3. End selection to continue. 

 

Darts - Fold/Close Dart End 

AccuMark = Blocks/ Darts/ Fold Dart 

MicroMark = Piece/ Darts/ Close Dart 

 

Use this function in the Piece menu to fold an existing dart, modifying the 
perimeter/boundary of the piece to compensate for folding. Folding a dart replaces a 
cut dart (one that is cut out of the perimeter/boundary of a piece) with an internal 
dart with options of including fold lines, notches, and drill holes.  

To fold a dart: 

1. From the Piece menu, choose Darts and then select Fold/Close Dart End. 

2. Select from these options: 

• Include Fold Lines 
• Include Drill Hole 
• Include Notches 
3. Select the dart leg on the side toward which it is to be folded. 

4. If Include Notches was selected in step 2, select the Notch Type from the 
drop-down list box. If working with MicroMark data, also enter a value for 
Notch Depth. Click OK or press Enter. 

5. Repeat steps 2 through 4 for each dart you want folded. 

6. End selection to continue. 
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Hints: 

• To unfold the dart, use Open Dart. 

• You can fold on either dart leg. When the system folds the dart, the 
perimeter/boundary of the dart becomes an internal line and a new 
perimeter/boundary appears at the base of the dart. The system also creates two 
notches at the base of the dart sew lines and a one point internal (drill hole) at the 
apex of the dart.  

• In production, remember to move the drill the correct amount. For example, when 
the dart is folded, the drill created is at the tip of the internals. Move the dart in 
approximately ½ inch before deleting the internal lines.  

 

Darts - Smooth Line  

AccuMark = New 

MicroMark = Piece/Darts/Smooth Line 

 

Use this function in the Piece menu to smooth an existing perimeter/boundary or 
internal line. This allows the system to reposition points, such as notches and 
marks, along a line (except end points).  

To smooth the points along a line: 

1. From the Piece menu, choose Darts and then select Smooth Line. 

2. Select the line to smooth. Thumbtacks are displayed at the ends of the line.  

3. Reposition the thumbtacks to specify the range to be affected. Left click in the 
work area to continue. 

The system repositions points and eliminates discrepancies on the curved line.  
4. End selection to continue. 

Hints: 

• A curved line can be smoothed several times, but it will flatten out more with each 
use and its shape will change. 

• You can smooth a line with notches but you have to define a range at each notch 
location to provide control. Use Move Pt Line Slide to reposition the notches after 
smoothing the line. 

• This function is helpful to use when you want to eliminate digitizing discrepancies 
or smooth rough edges on a piece. 
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Darts - Flatten Line Segment 

AccuMark = New 

MicroMark = Piece/ Darts/ Flatten Line Segment 

 

Use this function in the Piece menu to flatten a line by deleting all points in a 
selected range.  

To flatten a line: 

1. From the Piece menu, choose Darts and then select Flatten Line Segment. 

2. Select the line to flatten. Thumbtacks are displayed at the ends of the selected 
line. 

3. Reposition the thumbtacks to specify the region to be affected. Left click in the 
work area to continue. 

The system changes the line. 
4. End selection to continue. 

 

Convert to Dart 

AccuMark = New 

MicroMark = Point Modifiers/ Point Type 

 

Use this function in the Piece menu to convert a manually created or invalid dart into 
a system-recognized dart.  

Before converting: 

1. Merge the lines that will be converted to dart legs into one line. This line must 
be part of the piece perimeter (as opposed to an internal line.)  

To convert the line to a dart: 

1. From the Piece menu, choose Darts and then select Convert to Dart. 

2. Click the desired dart tip and then the first and last dart point when prompted.  

Note: When selecting the first and last dart points, the first and last points are 
determined by going around the piece perimeter clock-wise. These points should be 
selected by dragging along the dart line rather than by dragging along the piece 
perimeter. 
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For MicroMark data, D modifiers are added to the dart points. 
3. End selection to continue. 

4. Proceed to any other dart function. 
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Fullness 
Adding Fullness to Pieces 

Functions in the Fullness menu can add additional fullness to a piece. In pattern 
making, it can be necessary to add flare or gathers to a pattern for style. This is 
called Fullness.  

AccuMark users will be familiar with most of the available features. However, two 
new functions allow you to add fullness to multiple stacked pieces. 

 
Hints: 

• New grade rules are calculated for the piece if Modify Grade Rule is checked in 
Preferences/Options. 

Fullness - Fullness 

AccuMark = Blocks/ Fullness/ Fullness 

MicroMark = New 

 

Use this function in the Piece menu to evenly add or subtract fullness along an 
entire perimeter/boundary line. For AccuMark pieces, internal lines labeled P may 
be selected as "internals to move" in fullness and pleat functions. 

To add fullness: 

1. From the Piece menu, choose Fullness and then select Fullness. 

2. Select a perimeter/boundary line for fullness. 

3. Select a perimeter/boundary line to slash to. 

4. Select the perimeter/boundary line to remain stationary. 

5. Type the amount of fullness to add. Click OK or press Enter. 

Fullness is added evenly along the perimeter/boundary line chosen in step 2. The 
perimeter/boundary line opposite the stationary line moves to accommodate the 
fullness. 
6. End selection to continue. 
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Hints: 

• New grade rules are calculated for the piece if Modify Grade Rule is checked in 
Preferences/Options. 

 

Fullness - 1 Point Fullness 

AccuMark = Blocks/ Fullness/ 1 Point Fullness 

MicroMark = New 

 

Use this function in the Piece menu to add or subtract fullness evenly from a specific 
point on a line to an endpoint on that same line.  

For example, to add fullness to a section of piece without altering a curve on that 
same line, select a point before the curve and add the fullness only to that part. To 
have the notch remain stationary, select the notch and the area to the right of it.  

To add 1 point fullness: 

1. From the Piece menu, choose Fullness and then select 1 Point Fullness. 

2. Select a point on a perimeter/boundary line. Fullness will be added from this 
point to one endpoint of this line. 

3. Select a point on the perimeter/boundary line to slash to. 

4. Select the perimeter/boundary line to remain stationary. 

5. Type the amount of fullness to add. Click OK or press Enter. 

Fullness is added from the point selected in step 2 to the end of the line opposite 
the stationary perimeter/boundary line. 
6. End selection to continue. 

Hints: 

• New grade rules are calculated for the piece if Modify Grade Rule is checked in 
Preferences/Options. 
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Fullness - Variable Fullness 

AccuMark = Blocks/ Fullness/ Variable Fullness 

MicroMark = New 

 

Use this function in the Piece menu to create uneven, or variable, fullness.  
To add variable fullness: 

1. From the Piece menu, choose Fullness and then select Variable Fullness. 

2. Create a slash line(s) by selecting two points on perimeter/boundary lines. 

To use mpleting this function, click the right mouse button. Options 
provide greater control while selecting geometry. 

Options while co

3. End selection to continue. 

4. Select any internal lines to move. 

5. End selection to continue. 

The slash line selected in step 2 becomes two lines. 
6. To enter fullness, position the first end points of the slash lines: 

• In Cursor mode, drag the lines apart and click to position the spread distance. 
Check the Dist field.  

• In Value mode, type a value in the Dist field for the new position. Click OK or 
press Enter. 

7. To enter fullness, position the second end points for the slash lines: 

• In Cursor mode, repeat step 4. 
• In Value mode, type a different value in the Dist field or type a value in the Ang. 

Click OK or press Enter. 

The slash lines are separated at one end by the distance specified in step 6 and at 
the other end by the distance or angle values specified in step 7. 
8. End selection to continue. 

Hints: 

• New grade rules are calculated for the piece if Modify Grade Rule is checked in 
Preferences/Options. 
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Fullness - Tapered Fullness 

AccuMark = Blocks/ Fullness/ Tapered fullness 

MicroMark = New 

 

Use this function in the Piece menu to create uneven, tapering fullness. Specify the 
fullness amount at one end of the slash line while the other end is automatically set 
to 0.  

To add tapered fullness: 

1. From the Piece menu, choose Fullness and then select Tapered Fullness. 

2. Create  two perimeter/boundary points. 

 

 slash line(s) by selecting

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
3. End selection to continue. 

4. Select any internal lines to move. 

5. End selection to continue. 

Each slash line selected in step 2 becomes two lines. 
6. Enter fullness by doing one of the following: 

• In Cursor mode, drag the slash lines apart and click to position the spread. 
Check the Dist field. 

• In Value mode, type a value in the Dist or Ang fields. Click OK or press Enter. 

The slash lines are hinged at one end and separated at the other end by the 
distance or angle values specified. 
7. End selection to continue. 

Hints: 

• New grade rules are calculated for the piece if Modify Grade Rule is checked in 
Preferences/Options. 
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Fullness - Parallel Fullness 

AccuMark = Blocks/ Fullness/ Parallel Fullness 

MicroMark = New 

 

Use this function in the Piece menu to add a parallel amount of fullness across the 
piece.  

To add parallel fullness: 

1. From the Piece menu, choose Fullness and then select Parallel Fullness. 

2. Create slash line(s) by selecting two perimeter/boundary points. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting geometry. 
3. End selection to continue. 

4. Select any internal lines to move. 

5. End selection to continue. 

Each slash line selected in step 2 becomes two lines. 
6. Enter fullness by doing one of the following: 

• In Cursor mode, drag the slash lines apart and click to position the spread. 
Check the Dist field. 

• In Value mode, type a value in the Dist or Ang fields. Click OK or press Enter. 

The slash lines are parallel and separated by the distance or angle values 
specified. 
7. End selection to continue. 

Hints: 

• New grade rules are calculated for the piece if Modify Grade Rule is checked in 
Preferences/Options. 
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Fullness - Fan 

Use this function in the Piece menu to slash and spread a piece, positioning the 
curve of one piece to fit along the curve of another piece. 

The slash lines on the modified piece can be created manually or automatically by 
the system. If done automatically they can be created proportionally between the 
starting and ending lines, or perpendicular to the starting line. 

The spreading of the piece can be done manually or automatically. If done 
manually, each piece rotates with the movement of the cursor until a left click places 
that section of the piece. If done automatically, the piece is spread so that the curve 
of the modified piece fits the curve of the stationary piece. 

The modified piece is matched to the target piece clockwise from the match point 
selected on the target piece. 

To add slash lines to a modified piece: 

1. From the Piece menu, choose Fullness and then select Fan. 

2. Select a match point on the target piece. Select from the following three options: 

• None – Fullness is added and the final piece does not show any slash lines. The 
line fullness is a continuous line to which fullness can be added or removed. The 
points are left in the location where the individual sections are placed. 

• Keep as Internals – Draws the slash line for the beginning and end of placement 
so the exact areas where fullness is added or removed may be seen. The lines 
are internal lines and the perimeter lines fullness is a continuous line to which 
fullness can be added or removed. 

• Keep as Darts – Keeps the areas where the piece is slashed and spread as 
darts. This is similar to the result obtained when working manually. The system 
automatically splits the slashed area from the perimeter line and considers the 
lines as darts. 

Note: Darts must be 120 degrees or less. Any areas spread greater than 120 
degrees with the option Keep as Darts will remain as part of the continuous 
perimeter line and will not become a system recognized dart. 

The image below shows the results of the three slash line options. 
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None Keep as Internals Keep as Darts 

 
3. Select a line to receive slash points. 

4. Position the thumbtacks to define the slash lines range. 

5. Choose the cut method: 

• Manually –Select to manually create slash line(s) by selecting two points on 
perimeter/boundary lines. 

• Evenly (Perpendicular) – Specify the number of slash lines to draw. Slash lines 
are automatically drawn perpendicular to the starting line. 

• Evenly (Proportional) –  

• Select the lines to receive the slash points. This will be the line where the 
slash lines end. 

• Positions the thumbtacks to define the line range 

• Specify the number of slash lines to draw. 

• Slash lines are drawn automatically spaced proportionally between the 
starting range and ending range selected. 

6. Select the internals to move and end selection to continue. 

7. Choose the pivot method: 

• Manually – Each piece rotates with the movement of the cursor. Left click to 
place the section of the piece. 

• Automatically – The piece is spread so that the curve of the modified piece fits 
the curve of the stationary piece. 
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Hints: 
• The pieces are matched using the match point on the target piece and the start 

point of the slash line range. If automatic is selected, the slashed piece will be 
matched to the target piece from the match point clockwise around the match 
piece. 

• When manually creating slash lines, all the lines must start on one line and end 
on another line, and may not cross each other. 

 

Fullness - Parallel Slash n Spread 

AccuMark = New 

MicroMark = New 

 

Use this function in the Piece menu to add parallel fullness on multiple pieces. The 
input box is used to enter the fullness amount.  

To add tapered fullness on multiple stacked pieces: 

1. From the Piece menu, choose Fullness and then select Parallel Slash n 
Spread. 

2. Select all of the pieces to be modified.  End selection to continue 

3. Create slash line(s) across all selected pieces. Make sure the outermost ends 
of the slash lines are located on the outermost perimeters of the selected 
pieces. End selection to continue. 

4. Select location to remain stationary by selecting along a line. 

5. Select any internal lines to move. End selection to continue. 

6. Enter fullness by doing one of the following: 

• In Cursor mode, drag the slash lines apart and left click to position the spread. 
Check the Dist or Ang fields to see the amount of fullness being added. 

• In Value mode, type a value in the Dist field. Click OK or press Enter. 

The slash lines are parallel and separated by the distance values specified. 
Hints: 

• Balanced fullness or one-sided fullness is determined by where the location to 
remain stationary is selected. For example, to add balanced fullness with one 
slash line, select the location to remain stationary near first point of the slash line. 

• All pieces in the work area can quickly be selected by using the right mouse 
button menu option "Select All" or the hot key Ctrl +A. 
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Fullness - Taper Slash n Spread 

AccuMark = New 

MicroMark = New 

 

Use this function in the Piece menu to add tapered fullness on multiple pieces.  
To add tapered fullness on multiple stacked pieces: 

1. From the Piece menu, choose Fullness and then select Taper Slash n 
Spread. 

2. Select all of the pieces to be modified. End selection to continue. 

3. Create one slash line across all selected pieces. Make sure the outermost 
ends of the slash line are located on the outermost perimeters of the selected 
pieces.  
End selection to continue. 

4. Select location to remain stationary, by selecting along a line. 

5. Select any internal lines to move. End selection to continue. 

6. Enter fullness by doing one of the following: 

• In Cursor mode, drag the slash lines apart and click to position the spread. 
Check the Dist or Ang fields to see the amount of fullness being added. 

• In Value mode, type a value in the Dist or Ang fields. Click OK or press Enter. 

The slash lines are hinged at one end and separated at the other end by the 
distance or angle values specified. 
7. End selection to continue. 

Hints: 

• Balanced fullness or one-sided fullness is determined by where the location to 
remain stationary is selected. For example, to add balanced fullness with one 
slash line, select the location to remain stationary near first point of the slash line. 

• New grade rules are calculated for the piece if Modify Grade Rule is checked in 
Preferences/Options.  

• When creating slash lines, the first point selected is the pivot point, and the 
second point is where the fullness is added. 

• Balanced fullness or one-sided fullness is determined by where the location to 
remain stationary is selected. For example, to add balanced fullness with one 
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slash line, select the location to remain stationary near the first point of the slash 
line. 

• All pieces in the work area can quickly be selected by using the right button menu 
option "Select All" or the hot key Ctrl +A. 
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Asymmetrical Folds 
Working with Asymmetrical Folds 

The Assym Fold menu provides functions for folding pieces along a line other than a 
mirror line. These functions are designed to check patterns for features such as 
balance, etc. 

 
Hints: 

• An Asymmetrical fold can be made along a line connecting two points, along dart 
lines, or along pleat lines.  

• Folded pieces can be modified using many PDS/Silhouette functions. 

• Only one fold is allowed per piece except when using Pleat Fold, which allows two 
folds. 

• If you have previously worked with AccuMark or MicroMark pattern design 
systems, many of these functions will be familiar. However, you may improve your 
productivity by taking time to become acquainted with some new methods for 
working with asymmetrical folds. 

• Use Pref/Hide Seam for a clearer display. 

Asymm Fold - Line Fold 

AccuMark = Blocks/ Asymmetrical Folds/ Line Fold 

MicroMark = Piece/ Fold Check/ Select line 

 

Use this function in the Piece menu to fold a piece along an internal line. For 
example, use to fold a sleeve along the centerline to determine if the piece is 
balanced.  

To fold on a line: 

1. From the Piece menu, choose Asymm Fold and then select Line Fold. 

2. Select the internal line along which you want to fold.  

The system draws a dashed line that extends in both directions from the internal 
line to the perimeter/boundary lines at either end. 
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3. Select a perimeter/boundary line on the side of the piece that is to be folded 
toward the other side.  

The system redraws the folded piece. 
4. End selection to continue. 

 

Asymm Fold - Line to Line Fold 

AccuMark = Blocks/ Asymmetrical Folds/ Line to Line Fold 

MicroMark = New 

 

Use this function in the Piece menu to fold a piece between two selected lines. This 
is helpful if you want to see if two lines match up or if they are the same length. If 
the line has more than two points, the system uses the line’s end points to make the 
match.  

For example, use this function to make a fold on a pant leg, below the knee, down 
the front. The system draws a dashed line representing the fold (crease line). 

To create a fold between two lines: 

1. From the Piece menu, choose Asymm Fold and then select Line to Line. 

2. Select the first line. The second line is matched to this one. 

3. Select the line to match to. A dashed line, or fold line, is drawn to representing 
the fold. 

4. Choose a point on the perimeter/boundary of the piece that is folded towards 
the other.  

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points. 

The system redraws the piece to reflect the line-to-line fold. (See example) 
5. End selection to continue. 

Hints: 

• Use Unfold Keep to maintain the folding line. This may then be relabeled as the 
Grain Line. 
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Line To Line Example 

In this example, the piece is folded so that the two underarm seams meet to check 
balance. Using the function Unfold Keep, the piece can be unfolded saving the 
folding line. Make Parallel can then be used to make the Grain/Grade Ref Line 
parallel to the fold line. 

 

  

Asymm Fold - Match Points 

AccuMark = Blocks/ Asymmetrical Folds/ Match Points 

MicroMark = Piece/ Fold Check/ Match Points 

 

Use this function in the Piece menu to fold a piece between two selected points. The 
system matches up the second point to the first and creates a fold.  

For example, use to see match notches on a pant leg to check balance. 
To fold a piece from point to point: 

1. From the Piece menu, choose Asymm Fold and then select Match Points. 

2. Select the point to remain stationary. This can be on an internal or 
perimeter/boundary line. 
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To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points. 
3. Select the point to fold to the stationary point. The system redraws the piece 

with the fold line displayed as a dashed line. (See example) 

4. End selection to continue. 
Hint: 

• Use Unfold Keep to maintain the folding line. This may then be relabeled as the 
Grain Line. 

 

Asymm Match Points Fold Example 

In this example, Match Points can be used to check the balance of the pant leg by 
selecting the knee notches. 
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Asymm Fold - Dart Fold 

AccuMark = Blocks/ Asymmetrical Folds/ Dart Fold 

MicroMark = New 

 

Use this function in the Piece menu to shift the dart fullness to another location of 
the piece. The boundary line appears as if the dart was sewn. This allows you to 
check the legs of the dart to make sure they are the same length and that the seam 
is smooth. Folding the dart can be useful to verify the sew line.  

To fold a dart 

1. From the Piece menu, choose Asymm Fold and then select Dart Fold. 

2. Select the dart on the piece to fold. The system redraws the piece and the 
other side of the perimeter/boundary is slashed to allow for the dart fold. (See 
example) 

3. End selection to continue. 

 

Assym Dart Fold Example 

In this example, Dart Fold can be used to check the trueness and curve shape of 
the waist seam. 

 434 
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Asymm Fold - Pleat Fold 

AccuMark = Blocks/ Asymmetrical Folds/ Pleat Fold 

MicroMark = New 

 

Use this function in the Piece menu to fold a piece between two points to create a 
pleat. You are allowed to create two pleat folds per piece. After selecting two points 
on a piece, the system determines the fold line based on the center of the 
perpendicular between the two points. Use this function to fold a pleat in order to 
verify accurate underlay. 

To fold a pleat: 

1. From the Piece menu, choose Asymm Fold and then select Pleat Fold. 

2. Select the first point of the fold. The point displays as a solid red box. 

3. Select the second point. Two internal pleat lines are drawn on the piece 
representing the pleat lines. If this is the only pleat to be folded on this piece, 
end selection to continue. 

4. If you are folding two pleats on the piece, select the points for the second 
pleat. The system redraws the piece with both pleats folded. (See example) 

5. End selection to continue. 

 

Assym Pleat Fold Example 

In this example, Pleat Fold can be used to check the perimeter shape after the pleat 
is folded. 
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Asymm Fold - Perim Pt Fold 

AccuMark = Blocks/ Asymmetrical Folds/ Perimeter Point Fold 

MicroMark = Piece/ Fold Check/ Define Fold Line 

 

Use this function in the Piece menu to create a fold line between two 
perimeter/boundary points. Remember, you can only fold a piece one time. For 
example, use this function to show the fold line on the cuff of a sleeve or a jacket 
lapel. 

To fold a pleat between two points: 

1. From the Piece menu, choose Asymm Fold and then select Perim Pt Fold. 

2. Select the first fold point. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points. 
3. Select the second point. The system draws a dashed internal line drawn 

between the two points, representing the fold line. 

4. Click anywhere on the perimeter/boundary of the piece to fold. This tells the 
system which way the piece is to be folded. The part folded over the rest of the 
piece now has an internal fold line. (See example) 

5. End selection to continue. 

 

Assym Perim Pt Fold Example 

In this example, no internal line exists at the location of the break line, so the lapel is 
folded back by selecting the two perimeter points along the break line. 
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Asymm Fold - Unfold 

AccuMark = Blocks/ Asymmetrical Folds/ Asymmetrical Unfold 

MicroMark = Piece/ Fold Check/ Select Line, Define Fold Line or Match 2 Points 

 

Use this function in the Piece menu to unfold a piece. Basically, using Unfold 
reverses any folds made with the functions in this menu. Any internal fold lines that 
the system created are also removed. You can use Asymm Unfold Keep to keep 
internal lines. 

To unfold a piece: 

1. From the Piece menu, choose Asymm Fold and then select Unfold. 

2. Click on the piece that you want unfolded. The system redraws the piece 
without the folds and removes the internal fold lines. 
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3. End selection to continue. 

 

Asymm Fold - Unfold Keep 

AccuMark = Blocks/ Asymmetrical Folds/ Unfold Keep 

MicroMark = Piece/ Fold Check/ Define Fold Line, Keep Line or Match 2 Point Keep 
Line 

 

Use this function in the Piece menu to unfold a piece but keep the internal line 
where the fold was made. (When using Asymm UnFold, the internal line is 
removed.) The internal line may then be relabeled as a Grain Line. 

To unfold a piece: 

1. From the Piece menu, choose Asymm Fold and then select Unfold Keep. 

2. Click on the piece that you want unfolded.  

The system redraws the piece but retains the internal fold lines. 
3. End selection to continue. 
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Grading 
Overview of Grade Menu 

Use functions in this menu to create or modify grading on a piece. Grading refers to 
the way a pattern grows from size to size. When using the PDS/Silhouette main 
menu to access functions, click on Create/Edit Rules or Modify Rule to display 
additional functions. Or, add a custom tool bar that contains the functions you use 
most frequently. 

If you have previously worked with AccuMark or MicroMark systems, many of these 
functions will be familiar and can be accessed using the traditional AccuMark menu 
or MicroMark menu. However, you may improve your productivity by taking time to 
become acquainted with some new methods for working with grading. 

Hints on Viewing and Working with Grading 
 

• Use View/Grade functions to display sizes in a graded nest or to remove a 
displayed nest. 

• A pound symbol (#) displays after a rule number, if the grade rule was generated 
by the system. This happens, for instance when the Add Grade Point or when a 
nest is originally digitized. 

• An asterisk (*) displays after the rule number if the grade point was created, or 
modified, using many functions in the Grade menu.  

• If Modify Grade Rules is set to ON in General Preferences/Options, grade rules 
for AccuMark pieces modified with Piece menu functions such as Pivot Dart or 
Tapered Fullness are automatically updated and an asterisk (*) is placed next to 
the rule number. The new rule number is unique to that piece, independent of any 
rule table, and is stored with the piece information. 

• Forms and charts allow you to view or change grade point information or measure 
lines for nested pieces. 

• Nested pieces are generally graded about the grain/grade reference line for each 
piece. You can use stacking points (Z and R attributes) to stack about a common 
point or line instead. 
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Copy Size Line 

AccuMark = Grade/ Create Edit/ Copy Size Line 

MicroMark = Not applicable  

 

Use this function in the Grade menu to copy a size line from one piece to another. If 
the size line is edited on one piece, Use this function to update the size range of 
related pieces. This function can also be used to specify a size line for a piece 
before grading the piece using the Create Delta or Create Offset functions. 

To copy a size line between pieces: 

1. From the Grade menu, select Copy Size Line. 

2. Select the reference piece whose size line is to be copied to other pieces.  

3. Select the target piece(s). This is the piece (or pieces) the size line is copied 
to.  

4. End selection to continue.  

The system copies the size line from the first piece to the target piece. 

 

Add Size Break 

AccuMark = Grade/ Create Edit/ Add Size Break 

MicroMark = Not Applicable  

 

Use this function in the Grade menu to designate an intermediate size as a size 
break. This function applies only to AccuMark pieces with numeric sizes. All existing 
rules on a piece are affected. This is because a new growth amount is added to 
each intermediate size that is made into a break.  

Note: Once you update a piece, you cannot change a size break back to an 
intermediate size. 

To change an intermediate size to a break size: 

1. From the Grade menu, select Add Size Break. 

2. Select the piece to edit. 
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The Size Break form displays the current size line information. An asterisk appears 
beside the sizes that are already breaks.  
3. Click the intermediate size you want to make into a break size. An asterisk is 

placed next it. 

4. To deselect a size, click on it again to remove the asterisk. Sizes must be 
deselected before you choose Update in the next step. 

5. Click the Update button. 

The system makes the intermediate size into a break size and re-displays the nest 
of the piece to reflect the change. 
6. End selection to continue. 

Hints: 

• Using this function does not affect the rule table assigned to the piece. However, 
the piece can no longer reference that rule table.  

Assign Rule Table 

AccuMark = Grade/ Rule Table 

MicroMark = Style Descriptions/Grade Rule Table Name 

 

Use this function in the Grade menu to assign a new grade rule table to a piece. If a 
piece is stored after you assign a new rule table to it, the system recognizes that 
rule table the next time that piece is retrieved. You can use the Show All Sizes 
function to view how a piece grades after it is assigned a new rule table. 

When a rule table is assigned to a piece, the following happens: 

• The piece is automatically labeled the base size of the rule table. 
• The piece takes on the grading of that rule table and size line. 
• If the piece has grade rules that do not exist in the rule table, no growth is 

assigned to these points. 
To assign a new grade rule table: 

1. From the Grade menu, select Assign Rule Table or press the Alt +T keys. 

2. Select the piece(s) to be assigned to a new rule table. End selection to 
continue. 

The Assign Rule Table dialog box displays the rule tables for the current storage 
area, with the name of the rule table assigned to the piece(s) highlighted. 
3. Select another existing rule table (library). Click OK or press Enter.  
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The default path was selected on the Paths page of Preferences/Options.  

Note: The rule table you select must be in the same storage area or directory as the 
pieces you are currently grading. Type a rule table name or use the drop-down list 
boxes to find the location of other rule tables.  

If the piece has grade rules that are not in the new rule table, the system replaces 
these rules with a # symbol and assigns zero growth at that location. 
4. If prompted that zero growth has been assigned, click OK for each grade point 

that is not defined in the new rule table. 

5. End selection to continue. 
Hints: 

• Grade points can be changed to intermediate points by assigning a negative one 
(-1) rule number. 

• The rule tables used must be in the current storage area. 

• The storage area can be changed using the Pref/Paths function. 

 

Create Nest 

AccuMark = Grade/ Clear Nest 

MicroMark = New 

 

Use this function in the Grade menu to create a nest from different pieces of 
different sizes. You can also use this function to create a graded pattern from pieces 
scanned into the system. 

To create a nest using an existing size line: 

1. From the Grade menu, select Create Nest. 

2. Click Add Piece to Model/Style to have the piece automatically added to the 
active model or style. 

3. Select the Size Line option: 

• Base Size Line – uses the size line of the base piece for the nest. 
• Create New Size Line – creates a new size line for the next. 
4. Select the Stack Nest option: 

• Select Points – stacks the nest from one corresponding point on each piece. 
• Use Piece Center – stacks the nest at the piece center. 
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5. When prompted, click on pieces to identify as sizes in the size line. If Select 
Points was chosen in step 3, select a specific point on each piece to build the 
nest. 

6. End selection to continue. 
To create a nest with a new size line: 

1. From the Grade menu, select Create Nest. 

2. Select Create New Size Line to create a new size line for the nest. 

3. Select the Stack Nest option: 

• Select Points – stacks the nest from one corresponding point on each piece. 
• Use Piece Center – stacks the nest at the piece center. 
4. If Create New Size Line was chosen in step 2, the Create New Size Line 

dialog box opens.  

5. Enter the following types of information about the new size line: 

• Size Type – choose Numeric or Alphanumeric (only valid for MicroMark data). 
• Base Size – type the size to become the base size  
• Size Step – type a new size step or accept the default (1) (not applicable for 

MicroMark data). 
• Smallest Size – type the smallest size. 
• Size Breaks – type a size where you want the growth to change and then press 

the Tab key. This size is entered in the Size Break list at right. Repeat for other 
break sizes. 

When finished completing this dialog box, click OK. 
6. When prompted, click on pieces to identify as sizes in the size line. If Select 

Points was chosen in step 3, select a specific point on each piece to build the 
nest. 

7. End selection to continue. 

 

Edit Break Sizes 

AccuMark = Piece Verify/Edit Points/Edit Size Line/Add Break or Delete Break. 

 

This function in the Grade menu is used to add or remove size breaks. This 
function works differently depending on wheter a piece has an alphanumeric or 
numeric size line. 

Add Break 

• Alphanumeric – For pieces with an alphanumeric size line, all sizes are 
considered break sizes. Use Add Break to add a new size or change the 
smallest or the largest size. The dimensions of all sizes will remain the 
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same, and the added break size will take on the same dimensions as the 
previous size. The coordinates of the new size may be edited as needed. 
The size line will update to include the new size. 

• Numeric – For pieces with a numeric size line, only certain sizes are 
considered break sizes. These are the sizes where growth to the next size 
changes. When a break is added a different growth method for a new group 
of sizes may be specified.  

When a new smallest size is added, -for example the smallest size was 6 but 
now 4 will be the smallest size-, the new size automatically becomes a new 
break. For instance 2 to 4 and 4 to 10. To grade the new size as the 
previous smallest size, use Delete Break to delete the previous smallest 
size. For example, delete size break 4 to end up with a 2 to 10 break. 

When a new largest size is added, -for example, it was 18 but now it will be 22-, 
the new size will be automatically considered a new break. Use Delete 
Grade as needed to control the grading –see explanation in the paragraph 
below-. After a size break is added the increments of growth may be 
adjusted. The size line will update to reflect any changes. 

Delete Break 

• Alphanumeric – For pieces with an alphanumeric size line, all sizes are 
considered break sizes. If a break size is deleted the system will no longer 
allow the deleted size to be ordered. To change the smallest or largest size 
or eliminate any size in between, use Delete Break. The dimensions of all 
remaining sizes will remain the same and the size line will update. 

• Numeric – For pieces with a numeric size line, only certain sizes are 
considered break sizes. These are the sizes where growth to the next size 
changes. The sizes deleted can be ordered, -unless the smallest or largest 
sizes where deleted. It simply changes the method of applying growth to the 
next sizes. 

To delete the smallest size, -for example, it was 4 but now it will be 8-, the new 
smallest size must be added as a break before. For instance, if the original 
break size was 4 to 10 to eliminate sizes 4 and 6, first the size 8 must be 
added as a break. If the original size already contained breaks 4 to 8 and 8 
to10 there is no need to add size 8 as a break. 

To delete the largest size, -for example it was an 18 but now it will be 16-, the 
new largest size must be added before. 

After deleting a break, the growths increments may be adjusted if necessary. 
The size line will update to reflect the changes. 

To edit size breaks: 

1. From the Grade menu choose Edit Size Line and then select Break Sizes. 

2. Select the desired piece and end selection. 
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3. Select a size to add as a break or select a size to delete as a break. 

4. End selection to continue. 

 

Export Rules 

AccuMark = Grade/ Export Rules 

MicroMark = Grade/ Add Rules 

 

Use this function in the Grade menu to export grade rules to an existing rule table. If 
the rule table does not exist, the system creates one. The rule table must have the 
same base size and size line as the piece the grade rule is on.  

Rules can be exported either individually or by piece. You can also choose to export 
rules when saving models or styles using the Save or Save As functions.  

Note: If the size line of the piece is not the same as the size line in the rule table, the 
system prompts: Size Lines Do Not Match. You cannot export rules if the size line of 
the piece and the rule table do not match. 

To export rules to the grade rule table: 

1. From the Grade menu, select Export Rules. 

The Export Rules dialog box displays. 
2. Select from these options: 

• Style/Model – When selected, the rules of all pieces in the selected model or 
style are exported. This includes all pieces in the work area and the piece menu 
of the selected model or style. This option may be used on multiple model/styles 
at one time and is not selectable when only pieces are retrieved. 

• Piece/Point – Individual points or pieces may be selected for exporting. 
• Assign Rule Table – Assigns the rule table (that the rules were exported to) to 

either the pieces or the model/style depending on whether the Style/Model or 
Piece/Point option was selected. 

3. Select an existing rule table (library) you want to export rules to. Click OK or 
press Enter. 

The default path was selected on the Paths page of Preferences/Options.  

Note: The rule table you select must be in the same storage area or directory 
as the pieces you are currently grading. Type a rule table name or use the 
drop-down list boxes only to find the location of other rule tables.  
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4. Select the point or piece you want to export rules from. 

• If selecting a piece, click on the piece whose rules are to be exported. 
• If selecting a point on a piece, click on the point(s) whose rules are to be 

exported. 
5. End selection to continue.  

The system exports the grade rules to the rule table. The rules are 
renumbered to match the new rules in the rule table. 

Click OK when the system prompts when the process is completed.  
6. End selection to continue. 

The grade rules are exported to the table and renumbered according to 
existing rules in the table. 

Hints: 

• The rule table you export to must be in the current storage area. The storage area 
can be selected through Pref/Environ (either AccuMark or MicroMark 
environment). 

• Rules for an AccuMark piece can be exported to a MicroMark rule table, and vice 
versa. 

 

Tangent Grading for MicroMark Data 

Tangent grading is used on notches to control notch positioning when grading. 
Tangent grading is also used to maintain the smoothness of a curve as a notch is 
graded.  

A Tangent grade rule uses only one value, as opposed to two values (X and Y) 
required in delta grading. Plus and minus values determine whether growth is in the 
positive or negative direction from the sample size. The Curve Length Reference 
point type is the reference point used with Tangent grading. This point is 
automatically the first point of a line unless otherwise changed. There may only be 
one curve length reference point per line. 

Tangent grading can be added to an existing rule table.  

Note: MicroMark pieces with Tangent grade rules can be saved as AccuMark pieces 
with the tangent grading maintained. 

 
For AccuMark Data please see Specify Dist/Tangent. 
 

To use Tangent grading: 

1. From the MicroMark Main menu, select Grade Rule Table and (2) Add Rule: 
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a) Type in the name of the new rule with a "C" (for changed); example: 1000C. 

b) Change the default (2) Grade Type. Toggle to Tangent. 

c) Select (3) Keep Values. 

d) When prompted for variations, select (3) Keep Values. 

e) Specify modify as the action to change the grading values. 

f) Select Curvlenref as the Modifier. 

g) Repeat for additional grade rules. 

h) Press Enter when complete. 

i) Save revisions. 

j) Press the Escape key to return to PDS. 
2. In PDS, edit grading for a point: 

a) Use functions in the View/Grade menu to view graded sizes. 

b) Select Edit Point Info.  

c) Select the notch point that requires the Tangent rule.  

d) Specify the Tangent rule number and click the Apply button. 

e) Change the Curve Length Reference point, if necessary. 

 

 

Grade Forms and Charts 

Working with Create/Edit Forms 

A Create/Edit Grade form displays on-screen when using various functions in the 
Create/Edit Rules menu. Each form is similar to the one shown below. However, the 
fields and Option buttons at the right vary depending on the form. See example of 
MicroMark grading form. 

All Create/Edit forms contain fields that allow you to edit grading information for the 
currently selected point on all sizes in the graded nest.  

These forms open over the work area and can be repositioned, allowing you to 
observe how changes made in the form affect the graded nest and vice versa.  
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Note: Edits to grading must be made on the master set of perimeter lines. When 
attempting to edit grading on a piece in the "swapped" state, a warning will display 

To make edits using Edit Grade or Create Grade form: 

1. Make sure that the current perimeter/boundary lines are digitized or master 
lines. 

2. Open one of the following Create/Edit Rules functions. Follow the prompts to 
select a point to edit. 

• Edit Delta  
• Create Delta  
• Edit Offset  
• Create Offset  

A form similar to the one below displays over the work area.  

  

When using Edit Delta and Create Delta functions, a line connecting actual 
points in the nest in the work area also displays. This line (shown to the left of 
the sample form above) visually represents the X and Y values listed in the 
form. 

The grading method used in AccuMark or MicroMark is included in the title bar 
of the form (Small-Large Incremental, in the sample form). 

At the left of the form, view a list of all Size Breaks for the piece. Each row in the 
chart corresponds to a size break. 

To the right of the size break list are various columns. Some of these columns 
contain fields that can be edited. For specific field names and how to use, refer 
to the procedure for working with each function. 

3. To edit a specific size, click in the field of any editable column in the same row 
as the size. Type a value.  

 450 



Or, enter growth values for a few strategic sizes when working with either 
MicroMark Relative grading or AccuMark Base Up-Down Cummulative 
methods.  

4. Click Update to display changes applied in the work area. 

If using Relative or Base Up-Down Cummulative grading methods, the system 
automatically calculates growths for the additional sizes and updates the form. 
The calculation is similar to using \default in MicroMark or to using Update for 
the other AccuMark grading methods. The system considers the growth 
between two entered sizes and how many sizes exist between them, then 
applies the growth evenly for the remaining size(s). 

When using Edit Delta and Create Delta functions, the line connecting actual 
points in the nest in the work area is also updated. You can reposition this form 
in the work space to better view how your edits affect points on the piece. 

5. When using Edit Delta or Edit Offset functions, you can manipulate and view 
data in the form using option buttons below, as available for each function. 

• Clear X, Clear Y, Clear Offset – removes the amounts in each respective 
column. You can then easily enter new values. 

• Copy Previous, Copy Next – copies values from a grade point before or after 
the current grade point. 

• Previous – displays values for the previous grade point.  
• Next – displays values for the next grade point. 
• Print – allows growth values for a rule to be printed. 

Note: The previous grade point on the perimeter of a piece is the first grade point in 
the counter-clockwise direction from the currently selected one. On an internal line, 
the previous grade point is the next grade point toward the start of the line. 

6. When using Edit Delta and Create Delta functions, click the drop-down list box 
for the Grain Line field to select a different grain line, if more than one exists 
for the piece. Grading for edited points will be based on this grain line. 

7. Continue to edit the current point or select a different one. Verify changes 
made in this form and in the work area. Before selecting another point, click 
the Update button.  

8. When finished, save changes and/or close the form using these option 
buttons: 

• OK – closes the form and ends the function. 
• Cancel – closes the form without saving any changes that have not been 

updated. 

MicroMark Grading Formats for Editing Grading (MK) 

When editing grading on MicroMark styles, the grading form displays the MicroMark 
grading method, Relative or Incremental. The size line will also display appropriately 
based on the grading method for the current piece being worked on. 
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Working with Distances Grade Forms 

A Distances Grade form displays on-screen when using various functions in the 
Create/Edit Rules menu. Each form is identical to the one shown below. 

All Distances Grade forms contain an Amount field that allows you to edit grading 
information based on a distance for all sizes in the graded nest. Entering 0.00 for all 
sizes keeps the dimension the same for all sizes in the nest.  

These forms open over the work area and can be repositioned, allowing you to 
observe how changes made in the form affect the graded nest and vice versa.  

 
To make edits using Distances Grade form: 

1. Open one of the following Create/Edit Rules functions, then follow the prompts 
to select a point to edit. 

• Keep Angle Edge Ext  
• Parallel Ext  
• Specify distance  
• Intersection Offset  

A form similar to the one below displays over the work area. To view all of the 
screen, click on the middle button in the upper right corner of this help window. 
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At the left of the form, view a list of all Size Breaks for the piece. Each row in 
the chart corresponds to a size break. 

To the right of the size break list is the Amount column. For specifics on how to 
use each form, refer to the procedure for working with each function. 

2. To edit a specific size, click in the field of the Amount column in the same row 
as the size. Type a value.  

When editing or entering values in the form, you have to click Update before 
changes are applied in the work area. You can reposition this form in the work 
space to better view how your edits affect points on the piece.  

3. Click the drop-down list box for the Grain Line field to select a different grain 
line, if more than one exists for the piece. Grading for edited points will be 
based on this grain line. 

4. Continue to edit the current point or select a different one. Verify changes 
made in this form and in the work area. Before selecting another point, click 
the Update button.  

5. When finished, save changes and/or close the form using these option 
buttons: 

• OK – closes the form and ends the function. 
• Cancel – closes the form without saving any changes that have not been 

updated. 
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Measure Line 

AccuMark = Grade/ Measure Line 

MicroMark = New 

 

Use this function in the Grade menu to use a chart to measure the length of specific 
lines in each size for one or more graded pieces. 

To measure line lengths for each size in a graded nest: 

1. From the Grade menu, choose Measure and then select Line or press the Alt 
+Q keys. 

2. Select the line(s) you want to compare measurements for. End selection to 
continue.  

A Line Measure chart displays. 
3. To compare other lines to those selected in step 2, select these line(s). End 

selection to continue.  

A second Line Measure chart displays with a Difference column. 
4. End selection to continue. 

5. Use the charts to compare Difference values. 

6. To print the chart, click the Print button on the chart to open the Print dialog 
box. To output a copy of the chart, a printer must first be set up. 

7. To close a chart, the button marked with an X in the top right corner of the 
chart. 

8. To check other lines, repeat as desired. Or after fixing sew lines, repeat to 
verify the differences. 

9. End selection to continue. 

  Related Topics  

Working with Measure Line Charts 

Line Measure charts display when using the Grade/Measure Line function. Data can 
be printed. Use these charts to: 

• View measurements for one or more lines for all sizes in a graded nest. 
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• Check differences between the total lengths of one or more selected lines with 
another group of lines. Useful for comparing sew line lengths. 

To compare measurements using Measure Line charts: 

1. Open the Grade/Measure Line function.  

2. Select line(s) to measure. End selection. 

A chart similar to the top one below displays over the work area. Piece sizes 
display in a list at the left. Each row in the chart corresponds to one of these sizes. 
Values in the Total column reflect the sum of all line(s) selected for each size. 
Values in the Size Difference-Group 1 column reflect the difference in length 
between each size. 

  
3. To compare a second group of lines, select the appropriate line(s) on the 

same or another piece. End selection to continue. 

A second chart displays on the work area. In the second chart, the first four 
columns show the same information as in step 2. However, there are two additional 
columns. The fifth column, Difference Between Totals, shows the difference in line 
length for all of the lines selected in the second group. The sixth column, Overall 
Size Difference, shows the difference in line length between the two groups. 

Notice that each selected line in the work area has a label that corresponds to a 
heading column in one of the charts. The column headers are resizable; see step 5. 
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4. Review values in the Difference columns values.  

5. To reposition or resize the charts, do any of the following: 

• Click on the title bar of the chart you want to move. Then drag it to a new position 
in the work space. 

• Place the cursor at the right or left edge of the chart. When the cursor shape 
changes to a double arrow, click and drag to enlarge or reduce the width of the 
chart. 

• Place the cursor over the line between any two, column headings. When the 
cursor shape changes to a line with arrows, click and drag to the left or right to 
resize the column heading and view or hide the text. 

6. To print a copy of the chart, click the Print button on the chart to open the Print 
dialog box. To output to a file, a printer must first be set up. 

7. To close a chart, click the button marked with an X in the top right corner of the 
chart. 

Clear Charts 

AccuMark = Grade/ Clear Charts 

MicroMark = New 

 

Use this function in the Grade menu to remove charts displayed after using Measure 
Line. 

To remove measurement charts: 

1. From the Grade menu, select Clear Charts or press the Alt +Z keys. 

2. End selection to continue.  

 

Create/Edit Grade Rules 

Creating or Editing Grade Rules 

Use functions in the Create/Edit Rules menu to create grading for an AccuMark 
piece. The grading dialog boxes in the Edit/Create Grading menu are sized to allow 
more room to view the pieces in the work area.  

Note: Functions in this menu can be used with MicroMark data by exporting the 
rules to a rule table. 
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Grading with Rules 

The figure shows a piece displayed with Preferences/Perimeter set to Clipped. 
There are two different rules at the corner where the perimeter intersects with the 
side seam. The system finds the intersections of the graded lines for all of the sizes 
to create the graded nest. 

When using the 'Apply Rules to Joined End Points' option: 

• The 'Individual' option lets you use grading functions independently on the two 
lines of a corner.  If you copy a grade rule with the 'Individual' option selected, the 
rule is only copied to one end of one of the lines of the corner. 

• The 'Both if Same' option will apply the grading to both ends of the two lines at a 
corner if they had the same rule originally. 

• The 'Always Both' option will always apply the grading to both points at the 
corner whether or not they were the same to start with. 
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Grading with Line Extensions 

This is an example of a graded nest with line extensions displayed with 
Preferences/Perimeter set to Unclipped. In this example, the ends of the side seam 
and the shoulder line can have grade rules that are different from the ends of the 
curved design line. 

  

When editing or creating grading, select the option Apply Rule to Joined End Points 
to control whether grade rules will apply to individual or both end points. 

When applying or changing grade rules in Edit Point Info use the Apply to Both End 
Points check box to control whether grade rules will apply to individual or both end 
points. 

Modified Rules Display for Seam Internals 

Pattern Design generates grading on seam internals to maintain: 
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• Accuracy 
• Parallel seam allowance for all graded sizes 

Internally, the system grades each size and then adds the seam. This means that 
the value for the grade rule on the seam internal (dashed line) may need to be 
slightly different than the value that is applied to the perimeter line (solid line). 

Note: To copy the grade rules from the original piece perimeter to the system-
generated seam lines, see Swap Sew/Cut. 

The following illustration shows a piece in Pattern Design that has sew lines as the 
original piece perimeter. The piece is graded and seam allowance is applied. 

Notice at point A the growth is 0,0, but 
on the corresponding cut line at point B 
the growth is NOT 0,0. (Notice the 
position of the grade symbols.) The 
seam allowance is generated after the 
piece is graded which results in the 
grade rules of the cut line being 
different than the grade rules of the 
sew line. 

Also, notice the difference at point C. 
The Y growth of the grade rule on the 
sew line is 0, but to keep the seam 
truly parallel for all sizes the system 
has to generate a new rule on the cut 
line that has a Y growth.  This is the 
same result that MicroMark users 
would get. For AccuMark users, the 
system-generated rule is the same as if 
Adjust Grading had been used on this 
point.   

The system displays a modified rule 
number on the seam internal when the 
values it calculates are different from 
the original rule. In the example to the 
right, the rule #3 existed on the original 
sew line perimeter. When seam was 
added, the system updated to rule on 
the cut line to be a 5# because it had to 
modify the rule values. 
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The examples below show the values of both rules in Edit Delta. 

  

 

Create/Edit Rules – Edit Delta 

AccuMark = Grade/ Create Edit/ Edit Delta 

MicroMark = Only applicable if the data is to be stored as AccuMark data or the new 
rules are exported to a rule table and the table is converted to MicroMark. 

 

Use this function in the Grade menu to modify one or more size breaks in a nest 
without affecting the grading of other size breaks. To do this, either specify growth 
by entering X and Y changes (Delta), or by using the cursor to manually move 
points.  

To modify a Delta grade rule by changing the X and Y values: 

1. From the Grade menu, choose Create/Edit Rules and then select Edit Delta or 
press the Alt + J keys. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 
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• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with extesions or grading with grade rules.) 
3. Select Maintain Growths to apply growth only to sizes greater than the size 

you plan to edit. Sizes smaller than that size will not be affected. 

4. Select the piece that has the grade rule to be edited. The system displays the 
size breaks for the AccuMark piece.  

5. Select an existing grade point, intermediate point, or location to edit. 

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location.  

• In Value mode, type the location for the split in the Beg or End field in the status 
area. Click OK or press Enter. 

The Edit Delta form displays on-screen with the grading information for the 
current point on all sizes in the nest. In the work area, a line connecting the 
same point on all sizes displays. This line visually represents either the X or Y 
values in the form. 

6. Select a point on a size break to edit. 

Note: Any size, except the base size, can be edited. If a non-graded point is 
selected, the system creates a grade point to hold the shape of the size. Unless you 
are editing the smallest or largest size of the piece, the adjacent sizes are affected. 
In other words, if you change a size, the sizes around this size are also altered by 
the change. 

7. Make edits using the form.  

• If you change a Delta X or Delta Y amount, the Distance field is affected. If you 
change the Distance field, the either the Delta X and Delta Y fields may be 
affected. You must click Update to see your changes. 

• If you prefer manually editing with the cursor, you can click a break size button to 
select the corresponding point in the work area. Repositioning the point in the 
work area immediately updates the form. 

Note: You can print the growth values for the rule from this form. 
8. If you have many changes to make in this form, click either the Clear X or 

Clear Y buttons to clear all existing values in the respective fields.  

9. Select a Grain Line to be used for the above point, if more than one grain line 
exists on the piece. 

10. Continue to edit the current point or select a different one. Before selecting 
another point, click Update.  

11. Click the OK button to save your changes, close the form, and end the 
function. 
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Create/Edit Rules – Create Delta 

AccuMark = Grade/ Create Edit/ Create Delta 

MicroMark = New 

 

Use this function in the Grade menu to create grade rules on either a graded or non-
graded piece without using grade rules from a rule table. In order to do this, assign a 
value to a grade point in the Create Delta Form. The piece must have a size line.  

To create a new Delta rule: 

1. From the Grade menu, choose Create/Edit Rules and then select Create 
Delta or press the Alt + K keys. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the location where you want to create a grade point.  

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the button at the correct location.  

• In Value mode, type the location for the point in the Beg or End field in the Value 
Input area. Click OK or press Enter. 

The Create Delta form displays on-screen. 
4. Using the form, select the size break where growth changes and enter values 

in the Delta X and Delta Y fields. You must click Update to see your changes.  

Values display in the Distance field for your reference. 
5. Select a Grain Line to be used for the above point, if more than one grain line 

exists on the piece. 

6. Continue to edit the current point or select a different one. Before selecting 
another point, click Update.  

When your changes are updated, the system generates delta grading for all of the 
sizes in the piece. Fields left blank on the form are filled in with the previous growth 
amounts or the system applies zero growth, corresponding to the smallest size. 
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7. Click the OK button to close the form and end the function. 
Hints: 

• The piece must have a size line. If it does not, use one of the other functions 
(such as Copy Size Line or Assign Rule Table) to specify a size line for the piece. 

 

Create/Edit Rules – Edit Offset 

AccuMark = Grade/ Create Edit/ Edit Offset 

MicroMark = New 

 

Use this function in the Grade menu to edit grade rule values based on perimeter 
lines rather than X and Y growth amounts for grade points. Any rule can be edited 
using this function, even those originally defined in a rule table. 

To edit Offset grade rule values: 

1. From the Grade menu, choose Create/Edit Rules and then select Edit Offset. 

2. Select the Apply Offset to End Points option to use: 

• Individual – Allows grading to be applied selectively to either end-of-line points 
at the intersection of perimeter/boundary lines.  

• Prev/Next – Allows grading with Prev, Current, and Next offsets as in classic 
AccuMark PDS. 

• Always Both – Applies grading to both end-of-line points at the intersection of 
perimeter/boundary lines.  

(See illustration of grading with externals or grading with grade rules.) 
3. Select the piece to edit. The size breaks of the piece display in a nest. 

4. Next, click the point to edit on a non-base size. If an end point is chosen, 
select the previous or next line for line grading. Select a perimeter line on the 
base size to determine the direction of the offset. This perimeter line is 
perpendicular to the growth line. 

The Edit Offset Form appears on-screen with the offset grading information for 
the current point on all sizes in the nest. In the work area, a line connecting the 
same point on all sizes displays. This line visually represents offset values in 
the form. 

5. Select a field in a size break to edit and make edits using the form.  

You must click Update to see your changes. You can print the growth values for 
the rule from this form. 

 463 



6. If you have many changes to make in this form, click the Clear Offset button 
to clear all existing values in the Offset Dist field.  

7. To copy offset values from the previous or next grade points, click the Copy 
Previous or Copy Next buttons. 

8. Select a Grain Line to be used for the above point, if more than one grain line 
exists on the piece. 

9. Continue to edit the current point or select a different one. Before selecting 
another point, click Update.  

10. Click the OK button to close the form and end the function. 
Hints: 

• The piece must have a size line. If it does not, use one of the other functions 
(such as Copy Size Line or Assign Rule Table) to specify a size line for the piece. 

 

Create/Edit Rules – Create Offset 

AccuMark = Grade/ Create Edit/ Create Offset 

MicroMark = New  

 

Use this function in the Grade menu to create grade rule values based on perimeter 
lines rather than X and Y growth amounts. The form used with this function depends 
on the kind of point chosen. MicroMark users can use Perpendicular grading for a 
similar result. 

To create new Offset rules: 

1. From the Grade menu, choose Create/Edit Rules and then select Create 
Offset. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Prev/Next – Allows grading with Prev, Current, and Next offsets as in classic 
AccuMark PDS. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the point, or location on the base size, to which the grading will be 

added.  
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The Create Offset Form displays on-screen. If an intermediate or grade point 
was selected, the form displays with one column: Offset Dist. If an end of line 
point is selected, the form displays with two columns: Previous Offset and Next 
Offset.  

4. Using the form, select each size break and enter growth amounts as follows: 

• For an intermediate or grade point, type the growth amount in the Offset Dist 
field. 

• For an end of line point, type the growth amount for a size in the Previous Offset 
or Next Offset column. 

You must click Update to see your changes. 
5. Continue to edit the current point or select a different one. Before selecting 

another point, click Update.  

When your changes are updated, the new values assigned to the grade rule 
display in the form. 

6. Click the OK button to close the form and end the function. 
Hints: 

• The piece must have a size line. If it does not, use one of the other functions 
(such as Copy Size Line or Assign Rule Table) to specify a size line for the piece. 

 

Create/Edit Rules – Match Line X 

AccuMark = New 

MicroMark = New 

 

Use this function in the Grade menu to create a graded line length that matches the 
line length of the ‘sew to’ piece(s). This function creates a growth value in the X 
direction and uses the existing value for Y. 

To create a rule to match the graded line length of one line to another: 

1. From the Grade menu, choose Create/Edit Rules and then select Match Line 
X. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 
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• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the line to grade. 

4. Select the end of the line to receive the new grade rule. 

5. Select the line(s) on another piece to match the length. One or two lines can 
be selected.  

The display of the piece updates to reflect new grade rules. (See example) 
6. End selection to continue. 

Hint: 

• If the base size has ease, the system maintains proportional ease on graded 
sizes. 

 

 

Example of Match Line X 

In this example, Match Line X can be used to find the X growth for the underarm 
point on the sleeve. Growth in Y, for the grading of the bicep, already exists. 

Note: before the function is used, the sleeve cap is spit to isolate the front sleeve 
cap from the back sleeve cap. 

 466 



  

Result after Match Line X is used. 
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Create/Edit Rules – Match Line Y 

AccuMark = New 

MicroMark = New 

 

Use this function in the Grade menu to create a graded line length that matches the 
line length of the ‘sew to’ piece(s). This function creates a growth value in the Y 
direction and uses the existing value for X.  
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To create a rule to match the graded line length of one line to another: 

1. From the Grade menu, choose Create/Edit Rules and then select Match Line 
Y. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the line to grade. 

4. Select the end of the line to receive the new grade rule. 

5. Select the line(s) on another piece to match the length. One or two lines can 
be selected.  

The display of the piece updates to reflect new grade rules.  (See example) 
6. End selection to continue.. 

Hint: 

• If the base size has ease, the system maintains proportional ease on graded 
sizes. 

 

Example of Match Line Y 

In this example, Match Line Y can be used to find the Y growth for the underarm 
point on the sleeve. There will be no X growth at this point. 

Note: before the function is used, the sleeve cap is spit to isolate the front sleeve 
cap from the back sleeve cap. 
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Result after Match Line Y is used. 
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Create/Edit Rules – Keep Angle Apex 

AccuMark = New 

MicroMark = New 

 

Use this function in the Grade menu to create a grade rule at a point to maintain the 
angle of the base size at that point for all sizes in the nest. One of the two lines can 
be an internal. 
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To create a rule that keeps the angle for all sizes: 

1. From the Grade menu, choose Create/Edit Rules and then select Keep Angle 
Apex. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the point to be graded. 

The display of the piece updates to reflect new grade rules. 
4. End selection to continue.. 
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Example  

Keep Angle Apex Example 

In this example, after the neckline of the 
collar has been graded, the Keep Angle 
Apex function can be used to grade the 
collar point so that it is the same angle 
on all sizes. 

Result after Keep Angle Apex is used. 
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Create/Edit Rules – Keep Angle Edge X 

AccuMark = New 

MicroMark = New 

 

Use this function in the Grade menu to create a grade rule at a point to maintain the 
angle of the base size at an adjacent corner for all sizes in the nest. One of the two 
lines can be an internal. This function creates a growth value in the X direction only. 

To create a rule with growth in X direction and one angle for all sizes: 

1. From the Grade menu, choose Create/Edit Rules and then select Keep Angle 
Edge X. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the point to be graded. 

4. Select the apex point of the angle to maintain. 

5. Select other point on edge of angle to maintain.  

The display of the piece updates to reflect the new grade rule.  
6. End selection to continue. 
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Create/Edit Rules – Keep Angle Edge Y 

AccuMark = New 

MicroMark = New 

 

Use this function in the Grade menu to create a grade rule at a point to maintain the 
angle of the base size at an adjacent corner for all sizes in the nest. One of the two 
lines can be an internal. This function creates a growth value in the Y direction only. 

To create a rule with growth in Y direction and one angle for all sizes: 

1. From the Grade menu, choose Create/Edit Rules and then select Keep Angle 
 Edge Y. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the point to be graded. 

4. Select the apex point of the angle to maintain. 

5. Select other point on edge of angle to maintain.  

The display of the piece updates to reflect the new grade rule.  
6. End selection to continue. 

Sample: 
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Create/Edit Rules – Keep Angle Edge Ext 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data. 

 

Use this function in the Grade menu to create a grade rule at a point to maintain the 
angle of the base size at an adjacent corner for all sizes in the nest. The length of 
the line can also be graded for all sizes. One of the two lines can be an internal.  

To create a rule with growth in line length and one angle for all sizes: 

1. From the Grade menu, choose Create/Edit Rules and then select Keep Angle 
Edge Ext. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the point to be graded. 

4. Select the apex point of the angle to maintain. 

5. Select other point on edge of angle to maintain.  

A Distance Grading form displays. 
6. Use this form to enter values for grading the line length. Entering 0.00 for all 

sizes keeps the line the same length for all sizes in the nest.  

7. Click the Update button. 

The display of the piece updates to reflect the new grade rule.  
8. Select a Grain Line to be used for the above point, if more than one grain line 

exists on the piece. 

9. Continue to edit the current point or select a different one. Before selecting 
another point, click Update.  
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10. Click OK to close the form. 

11. End selection to continue. 
Sample: 

In this example, the grading of the break point of the lapel is known.  A grade rule 
needs to be found for the lapel point so that the angle of the break line and lapel is 
constant for all sizes and the length of the lapel can be controlled. 

 

  

Result after Keep Angle Ext is used.  The length of the lapel was graded to be .75 
cm longer for each size. 
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Create/Edit Rules – Parallel X 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data.  

 

Use this function in the Grade menu to create a grade rule at a point that makes one 
of the two lines of the intersection parallel for all sizes. This function creates a 
growth value in the X direction only. MicroMark users can use Perpendicular grading 
for a similar result. 

To create a rule with one line of an intersection parallel in X for all sizes: 

1. From the Grade menu, choose Create/Edit Rules and then select Parallel X. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 
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(See illustration of grading with externals or grading with grade rules.) 
3. Select the point to grade.  

4. Select the other end of the line for the parallel grading.  

The display of the piece updates to reflect the new grade rule.  
5. End selection to continue. 

Sample: 

 

 

Create/Edit Rules – Parallel Y 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data. 

 

Use this function in the Grade menu to create a grade rule at a point that makes one 
of the two lines of the intersection parallel for all sizes. This function creates a 
growth value in the X direction only. . MicroMark users can use Perpendicular 
grading for a similar result. 

To create a rule with one line of an intersection parallel in Y for all sizes: 

1. From the Grade menu, choose Create/Edit Rules and then select Parallel Y. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

 479 



• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the point to grade.  

4. Select the other end of the line for the parallel grading.  

The display of the piece updates to reflect the new grade rule.  (See example) 
5. End selection to continue. 

 

Example of Parallel Y 

A grade rule needs to be created for the shoulder point. This rule will keep the 
current X value and keeps the shoulder line parallel for all sizes. 

  

 480 



Result after Parallel Y is used, the shoulder line is parallel for all sizes. 

  

Create/Edit Rules – Parallel Ext 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data. 

  

Use this function in the Grade menu to make a line parallel to the base size for all 
sizes. The length of the line can also be graded for all sizes. 
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To create a rule with a line parallel to base and graded for all sizes: 

1. From the Grade menu, choose Create/Edit Rules and then select Parallel Ext. 

2. Select the Apply Rules to Joined End Points option to use: 

• Individual – allows you to use grading functions independently on the two lines 
of a corner. If you copy a grade rule with the 'Individual' option selected, the rule 
is only copied to one end of one of the lines of the corner. 

• Both if Same – applies grading to both endpoints of the two lines at a corner if 
they had the same rule originally. 

• Always Both – applies the grading to both endpoints at the corner whether or 
not they were the same rule originally. 

(See illustration of grading with externals or grading with grade rules.) 
3. Select the point to grade.  

4. Select the other end of the line for the parallel grading. 

A Distance Grading form displays. 
5. Use this form to enter values for grading the line length. Entering 0.00 for all 

sizes keeps the line the same length for all sizes in the nest.  

6. Click the Update button. 

The display of the piece updates to reflect the new grade rule. (See example) 
7. Select a Grain Line to be used for the above point, if more than one grain line 

exists on the piece. 

8. Continue to edit the current point or select a different one. Before selecting 
another point, click Update.  

9. Click OK to close the form. 

10. End selection to continue. 

 

Example of Parallel Ext 

In this example (a bottom cup), the grading is known for the center point and right 
point of the top line.  A new rule is needed for the left point of the line so that it will 
be parallel for all sizes. This also assures that  the line length will grow a specific 
amount for each size. 
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After Parallel Ext is used, the line is parallel for all sizes. An additional 0.3 cm, to 
sew to the top cup, is added to each size. 
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Create/Edit Rules - Specify Distance/Tangent 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data.  

 

Tangent grading is used on notches to control notch positioning along curve shapes 
when grading. Tangent grading maintains the smoothness of a curve as a notch is 
graded. Use Specify Distance/Tangent to create a new Tangent graded notch or to 
edit an existing Tangent rule previously created with this function. MicroMark users 
can use Tangent grading for a similar result. 

 

A Tangent grade rule uses only one value, as opposed to two values (X and Y) 
required in delta grading. Plus and minus values determine whether growth is in the 
clockwise or counter-clockwise direction from the sample size (Base up-down grading 
method) or previous size (Small-Large Incremental method). 

For example, if a notch is 10 cm from its reference point on the base size, and an 
amount of 0.00 cm is specified, then the notch will be 10 cm from the reference point 
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on all sizes. If 1 cm is entered, then the notch would be 10 cm from the reference 
point on the base size, 11 cm on the next size up, 12 cm on the next size and so on. 

 
For MicroMark data please see Tangent Grading for MicroMark Data. 
 

To create a Specify Dist/Tangent: 

1. From the Notch menu select Specify Dist/Tangent. 

2. In the Input box, select the Notch type: 

• For AccuMark data: 1, 2, 3, 4, 5 

• For MicroMark data: Flick, V, 0 Width, AV.0 Width, Slit, T.A. Slit 
3. Select one of the Notch Position on Seam options: 

• Perpendicular – this option places the notch in the perpendicular direction 
between the sew and the cut lines. This is equivalent to the Classic 
AccuMark method. 

•  Notch Angle – this option places the notch in the direction of the angle of 
the notch between the cut and sew lines. The illustration below shows the 
positioning of the notches. 

  

• Same Dist on Seam – this option is used to control the position of the notch 
on the seam line. When the option is ON, the reference distance is used to 
position the notch on the cut and the sew lines. 

4. To create a Group, select the group option under Multiple, then enter the 
following: 

• Dist Between- spacing between the notches. 

• # of Notches- number on notches in the group. 

The group is created on the line to the side opposite the Reference point. 
5. Select a location on a perimeter/boundary line where the new grade point will 

be added.  

• In Cursor mode, position the cursor over the line, press and hold the left 
button. Release the left mouse button at the correct location. End selection 
to continue. 

• In Value mode, type the location for the grade point in the Beg or End field 
in the value input area, click OK or press Enter. 
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6. Select the previous or next adjacent grade point for distance measurement. 
When a point is selected the grading distances form displays. Enter the growth 
amount for every size break according to the grading method used. This grade 
rule is saved with the piece. 

7. End selection to continue. 

 
Hints: 

• When a Specify Dist/Tangent is applied on AccuMark data it is also a reference 
notch. 

• Tangent rules have only one value in the grade rule, making them ideal for 
grading along curves. 

• Use Specify Distance to edit an existent Specify Dist/Tangent. 
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Examples of Specify Distance/Tangent 

Base Up-Down Incremental grading method 

The following example shows the values entered and the result using the Base Up-
Down Incremental grading method. The notch grows .25 inch between the smaller 
sizes and the base and .50 inch between the base size and each larger size. 

 

 

  
Specify Distance is too large 
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When the growth amount entered in Specify distance will cause the point to go 
beyond the end of the line or to interfere with a corner, the system will display a 
message. The message indicates that the growth amount entered is too large for 
the geometry selected on a specific size.  No grading is applied and the piece is 
returned to the previous state 

 

 

Create/Edit Rules – Intersection X 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data.  

 

Use this function in the Grade menu to find the X grading for the end of an internal 
so that it intersects the perimeter of the graded sizes, when the Y is known. 

To grade the end of an internal when Y distance to intersection is known: 

1. From the Grade menu, choose Create/Edit Rules and then select Intersection 
X. 

2. Select the point to grade. 
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The display updates to reflect the new grade rule. 
3. End selection to continue. 
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Sample: 

A new rule is needed to grade the internal where it intersects the shoulder line so 
that the internal touches the perimeter for all sizes. After Intersection X is used, the 
internal touches the perimeter on all sizes.                  
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Create/Edit Rules – Intersection Y 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data. 

 

Use this function in the Grade menu to find the Y grading for the end of an internal 
so that it intersects the perimeter of the graded sizes, when the X is known. 

To grade the end of an internal when X distance to intersection is known: 

1. From the Grade menu, choose Create/Edit Rules and then select Intersection 
Y. 

2. Select the point to grade. 

The display updates to reflect the new grade rule. 
3. End selection to continue. 

Sample: 

In this example, a grade rule is needed with a Y value so that the internal for the 
pocket opening intersects with the perimeter for all sizes.  

  

Result after Intersection Y is used.  Intersect Parallel could then be used to grade 
the pocket internal at the waist. 

 492 



  

Create/Edit Rules – Intersect Parallel 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data.  

 

Use this function in the Grade menu to find the X and Y grading for one end of an 
internal so that it remains parallel on all sizes and intersects with the perimeter, 
when the other end is graded. 

To grade the end of an internal and keep parallel when other end is graded: 

1. From the Grade menu, choose Create/Edit Rules and then select Intersect 
Parallel. 

2. Select from these options: 

• Find Rule For Both End Points – Allows grading to be applied to both end-of-
line points at the intersection of perimeter/boundary lines. 
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• Add Inter. Grade Rules – When checked, grade rules are found for all 
intermediate points on the line being graded; when unchecked, the system 
grades only the end point(s) of the line. 

3. Select the point to grade. 

4. Select the other end of the line. 

The display updates to reflect the new grade rule. 
5. End selection to continue. 

Sample: 

 

Create/Edit Rules - Intersection Offset 

AccuMark = New 

MicroMark = Only applicable if the data is to be stored as AccuMark data. 

 

Use this function in the Grade menu to find the X and Y grading for one end of an 
internal so that it intersects the perimeter of the graded sizes, when the offset 
amount is specified. (Intersecting Internals) 

To grade the end of an internal when offset amount is specified: 

1. From the Grade menu, choose Create/Edit Rules and then select Intersection 
Offset. 

2. Select from these options: 

• Find Rule For Both End Points – Allows grading to be applied to both end-of-
line points at the intersection of perimeter/boundary lines. 

• Add Inter. Grade Rules – When checked, grade rules are found for all 
intermediate points on the line being graded; when unchecked, the system 
grades only the end point(s) of the line. 

3. Select the point to grade.  

 494 



A Distance Grading form displays. 
4. Use this form to enter values for grading the line length. Entering 0.00 for all 

sizes keeps the line the same length for all sizes in the nest.  

5. Click the Update button. 

The display of the piece updates to reflect the new grade rule. (See example) 

Note: The system prompts to move point(s) on the curve, whenever the applied 
offset grading would create an intermediate point beyond the perimeter of the piece. 

6. Select a Grain Line to be used for the above point, if more than one grain line 
exists on the piece. 

7. Continue to edit the current point or select a different one. Before selecting 
another point, click Update.  

8. Click OK to close the form. 

9. End selection to continue. 

Example of Intersection Offset 

In this example, the internal needs to be graded so that it is parallel for all sizes. 
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Result after using Intersection Offset and setting the Offset amount to 0.00. The 
internal is at the same location for all sizes but extends out to touch the perimeter 
for all sizes. 

  

Result after using Intersection Offset and setting the Offset amount to 1 inch. The 
internal is spaced apart 1 inch for each size and extends out to touch the perimeter 
for all sizes. 
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Intersecting Internals 

Use this function in the Grade menu to create a new grade rule for the intersection 
of two graded internals. 

Create/Edit Rules - Intersection Internals 

AccuMark = New 

MicroMark = New 

  

Use this function in the Grade menu to create a new grade rule for the intersection 
of two graded internals. 

In the example below, the piece on the left has two graded internals where the 
graded endpoints do not intersect. After using the function, a rule is created for the 
endpoints of both lines. 
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To grade the point of intersection on two internals: 

1. From the Grade menu, choose Create/Edit Rules and then select Intersection 
Internals. 

2. Select a point to grade on the first internal.  

3. Select a point to grade on the second internal. 

A new graded point is created at the intersection. 

 

Create/Edit Rules - Intersection Proportional 

AccuMark = New 

MicroMark = New 

  

Use this function in the Grade menu to create a proportional grade rule for the 
intersection of an internal and another graded line. The system automatically 
creates a proportional grade rule and applies it to the end of the internal.  

Using Intersection Proportional has the same effect as adding a grade rule at the 
intersection of the two lines and then copying the grade rule from the intersection 
onto the internal line. 
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To create a proportional grade rule for an intersection: 

1. From the Grade menu, choose Create/Edit Rules and then select Intersection 
Proportional. 

2. Select from these options: 

• Find Rule For Both End Points – Allows grading to be applied to both end-of-
line points at the intersection of perimeter/boundary lines. 

3. Select a point to grade on the internal.  

4. Select a point to grade on another graded line that intersects the internal. 

5. End selection to continue. 

 

Create/Edit Rules - Distribute Proportional 

AccuMark = New 

MicroMark = New 

  

Use this function in the Grade menu to automatically distribute grading 
proportionally between the smallest and base sizes, and the largest and base sizes.  

To distribute grading proportionally between sizes: 

1. From the Grade menu, choose Create/Edit Rules and then select Distribute 
Proportional. 

2. Select from these options: 
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• All Sizes – adjusts the grading of all of the sizes in the size line for the selected 
point. 

• Base to Selected Size – adjusts only the sizes between the base size and the 
selected size. 

3. Select points to distribute proportionally. 

4. End selection to continue. 

  

Before 

 

After 

 

 

Create/Edit Rules - Smooth Grade 

AccuMark = New 

MicroMark = New 

  

Use this function in the Grade menu to automatically create smoother grading along 
a curve. The result is similar to removing the grade rule(s) along a curve to allow the 
curve to "relax" and then using the function Add Grade Point to add grade points 
back in.  

To smooth grading on a curve: 

1. From the Grade menu, choose Create/Edit Rules and then select Smooth 
Grade. 

2. Select the points to smooth evenly. 

3. End selection to continue. 
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The image below shows a curve before and after smooth grade was used. The 
shape of the base size stays the same, but the shape of the graded sizes can 
change significantly depending on the existing grading and the points selected.  

 

 

Modify Grade Rules 

Modifying Grade Rules 

Use functions in the Modify Rule menu to copy or change the existing grading for a 
piece. 
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Modify Rule – Change Grd Rule 

AccuMark = Grade/ Change Grade Rule 

MicroMark = Grade/ Change Rule Number 

 

Use this function in the Grade menu to change the grade rule currently assigned to 
a point(s) displayed in the work area. The number assigned must already exist in a 
grade rule table. 

To change a grade rule number: 

1. From the Grade menu, choose Modify Rule and then select Change Grd Rule 
or press the Alt +N keys. 

The Edit Point Info box displays. 
2. Select the point(s)Selecting_multiple_points_lines_or_pieces to change. 

3. Type the new grade rule number in the GR field. 

4. If you change the grading using rules not previously applied in the piece, type 
the name of the Rule Table where this rule is defined. 

5. If there are multiple grading lines in the piece, select the grading line for that 
point to reference. 

6. Click OK or Apply.  

7. Continue selecting points to edit or End selection to continue. 
Hints: 

• If you change the current grade point to a negative one (-1), all the grading is 
removed and the point is changed from a graded end point to an end point. 

• On the General page in Preferences/Options, make sure the Environment is set 
for AccuMark or MicroMark and the correct rule table is selected. 

• Grade rule numbers can be changed for MicroMark pieces that only have one 
size defined. 

• See Hints for viewing and working with grading. 
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Modify Rule – Add Grade Point 

AccuMark = Grade/ Create Edit/ Add Grade Point 

MicroMark = Only applicable if the data is to be stored as AccuMark data. 

 

Use this function in the Grade menu to make an intermediate point or location a 
grade point. Any grade point added maintains the shape of the nest. 

To have the system create a grade rule from a blend rule: 

1. From the Grade menu, choose Modify Rule and then select Add Grade Point 
Rule or press the Alt + A keys. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the intermediate point or a location where you want to make a grade 
point.  

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location.  

• In Value mode, type the location for the split in the Beg or End field in the status 
area. Click OK or press Enter. 

• To use Options while completing this function, click the right mouse button. 
Options provide greater control while selecting points on a line.  

The system splits the line and displays an end point or a graded end point. The 
new grade point is assigned the next available rule number followed by a pound 
(#) sign. The system grades the point according to its position on the line of the 
base size and maintains that position on all other sizes. 

4. End selection to continue. 

When the user attempts to apply either a P, X, or A atttibute to a grade point the 
following message appears: 
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Select OK to continue with the edit, removing the original attribute or grade rule. 
Selecting Cancel, aborts the edit leaving the original grade rule or attribute on the 
point. A similar message appears when the user attemps to apply a P, X, or A 
attribute to a grade point using the Edit Point Info. 

Hints: 

• On the General page in Preferences/Options, make sure the Environment is set 
for AccuMark or MicroMark and the correct rule table is selected. 

• See Hints for viewing and working with grading. 

 

Modify Rule - Copy Table Rule 

AccuMark = Grade/ Copy Table Rule 

MicroMark = Only applicable if the data is to be stored as AccuMark data. 

 

Use this function in the Grade menu to assign specific grade rules from an existing 
a piece. Normally, when you copy a rule, the system looks first to the 

piece information to see if that rule already exists and uses those values. This 
function forces the system to check the rule table instead of the Piece Information. If 
the rule cannot be found, the system will prompt you to define which rule table 
(library) contains it. 

The system copies rules from the table and applies these rules to the selected 
points. 

rule table to 

For example, you would use this function if a rule is already assigned to the piece 
but the X and Y values for that rule differ from the table. 

To copy a grade rule from the Rule Table: 

1. From the Grade menu, choose Modify Rule and then select Copy Table Rule 
or press the Alt + B keys. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the points on the piece to be assigned specific grade rules.  

4. End selection to continue. 

5. In the User Input box, type the grade rule number that is to be applied to the 
point(s). Click OK or press Enter.  
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6. End selection to continue. 
Hints: 

• See Hints for viewing and working with grading. 

Modify Rule - Copy Grade Rule 

AccuMark = Grade/ Create Edit/ Copy Grade Rule 

MicroMark = Not applicable. 

 

Use this function in the Grade menu to copy one or more grade rules from one piece 
to another. 

To copy grade rules between points: 

1. From the Grade menu, choose Modify Rule and then select Copy Grade Rule 
or press the Alt + C keys. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the reference point on a piece with the grade rule you want to copy.  

4. Select the target point(s) to be assigned the grade rule from the reference 
point.  

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location. End selection to continue. 

• In Value mode, type the location for the grade point in the Beg or End field in the 
value input area. When finished, click OK or press Enter. 

The system copies the grade rule from the reference point to the target point.  
5. End selection to continue. 

To copy grade rules between pieces: 

1. From the Grade menu, choose Modify Rule and then select Copy Grade 
Rule. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the reference piece whose grade rules you want to copy.  
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4. Select the starting point on the reference piece where the system is to begin 
copying.  

5. Select the starting point on the target piece. This is the point where you want 
the system to start assigning the grade rules copied from the reference piece.  

6. If prompted that the number of grade points between the two pieces are not 
equal, select the points on either the target or the reference piece that do not 
match and are to be ignored by the system. The grade rules on these points 
do not change.  

7. End selection to continue. 

The system copies the grade rules assigned to the points on the reference piece 
to the points that match on the target piece. 
8. End selection to continue. 

Hints: 

• See Hints for viewing and working with grading. 

 

Modify Rule – Copy X Rule 

AccuMark = Grade/ Create Edit/ Copy X Rule 

MicroMark = New 

 

Use this function in the Grade menu to copy the X growth value from the grade rule 
of a grade point and apply it to a different point. 

To copy the X value from one rule to another: 

1. From the Grade menu, choose Modify Rule and then select Copy X Rule. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the point of reference from which the X value will be copied. 

4. Select the target point(s). The growth value from the reference point is applied 
to the target point.  

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location. End selection to continue. 
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• In Value mode, type the location for the grade rule in the Beg or End field in the 
value input area. Click Apply to select more than one point. When finished, click 
OK or press Enter. 

The system applies the growth value from the reference point to the target point. 
Hints: 

• See Hints for viewing and working with grading. 

 Related Topic  

Modify Rule – Copy Y Rule 

AccuMark = Grade/ Create Edit/ Copy Y Rule 

MicroMark = New 

 

Use this function in the Grade menu to copy the Y growth value from the grade rule 
of a grade point and apply it to a different point. 

To copy the Y value from one rule to another: 

1. From the Grade menu, choose Modify Rule and then select Copy Y Rule. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the point of reference from which the Y value will be copied. 

4. Select the target point(s). The growth value from the reference point is applied 
to the target point.  

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location. End selection to continue. 

• In Value mode, type the location for the grade rule in the Beg or End field in the 
value input area. Click Apply to select more than one point. When finished, click 
OK or press Enter. 

The system applies the growth value from the reference point to the target point. 
Hints: 

• See Hints for viewing and working with grading. 
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Modify Rule – Copy Nest Rule 

AccuMark = Grade/ Create Edit/ Copy Nest Rule 

MicroMark = New 

 

Use this function in the Grade menu to copy the displayed growth values from a 
grade rule in a nest and apply it to a new point. Both the X and Y values are copied. 
This function is used in conjunction with the Stack On/Off function or for pieces that 
have been modified by flipping or rotating/pivoting. 

To copy a rule from a stacked piece: 

1. From the Grade menu, choose Modify Rule and then select Copy Nest Rule. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the point of reference from which the nest rule will be copied. The 
system displays the nested piece. 

4. Select the target point(s). The growth value from the reference point is applied 
to the target point.  

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location. End selection to continue. 

• In Value mode, type the location for the grade rule in the Beg or End field in the 
value input area. Click Apply to select more than one point. When finished, click 
OK or press Enter. 

The system applies the growth value from the reference point to the target point. 
Hints: 

• See Hints for viewing and working with grading. 
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Modify Rule – Copy Nest X 

AccuMark = Grade/ Create Edit/ Copy Nest Rule 

MicroMark = New 

 

Use this function in the Grade menu to copy the displayed X growth values from a 
grade rule in a nest and apply it to a new point. This function is used in conjunction 
with the Stack On/Off function or for pieces that have been modified by flipping or 
rotating/pivoting. 

To copy the X values from a stacked piece: 

1. From the Grade menu, choose Modify Rule and then select Copy Nest X. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the point of reference from which the nest rule will be copied. The 
system displays the nested piece. 

4. Select the target point. The growth value from the reference point is applied to 
the target point. Do one of the following: 

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location. End selection to continue. 

• In Value mode, type the location for the grade rule in the Beg or End field in the 
value input area. Click Apply to select more than one point. When finished, click 
OK or press Enter. 

The system applies the growth value from the reference point to the target point. 
Hints: 

• See Hints for viewing and working with grading. 
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Modify Rule – Copy Nest Y 

AccuMark = Grade/ Create Edit/ Copy Nest Rule 

MicroMark = New 

 

Use this function in the Grade menu to copy the displayed Y growth values from 
from a grade rule in a nest and apply it to a new point. This function is used in 
conjunction with the Stack On/Off function or for pieces that have been modified by 
flipping or rotating/pivoting. 

To copy the Y values from a stacked piece 

1. From the Grade menu, choose Modify Rule and then select Copy Nest Y. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the point of reference from which the nest rule will be copied. The 
system displays the nested piece. 

4. Select the target point(s). The growth value from the reference point is applied 
to the target point. Do one of the following: 

• In Cursor mode, position the cursor over the line, press and hold the left button. 
Release the left mouse button at the correct location. End selection to continue. 

• In Value mode, type the location for the grade rule in the Beg or End field in the 
value input area. Click Apply to select more than one point. When finished, click 
OK or press Enter. 

The system applies the growth value from the reference point to the target point. 
Hints: 

• See Hints for viewing and working with grading. 
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Modify Rule – Flip X Rule 

AccuMark = Grade/ Create Edit/ Flip X Rule 

MicroMark = New 

 

Use this function in the Grade menu to change the sign of the X value of a grade 
rule from a positive number to a negative number, or vice versa. 

To change the sign of the X value: 

1. From the Grade menu, choose Modify Rule and then select Flip X Rule. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  

3. Select the grade point on the base size to change. 

4. End selection to continue. 
Hints: 

• See Hints for viewing and working with grading. 

 

Modify Rule – Flip Y Rule 

AccuMark = Grade/ Create Edit/ Flip Y Rule 

MicroMark = New 

 

Use this function in the Grade menu to change the sign of the Y value of a grade 
rule from a positive number to a negative number, or vice versa. 

To change the sign of the Y value: 

1. From the Grade menu, choose Modify Rule and then select Flip Y Rule. 

2. Select the option: 

• Apply Rules to Joined End Points – Allows grading to be selectively applied to 
both end-of-line points at the intersection of perimeter/boundary lines. Choose: 
Individual, Both if Same, or Always Both.  
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3. Select the grade point on the base size to change. 

4. End selection to continue. 
Hints: 

• See Hints for viewing and working with grading. 

 

 

Modify Rule – Rotate 90 

AccuMark = Grade/ Create Edit/ Rotate 90 

MicroMark = New 

 

Use this function in the Grade menu to change the grade rule by rotating the growth 
of a grade point 90 degrees in a clockwise direction. 

To rotate a grade rule: 

1. From the Grade menu, choose Modify Rule and then select Rotate 90. 

2. Select the grade point on the base size to rotate 90 degrees.  

The system redraws the piece to reflect the changes. 
3. End selection to continue. 

Hints: 

• See Hints for viewing and working with grading. 

  
MicroMark Grading Types 

Working with MicroMark Grading 

PDS/Silhouette supports MicroMark grading and grading methods for pieces and 
nested pieces. 

Delta grading is the most common type of grading used. This type grades a point on 
nested pieces based on movement along the X and Y-axis. Other types of grading, 
listed below, can be used to meet specific grading needs. 
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Perpendicular Grading 

Perpendicular grading is used to grade a point perpendicular to a curved or sloped 
line. The result of the line with the perpendicular grade is parallel growth.  

A Perpendicular grade rule uses only one value, as opposed to two values (X and 
Y) required in delta grading. Plus and minus values determine whether growth is in 
the positive or negative direction from the sample size. Perpendicular grading can 
be added to an existing rule table. Grade Like Intersection can be used with 
Perpendicular Grading. 

To use Perpendicular grading: 

1. In the MicroMark system, add a perpendicular rule to an existing rule table.  

a) From the Grade menu, select Grade Rule Table and (2) Add Rule. 

b) Type in the name of the new rule with a "C" (for changed); example: 1000C. 

c) Change the default (3) Grade Type. Toggle to Perpendicular. 

d) Select (3) Keep Values. 

e) When prompted for variations, select (3) Keep Values. 

f) Specify modify as the action to change the grading values. 

g) Press Enter when complete. 

h) Save revisions. 

i) Press the Escape key to return to PDS. 
2. In PDS, edit grading for a point: 

3. Select Edit Point Info.  

a) Select the point of the line to be graded. 

Uncheck the Apply to both endpoints option if the rule is to be assigned to only 
one line of a corner. 

b) Specify the Perpendicular rule number and click the Apply button. 

 
Grade Like Intersection 

Grade Like Intersection is commonly used with perpendicular grading. It allows a 
point to be graded exactly as the intersection is graded.  
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A common application for Grade Like Intersection is for hem notches, where the 
intersection of the hem and side seam is graded using both a delta and a 
perpendicular grade. When a graded intersection is calculated using two different 
grade rules, Grade Like Intersection is applied to the notch since the notch may not 
have two grade rules applied at one time. Using Grade Like Intersection forces the 
notch to grade like the intersection. 

To use Grade Like Intersection: 

1. Edit an existing rule table as explained above, except select GrLike Int as the 
Modifier. 

2. In PDS edit grading for a point: 

3. Select Edit Point Info. 

4. Select the point to be graded. 

5. Select GLI (GrLike Int) in the modifiers popup menu: select Apply. 

6. Select the lines, and indicate which end of the line from which to apply the 
grading. 

Opposite Grading 

Opposite grade uses an existing grade rule to create an opposite rule. The system 
automatically reverses the direction of the X values or the Y values depending on 
the grade axis line. If the grade axis line is horizontal, the Y values for the opposite 
grade reverse from positive to negative or vice versa.  

The Opposite Grade option automatically reverses the appropriate values and 
applies the appropriate increments to the opposite grade point. The purpose of the 
option is to eliminate the necessity of creating a separate new rule for the opposite 
grade point.  

Opposite grading is automatically applied to mirrored pieces. 
To use Opposite grading: 

1. Use the Line Types/Labels function in the View menu. Or click the F5 key and 
from the MicroMark menu, choose the type of points you want to view. 

2. Note the rule number of the grade reference (opposite grade axis) line on the 
piece. 

3. Open the Edit Point Info box. 

4. Select the point to grade.  

5. Specify the appropriate rule number. 

6. Select OPP in the modifiers popup menu. 

7. Click OK or Apply. 

 514 



Note: Only assign the opposite grade option one time per piece. 

 

Opposite Grade Axis Line 

An additional reference line that is used in Opposite Grading to reverse grading from 
positive to negative, or vice versa, relative to the this line. The opposite grade axis 
line can be horizontal or vertical. If horizontal, Y values change for grading of any 
points associated with this line; if vertical, X values change.  

For example: If a point with the normal grading of X1, Y1 was opposite graded using 
a vertical opposite grade axis line, the grade for the point becomes X-1, Y1. 

Use Edit Line Info to make a line an opposite grade axis line. Use Edit Point Info to 
assign the relationship to specific points. 

Blend Grading 

Blend grading is used to blend grading between two definitive grade rule numbers. 
When blend grading is applied, points with the blend grade rule, -1, grade naturally 
between the two points where a definitive grade rule number is applied. 

Styles with blend grading can be retrieved into PDS. However, the shape and 
positioning of intermediate points on the graded sizes is affected.  

CAUTION: Changes in curve shapes may result from saving data with Blend 
grading more than once between PDS and MicroMark. Also, using Add Grade Point 
on MicroMark data along a curve may cause the curve shape on the graded sizes to 
change. 

Proportional Grading 

Proportional grading proportionally divides grading on a split piece. This is useful 
when standard pattern pieces are cut into "non-standard" parts by eliminating the 
need to create grade rules for "non-standard" parts. 

Note: The Proport utility allows you to convert MicroMark Proportional grading into 
Delta grade rules, if desired. The original style is modified. 

To use Proportional grading: 

1. In the MicroMark system: 

a) Grade the original piece.  

b) Add two Proportional grade points to the piece. 

c) Save changes. 
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d) Press the Escape key to return to PDS. 
2. In PDS: 

a) From the Line menu, select Unclipped Perimeter. 

b) Select the boundary lines of the piece. 

c) Trace the piece on the splitting lines. 
Hints: 

• Set the Perimeter (boundary) option on the General page in Preferences/Options 
to Unclipped to see the line extensions. 

• Do not delete a proportionally graded piece from a style without deleting the 
pieces that are also proportionally graded or removing proportions from the 
pieces. 

   

Converting Proportional Grading to Delta Grade Rules 

The Proport utility is available to convert MicroMark Proportional grading into Delta 
grade rules. This utility creates the new grade rules, exports them to an existing or 
new rule table, and assigns the rule numbers to the pieces. 

CAUTIONS 

• Back up data before running the utility. The original style will be modified without 
an opportunity to rename it. 

• Make sure the directory where the styles exist has been updated, especially if 
styles or grade rule tables have been moved/copied prior to converting the data. 

• After conversion, do not try to compare the before and after versions of the style 
in PDS Instead, use MicroMark Classic PDS to compare the original style and 
either MicroMark Classic PDS or PDS to look at the converted version. 

To open the Proport utility: 

1. From the Start menu, select Run. Click the Browse button. The utility is in the 
Utility\ProPort directory on the PDS CD.  

2. Double-click on Proport.exe to start the program. 
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To select and convert styles: 

1. Click the Select Styles button.  

A File/Open dialog box displays all of the styles in the current directory that have 
Proportional Grading. The initial drive read by the utility can be controlled using the 
Paths page in Preferences/Options.  
2. Select the styles to be converted (remember to back up the styles first). 

The selected styles display in the spreadsheet view with their currently assigned 
rule tables and drives. The rule table name and drive can be changed.  
3. Click the Apply button to initiate the conversion process. An MS-DOS window 

displays during the process. A log of the conversion is saved in 
C:\ads\PropGrad.log. 

To compare converted and original versions: 

After the process is completed, the styles can be retrieved into PDS or Classic 
MicroMark PDS.  

Do not try to compare the before and after versions of the style in PDS. 
Instead, use MicroMark Classic PDS to compare the original style and either 
MicroMark Classic PDS or PDS to look at the new version.  
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Note: The system prompts whenever an unconverted style with proportional grading 
is opened in PDS. 

Paste Grading 

Paste grading is used when creating a pattern piece from two pattern pieces that 
have already been graded. When Paste Grading is applied the system generates 
Paste Lines.  

To use Paste grading: 

Use the Combine/Merge function. 
Hints: 

• Do not delete Paste Lines. 

 

Line Grading 

Line Grading is used when Perpendicular grade rules are applied to a piece. Line 
Grading is also used in combination with Unclipped Perimeter (boundary), to grade 
adjoining lines without forcing them to intersect. This may be useful to avoid 
calculating difficult grades.  

To use Line grading: 

1. In the MicroMark system, add a perpendicular rule to an existing rule table.  

a) From the Grade menu, select Grade Rule Table and (2) Add Rule. 

b) Type in the name of the new rule with a "C" (for changed); example: 1000C. 

c) Change the default (3) Grade Type. Toggle to Perpendicular. 

d) Select (3) Keep Values. 

e) When prompted for variations, select (3) Keep Values. 

f) Specify modify as the action to change the grading values. 

g) Press Enter when complete. 

h) Save revisions. 

i) Press the Escape key to return to PDS. 
2. In PDS, edit grading for a point: 

a) Select Edit Point Info.  

b) Select the point of the line to be graded. 
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Uncheck the Apply to both endpoints option if the rule is to be assigned to only 
one line of a corner. 

c) Specify the Perpendicular rule number and click the Apply button. 
Hints: 

• Set the Perimeter (boundary) option on the General page in Preferences/Options 
to Unclipped to see the line extensions. 

 

Variation Grading 

Variation grading can be used to create Shorts, Longs, and Extra Longs from a 
regular sized piece. Variation grading does not change the original grading.  

For example, a 38 jacket, can be available in four lengths, each hem length differing 
by a multiplier or variation: 38 short (-1 variation), 38 regular (zero variation), 38 long 
(+1 variation) and 38 extra long (+2 variation). If the multiplier is set equal to one 
inch, the extra long jacket would be three inches longer than the short jacket. 

To use Variation grading: 

In the MicroMark system, do the following: 

• Set up a synonym table (.syn). 

• From the Main menu, select Grade Rule Table.  

• Edit an existing grade rule table by selecting Add Variation. Enter variation 
name(s) and values for each variation. 

• Use the Style-Piece menu to choose all values in the synonym table. 

In PDS/ Silhouette, use one of the following functions to view variations: 
• Style Description  
• View/Grade menu  

Hints: 

• Variation grading is similar to alterations made on an AccuMark system using size 
codes. 

 
Synonym Table 

Variation grading requires the use of a synonym table. This table is created in a text 
editor and saved with the .SYN extension. A multiplier for each size variation is 
included in the table.  
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Typical entries in the table might be: 
          28S 28 1 
          1 LENGTH 
          28L 28 1 
          -1 LENGTH 
where 28S and 28L are new sizes based on the original size (28) and LENGTH is 
the only variation with a multiplier of 1 and -1 respectively. 

Another example: 

 

 

Edit Size Line 

Change Base Size 

AccuMark = Piece Verify/Edit Points/Edit Size Line/Base Size. 

MicroMark = Style Description/Sample Size. 

Use this function in the Grade menu to establish a new base size for a piece. For 
example, if the current base size of a piece is 10, you can change it to 12. 

To make a piece the base size: 

1. From the Grade menu choose Edit Size Line and then select Change Base 
Size. 
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2. Select the piece(s) for which to change the base size. The piece updates 
automatically to the new base size. 

3. End selection to continue. 
Hints: 

• The dimensions of the nest do not change when a new base size is created. 

 

Change Base Dimensions 

AccuMark = New 

Use this function in the Grade menu to display a different size from the nest as the 
base size, but give it the original base size label. This results in the original base size 
changing dimensions.  

To change the base size dimensions: 

1. From the Grade menu choose Edit Size Line and then select Change Base 
Dimensions. 

2. Select the piece that will determine the new base size. 

3. From the chart choose the new base size. The base size will take the 
dimensions of the new size but still be called the original base size. 

4. End selection to continue. 
Hints: 

• The Change Base Dimensions function is equivalent to the Show Non-Base Size 
function of previous releases and save the piece as a new size. 

 

More/Fewer Size Steps 

AccuMark = Piece Verify/Edit Points/Edit Size Steps/More/Fewer Szs. 

Many numeric size lines consist of either even numbers (8,10, 12…) or odd 
numbers (7, 9, 11…). These size line examples have a size step of 2. There may be 
an occasion when you need to order "in-between" sizes. The More/Fewer Size 
Steps function lets you do just this. With this function, the dimensions of your 
original sizes will remain the same and the size line will update with the new size 
step and the new sizes. 

To change the size step of a piece: 

1. From the Grade menu choose Edit Size Line and then select Change Base 
Dimensions. 

2. Select the piece. 
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3. From the chart select a different size step. The original dimensions for the 
graded sizes do not change. 

4. End selection to continue. 

Note: Since alphanumeric pieces do not have a size step, this function can only be 
used for pieces with a numeric size range. 

Redistribute Growths 

AccuMark = Piece Verify/Edit Points/Edit Size Steps/Redistrib Grwth. 

 

Use this function in the Grade menu to change the original X, Y growth amounts to a 
different size step. The Redistribute Growths function causes all sizes, except the 
base size, to change and the size line will update with the new size step. If a size 
step is changed from 2 to 1, each size will grow twice as much as originally planned. 
The Redistribute Growths function causes all sizes, except the base size, to change 
and the size line will update with the new size step. 

To redistribute growth in a piece: 

1. From the Grade menu choose Edit Size Line and then select Redistribute 
Growths. 

2. Select the desired piece and end selection. 

3. From the chart select a different size step. Only the base size will stay the 
same the graded sizes will grow accordingly. 

4. End selection to continue.  

Note: Since alphanumeric pieces do not have a size step, this function can only be 
used for pieces with a numeric size range. 

 

Rename Size 

AccuMark = Piece Verify/EditPoints/Edit Size Line/Rename Size. 

 

Use this function to change the name of all or specific sizes for a piece. This function 
can only be used for pieces with alphanumeric size ranges. The size names of 
numeric pieces cannot be renamed since these sizes are based on numbers and size 
steps. 

To rename a size of a piece: 

1. From the Grade menu choose Edit Size Line and then select Rename Size. 
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2. Select the piece(s). 

3. Select the field size and edit the name. The size name must be unique. 

4. End Selection to continue. 

 

Size Break 

A size break in a grade rule table indicates that the growth of a grade point changes 
between these two sizes in the size line. 
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Measure Menu 
Overview of Measure Menu 

Use functions in this menu to measure distances on pieces or between pieces in the 
work area. You can create a custom tool bar with the functions you use most 
frequently. 

 
Hint: 

• If you have previously worked with AccuMark or MicroMark pattern design 
systems, many of these functions will be familiar. However, you may improve your 
productivity by taking time to become acquainted with some new methods for 
working with lines. 

Measurement Chart 

Measurement charts are a feature that allows you to use Measure functions, such 
as Measure/Line and Distance 2 Point, to create a spec sheet with all of the graded 
values for a specific model or style.  

Creating measurement specs 
To create garment specs: 

1. Create and save a measurement template. 

2. Open a style or model into a work area. 

3. In File/Open, change the file type to ‘Measure Chart’ and retrieve the template. 

4. Select a row of cells by clicking the name of the item to be measured. 

5. Using any of the Measure functions, take a measurement from one or more 
pieces.  

6. End Selection to continue. 

The row of cells is filled in for all sizes. 
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7. Continue taking measurements until complete. While the measurement chart 

remains open, measurements will automatically update as the geometry is 
modified. 

8. When the style or model is saved, the system also saves the garment spec. 
Measurement specs are saved with a .mcp extension.  

Note: For MicroMark data, the dimension lines created in step 5 are stored in the 
Style extension (.f) file. 

Creating the Measurement Template 

A measurement spec template can be created using Notepad to specify the names 
of all of the measurement objects. Save the chart in the C:\Userroot directory. Once 
the file is created and saved, use MS Explorer to change the file extension from .txt 
to .mct.  
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Working with Measurement Charts 
Opening the garment spec 

If a garment spec has been saved with a model or style, it will automatically be 
opened when the model or style is opened. It can be minimized while working. If a 
chart is CLOSED when making pattern modifications the measurement information 
will not be updated. 

Warning Message 

A message is displayed when Measurement Charts are first opened to remind the 
user that pattern modifications should be performed before measurements are taken 
for the chart. Certain pattern modifications can invalidate the equations created when 
measurements are taken. For example, if a line is measured and then that line is split, 
the equation is no longer accurate. 

  
Hiding the measurements and dimensioning lines 

The o hide/show the display of the 
measurements on the pattern piece(s) in the work area. 

Updating the values in the chart  

• Operations to the current row such as halving, doubling, or multiplying by a 
constant 

1. Take the desired base measurement to fill in the chart.  

Hide/Show Measurements function is used t

Clearing the measurements from the model or style 

The Clear Measurements function is used to remove the dimensioning information 
from the current style or model. The measurements are removed from the work 
area, as well as the measure chart. 

When piece geometry is modified in PDS, the values in the chart will be updated to 
reflect the changes in the measurements. If a chart is CLOSED while you are 
modifying patterns, the measurement information will not be updated. To update this 
information, open the chart, and click the Recalculate button. 

Additional options are available under the right button pop-up menu of the Measure 
Chart. These options allow: 

• Inserting/ clearing/deleting rows from the chart  
To use options: 
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2. Click the right button over the desired row's header to activate the right button 
menu.  

3. Select the desired operation: 

• Add; Subtract; Half; Double; Add constant; Subtract constant; Multiply constant; 
Divide constant 

• Delete Row; Clear Row; Insert Row 
4. When using operations that require a constant, enter a value in the Constant 

field at the bottom of the chart.  

  

Note: The Operations column of the Measurement Chart displays the functions 
selected from the right mouse button used on the current row. If multiple operations 
were performed on the row of data, all of the operations will be listed and divided 
with semicolons. 

 
Buttons on the chart: 

Close – Closes the measure chart. 

Print – Prints a copy of the chart. 

Export – Exports the measurement chart as a .txt file. 
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Line Length 

AccuMark = Measure/ Line 

MicroMark = F5 Measure/ Line Lengths 

 

Use this function in the Measure menu to measure the length of perimeter/boundary 
or internal lines. Graded measurements are available using the Measure Line 
function. 

To measure length of a line: 

5. From the Measure menu, select Line Length. 

6. Select the line(s) to measure. The lines can be on the same or different 
pieces. 

7. End selection to continue. 

8. UseHide or Clear Measurements to remove measurements. 

 

Distance 2 Line 

AccuMark = Measure/ Distance 2 Line 

MicroMark = New 

 

Use this function in the Measure menu to measure the distance between two lines in 
a piece. With this function you can measure across the piece: 

• Horizontally or vertically from one perimeter/boundary or internal line to another 
line 

• From perimeter/boundary or internal line parallel or perpendicular to grain/grade 
reference line 

To measure distances between two lines: 

1. From the Measure menu, select Distance 2 Line. 

2. Select an option: 

• Vertical – measures vertically across a piece. 
• Horizontal – measures horizontally across a piece. 
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• Perpendicular to Grain – measures a line perpendicular to the grain/grade 
reference line. 

• Parallel to Grain – measures a line parallel to the grain/grade reference line. 

Note: Line choices in step 3 will be limited by the option chosen in this step. 
3. Select the line to measure from. To measure from a specific point on the 

selected line, do one of the following: 

• Click on the line and drag the cursor until you reach an existing point. Release 
the mouse button to display the measure line. 

• Click anywhere on the line. When the measure line attaches to the cursor, drag it 
along the selected line until you reach the point you want to measure. 

• To use Options while completing this function, click the right mouse button. 
Options provide greater control while selecting points on a line.  

Note: The new measure line can be dragged along the selected line and any 
adjacent lines. The measurement updates as the measure line is moved. 

4. End selection to continue. 

5. Use Hide or Clear Measurements to remove measurements. 
Sample: 

 

 
Hints: 

• Use Swap Sew/Cut to measure from sew line to sew line if the cut line is the 
current piece perimeter. 

• The length of the line on which the first measurement point was selected limits the 
range of the measurement line being dragged. 
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Perimeter 2 Pt/ Measure Along Piece 

AccuMark = Measure/ Perimeter 2 Point 

MicroMark = F5 Measure/ Measure Along Piece 

  

Use this function in the Measure menu to measure the distance between two 
perimeter/boundary points. 

Note: Graded/nested pieces can be measured using this feature. 
To measure length of a line segment: 

1. From the Measure menu, select Line Length. 

2. To select the first point on a perimeter/boundary line, do one of the following: 

• Click on the line and drag the cursor until you reach an existing point. Release 
the mouse button to display the measure line. 

• To use Options while completing this function, click the right mouse button. 
Options provide greater control while selecting points on a line.  

3. Select the second point on a perimeter/boundary line. 

A line segment is highlighted with measurements. 
4. Use the charts to compare Difference values. 

5. End selection to continue. 

6. Use Hide or Clear Measurements to remove measurements. 
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Distance 2 Pt/ Measure Straight 

AccuMark = Measure/ Distance 2 Point 

MicroMark = F5 Measure/ Measure Straight 

 

Use this function in the Measure menu to measure the straightline distance between 
any two points.  

Note: Graded/nested pieces can be measured using this feature. 
To measure length of a line: 

1. From the Measure menu, select Distance 2 Pt/Measure Straight. 

2. Select two points that you want to measure the distance between. Points can 
be selected on any perimeter/boundary, internal, or grain/grade reference line. 

To use Options while completing this function, click the right mouse button. Options 
provide greater control while selecting points on a line.  

A straight line connecting the points displays along with a measurement. 
3. Use the charts to compare Difference values. 

4. To measure between the first point selected and another second point, click to 
select a different point. 

5. End selection. To select a new first point, repeat step 2. 

6. End selection to continue. 

7. Use Hide or Clear Measurements to remove measurements. 

 

Distance 2 Pt/Measure Finished 

Use this function in the Measure menu or the Grade menu to obtain the finished 
measurement across a piece from sew line to sew line. 

To obtain the finished measurement across a piece: 

1. From the Measure menu select Distance 2 Pt/Measure Finished. 

2. Select the first point from where the straight distance will be measured. 

3. Select the second point to where the straight distance will be measured. 

4. End selection to continue. 
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Note: If the point selections are made on the cut line the function will give the 
finished measurement across the piece from sew line to sew line. 

  
Piece Perimeter 

AccuMark = Measure/ Piece Perimeter 

MicroMark = F5 Measure/ Piece Perimeter 

 

Use this function in the Measure menu to take the measurement along the 
perimeter/boundary of the piece. 

To measure total length of perimeter/boundary lines for a piece: 

1. From the Measure menu, select Piece Perimeter. 

2. Select the piece(s) to measure by clicking on them one at a time. 

The measurement for each piece displays in the center of the piece. 
3. End selection to continue. 
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Piece Area 

AccuMark = Measure/ Piece Area 

MicroMark = F5 Measure/ Piece Area 

 

Use this function in the Measure menu to measure the area of a piece. 
To measure the area of a piece: 

1. From the Measure menu, select Piece Area. 

2. Select the piece(s) to measure by clicking on them one at a time. 

The measurement for each piece displays in the center of the piece. 
3. End selection to continue. 

 

Angle 

AccuMark = Measure/ Angle 

MicroMark = F5 Measure/ Line Angles 

 

Use this function in the Measure menu to measure the angle between two lines. 
To measure an angle between two lines: 

1. From the Measure menu, select Angle. 

2. Select two line(s) adjacent to the angle you want to measure. 

The measurement displays in the Ang field in the User Input box. This is a 
temporary display, cleared when you end the selection. 

Note: Continue to select two adjacent lines to display angle until you end selection. 
3. End selection to continue. 
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Clear Measurements 

AccuMark = Measure/ Clear Measurements 

MicroMark = F5 Clear All 

 

Use this function in the Measure menu to clear all measurements visible in the work 
area. 

To remove measurements: 

1. From the Measure menu, select Clear Measurements. 

 

Hide/Show Measurements 

AccuMark = New 

MicroMark = New 

  

Use this function in the Measure menu to temporarily hide any measurements 
visible in the work area. 

To remove measurements: 

1. From the Measure menu, select Hide/Show Measurements. 

 

Model Editor 

The model editor may be opened directly from PDS. Simply select File / Create Edit 
Model / Edit Mode, and then browse to the desired model. 

Note: 

The model editor may only be opened from PDS if the model is not currently 
retrieved in PDS. 
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Draft/Sketch 
Drafting on the Silhouette Table 

The Silhouette Table works in conjunction with PDS/Silhouette This combination of 
software and hardware fits neatly into your traditional pattern making process 
without changing the way you currently do things. With Silhouette, you work the 
same way you would if you were using pencils and scissors. The difference is that 
the Silhouette table replaces your drafting table and your pencil is replaced by a 
computerized pen/stylus. 

The Draft menu provides functions to create and modify patterns, including Sketch 
and Line/Curve. Choosing the appropriate drafting function depends upon the 
drawing method preferred by the pattern maker and requirements for the piece. 

Sketch 

AccuMark = Draft/ Sketch 

MicroMark = New 

 

Use this function in the Draft menu to draw on the Silhouette table just as you would 
on any table when creating pattern pieces. Treat the pen/stylus as if it were a pencil 
in your hand. As lines are drawn on the table, the system simultaneously draws 
them on-screen. You can use this function when: 

• Free hand drafting or drawing. 
• Experimenting with multiple new style lines 
• Drafting with rulers and curves. 
• Inputting cut out oak tag patterns. 
• Using slopers to create new pieces. 

See examples for these applications. 
Before you begin: 

1. Make sure any existing pattern is properly secured to the table.  

2. Choose Draft Scale to adjust the scale of the screen so that it represents and 
equals the area of the table surface. This step is not always required. 

To sketch a new pattern piece: 

1. From the Draft menu, select Sketch. 
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2. Select a piece in the work area to add the new lines to, or click the pen/stylus 
button to begin a new piece. 

3. Begin drawing the pattern on the paper. Press and hold the pen/stylus tip 
against the surface of the table as you draw the line. Each line appears on-
screen as it is sketched. 

4. Use the Erase button to remove unwanted line segments in the reverse order 
as they were created.  

5. When finished drawing the pattern, end selection to continue. 

6. Use Create Piece or Draft Trace to create a valid piece. 
Hints: 

• When drawing, the fewer, longer, and cleaner your line segments, the easier it is 
for the computer to understand where the segments join. If you have a tendency 
of drawing short, choppy segments, you may want to use the Line/Curve function 
to input the pattern. 

• To make sharp corners when tracing a pattern, stop before the corner. 

• See hints for setting Preferences/Options for viewing pieces, working with grade 
points, and setting pen resolution when drafting. 

• Use the Anchor/Unanchor function to keep from accidentally moving the draft 
piece on-screen once it has been created. If the piece is moved, you have to 
reorient the draft piece on-screen to the pattern on the table. 

 

Line - Curve 

AccuMark = Draft/ Line – Curve 

MicroMark = New 

 

Use this function in the Draft menu to select points along the perimeter/boundary of 
a pattern piece in order to enter it into the system. Commonly used for entering 
existing patterns made from soft paper or muslin material, it can also be used to 
copy an already assembled garment. Somewhat like "connecting the dots", the 
system automatically creates either straight or curved line segments between the 
points. You can continually change between straight or curved line input modes. 

Use this function when: 

• Working with paper patterns. 
• Alternating between straight or curved lines. 
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• Creating internals such as drills, grain lines, cutouts, or slash lines. 
• Creating a piece from a garment or a muslin. 

See examples for these applications. 
Before you begin: 

1. Make sure any existing pattern is properly secured to the table.  

2. Choose Draft Scale to adjust the scale of the screen so that it represents and 
equals the area of the table surface. This step is not always required. 

To create a new piece using Line/Curve: 

1. From the Draft menu, select Line/Curve. 

2. Select a piece in the work area to add the new lines to, or click the pen/stylus 
button to begin a new piece. 

3. Define a piece as follows: 

Straight Line 

• Press the pen/stylus once at each location along the perimeter/boundary of the 
pattern where a point should be created. Make sure points are placed at the 
corners (or end points).  

• Mark the intermediate (or holding) points around the perimeter/boundary.  
• Enter drill holes, notches, or grade rules where needed.  

To add notch or grade points using the keyboard, press the pen down to indicate 
the point, then type G(grade rule number) or N(notch type number) on the 
keyboard followed by the Enter key. For example, G345N2 assigns a grade rule 
345 and a notch type 2 to the point. 

4. Click the pen/stylus button once, to alternate between creating straight and 
curved line segments by clicking the pen/stylus button once.  

Each time the tip of the pen/stylus is pressed down, a small square (when creating 
straight lines) or a circle (when creating curved lines) appears on-screen. Types of 
points created are explained in table below. 

Input Mode AccuMark 
Attribute 

MicroMark 
Type 

N (non-
smoothing) 

Turn Point 

Curved Line S (smoothing) Curve Point 

For AccuMark data, any point created in straight line input mode is assigned an N 
(non-smoothing) attribute while any point created in curved line input mode is 
assigned an S (smoothing) attribute. For MicroMark data, any point created while 
using this function is a Turn Point type. 
5. Use the Erase button to remove unwanted line segments in the reverse order 

as they were created.  
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6. When finished drawing the pattern, click the pen/stylus button once to click 
past the change between straight and curved line input.  

7. End selection to continue. 

8. Use Create Piece or Draft Trace to create a valid piece. 
Hints: 

• If System Smoothing is turned off, the segments appear as straight lines even if 
creating curved lines. 

• If drawing short line segments, it is easier to alternate between lines or curves. 
Sharp, crisp corners are produced and the system generates end or grade points 
at these corners.  

• Use Note/Illustrate to add designs to the pattern. 

• See hints for setting Preferences/Options for viewing pieces, working with grade 
points, and setting pen resolution when drafting. 

• Use the Anchor/Unanchor function to keep from accidentally moving the draft 
piece on-screen once it has been created. If the piece is moved, you have to 
reorient the draft piece on-screen to the pattern on the table. 

 

Note - Illustrate 

AccuMark = Draft/ Note/Illustrate 

MicroMark = New 

 

Use this function in the Draft menu to make notes on patterns, create construction 
diagrams and information, or create working drawings of fashion illustrations. These 
notes and illustrations are stored with the piece and can be used during the 
production process. Before actually sending the pieces to production, however, 
delete these notes. Saving pieces with notes uses additional storage space. 

To add notes or illustrations by hand: 

1. From the Draft menu, select Note/Illustrate. 

2. Select the piece to which the information is to be attached. 

3. Using the stylus, write the note or draw the illustration.  

4. Use the delete a note or line.  Erase button to 

5. When finished, end selection to continue. 
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6. To create notes for another piece, repeat the above steps.  
Hints: 

• You may find it easier to enter notes or illustrations if Symbols is turned Off and 
Filled Pieces is turned On in General Preferences/Options. 

• Piece/Annotate Piece can be used to add typed text to pieces. 
 

Note Pen Resolution 

This setting directly affects the Note/Illustrate function on the Draft menu and is 
similar to the way Sketch Pen Resolution works with the Sketch function. By 
changing the Note Pen Resolution value, you can control the number of 
intermediate points the system creates on the lines drawn when using the 
Note/Illustrate function. The default setting for this feature is 0.1 inch (or 0.25 cm) 
which means the system will create a point every 0.1 inch (or 0.25 cm) along the 
lines drawn for notes or illustrations. 

Use the Point Filter setting in conjunction with this setting to eliminate unnecessary 
intermediate points along straight or slightly curved lines: the lower the Note Pen 
Resolution setting, the greater the number of intermediate points. 

 

Point Filter 

This setting directly affects the Sketch and Note/Illustrate functions. As a line is 
initially sketched, the system refers to the Sketch Pen Resolution or the Note Pen 
Resolution value for placement of intermediate points. This is important in capturing 
the intricacy of subtle curves. However, as soon as you lift the pen/stylus off the 
table, the system refers to the Point Filter value to eliminate any unnecessary 
points.  

The lower the value, the more points are left. For AccuMark data, increasing 
decimal precision from two to three places in the User Environment parameter 
tables provides better control over eliminating unnecessary points. 
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Reorient 

AccuMark = Draft/ Reorient  

MicroMark = New 

 

Use this function in the Draft menu to reorient or establish a relationship between a 
pattern on the Silhouette table and its corresponding draft piece or working piece 
on-screen. A piece needs to be reoriented if it has been moved on the table or if you 
are modifying an existing pattern that has recently been taped to the table. 

For example, say you began to enter a pattern into the system using the Sketch or 
Line/Curve functions. The pattern on the table is moved or you are interrupted and 
have to stop. Use this function to return the draft piece on-screen exactly in the 
same position as the pattern on the table. 

To reorient a piece on the table with a piece in the system: 

1. Open the existing pattern piece that you need to make changes to. 

2. Plot the piece, if the oak tag or paper pattern is not available. 

3. Tape the pattern or plotted piece to the Silhouette table.  

4. Use Draft Scale. 

5. From the Draft menu, select Reorient. 

6. To check orientation, do all of the following: 

• On-screen, select two points, from left to right, diagonally across from each other 
on the piece you want to reorient. To obtain the most accurate orientation, select 
the two furthest points on the piece. 

• On the table, select in the same order the two corresponding points on the hard 
pattern. 

If the two pieces are in alignment, go to step 6. If the two pieces are not in 
alignment with each other, the difference is displayed on-screen.  
7. To reorient the piece, repeat step 2.  

When you mark the second point, the system adjusts the position of the draft piece 
on-screen to be in line with the hard pattern piece on the table. 
8. Use the Anchor/Unanchor function to keep from accidentally moving the on-

screen piece once it has been reoriented. 

9. After making changes, use Draft Trace to copy the new style lines and save 
the draft as a new piece. The original is not changed. 

10. End selection to continue. 
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To reorient the piece you are currently creating or editing: 

1. From the Draft menu, select Reorient. 

2. To check orientation, do all of the following: 

• On-screen, select two points, from left to right, diagonally across from each other 
on the piece you want to reorient.  

Note: To obtain the most accurate orientation, select the two furthest points on 
the piece. 

• On the table, select in the same order the two corresponding points on the hard 
pattern. 

If the two pieces are in alignment, go to step 6. If the two pieces are not in 
alignment with each other, the difference is displayed on-screen.  
3. To reorient the piece, repeat step 2.  

When you mark the second point, the system adjusts the position of the draft piece 
on-screen to be in line with the hard pattern piece on the table. 
4. Select the Anchor/Unachor function to lock the piece in place on-screen. 

5. End selection to continue. 
Hint: 

• If you accidentally pick up a piece, and move it, Undo will return it to the original 
location. 

Draft Scale 

AccuMark = Draft/ Draft Scale 

MicroMark = New 

 

Use this function in the Draft menu to change the scale of the on-screen display so 
that it represents the area of the table surface. Whenever you use a Zoom function 
other than Full Scale, select Draft Scale to automatically change the scale of the 
screen.  

To use draft scale: 

1 Use a Zoom function other than Fullscale. 

2 From the Draft menu, select Draft Scale. 

3 On the table, select the pen/stylus to the table at some location on a piece. 

The location on the table matches the location on-screen. 
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Hints: 
• In Preferences/Options, select Full Scale as the default view for Fit Pieces in 

Work Area when pieces are first placed. 

 

Create Piece 

AccuMark = Draft/ Create Piece 

MicroMark = New 

 

Once you create a draft piece using either Sketch or Line/Curve, use this function in 
the Draft menu to convert the drafted piece by closing the perimeter/boundary and 
assigning a grain/grade reference line. This function finds gaps in lines where no 
intersection should exist. 

Create Piece takes the entire "drafted" piece and converts it into a valid pattern 
piece. Because it works with all of the lines in the piece, the pieces must have long 
clean lines with clear intersections. An error message notifies you if the system 
cannot determine the intersection of perimeter/boundary lines.  

To create a piece from a draft: 

1. Make sure the draft piece is displayed in the work area.  

2. From the Draft menu, select Create Piece. 

3. Select the draft piece to be converted into a piece. 

4. To designate a grain/grade reference line, do one of the following: 

• Manually select line(s) in the piece. The first line chosen is the primary 
grain/grade reference line. This is labeled G0 for AccuMark data and Grade Ref 
Line for MicroMark data.  

• To have the system generate a grain line, based on the grid on the Silhouette 
table, click the stylus button or use Draft Trace. 

The orientation symbol displays on the line.  
5. Choose the remaining internal lines in the piece. All lines drawn inside the 

piece must be selected. If all the lines are not chosen and the piece is not 
created, the error message, Line Failure, displays. See hint below. 

6. Type the name for the piece. Click OK or press Enter to accept. Repeat the 
above procedure to create another piece or click the button to end.  

7. End selection to continue. 
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Hints: 

• You may not want to use all of the lines on the piece. In order to save the piece 
without receiving an error message, you can identify lines as internals. Then you 
can delete them using the Delete Line function, since they are not part of the 
perimeter/boundary. 

 

Draft Trace 

AccuMark = Draft/ Draft Trace 

MicroMark = New 

 

Use this function in the Draft menu to create a valid piece from a draft piece by 
selecting specific lines to be used. Lines not selected are not made part of the 
piece. Once the piece is created and it is moved to another area on-screen, the 
original draft remains. 

To trace a draft and create a valid piece: 

1. Make sure the draft piece is displayed in the work area. From the Draft menu, 
select Draft Trace. 

2. On the draft piece, select the lines that are to be made into 
perimeter/boundary lines, beginning in the lower left corner and working 
clockwise around the piece. 

3. Choose the line in the piece to be the grain line. The first line selected is the 
primary grain line and is labeled G0 for AccuMark data and Grade Ref Line for 
MicroMark data. To have the system generate a grain line, based on the 
horizontal grid on the Silhouette table, click the stylus button. 

4. Select all other internal lines and points. These lines are labeled I for 
AccuMark data and Style Lines for MicroMark data. To deselect a line or a 
point, press the pen/stylus tip again. If you do not have any internals, click the 
pen/stylus button to continue past the prompt. 

5. Type a name for the piece. Click OK or press Enter.  

6. Repeat the above procedure to create another piece. Or end selection to 
continue. 

7. Once you have converted and saved the piece, you can use any 
PDS/Silhouette function. 

 
 
 
 
 

 543 



Hints: 

• If there are areas where the lines do not meet, the system draws a small 
connecting line at the point where the two lines are closest. Clip the excess line 
segments in either direction to create a closed piece. 

• If the angle of intersection is less than 120 or greater than 150 degrees, a non-
smoothing attribute (N) is added. 

• Lines with an angle of less than 130 degrees are split. 

 

Trim/Extend Line 

AccuMark = Draft/ Trim – Extend Line 

MicroMark = New 

 

Use this function in the Draft menu to shorten or lengthen lines on draft pieces prior 
to using Draft Trace or Create Piece. 

If lengthening lines, the endpoint of the line is extended along the same axes/angle. 
Many times when sketching a piece, the endpoints do not clearly intersect. Using 
this function allows for "easy line repair" in that the system finds the closest 
intersection between two points. 

To extend or trim a line on a draft piece: 

1 From the Draft menu, select Trim/Extend. 

2 Select a point on the piece by pressing down on the point with the stylus and 
dragging it in the direction you want to go. Press the stylus down again to "drop" 
the point into place. 

3 End selection to continue. 
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Trim/Extend Piece 

AccuMark = Draft/ Kerf 

MicroMark = New 

 

Use this function in the Draft menu to trim half of the pen thickness from the 
perimeter/boundary of a piece created using Create Piece or Draft Trace. This is 
necessary when sketching a hard pattern due to the thickness of the pen/stylus tip 
creating a piece slightly larger than the original.  

To trim a piece after sketching: 

1. From the Draft menu, select Trim/Extend Piece. 

2. Enter the amount to offset the piece perimeter/boundary. A negative amount is 
used to trim a piece. You have the option of entering +0.25" to -0.25" or 
+0.635cm to -0.635cm. 

3. End selection to continue. 

 

Stream Sketch 

AccuMark = Draft/ Stream Sketch 

MicroMark = New 

 

Use this function in the Draft menu to create sketched lines with the pen tip above 
(not touching) the table surface. This function is helpful when inputting fabric or lace 
designs where the pen tip cannot be dragged along the fabric surface with the pen 
tip depressed. 

To use stream sketch mode: 

1. From the Draft menu, select Trim/Extend Piece. 

2. Enter the amount to offset the piece perimeter/boundary. A negative amount is 
used to trim a piece. You have the option of entering +0.25 to -0.25 inch or 
+0.635 to -0.635 centimeter. 

3. End selection to continue. 
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Sketch Pen Resolution 

This setting directly affects the Sketch function on the Draft menu. By changing the 
Sketch Pen Resolution value, you can control the number of intermediate points the 
system creates on the lines drawn when using the Sketch function. The default 
setting for this feature is .1 inch (or 0.25 cm) which means the system will create a 
point every 0.1 inch (or 0.25 cm) along the lines. 

Use the Point Filter setting in conjunction with this setting to eliminate unnecessary 
intermediate points along straight or slightly curved lines.  

To test the results: 

1. Set Point Filter to zero and enter a value in Sketch Pen Resolution.  

A lower number results in a greater number of intermediate points. 
2. Once you are getting the results you want, enter a different value in Point 

Filter:  

A higher number, results in more points being deleted. 

 

Basics of Drafting Pieces 

Create Draft Pieces and Save Working Pieces 
Draft, Working, or Saved Pieces 

Draft Piece refers to a sketch of a pattern piece that has not yet been saved as a 
valid piece, with a closed piece perimeter. When you create new pieces using the 
Draft functions, the system recognizes them as drafts.  

In order for the pieces to be stored and used throughout PDS/Silhouette, they must 
be changed into "working (valid) pieces." A valid piece has at least three closed 
sides and a grain/grade reference line. To be used in a model, these pieces must 
also be saved.  

Example of creating a new pattern using Silhouette: 

1. You begin by taping or pinning a clean sheet of paper to the surface of the 
Silhouette table. This eliminates the risk of accidentally drawing on the table 
surface when using the ink cartridge in the pen/stylus. Next, pin the garment or 
muslin to the table. 

2. Using the pen/stylus, trace the sew lines using Line/Curve. An image of the 
piece appears on-screen as you sketch. 

3. Using other PDS/Silhouette functions, modify or erase any lines drawn on-
screen. Notes made within the pattern will also display on-screen. 
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4. Once you finish tracing the new pattern, convert it into a valid piece. You can 
then save it to a storage area or send the pattern to a plotter to obtain a hard 
copy of your work. 

5. The piece can then be further modified using other Silhouette functions. 

Note: An additional security key is needed to activate these functions. 

Working with Silhouette Table, Screen, and Pen 

PDS/Silhouette software permits a direct relationship to exist between: 

• Silhouette Table and the work area on-screen. 
• On-screen cursor and pen/stylus tip. 
• Menu area and pen/stylus tip. 

Working with Pieces 
For most PDS/Silhouette functions: 

When you press the pen/stylus tip on a point on a piece at the table, the cursor is 
located at the same point and piece on-screen. This direct relationship results from: 

• Using Reorient to locate a piece taped to the table. 
• Draft scale is the current View/Zoom mode. 

After using Zoom functions: 

After using any Zoom function other than Fullscale, use Draft Scale to restore the 
direct relationship between the table and on-screen work area. 

Working with Menu Area 

Note: The menu is no longer limited to three locations on the Silhouette table. 

In order to work with the menu wherever the pen is, you must set the Silhouette 
Tablet to Custom menu position and tracking to Absolute. These settings are made 
in AccuMark Hardware Configuration. 

Using PDS/Silhouette Functions 

Wherever you press the pen/stylus tip on the Silhouette table, the PDS/Silhouette 
menu is positioned on the table in the exact same relationship as the on-screen 
cursor to the on-screen menu. Each time you move and press the pen/stylus tip on 
the table, the menu moves with it. 

Note: You no longer need to use Cursor mode to work life size in the work area. 
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To use certain Draft menu functions: 

1. Before beginning a Draft menu function, it is a good idea to first select Draft 
Scale. This guarantees that there is a direct relationship between the table and 
on-screen work area.  

2. Select one of the following Draft menu functions. 

• Sketch  
• Line/Curve  
• Note/Illustrate  

The menu area remains in place on the table, exactly where it was when you 
performed step 2. The cursor becomes locked within the work area and you are 
working life size on the Silhouette table. 
3. When finished using the function, end selection to continue. 

The cursor is free to access other PDS/Silhouette functions or to navigate within the 
Windows environment.  

 

Using the Pen/Stylus 

Unless otherwise noted, the mouse and the pen/stylus perform the same functions, 
including: 

• Selecting menu functions. 
• Selecting and modifying geometry. 
• Selecting characters from the on-screen keyboard. 
• Exiting functions. 
• Moving pieces in the work area. 

Pen/stylus vs. Mouse 

• Pressing the pen/stylus tip down on the table is the same as clicking the left 
mouse button once. This is used when selecting piece geometry, a function, or 
clicking an on-screen button. 

• Clicking the button on a two button pen/stylus is the same as clicking the right 
mouse button. This is used when ending selection to continue. 

• Clicking the button on a two pen/stylus while pressing the tip down on the table is 
the same as clicking both the left and right mouse buttons. This is used to switch 
between Value and Cursor mode. 

• Clicking the button closest to the pen/stylus tip on a three button pen/stylus is the 
same as clicking the right mouse button. This is used when ending selection to 
continue. 
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• Clicking the button closest to the pen/stylus tip on a three pen/stylus is the same 
as right clicking and then clicking OK. 

• Clicking the button farthest from the tip is the same as using the middle button on 
a 3-button mouse. It automatically ends selection or exits a function, bypassing 
the right-button/OK selection. 

Hints: 

• You can use the pen/stylus exclusively or along with the mouse. 

• You may prefer using the mouse for tasks such as data management. 

• You can use the pen/stylus with or without a working ink cartridge. With the pen 
tip inserted, you can draft actual pattern lines on clean paper taped to the table. 

 

Using the Eraser 

Use the Erase option to remove unwanted line segments in the reverse order as 
they were created. This function is available when using the Sketch, Note/Illustrate, 
or Line/Curve functions. 

What is erased depends upon which function you are working in. 

• If using the Sketch function, the last line created is erased. 
• If using the Line/Curve function, the last point created is erased. 

To erase when working in Draft menu: 

1 When you begin working in one of the above functions, an ‘E’ (for Erase) displays 
in the bottom left or right corner of the work area. 

2 Use either the mouse or the pen/stylus to click this button. 

3 Each time you click on the Erase button, the system removes the point or line 
drawn previously. 

 

Hints on Setting Preferences/Options 
For Visual Display 

For the best visual display when creating draft pieces, check these settings on the 
General page of Preferences/Options: 

• Display Symbols – set to On  
• Display Internals – set to Dashed.  
• Fit Pieces in Work Area – select Full Scale as the default view for when pieces 

are first placed. 
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For Sketch Pen Resolution and Point Filter 

Use default values on Draft page of Preferences/Options or follow test procedure to 
adjust settings. 

For Grading 

When grade points are created, the default rule number is 1. For AccuMark data, 
the default rule table specified on the General page in Preferences/Options is 
assigned. This rule table must be in the current storage area. For MicroMark data, 
the rule table of the current style is assigned. 

 

Practical Application Examples 

Draft a Design 

Drafting a design using Silhouette is less time consuming than traditional methods. 
One benefit is that you no longer have to perform all the repetitive copying. The 
following steps can be used as a guideline to incorporate Silhouette into your own 
drafting methods. 

To draft a design: 

1. Secure a clean piece of paper to the surface of the table. 

2. Make sure the ink cartridge is in the pen/stylus. 

3. If the full view of the work area does not display on-screen, choose Draft 
Scale. This returns the screen to the same scale as the table. 

4. Choose Sketch. 

5. Click the pen/stylus button to indicate the beginning of a new piece. 

6. Begin drafting the pattern following your usual method. Use the pen/stylus 
along with traditional rulers and curves to draft the various lines for the piece. 
As you draw, the lines of the pattern will display on-screen. 

7. When you have finished drafting, choose Draft Trace to identify and copy the 
lines you want to use for the actual pattern piece. This also will convert it into a 
valid piece. After the piece is traced, reposition it on-screen. Your original work 
remains. 

8. Save the new piece. 

Design From Sloper 

This procedure explains how to use PDS/Silhouette to create a new design from a 
sloper (or basic pattern). 

To design from a sloper: 

1. Before beginning, make sure the slopers you want to use are in the system 
(through digitizing or sketching in using Silhouette). 
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2. Use the Open function to display the sloper model/style in the work area. 

3. Cut or plot out the sloper so that you have a hard copy. 

4. Secure the copy of the sloper to the surface of the table. 

5. Using the Reorient function, align the sloper in the work area to the copy on 
the table. 

6. Lock the sloper into its current position on-screen using the 
function. This prevents you from accidentally moving the piece on-screen. 

Anchor/Unanchor 

7. Make sure the ink cartridge is in the pen/stylus. 

8. Select Sketch and using your customary functions, such as curves and rulers, 
create the new style or design lines on the pattern. 

9. Cut (preferably) or plot a paper copy of the new design. For this example, you 
will want the design (internal) lines cut also. 

10. Remove the pattern from the plotter, detach it at the perforations and position 
the pieces on the table in the manner that you want to work with them. 

11. Select Line/Curve to enter the new shape of the pattern into the system. In this 
example, this would be the center front yoke. 

12. Select Create Piece to convert the new design into a valid piece and then 
Save to save the piece. 

13. Once you have created a new pattern, you can use the Define/Add Seam 
function to add seam allowance. 

Create and Modify a First Pattern 

Once you finish draping a pattern on a form, whether done with muslin or the actual 
fabric, you can use Silhouette to create the first patterns of the garment. Any 
adjustments made during the fitting can be incorporated into the first pattern while 
you are entering it into the system. The following procedure explains how to create 
and modify a first pattern using Silhouette Use this example as a guideline to 
creating and modifying your own first patterns. 

To create and modify a first pattern: 

1. Secure the muslin or fabric piece to the table. 

2. Make sure the plastic nib is in the pen/stylus. This will prevent any unwanted 
markings from appearing on the muslin or fabric. 

3. If the full view of the work area does not display on-screen, choose Draft 
Scale. This returns the screen to the same scale as the table. 

4. Use the Line/Curve function to identify points along the perimeter/boundary of 
the pattern. Work in a clockwise direction to identify the shape of the 
perimeter/boundary. Remember to use the Line mode for straight lines and the 
Curve mode for curved lines. Change modes by clicking the pen/stylus button. 
You can also click on Erase to remove any unwanted lines. 
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5. Once you have selected the last point on the perimeter/boundary of the piece, 
click the pen/stylus button, select the same piece, and add internal lines if 
applicable. 

6. When you have finished entering all the lines for the pattern with Line/Curve, 
select Create Piece to store the pattern as a valid piece. 

7. You can now add notches to the piece. First, secure the pattern in place on-
screen using the Anchor/unanchor function. Then select a function in the Point 
menu for adding notches to mark the location and type of notches along the 
perimeter/boundary of the piece. 

8. Plot a paper copy of the piece.  

9. Save the piece. 

 

Copy an Assembled Garment 

With Silhouette it is easy to take a garment that is already assembled and copy its 
design into the system. Before you begin, make sure the plastic tip is inserted into 
the Silhouette pen/stylus. Leaving the ink cartridge in the pen/stylus, you run the risk 
of marking up the garment you are copying. Use this example as a guideline to 
copying garments. 

To copy a garment: 

1. Pin the portion of the garment you want to work with to the surface of the table. 
Make sure this area of the garment lies flat. You can work with fabric that is up 
to 0.375 inch (0.148 centimeter) thick.  

2. From the Draft menu, choose Line/Curve. 

3. When you are prompted, click the pen/stylus button to indicate you are 
beginning a new piece. Press the pen/stylus tip down at selected points 
around the perimeter/boundary of the pattern you are copying. 

4. If necessary, reposition the garment on the table and finish entering the shape 
into the system. When you reposition a piece, you will need to select the piece 
again in the on-screen work area. 

5. Once you have finished entering the entire perimeter/boundary of the piece, 
enter internals such as buttonholes, pockets, or darts. 

6. Use Create Piece or Draft Trace to create a valid piece.  

7. Once the main pieces of the garment are copied, create secondary pieces. 
Digitize Line and Create Trace can be used to create facings and linings. 
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Alter Patterns 

With Silhouette, you can apply alterations to a pattern at the same time you initially 
enter it into the system by using the pivot method. 

The techniques in this procedure can be used for several different applications 
including: 

• Altering men’s wear 
• Making fitting changes to women’s wear 
• Manipulating women’s pattern pieces. 

Before you begin, make sure that the work area on-screen is empty and you have 
the hard pattern that you want to alter. 

To alter a pattern using the pivot method: 

1. Tape or pin a clean sheet of paper to the table. 

2. Place the hard pattern over the paper on the table. 

3. From the Draft menu, choose Sketch. 

4. Click the pen/stylus button to begin a new block. Start at the point on the 
pattern where you want to make your alteration and begin sketching around 
the piece. 

5. When you reach the appropriate point, pivot the pattern the amount necessary 
on the table and continue sketching until you enter the remainder into the 
system. You may have to use the hard pattern or a curve to sketch over any 
gaps that occur between lines where the pattern was altered. 

6. Pivot the hard pattern back to its original position on the table. This is done so 
that you can return the grain/grade reference line to its correct orientation. 

7. Use the Line/Curve function to identify the grain line for the piece. Select the 
piece and then the beginning and ending points of the grain line. 

8. Use Create Piece or Draft Trace to create a valid piece from the pattern on-
screen.  

9. If you want, you can now add grading to the piece. The easiest way to go 
about this is to find a piece in the system with grading similar to what you want 
to apply to this one. Open model/style that contains the graded piece. Make 
sure that both the graded piece and the new one display in the work area and 
that, they both have the same orientation and size line. 

10. Use Show All Sizes to display the current grading for both pieces. The new 
piece, at this point, does not have any grading applied to it. To copy the 
grading, use Copy Grade Rule to duplicate the grading from the made piece to 
the new one. 

11. Save the new pattern. 
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Add Designs to Patterns 

With Silhouette, you can easily design lace work, fabric, or appliqués. You can even 
create alignment guides for beading. The following procedure focuses on how to 
add a lace design to a shirtsleeve. Use this as a guideline for adding your own 
designs. 

To add a lace design: 

1. Secure your pattern piece to the table. 

2. From the Draft menu, choose Line/Curve to enter the shape of the pattern into 
the system. 

3. Use Create Piece to transform it into a valid piece. 

4. Place the lace on the table so that it is properly positioned over the pattern 
piece. Make sure the plastic tip is in the pen/stylus so not to damage the 
material. 

5. Using the Line/Curve function, begin tracing the lace pattern. As you draw the 
outline will display on the piece on the work area.  

6. Save the new design.  

 

Armhole/Sleeve Cap - Practical Exercise 

The Armhole/Sleeve Cap function is used to make modifications to the armhole and 
sleeve cap simultaneously. The function can be used without the pieces placed next 
to each other in the work area, however, it’s easier to see the effect on the curve 
with the pieces placed together.  

5. Position the thumbtack at the notch on the armhole. Click left to continue. 

Exercise 1: Ladies Blouse – Place the front, back and sleeve in the work area.  
Flip the back piece along the X-axis. 

Armhole/Sleeve Cap  

1. Set the function options to the following values: 

• Armhole option set to Horizontal Pos 
• % of Distance set to 100 
2. Select the shoulder point on the back piece, end selection. 

3. Position the thumbtack at the notch on the armhole. Click left to continue. 

Hint: For easy positioning of the thumbtack at the notch, turn Snap to Geom On. 
4. Select the shoulder point on the front piece, end selection. 
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6. End selection to finish the armhole selection. 

7. Set the function options to the following values: 

• Sleeve option set to Horizontal Pos. 
• % of Distance set to 200. 
8. Select the center notch on the sleeve cap, end selection. 

9. Position the thumbtacks at the underarm notches on the sleeve cap. 

10. End selection to finish the sleeve cap selection. 

11. Move the geometry to the new location. Notice the sleeve cap moves twice the 
distance of the shoulder points. 

  

Practical Silhouette Applications 

In order to help you to apply methods of designing and pattern making using 
Silhouette, six different tasks are described. These examples utilize PDS/Silhouette 
functions. 
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Definition of Terms 
Absolute Values 

Absolute value is a non-negative number equal in numerical value to a given real 
number. For example, 6 is the absolute value of -6.  

Address 

The path to an object, storage area, or other destination. An address can be a URL 
(address to an Internet or intranet) or a path to a file on a local area network. When 
you click on a hyperlink, your browser uses the address to go to the specified 
destination. 

 

Alternate Grade Reference Lines 

Alternate Grade Reference lines are used on pattern pieces in addition to the original 
grade reference line. The purpose of using alternate grade references lines is to 
establish a separate grade reference line for a point(s) on a piece. For MicroMark 
data, this allows easy grading on certain points that are difficult to grade when using 
the original grade reference line.  

 

Annotation 

Information added as textual notes to a pattern piece or marker. You can request that 
annotation be plotted when the piece or marker is plotted. 

 

Apex 

The top point or tip of a dart. 

 

Base or Sample Size 

The base size is the size of the pattern upon which all grade rule data is applied.  

The base size and sample size are identical in geometry, only differing in the size 
name. For example, some style lines label a size 14 base size as a size 10 sample 
size.  

Beg 

This field in the User Input box represents the measurement of distance between two 
selected points. If measuring points located on: 
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• Perimeter of AccuMark piece – this value is equal to the distance between the 
points when traveling around the piece clockwise.  

• Boundary line of MicroMark piece – this value is equal to the distance from the 
point to the end of the line.  

• Internal line – this value is equal to the distance from the point to the end of the 
line. 

Beg works in conjunction with End; entering a value in one field automatically adjusts 
the value in the other. Values can be edited and viewed in the User Input box and 
viewed in the Info bar. 

 

Curve Point 

A user-defined intermediate point for a MicroMark piece. Curve points, which help to 
give a line its shape or curvature, have an S attribute. Curve points can be added 
while digitizing a piece or while making edits to the piece. They may or may not be 
graded points. 

 

Darts 

Darts are wedge shaped cutouts in a pattern that are used to control the fit of a 
garment. They affect how the garment looks. The apex of the dart is the point at which 
the dart tapers to an end. The apex may or may not be the pivot point.  
The program recognizes three point lines with an apex angle less than 75 degrees as 
a dart. Cut darts display as separate lines on pieces while in the work area. 

 

MicroMark Darts 

On MicroMark data there is a specific point type that indicates dart points. MicroMark 
requires that at least one Turn or Curve point exist between multiple darts on the 
same line. 

Device 

Model, style, and piece data  is stored on different kinds of devices called drives. 
Devices can be located on the network or can be actual drives on your PC, such as 
C:\ or D:\. When opening a model or style, you need to specify which drive (device) 
contains your data. 

 

Digitizing 

The process of transforming pattern pieces into numeric data to be used by a 
marking/grading system. When pieces are digitized, you specify all of the grade 
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points, grade rules, intermediate points/digitized points, special point numbers, 
notches, and internals that apply to a piece.  

 

 

Drill Holes 

Drill holes are internal lines that indicate where a piece needs to be drilled and are 
represented by a + sign. They are used to indicate pattern markings such as 
diminishing points of darts and dart tucks, placement of pockets and trimming, and 
buttonholes and buttons. Drill holes are also be used to indicate a point or position of 
design feature such as gussets, godets, and bands.  

 

 

Drive 

A device in a computer that holds software and data. A hard disk drive uses rigid 
metal disks to store large amounts of data.  

End 

This field in the User Input box represents the measurement of distance between two 
selected points. If measuring points located on: 

• Perimeter of AccuMark piece – this value is equal to the distance between the 
points when traveling around the piece counterclockwise.  

• Boundary line of MicroMark piece – this value is equal to the distance from the 
point to the end of the line.  

• Internal line – this value is equal to the distance from the point to the end of the 
line. 

End works in conjunction with Beg; entering a value in one field automatically adjusts 
the value in the other. Values can be edited and viewed in the User Input box and 
viewed in the Info bar. 

 

End of Line Point 

Points that mark the beginning and end of a perimeter/boundary or internal line. For 
AccuMark data, end points are a single point. For MicroMark data, end points are two, 
separate points that can be manipulated individually. 

If Symbols is checked in General Preferences/Options, these points display as 
triangles.  

See also Graded End of Line Point. 
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Fabric Type 

Pieces in an AccuMark model that will be cut in the same marker from one fabric, 
such as lining, are assigned a material group.  

Same as Material Group for MicroMark data. 

F Rotation (Facing Line) 

Also known as a facing line, F Rotation is added to a piece in order to specify the 
orientation of that piece in a marker. Two points, assigned an F attribute, define the 
facing line. The facing line runs parallel to the selvage of a marker. The piece is 
oriented according to the facing line and is graded according to the grain/grade 
reference line. 

 

Flipped Piece 

A flipped piece is the piece, as digitized, that has been rotated around the X, Y or both 
X and Y axes. Flipped pieces in AccuMark are called opposite pieces in MicroMark. 

Grade Points 

The points on a pattern piece that carry grading information or rules. If Symbols is 
checked in General Preferences/Options, these points display as upside-down 
triangles (unless they are also graded end of line points. 

Graded End of Line Points 

Every perimeter/boundary or internal line begins and ends with an end of line point. In 
addition, graded end of line points carry grading information. If Symbols is checked in 
General Preferences/Options, these points display as diamond shaped symbols. 

 

Grading/Grade Rule 

Grading refers to the way a pattern grows from size to size. Relative Grading grows 
outward from the base size; smaller sizes will be located at negative X and Y 
coordinates. Incremental Grading grows from the smallest size to the largest size. 

 

Grade Rule Table 

A grade rule table stores measurements that define how points on desired sizes move 
in X and Y directions relative to the same points on the base, or smallest, size. For 
example, a point on the base size might be located at X0, Y0, while the same point on 
a larger size in the size line might be located at X8, Y24 and, on a smaller size, at X-4, 
Y-12.  
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Grade rule tables are created in your grading/marking system. Values in a rule table 
are determined by actually measuring the X and Y distances and directions between 
points on a nest of pieces. 

 

Grade Rule 

Each grade rule in a rule table is a unique set of growth measurements appropriate for 
the size line. A point on piece that has a grade rule assigned is called a graded point. 
All points on a piece can have the same grade rule; or each point could have a 
different grade rule. 

In PDS/Silhouette, you can export rules from a digitized piece to an existing grade rule 
table. 

 

Grain/Grade Reference Line 

Grain/grade reference lines are represented on pieces as straight internal line(s). If 
Symbols is checked in General Preferences/Options, the orientation symbol displays 
on the line.  

The primary grain/grade reference line: 

• Indicates the placement or alignment of pattern pieces on a corresponding 
grain of fabric.  

• Determines the horizontal axis for grading.  

• Indicates the orientation of a pattern piece in a marker. 

 

In AccuMark, you can assign more than one grain line per piece for grading purposes. 
The primary grain/grade reference line is labeled G0. Alternate grain/grade 
reference lines are labeled G1, G2, etc. 

In MicroMark, the primary grain/grade reference line is labeled Grade Ref Line. PDS 
allows you to view and edit MicroMark grading, such as Tangent grading or 
Perpendicular grading. 

Hold Line 

The hold line represents the side of the piece to remain stationary. It maintains its 
orientation with the grain of the fabric and is not affected when geometry, such as 
darts, are combined. 
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Internal Lines 

Internal lines are lines for a piece that are not perimeter/boundary lines. They may be 
labeled drafting lines, style lines, drill holes, or lines that must be cut in the interior of a 
piece. 

 

Intermediate Points 

Intermediate points act as holding points between end of line points. They help to give 
a line its shape or curvature. If Symbols is checked in General Preferences/Options, 
these points display as squares. 

 

Line Extensions 

While completing some pattern design tasks it is helpful to extend lines in order to 
preserve piece or grading information. 

Perimeter/Boundary Lines 

In MicroMark data, the ends of two adjacent boundary lines do not have to be 
common. Since they do not need to exist at the same location and can have different 
grade rules and point types, they can be extended. 

In previous releases of AccuMark PDS/Silhouette, perimeter lines could not be 
extended. This was because in AccuMark data, two adjacent perimeter lines share a 
common end point. This end point always had just one set of attributes (point types) 
and grade rules. 

 

Line Names 

Line names are used in procedures to recognize certain lines in a piece.  

Location or Point on Line 

When working with functions, you often may select a location that is not yet a defined 
point. This selection, called a Location on Line or Point on Line, displays as a 
hollow box.  

 

Material Group 

Pieces in a MicroMark style that will be cut in the same marker from one fabric, such 
as lining, are assigned a material group.  
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Same as Fabric Type for AccuMark data. 

Mirrored Piece 

A mirrored piece is one that is symmetrical, or has identical sides. The mirror line is 
the line that divides the piece into two equal halves. 

When a piece is mirrored, it can display: 
 Normally, as a half with a dashed line indicating the mirror line. 
 In the unfolded state, with both sides displayed with the mirror line dashed.  
 In the Piece/Icon menu, with the mirrored symbol.  

 

Note: To maintain the piece as mirrored and symmetrical, all piece modifications to 
mirrored pieces should be done on the half with the piece folded on the mirror line.  

Model 

A model consists of all the pieces of a garment that are cut out of the same fabric. For 
example, a men’s jacket may be made up of two different fabrics: the outside of wool 
and an inner lining. You would have a separate model for each type of fabric used. 

Similar to Style for MicroMark data. 

 

Nest 

A Nest is a pattern piece showing all sizes of the piece stacked together. 

 

Notches 
Notches are marks on pattern pieces that indicate where pieces should line up as 
they are stitched together. They help to ensure matching of corresponding pattern 
areas such as sleeves, collars, cuffs, pockets, and yokes. Basically, notching is a 
process of clipping to remove a small wedge of fabric from the seam allowance 
plies.  

To learn more about available notch types, refer to documentation for your 
marking/grading system. 

Opening Point 

The opening point is the point of intersection between a dart center line and the 
perimeter/boundary of a piece. 
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Options Pop-up Menu 

Additional menus with options are available while working in PDS Silhouette These 
construction tools have been added to increase productivity. An Options Pop-up menu 
displays when you click with the right mouse button: 

• With the mouse cursor or over the Piece/Icon menu over an icon button for a piece 
in the Piece/Icon menu 

• With the mouse cursor over the work area while the system is idle (no function is 
selected). 

• While in functions. 

When working in many functions, your options always include OK, Cancel, and Clear 
All. OK accepts your selection(s) and input value(s) or exits the current function. 
Cancel gives you another opportunity to make changes. Clear All removes all 
selections, allowing you a fresh start. 

For functions working with points or lines, such as Create Line – Digitize, you have 
additional options. Options can be used to efficiently find locations while performing 
tasks. 

Orientation Symbol 

When Symbols is checked in General Preferences/Options, the orientation symbol 
displays on the primary grain/grade reference line. This symbol indicates in what 
quadrant a piece is located.  

 

Path 

A path is all the information the system requires to locate a directory (storage area) or 
file. When you type a path, a colon (:) and backslash (\) separate the drive from the 
directory; backslashes are used to separate the directory, any sub-directories, and the 
filename. 

Drive:\directory\sub-directory\filename 

c:\PDS\springdata\shirt98 

 

Perimeter/boundary Lines 

Solid lines designate the shape of a piece as it was originally digitized or created.  

Intersections of Perimeter/boundary Lines 

Each perimeter/boundary line has two end points. Therefore, at any location on the 
piece where two perimeter/boundary lines intersect, there are two end points. A 
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computed intersection occurs whenever one line crosses another or would meet if 
extended. 

Many functions have a checkbox that allows both the endpoints at an intersection to 
be modified or edited as one. For most data, these options should be selected.  For 
MicroMark data, particularly data with unclipped lines and line extensions, this option 
may need to be deselected to allow for modifying the individual end points.  

 

Piece 

A piece is a geometric shape that can become a pattern piece when saved. A piece 
may also be a pattern piece that was digitized on an AccuMark or MicroMark system, 
created in Silhouette, or created in AccuMark or MicroMark PDS. In order for 
PDS/Silhouette to recognize a piece, it must have at least three adjacent lines.  

 

Pivot Point 

The pivot point can be any internal point (not necessarily an existing internal point) in 
a piece. The selected geometry, for example line or dart, that is being moved pivots 
around this point. 

Pleat 

The open side of the pleat is the side you add material to when you create pleats or 
the direction in which you plan to add the next pleat.  

The lay side of the pleat is the side the pleat is folded into.  

Pleat depth is the distance from the outside fold of the pleat to the inside fold. 

 

Point Attributes 

Point attributes are used to define specific point characteristics such as 
Smoothing/Curve Points or Non-smoothing/Turn Points, buffering, or lift and plunge. 
Use the Edit Point Info box to verify point attributes or see a list of available point 
attributes. 

Point Numbers 

Point numbers are sequential numbers automatically assigned to end points and 
grade points when a piece is created or edited. They help to tell you in what order the 
end points were digitized. These numbers can be used to assign block buffering or 
used to assist in pattern matching. You can also manually assign specific or special 
point numbers when you digitize a piece. 
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Prompted Values 

A Prompted value in a macro is a value that the system does not apply automatically, 
but rather waits for your input during Perform Macro. Each time you need to specify a 
Prompted value, the system pauses to allow you enter it.  

 

Reduce Factor 

The Reduce Points function in the Points menu allows you to enter a factor to control 
the number of intermediate points that are removed when using this function. 

The higher the number entered here, the greater number of points removed. A lower 
setting, such as the 0.4 default, eliminates fewer points. 

Rule Table 

Rule tables set up the base / sample size and size line for all pieces. 

Rules – Tangent 

Tangent rules are used to grade the position of a notch along a line. Tangent rules 
only have one value.  

Rules – Perpendicular 

Perpendicular rules are used for line grading. Perpendicular rules give a similar affect 
as AccuMark Offset grading, but these rules can be assigned at digitizing time and are 
valid even after the piece geometry is modified. 

This is the size of the pattern upon which all grade rule data is applied. 

 

Seam Allowance 

Seam allowance is an amount added to the piece perimeter/boundary to allow for 
sewing. When seam allowance is first added to a piece, dashed lines display inside or 
outside of the piece perimeter/boundary.  

Making Edits After Adding 

To make edits to a piece after adding seam allowance, you can use the Swap/Sew 
Cut function in the Piece/Seam menu to swap the sew and cut lines. Dashed lines will 
display where the perimeter/boundary lines previously were. When finished making 
edits to the solid lines, use Swap/Sew Cut again. 

Score Line 

A score line is different from a mirror line in that it "reflects" only the geometry 
selected to be scored across the score line and the new piece is not symmetrical.  
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Slash Lines 

Adding slash lines to a pattern is a method of cutting from the free edge to a 
designated point in the body of the piece or from two designated points within the 
piece in order to achieve a design detail. Slashing can be used to produce a sharp 
corner, to allow for the insertion of a gusset or in the process of: 

• Opening tailored or bound buttonholes or pockets; 
• Opening eye and open-slip buttonholes 
• Opening darts in interfacing 
• Opening the fold of a dart in heavy fabrics. 

Slash lines are referred to when using the following menus: 

• Darts Menu  

• Fullness Menu  

• Pleats Menu  

 

Sloper 
Sloper is a pattern of a garment section, without style lines or seam allowances, 
developed from specific measurements, model form, live model, or manufacturer’s 
specifications. It can be thought of as a template used to create or base new 
designs upon. 

Pivot/Pivoting 

The shift or moving of a sloper from a marked position towards a designated guide 
line. This is usually used as part of the process of developing a new design and is an 
alternative to or can work in conjunction with the slash and spread method. Pivoting is 
controlled from the apex, point or points on the perimeter/boundary, or from a given 
point within the sloper. 

Slash and Spread 

Part of a process for developing a new design and/or introducing fullness to a design, 
by cutting a sloper along predetermined guide lines and opening or spreading apart 
the pieces to a designated measurement. Slash and spread can be used as an 
alternative or in conjunction with the pivot method to manipulate the sloper. 
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Smoothing Points 

These points are used to display curved (smooth) lines on the pattern as they will 
appear if you plot them. They are represented by circles and have an S attribute. 

 

Stacking Points 

Z and R attributes are used as stacking points to maintain grading when pieces are 
combined using Create Trace, Split Piece, Mirror Piece, and Combine/Merge 
functions in the Piece menu. Using a Z attribute stacks all pieces in the graded nest at 
this common point. Using an R attribute along with the Z attribute rotates all pieces in 
the graded nest on a common line (connecting Z and R points). 

Note: Sizes have to rotate when the slope of a common line changes throughout the 
graded nest. The grain/grade reference line also rotates when using an R attribute. 

Standard Piece 

In MicroMark, a piece that is not stored within a style. Standard pieces can be shared 
between different styles. A standard piece is defined using the Style Description 
function in the File menu. 

Storage Areas 

When working in AccuMark, your work is stored in user-defined areas called storage 
areas. Storage areas reside on devices. When you need to retrieve or save data, a 
pop-up will display the default settings. You may change the default settings for the 
device and the storage area if needed. 

 

Style 

A collection of all MicroMark pieces required to create a single garment. This includes 
all the pieces of material group needed to complete the garment.  

Similar to Model for AccuMark data. 

 

Tracking 

Point tracking is used to view individual points on a line or a piece. If tracking is turned 
on in Preferences/Options, as you move the cursor along a line a box displays 
showing information about the current point. If AutoTracking is Off, click the Track 
button in the Edit Info box before automatic tracking begins. 
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NOTE: The keyboard arrow keys, as well as the arrow keys in the screen dialog 
box, can also be used to track points 

 

Turn Point 

A user-defined intermediate point for a MicroMark piece. Turn points, which allow 
blending of straight lines and sharp angles, have a N attribute. Turn points can be 
added while digitizing a piece or while making edits to the piece, such as adding a 
notch. 

Underlay 

Underlay is the portion of the pattern which constitutes the inside or underside of the 
design, fold line, or dart pick-up. It is formed when establishing darts, pleats, closures, 
and extensions. In relation to pleats, underlay is the distance equal to twice the 
"depth" of the pleat. A half underlay is the same as half the finished width of the pleat. 

 

Work Area 

In PDS/Silhouette you can have multiple work areas, each in its own window. For 
example, you could create a new work area and then open an existing model or style 
in a second work area. 

You can have multiple work areas open in the PDS/Silhouette work space. 

 

Workspace 

Workspace refers to the entire main PDS/Silhouette window. You can customize your 
workspace to suit your needs.  

You can have multiple work areas open in the work space. 

X and Y Axes 

A grid is used to determine positive or negative X and Y movements applied to a 
piece.  

For example, when grading a piece, you start with a base size and grade by going up 
and down and in out to get all of your sizes. On the grid, the X and Y movements take 
the place of manual up and down, in and out movements. Refer to the figure below. 
The horizontal line is called the X-axis and the vertical line is called the Y-axis. X and 
Y coordinates are assigned positive and negative values. 
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On the status bar, when you move a line or point, the X and Y coordinates change 
with the movement.  

• A positive (+) X increment is the same as an upward (right) motion. 
• A negative (-) X increment is the same as a downward (left) motion. 
• A positive (+) Y increment is the same as an outward motion. 
• A negative (-) Y increment is the same as an inward motion. 

 

X Point 

A visible reference point which can be located on a line or in space.  

 

Base point 

A reference point to which a notch is attached to.  

Size Code 

The Size Code Editor defines the sizes that should be put in a marker and whether or 
not they will be altered. The size code can be used to change the names of sizes 
without using another rule table. The system uses the rule table along with alteration 
rules to create a new size. A size code library can be used alone or with an alterations 
library. 

 

Renderer 

To convert graphics from a file into visual form, as on a video display. 

 

User Input Function/Prompt Section 

This top section of the User Input box identifies the function currently being used 
and prompts you to take the next action to complete the function. 
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Using Options Pop-up Menus for Functions 

PDS/Silhouette provides tools that help you follow the steps for various functions. 
These include prompts, changing cursor shape, and the Options Pop-up menu. 

Options Pop-up menus are available while in the work area and when using 
functions These construction tools have been added to increase productivity. 
Options available at any given time depend on the function being used and the 
prompt currently displayed for the function. 

 

Piece Properties 

  

The piece properties window displays the following types of information for the 
selected piece:  paths; model/style; rule table; piece name, category, description; 
fabric type; digitized boundary; seam settings status – severed boundary, auto 
update seam, seam extensions, and move end points; number of points per piece. 
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